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Welcome to ProWORX NxT 2.0

ProWORX NxT is the most advanced programming software available for
Modicon logic controllers. It gives you the power to program online and
offline in a familiar Microsoft Windows environment. If you know how to use
a mouse, you can work in ProWORX NxT quite easily!

About this manual

This manual is a guide for installing and operating ProWORX NxT. It does not
contain information about specific controllers, I/O cards, or ladder logic
instructions. This kind of hardware and ladder logic information is available
in the NxT help system.

This guide uses the following conventions:

e “Click” and “double-click” mean click the left mouse button once or
twice (respectively) while the cursor is positioned on a button or item.
“Right-click” means click the right mouse button once while the
cursor is positioned on a button or item.

* Boldis used to emphasize fields and buttons, and to give instructions.

* Keystrokes are presented inside angle brackets. For example, “Press
ENTER” means press the Enter key on your keyboard.

If you are new to Microsoft Windows

ProWORX NxT uses the same operating conventions as most other Windows
programs. You should be familiar with these conventions before starting to
use NxT. This manual assumes that you can:

* Use a mouse to click, double-click, and perform drag-and-drop
operations.

* Select items using menus, toolbars, checkboxes, and drop-down lists.
* Navigate through standard open and save dialog boxes.
* Locate items in an online help system.

% If you're new to Windows or haven’t used some of these features
before, refer to your Windows documentation for instructions.

2 ® \Welcome to ProWORX NxT 2.0
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Installing ProwORX NxT

System requirements
To run ProWORX NxT (Online and Offline), you require:

A PC-compatible computer with a 33 MHz 80386DX or faster
processor (Pentium system recommended).

Microsoft Windows 3.1, 95, or NT 3.51 or later.
4 MB of RAM.
25 MB of available hard drive space (45 MB with drawings).

An asynchronous adaptor (RS-232 serial port or an SA85 card) for
direct communication with programmable controllers.

A printer port and compatible printer to generate document listings.

One or more Modicon controllers.

How to install ProWORX NxT

You can install ProWORX NxT in one easy step from the CD. The CD also
allows you to make a set of floppy disks so you can install ProWORX NxT on
PCs which do not have a CD-ROM.

» Toinstall ProwWORX NxT from the CD:

See the directions in the booklet that comes with your CD.

Windows 95 and NT 4.x only

The Installer updates your Start menu to include the ProWORX NxT Online
and Offline Editors, Drawing (DXF) Viewer, and Product Authorization
Wizard. It does not create any other shortcuts.

» To create a shortcut on the Windows desktop:

1.
2.
3.

Right-click the desktop.
Click New, then click Shortcut.

In the Command Line field, type the full path and file name of the
version of NxT to which you want a shortcut. If you used the standard
NxT install options, this is c:\proworx\nxt\nxton.exe or nxt.exe.

Installing ProwORX NxT @ 3



ProWORX NXT User's Guide

Click Next.

Type ProWORX NxT Online or ProWORX NxT as the shortcut name,
then click Next.

6. Select an icon, then click Finish.

You can also make shortcuts from the folder where you installed NxT. Click the
@ icon of an NxT editor and select Create Shortcut or right-click the icon of an

editor and select Create Shortcut . Now move the new shortcut to where you
want it.

Registering your product

If you received one, please take a few moments to fill out the registration card

in your software package. Registering helps us notify you of updates to this
product.

4 @ Registering your product
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Starting ProWORX NxT

Windows 3.1 and Windows NT 3.51

Once you have installed ProWORX NxT, open its Program Group (ProWORX
by default), then double-click the program item (icon) of the editor you want.

Double-click to launch
NXT Offline. - P AL
%:5 % |2
2 ZE &8 2
ProwOR= FrotfOR Di=F Wiewer MuT Help unlnztall Froduct
M=T MxT Online ProwOR»>  Authorization
/ NxT \
Double-click to Double-click to view JIC and Double-click to remove Double-click to}onvert
launch NXT On- Process drawings, if you in- NXT from your computer. NXT from a demo to a full
line. stalled them. version.

When you start either the Offline or Online Editor, a minimized program
called “Graphics Server” appears in the Program Manager next to the editor’s
icon. A second minimized program appears in the Program Manager when
you

* Open a database in the Offline Editor (in which case the minimized
program is called “NxT Startup”).

*  Connect to a controller in the Online Editor (in which case the
minimized program is called “NxTOn Startup”).

NXT requires the Graphics This icon shows the Offline Editor.
Server. Do not force it to close \% % % / If you minimize either NxT editor,

manually. = double-click its icon to maximize
Graphics M=T Startup  ProwOR» NxT (restore) the window.
Server

The Offline and Online editors require
their respective Startup programs.

Do not force either minimized program to close as NxT requires them to operate.
They close automatically when you exit NxT.

Starting ProWORX NXT @ 5
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Windows 95 or Windows NT 4.x
Once ProWORX NXxT is installed, start the application in one of these ways:

*  Click Start, then Programs. Select the folder where you installed NxT
(ProWORX by default), then select the editor you want.

= ; , Click to see JIC and

Accessories Process drawings, if

StartUp 3 you installed them.
QR L4 &I DxF Viewer

Click to convert NxT

E MS-D05 Prompt E} Product Autharization from a demo to a full
@ ‘windaws Explorer @ Pro\wDRE MxT version.
B Programs L4 WinZip Prow/ORx NxT Online
o }-@— - N Click to launch NxT
Documents Offline.
Settings 4
2] Find 3 Click to launch NxT
Online.
& Help
ﬂ Bun...
@ Shut Diown...

*  Click Start, then Run. Type the path of the folder where you installed
NxT (C:\ProWORX\NXT by default), followed by \NXT for the
Offline Editor or \NXTON for the Online Editor. For example, if you
installed NxT into its default location and want to start the Offline
Editor, at the Run prompt, type:

c:\proworx\nxt\nxt

* Ifyoucreated shortcuts to NxT’s Online and Offline editors during the
installation procedure, double-click the icon of the editor you want.

6 ® Windows 95 or Windows NT 4.x
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When you start either the Offline or Online Editor, a minimized program
called Graphics Server appears in the Taskbar next to the Editor’s button. A
second minimized program appears in the Taskbar when you

* Open a database in the Offline Editor (in which case the button is
labelled “NxT Startup”).

* Connect to a controller in the Online Editor (in which case the button
is labelled “NxTOn Startup”).

a Slalll %Graphics Server | NxT Startup |PmW'l]F|X MxT
NXT requires the Graphics The Offline and Online editors This button shows the Offline Ed-
Server. Do not force it to close require their respective Start- itor. If you minimize NxT, click to
manually. up programs. maximize (restore) the window.

Do not force either minimized program to close as NxT requires them to operate.
They close automatically when you exit NxT.

Windows 95 or Windows NT 4.x ® 7
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Authorizing ProWwORX NxT

Until you authorize your copy of ProWORX NxT, it runs in demonstration
mode. You have access to all NxT features, but are limited to 25 networks of
logic per database. When you authorize your copy, you can use up to 5,000
networks of logic per database.

You can authorize NxT with either a software or hardware key.

» To authorize NXT with a software key:

1. Have the serial number for your copy of NxT ready.

o,

5 If you don’t know your serial number, start NxT, then select About on the Help
k menu to find it.

2. The Product Authorization window appears when you do one of the
following:

* Start NxT, then on the Help menu, click Authorize Product.

* From the Windows 95 or NT 4.x Desktop, click Start, point to
Programs, then select the folder where you installed NxT
(ProWORX by default). Select Product Authorization.

¢ In Windows 3.1 or NT 3.51, double-click g in the Program
Group where you installed NxT (ProWORX by default).

3. Click Software Keys. A list of registered products appears.
Click Add to start the Product Authorization Wizard.
5. Do one of the following:

* If you have already received a Key Code on a 3'%” disk, select
Authorize by Disk, then click Next.

* If youdo not yet have a Key Code, select Authorize by Phone/Fax,
then click Next.

6. Follow the instructions as they appear on your display.

8 @ Authorizing ProWwORX NXT
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» To authorize NXT with a hardware key:

1. Locate the hardware key and the 3'4” disk labelled “NxT Hardware
Key Authorization” included with your installation package.

Insert the NxT Hardware Key Authorization disk into your 3%” drive.

3. From the Windows Explorer or Program Manager, run A:\SETUP (or
B:\SETUP). The Install Wizard authorizes NxT to run with the key.

4. Plug the hardware key into the parallel port (also called the LPT1
printer port) of your PC. This “pass-through” hardware key will not
interfere with other devices attached to the port.

» To confirm that your hardware key is working correctly:

1. Have the serial number for your copy of NxT ready.

o,

5 If you don’t know your serial number, start NxT, then select About on the Help
k menu to find it.

2. Do one of the following:
* Start NxT, then on the Help menu, click Authorize Product.

* From the Windows 95 or NT 4.x Desktop, click Start, point to
Programs, then select the folder where you installed NxT
(ProWORX by default). Select Product Authorization.

* In Windows 3.1 or NT 3.51, double-click @ in the Program
Group where you installed NxT (ProWORX by default).

The Product Authorization window appears.

3. Click Hardware Keys. The Hardware Key Viewer checks the key in
your PC’s parallel port. It displays the names, serial numbers, and
options of the products configured on the key.

4. Confirm that the products and serial numbers listed for the key match
yours, then click Exit.

Authorizing ProWORX NxT @ 9
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Customer support

Customer support is available to registered ProWORX NxT users.

If you have a question about ProWORX NxT and can’t find the answer in this
User’s Guide or in the NxT Help system, contact our Customer Service staff for
assistance. You can reach Customer Service department by Internet,
telephone, fax, or mail:

Schneider Electric

One High Street

North Andover, MA 01845

Internet: http:/ /www.proworx.com

Email: customercentral@schneiderautomation.com
Support Hotline: ~ (888) 266-8705

Telephone: (978) 794-0800

Fax: (978) 975-9301

Leave NxT running on your computer and call from a telephone near it. To
help us assist you as quickly as possible, we suggest you have the following
information ready:

*  The version and serial number of your copy of NxT. To find this
information, on the Help menu, click About in the NxT Title Screen or
Network Editor.

*  What you were doing when the problem occurred, whether you can
repeat the problem, and any error messages you received.

* Information about your computer, including its processor type,
memory, hard drive size, video card type, and I/O boards.

*  Your version of Windows. To find this information:

Windows 95 or NT 4.x: click Start, then Settings. Select Control Panel.
When the Control Panel window opens, double-click System. When the
System window opens, select the General tab. Your version of Windows
is listed under the heading System.

Windows 3.1 or NT 3.51: From the Program Manager, on the Help menu,
click About the Program Manager.

10 e Customer support
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Working with a database: Overview

ProWORX NxT holds information about each of your controllers in a database.
The database consists of a group of files which store

*  The controller’s configuration;
* Its networks of ladder logic; and
*  Descriptors of the controller and ladder logic.

The files making up one database have the same file name but different file
extensions.

o

% To learn how these file extensions identify the parts of a database, see
Appendix B - File Extensions on page 351.

To work with a controller offline, you must create a database for it. This
database stores the controller’s Traffic Cop and configuration information, its
ladder logic, and descriptors of the controller and ladder logic. As you work,
the Offline Editor modifies this data. Because the Offline Editor is not
connected directly to the controller, changes made in it do not take effect
immediately. Instead, when you have finished programming, you write all
your changes to the controller in one pass.

To work with a controller online, you do not have to open its database. The
Online Editor reads ladder logic, Traffic Cop information, and the controller’s
configuration directly from the controller and writes back to it, so the database
is not needed. However, descriptors are stored in a controller’s database, not
the controller itself, so if you do not have its database open, you cannot read
or edit a controller’s documentation. For this reason, it is usually a good idea
to open a controller’s database while working online. Opening a controller’s
database may also help remind you that changes made in the Online Editor
take effect in the controller immediately, but don’t appear in its database until
you read the new logic from the controller.

7

% For more information on reading and writing to a controller, see
page 102.

12 e Working with a database: Overview
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Creating a new database

This section tells you how to create a new, empty database from either the
Online or Offline Editor. You can also create a new database to contain ladder
logic and configuration information as you read it from a controller.

7

% Tolearn how, see Reading from a controller on page 102.

Creating a new database in the Offline Editor consists of entering summary
information, setting the number and length of the database’s descriptor fields,
and specifying the type of controller the database describes and its options (its
address, additional memory, I/O cards, etc.).

To create a new database in the Online Editor, you must be attached to a
controller. You are prompted for summary information and the number and
length of descriptor fields you want, but not for a controller type or options
(the Online Editor reads this information from the controller itself). The first
time you open the database in the Offline Editor, you are prompted for the
additional controller information.

Part 1: For both the online and offline editors

> To create a new database:
1. The New dialog box appears when you do one of the following:

¢ From the Title Screen of the Offline Editor, on the File menu, click
New.

¢ From the Network Editor, on the File menu, click New.

¢ In the Network Editor, click - on the toolbar.
2. Type a path and file name for the new database.

Creating a new database ® 13
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3. Click OK. The Database Setup dialog box appears.

Database Setup

Description: |PloWDRX NxT Sample Databasze

Page Header: |Sample Database

|
|
Summary information / (s | |
|
|

Llient: |

Author: |

Controller Address: Descriptor Field Width:
Hetwork: Row: lz‘ Column: Mumber of Descriptor Fields:

Controller information —T Descriptor Field
Confirm Address on Entiy: @ Yes O No No. of Network Listing Fields: Information

(114 I Cancel | Help |

4. Enter summary information for the database:

* Inthe Description field, type a short description of the database (its
purpose, logic, process, etc.).

* Inthe Page Header field, type a title for the database. This text will
appear at the top of printouts from the database.

* In the Project field, type a project identification code or number.
* In the Client field, type the name of a client.

* In the Author field, type the name(s) of the person(s) creating the
database.

5. Enter information about the controller for this database:

* In the Controller Address field, type the address of the controller
that the database describes. The format of the address depends on
whether the controller is part of a Modbus, Modbus Plus, or
Ethernet network. NXT does not assign the address in this field to
the controller; it is for reference only.

7
*

To assign a Modbus address to a controller, see Controller
configuration - Ports tab on page 60.

* In the Network, Row, and Column fields, type the location of a
ladder logic network. The Online Editor jumps to this location
when it starts up.

14 e Part 1: For both the online and offline editors
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* In the Confirm Address on Entry field, select whether NxT
automatically connects to the controller in the Controller Address
field when you enter the Online Editor or displays the Select Device
window (where you can manually select a controller).

6. Set the number and width of descriptor fields for the database:

* Inthe Descriptor Field Width field, type the maximum number of
characters (9, 12, or 15) each descriptor field can hold.

* In Number of Descriptor Fields, type the number of descriptor
fields (5 to 9) that will be available for each instruction in logic.

* In No. of Network Listing Fields, type the number of descriptor
fields (3 to 5) for each instruction in logic that print when you print
a ladder logic network.

7. Click OK.

* If you are working in the Online Editor, NxT creates your
database. The first time you open this database in the Offline
Editor, you will be prompted for more information about the
controller.

* If you are working in the Offline Editor, go on to Part 2.

Part 1: For both the online and offline editors ® 15
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Part 2: For the offline editor only

Because the Offline Editor is not connected directly to the controller, it requires
more information than the Online Editor before it can set up a database. After
you select options for your database, NxT prompts you for information about
the type of controller you have.

» To specify a controller type for a new database:

1. When you click OK in the Database Setup window, the Select
Controller Type dialog box appears.

Select Controller Type

Start by selecting a Controller Groups: Lonhiallers: The (_;ontrqllers inthe group appear in
controller group. o YT the right side of the window. Sel_ect

484 Replacement 984-381E your controller you want, then click

OTHER 984-385 oK

9BAAEK 984-385E/D :

584 -

Quantum

Compact

Micro

(114 | Cancel | Help |

2. From the list on the left, select a controller group. A list of controllers
in the group appears on the right.

3. From the list on the right, select the type of controller for the new
database.

4. Click OK. Depending on the controller type you select, the Edit

Controller Details dialog box may appear. If so, complete Steps 5 and
6.

With the drop-down menus, type details about your controller.

Click OK. NxT sets up your database. For your convenience, the
Controller Configuration window opens so you can set up your
controller.

% For more information, see Configuring a controller on page 54.

To configure your controller later and return to the Network Editor,
click OK.
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Opening an existing database

In addition to its own databases, ProWORX NxT can open databases from
ProWORXPLUS v1.40 or later directly.

Databases from ProWORX, early versions of ProWORXPLUS, Modsoft, or
competitive products must be converted to NxT’s format before they can be
opened.

» To open an existing database:
1. Do one of the following;:
¢ From the ProWORX NxT Title Screen or the Network Editor, on the

File menu, click Open.

¢ In the Network Editor, click in the toolbar.

¢ TFrom the Title Screen, on the Controller menu, click Select Device,
then click Select Setup.

The Open window appears.
2. Type the path and file name of the database, then click OK.

i NXT lists the last nine databases you have opened at the bottom of the File
k menu. You can open any database from the list by clicking its name.

Converting an older ProWwORX database

ProWORX NxT includes a stand-alone utility for converting logic in
ProWORX and older ProWORXPLUS databases to NxT’s format. Databases
from ProWORXPLUS v1.40 or later are fully compatible with NxT and do not
require conversion.

The Import/Export command found on the File menu under Utilities does not
@ import logic into ProWwORX NXT, only documentation.

% For more information, see “Importing database documentation into
ProWORX NxT” on page 221.
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» To convert logic to the NxT:

A

The database you select receives data from the converted file. It will be
completely overwritten.

you select.

Click Start, point to Programs, then to ProWORX and click %
NxTConv. The NxT Convert Utility dialog box.

MxT Convert Utility E

O Update old ProwW0ORX database to NxT

O Convert Updoc database to NxT
O Convert NxT database to Prow0ORX

O Convert to a Macro

Select a database for the source: o
| | Browse | | |  This field appears for

—[~ conversions that require
Select a new datab for the destination: / a destination.
| | Browse |
Click to convert
the database(s) \
Start | Cloze | Help |

Select one of the following:

* Update an old ProWORX database to NxT.
* Convert a Modsoft database to NxT.

* Convert an Updoc database to NxT.

* Convert an NxT database to ProWORX.

* Convert an NxT database to a macro.

Type the path and file name of the source database or click Browse to
navigate to it.

If the conversion requires a destination, type the path and file name of
the destination or click Browse to navigate to it.

Click Start. The database or macro is converted.
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Editing the setup of a database

At times, you may need to change the setup of an existing database because of
a change in the address of the database’s controller, for example, or to add
additional descriptor fields. You can easily modify the summary, controller,
and descriptor field information of a database.

» To edit the setup of a database:

1. From the Network Editor, on the File menu, click Utilities, then click
Database Setup. The Database Setup dialog box appears.

Database Setup

Description: |PloWDRX NxT Sample Databasze

Page Header: |Sample Database

Summary information / (e |

Llient: |

Author: |

Controller Address:
Hetwork: Row: lz‘ Column:

Confirm Address on Entiy: @ Yes O Mo

Controller information —T

Descriptor Field Width:
Mumber of Descriptor Fields:
No. of Network Listing Fields:

0K I Cancel |

Help |

Descriptor Field
Information

2. Make changes to the summary information for the database:

* Inthe Description field, type a short description of the database (its
purpose, logic, process, etc.).

* Inthe Page Header field, type a title for the database. This text will

appear at the top of printouts from the database.

* In the Project field, type a project identification code or number.

* In the Client field, type the name of a client.

* In the Author field, type the name(s) of the person(s) creating the

database.
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3. Make changes to the controller information for the database:

* In the Controller Address field, type the address of the controller
that the database describes. The format of the address depends on
whether the controller is part of a Modbus, Modbus Plus, or
Ethernet network. NxT does not assign the address in this field to
the controller; it is for reference only.

% To assign a Modbus address to a controller, see Controller
configuration - Ports tab on page 60.

* In the Network, Row, and Column fields, type the location of a
ladder logic network. The Online Editor jumps to this location
when it starts up.

* In the Confirm Address on Entry field, select whether NxT
automatically connects to the controller in the Controller Address
field when you enter the Online Editor or displays the Select Device
window (where you can manually select a controller).

4. Set the number and width of descriptor fields for the database:

* Inthe Descriptor Field Width field, type the maximum number of
characters (9, 12, or 15) each descriptor field can hold.

* In Number of Descriptor Fields, type the number of descriptor
fields (5 to 9) that will be available for each instruction in logic.

* In No. of Network Listing Fields, type the number of descriptor
fields (3 to 5) for each instruction in logic that print when you print
a ladder logic network.

5. Click OK. You may be prompted to confirm your changes. To keep
them, click OK.
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Saving and deleting a database

NxT saves changes to the open database automatically and frequently. It saves
your work whenever you exit the Traffic Cop or Controller Configuration
windows, move from one network of logic to another, close your database, or
change between Online and Offline editing. You therefore do not need to save
your work manually.

Use the Save As command to create a copy of a database before, for example,
making significant changes to it. The Database Backup/Restore function can
also create a copy of a database, but the Save As command may be faster as it
does not compress the database’s files.

» To save a copy of a database:

1. From the Network Editor, on the File menu, click Save As. The Save
As dialog box appears.

2. Type a path and file name for the database.

To save your copy in the same folder as the original database, give the
copy a different name.

3. Click OK. NxT saves a copy of your database.

Deleting a database (offline only)

Deleting a database erases all database files, including logic, traffic cop
information and documentation. You can only delete a database while offline.

» To delete a database:

1. From the ProWORX NxT Title Screen or the Offline Network Editor,
on the File menu, click Delete.

2. Type the name of the database file in File Name or browse to the
database file you want to delete.

3. Click OK.
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Backing up and restoring a database (offline only)

The Database Backup function compresses a copy of all the files making up a
database to a single .ZIP file. The Restore function expands a previously-
compressed .ZIP file into a usable set of database files.

Use the Database Backup/Restore function to create a small copy of a
database to store, for example, on removable media. The Save As command
can also create a copy of a database, but it does not compile the database’s files
into one file or compress them.

The Database Backup and Restore functions are not available while you have
a database open or while you are working with a controller online. To backup
or restore an active database, first close it (it's saved automatically), then
follow the procedures below.

» To back up a database:

1. From the ProWORX NxT Title Screen, on the File menu, click
Database Backup/Restore. The Database Backup/Restore dialog box

appears.
Database Backup/Restore E
|_ Select a database and
@® Backup Database:[C:\PROWORX\NXTA\DEMO | Browse...|—1 .Z|P file here.

Select either the Backup—""
or Restore function.

O/Restore | | Zip Location:[C:\PROWORX\NXT\DEM0.Z Browse... |

Start | Cancel | Help |

Click Backup.

Type the path and file name (with a .DCF extension) of the database to
back up or click Browse to navigate to it.

4. Type the path where the compressed .ZIP backup file is to be created
or click Browse to select a path.

5. Click Start. A temporary DOS window appears, and the database files
are compressed.

22 @ Backing up and restoring a database (offline only)



Chapter 2 Working with a Database

» To restore a database:

1. From the ProWORX NxT Title Screen, on the File menu, click
Database Backup/Restore. The Database Backup/Restore window
appears.

Click Restore.

Type the path and file name of the compressed .ZIP backup file to
restore or click Browse to navigate to it.

4. Type the path where you want to restore database or click Browse to
navigate.

5. Click Start. A temporary DOS window appears and the database files
are decompressed.
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Keeping NXT secure

The NXT Security Settings restrict access to certain functions of ProWORX
NxT. A password is required to change the settings to make those functions
accessible. This can be useful if multiple users are likely to work on the same
machine and you don’t want all of them to have access to every single feature.

S

1
T™

If the SecurWORX or fxManager products from Total Control Products (Canada)
Inc. are installed, the NxT Security Settings will have no effect.

++ For more information on fxManager, see “Appendix G - NxT and fxManager”
on page 383.

» To change the security settings:
1. Do one of the following;:
* From the main startup screen, on the File menu, click Security.

* Attempt to access a restricted function and click Yes when NxT
asks if you want to change the Security Settings.

2. Type the Supervisor Password. If this is the first time anyone has tried
to access the Security Settings, the password is PROWORX. The

Security Options dialog box appears.

& It is strongly recommended that you change the default password as soon as
possible.

3. Typeanew Supervisor Password, if desired. The password can be up
to 32 characters long. Type the same thing in Confirm Password.

4. Select or clear the desired Security Options. Selecting an option allows
unlimited access to the given function. Clearing an option prevents
users from accessing the function.

* ALT+P Function Active (Monitor/Program Mode): If selected, the
user can switch to Program Mode in the Online Editor.

* Online Logic Editing: If selected, the user can modify logic while
in the Online Editor.

» Start/Stop Controller: If selected, the user can start or stop a
controller.
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Read From Controller: If selected, the user can read information
from a controller. This option also affects operations that require
NxT to read from the controller, such as comparing databases.

Write To Controller: If selected, the user can write information to a
controller. This option also affects operations that require NxT to
write to a controller, such as initializing logic.

Traffic Cop Editing: If selected, the user can configure I/ O with the
Traffic Cop. If this option is cleared, the user can view Traffic Cop
information, but can’t change anything.

Controller Configuration: If selected, the user can save changes in
configuration to the controller. If this option is cleared, the user can
view the configuration, but can’t make any changes.

Enable Protected Registers: If cleared, the user has read and write
access to all register addresses. If selected, the user has read-only
access to addresses within the list of “Protected” ranges. The user
still has both read and write access to addresses outside of those
ranges. To change the Protected addresses list, click Edit List.

Click OK. If you typed a new Supervisor Password, you're prompted
to type the password again before the new settings are accepted.

D

If you forget your password, contact Customer Support.

For more information on contacting Customer Support, see page 10.

Editing the protected register address list

You change the list of protected addresses from the Edit Protected Registers
dialog box.

A

If Enable Protected Registers is cleared in the Security Options dialog box, the
address ranges you enter here will have no effect.

To secure registers in all databases:

From the ProWORX NxT Title Screen, on the File menu, click
Security.

Editing the protected register address list ® 25



ProWORX NXT User's Guide

Click Edit List. The Edit Protected Registers dialog box appears.

Edit Protected Registers

@+ Protect Specific Databaze
" Pratect Online %ithout a Database

Database:
‘D:\DB\DATA

Browse. .. |

4% address range to protect: Frotected Ranges:
From: [4:00005 400007 - 400002
400003 - 400004

Add

Delete

b

0K Cancel

Select Protect Online Without a Database.
Type the first address of the range in the From box.
Type the last address of the range in the To box.

The protected address ranges apply regardless of which (if any)
database is currently open, and of whether ProWORX NxT is online or
offline. Thus, you must type an entire six-digit address in the From
and To boxes.

Click Add. The new range is added to the list displayed in the
Protected Ranges box.

» To secure registers in a specific database:

1.

From the ProWORX NxT Title Screen, on the File menu, click
Security.

Click Edit List. The Edit Protected Registers dialog box appears.
Select Protect Specific Database.

Type the path and file name of the database you want or click Browse
to navigate to it.

Type the first address of the range in the From box.
Type the last address of the range in the To box.
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The protected address ranges apply regardless of which (if any)
database is currently open, and of whether ProWORX NxT is online or
offline. Thus, you must enter an entire six-digit address in the From
and To boxes.

7. Click Add. The new range is added to the list displayed in the
Protected Ranges box.

» Toremove a range of addresses from the list:

1. In the Protected Ranges box, select the range to be deleted.
2. Click Delete.
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Year 2000 compatibility check

The Year 2000 (Y2K) Compatibility Check checks your databases to see if it will
function correctly after midnight, Dec. 31, 1999. The Y2K problem occurs
because most early software stored only the last two digits of years to conserve
memory. Normally this works fine, since the computer revolution has so far
taken place in the same century. However, when the turn of the millennium
occurs, a non-Y2K compliant software program will think that the current year
(stored as "00") is older than the previous year (stored as "99").

» To check databases for Year 2000 Compatibility:

1. From the Network Editor, on the Tools menu, click Y2K
Compatibility.

2. Click Browse and navigate to the directory containing databases you
want to check.

3. Click Check DB’s. All databases in the chosen directory are tested.

Databases that are Y2K compliant are marked as “Yes” in the Year
2000 Compliant column. Databases that might not be Y2K compliant
are marked with “Suspect”.

i The Year 2000 Compatibility Check works by checking whether a database uses
K a Time of Day clock, marking those that do as “Suspect”. Thus, a “Suspect”
database will not necessarily fail to work at the turn of the century — it's just that
the possibility exists.

4. Youcanclick Print to send a report of the results to the default printer.

5. Click Close when you're finished.
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Setting system preferences

You can change several of NxT’s configuration settings in the system
Preferences dialog box. These options affect how NXT works with databases
and how it behaves when it starts up.

» To configure your preferences:

1. From the Title Screen or Network Editor, on the File menu, click
Preferences. The Preferences window appears.

6 Digit Add

[® Initialize 5A85 Adapter: | ® C -
[® Initialize lapter: (@0 O1 ® Auto O 0n
[ Multi Function Naming

[ Multi User Access

Maximum Decimal ¥alue:

DEmfes @999 (65535
[ Display Editor For New Instructions

[® Keyboard Menu Options Enabled Add Watch/Track Data Into:
[ Emulate ProwORXPLUS Hotkeys ® Data Walch Window
[X Use Insert/Delete Key Menus O Data Watch Panel

[ Confirm When Overwriting Instiuctions Online Mode:

[ Confirm Network E ditor Deletions: ® Program O Manitor

X Prompt For Read When Exiting Online

[® Fill Single Type References A Auto Monitor / Logout:

[ One Line Doc Window Enabled 3 Logout @ Manitor
[ Verify Device Selection Tz i
Database Palh:‘ c:hproworndatidemadbhinst_dema ‘ Browse._. ‘

OK ] Cancel ‘ Help

2. Select the system preferences you want:

* Initialize SA85 Adapter: The SA85 Network Card driver may
sometimes interfere with Modbus communications. This option
helps reduce conflicts as you move between Modbus and Modbus
Plus networks:

*  When Modbus networking is selected, NxT disables the SA85
driver at startup to prevent conflicts.

*  When Modbus Plus networking is selected, NxT resets the SA85
driver at startup to ensure it is working.

* If you're using two SA85 cards, you must specify which card
you want to initialize: Adapter 0 or Adapter 1.
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* Multi Function Naming: This option replaces function identifier
constants in your ladder logic with four-letter descriptions of the
function operation.

* Multi User Access: Select this option if other users can edit your
NxT databases over a network. When you open a database, NxT
locks it so that no one else can edit it at the same time. When this
optionis clear, other users can access your databases even if you are
already working in them.

* Symbols: This allows you to use symbols (which you configure)
instead of addresses while editing ladder logic.

* Display Editor for New Instructions: NxT automatically displays
the Edit Instruction dialog when you place a new instruction into
logic so you can assign addresses to it immediately. If this function
is not enabled, the Network Editor displays the instruction’s
unassigned addresses as question marks.

* Keyboard Menu Options Enabled: Functions that you normally
access with keystroke combinations (for example, Goto Assembly
Register) are also placed in menus.

* Emulate ProWORXPLUS Hotkeys: This option enables the
following shortcut keys available in ProWORXPLUS (the DOS
version of ProWORX Nxt).

* ALT+S to open the Search dialog box to the address highlighted
by the logic cursor.

* ALT+O to open the Locate Coil dialog box. This hotkey only
works if the logic cursor is highlighting a Oxxxx discrete
function.

* ALT+R to open a Register Editor for the function block located
at the logic cursor. If the cursor isn't on a function block, the
Generic Register Editor is opened instead.

* ALT+T to add the address at the cursor position into the Data
Watch Panel or Data Watch Window.

* ALT+W to toggle between the Network Editor and the Data
Watch Panel.

* Use Insert/Delete Key Menus: When selected, you can access the
Insert menu by pressing the INSERT key and the Delete menu by
pressing the DELETE key. When cleared, these keys operate
normally and the menus are only accessible from the Edit menu.
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Confirm When Overwriting Instructions: NxT prompts you to
confirm each time you overwrite an existing ladder logic
instruction with a new one. This security feature is useful when
working online.

Confirm Network Editor Deletions: When selected, NxT asks you
to confirm each time you try to delete an instruction from ladder
logic as you work in the Network Editor. Use this function to
protect your ladder logic, especially while working online.

Prompt for Read When Exiting Online: When selected, you're
prompted each time you exit from the Online Network Editor to
perform a read when the controller’s contents have changed.

Fill Single Type References: When selected, the Instruction Editor
automatically fills only single address types and positions the
cursor in the entry of the address offset.

One-Line Doc Window Enabled: The small One-Line
Documentation Window replaces the standard Documentation
Editor at the bottom of the Network Editor.

Verify Device Selection: When selected and when the memory
protect state is toggled, you're prompted to verify the device after
connecting to a controller. This ensures you've attached to the right
controller. This feature is only available to users working with
SecurWORX or fxManager.

6 Digit Addressing: When On, sets all addressing to six digits,
allowing NxT to enter and display constants greater than 9999.
Auto is the default, which sets addressing to five digits unless the
controller has addresses configured that require six.

Max Decimal Value: Restricts registers to a decimal value of either
9999 (default) or 65535.

Add Watch/Track Data Info: This setting determines where Data
Watch address and tracking request additions go, either to a Data
Watch Window or the Data Watch Panel. These additions are done
through the Watch and Track items on the Data menu.

For more information on the Data Watch Panel, see page 122. For
more information on Data Watch Windows, see page 276.

* Online Mode: This allows you to set the default startup mode

when going Online. You can start up in either Program or Monitor
mode.
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* Auto Monitor/Logout: When selected with Logout, the Online
Network Editor closes after the specified amount of inactive time
and the main menu opens. When selected with Monitor, the Online
Network Editor closes after the specified amount of inactive time
and Monitor mode is activated.

* Database Path: This setting determines the default directory
(folder in Windows 95) for ProWORX NxT database projects. You
can type the path name manually or click Browse to search for the
folder you want. NxT uses this folder as the initial directory for
creating, saving and loading database projects.
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Connecting to controllers: Overview

ProWORX NxT can communicate with controllers in several ways. This
chapter explains how to configure NxT for several common types of network
connections:

Modbus: Modicon’s master/slave protocol, standard on 984 and
many other controllers. Select this option if your computer is
connected to a controller’s Modbus port, either directly or through a
modem.

Modbus through a modem: Controllers in remote locations can be
equipped with RS5-232 modems. Your computer can then connect to
the controller (by telephone, radio, or microwave systems) using its
own modem. Once the connection is established, the computer and
controller behave as if they were connected directly through a
Modbus network.

Modbus Plus: Modicon’s fast peer-to-peer protocol, standard on
many 984 and other controllers. Select this option if your computer is
connected to a Modbus Plus network through a network adapter card
such as an SA85.

Ethernet Gateway: A gateway connects two networks that would not
normally be able to communicate with each other. NxT supports
Modicon’s EMBP Gateway, which bridges your computer’s TCP/IP
Ethernet to the controller’s Modbus Plus network.

TCP/IP: Some controllers can be equipped with TCP/IP cards. Select
this option if both your computer and controller use TCP/IP
networking, regardless of whether they are on the same network or
are connected by a gateway.

This chapter also tells you how to select and attach to a controller, both directly
and by scanning your entire network for devices.
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Setting up communications for your PC

Before your computer can connect to a controller (or, for some systems, the
gateway which relays information to and from the controller), NxT must be
configured for your communication system.

To connect with each other, your computer and controller must be configured for
the same communication system with the same parameters.

In the Communication Setup dialog box, you select the communication system
your computer uses to connect to your network of PLCs. You also set
communication parameters for your PC.

Configuring Modbus communications

The Modbus Communications Setup dialog box is divided into two parts:
Modbus parameters (top) and Modem settings (bottom). Set the Modbus
parameters if your computer is connected directly to a controller’s Modbus
port or if it connects to a controller’s Modbus port through a modem.

The controller must have the same Modbus settings as the computer. Set
@ Modbus parameters for your PLC with the Ports tab of the Controller
Configuration window or with its DIP switches.

e

% For more information, see “Controller configuration - Ports tab” on page 60.
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» To select and configure Modbus communications:

From the ProWORX NxT Title Screen or the Offline Network Editor,
on the Controller menu, click Communication Setup. The
Communications Setup dialog box appears.

1.

These parameters affect
the PC only. They must
match the parameters
set for the controller.

After you choose a com-
munication system from

the list on the left, its op-
tions appear on the right.

To select Modbus com-
munications, the Modem
Type must be setto None.

Communications Setup

Interface: Modbus

@ Modbus Port: |CDM1 j| Stop: |1 j‘
C Modbus Pl
odbus Plus Baud: [[9600 ~| Iimeout: (010 :|¢
) Ethernet Gateway
O TePaP _ Paiity: [None =] Mode:| @ RTU O Ascil

Hodem
Modem Type: [T SRGEG—G— ~
italization:

Dial Command:[47D

Command Suffix:[013 010

Hangup Command: |AT H

oK |

Help |

Cancel |

From the Interface list on the left, select Modbus.

Set the parameters for your Modbus communication system:

Port: Identifies which serial port on your PC is connected to the
controller or modem (if you are connecting to the controller
through one). Default is COM1.

Baud: Sets the data transfer speed of your PC’s serial port in bits
per second. The PC and controller must be set to the same baud.
Default is 9600.

Parity: Adds a check bit to a packet to make the number of binary
ones always either odd (Odd parity) or even (Even parity). If parity
is set to None, the check bit is not added. The PC and controller
must use the same parity. Default is Even.

Stop Bit: Sets the number of bits at the end of a packet prepares the
receiving device for the next packet. The PC and controller must
use the same number of stop bits. Default is 1.

Timeout: Specifies the length of time the PC will wait for successful
communication with a controller before displaying an error
message. Default is 2 seconds.
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* Mode: Identifies which data protocol (Remote Terminal Unit or
ASCII) to use. Both the PC and controller must use the same data
protocol. Default is RTU.

4. Do one of the following:

* If your computer is connected directly to the controller, set the
Modem Type drop-down menu to None, then click OK.

* If your computer connects to the controller’'s Modbus port through
a modem, set the parameters in the Modem box.

Modbus communications by modem

You can easily configure ProWORX NxT to connect to controllers through
dial-up and dedicated-line modems. Before you begin, confirm that

*  The controller is properly connected to its RS-232 modem.
*  Your computer is properly connected to its modem.

* The modems’ DIP switches, if they have them, are set like this:

Modem DIP Switch Seting | 0'SL ke Ccur i back)
Data Terminal Ready Always On Switch 1 (on left): Down

Verbal Word Results Switch 2: Up

Result Code Display Enabled Switch 3: Down

Command mode local echo Switch 4: Up

Auto Answer Switch 5: Up

Carrier Detect Normal Switch 6: Up

Load Non-Volatile RAM Defaults Switch 7: Up

Use AT Command Set (Smart Mode) | Switch 8 (on right): Down

After configuring NxT to use a modem, it checks to see whether there is an
active connection each time you select a device on your network.

* If it cannot find one, NxT asks you for a phone number to dial or, if
your modem uses a dedicated line, opens a connection automatically.
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Use a modem connection to a controller just like a direct Modbus link. You can
scan for and attach to Modbus devices (and Modbus Plus devices, if the
controller supports Bridge Mode to allow you to connect to a Modbus Plus

If it finds a connection (or after opening one), you can choose to select
a Modbus device or close the connection and open a new one.

network) just as you normally would.

o,

Iﬁ? i

NXT uses the same information to configure modems as ProWORXPLUS, so
users going from one program to the other can copy the settings directly.

» To select and configure Modbus communications using modems:

1. From the ProWORX NxT Title Screen or the Offline Network Editor,
on the Controller menu, click Communications Setup.

Interface: Modbs
These parameters affec nieflace odbus
the PC only. They must ® Modbus

match the parameters
set for the controller.

After you choose a com-
munication system from

the list on the left, its op-
tions appear on the right.

To select Modbus com-
munications, the Modem
Type must be setto None.

) Modbus Plus

C Ethernet G ateway

O TCPAP

Pot: [COM1 -] Stop: |1 =
Baud: | 9600 ~| Timeout: (010 :I:

| Parity: Mode: @ RTU C) ASCHl
Hodem

Moden Type: TSR ~

Inilializaliun:l

Dial Command: |10

|

|

Command Suffix:[013 010 |
|

Hangup Command: |AT H

0K |

Cancel |

Help |

2. From the Interface list on the left of the Communications Setup dialog

box, select Modbus.
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3. Set Modbus communication parameters for your network.

A

The controller must have the same Modbus settings as the computer. Set
Modbus parameters for your PLC with the Ports tab of the Controller
Configuration window.

« For more information, see “Controller configuration - Ports tab” on page 60.

* The Modbus Port setting must show the computer port connected
to the modem; otherwise, NxT won’t be able to locate it.

7

% For more information, see the Modbus table on page 36.

* The Modbus configuration must send exactly 10 bits per data
package to your modem.

Modems generally expect 10 bits in a data package; however, the
Modbus defaults (Even parity, RTU mode, and one stop bit) send
11 bits per package.

Change the Modbus settings to provide 10 bits per data package or
NxT will not be able to communicate with the modem.
Alternatively, if your modem supports large data packages, you
can set its DIP switches to allow 11 bits per data package (see your
modem’s manual).

These Modbus configurations provide 10 bits per data package:

Parameters ASCIl Mode |ASCIl Mode  |RTU Mode
Start Bit 1 bit 1 bit 1 bit
Data 7 bits 7 bits 8 bits
Stop Bits: 1 1 bit 1 bit
2 2 bits

Parity: None 0 bits 0 bits

Odd or Even | 1 bit
Total 10 bits 10 bits 10 bits

4. Choose settings for your modem.
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* Modem Type: Specifies the kind of modem connected to your
computer.

* None (default setting): for direct Modbus connections
between the PC and controller without a modem. This setting
disables the other modem options.

* Dial-Up: For standard modems which do not require a
password. If you are unsure, try this setting first. When you
select a device, NxT asks you for a number to dial.

* Dial-Chat: For password-protected modems. After the
connection is established, a terminal window opens so you
can enter text. When you select a device, NxT asks you for a
number to dial.

* Line/J478: For modems with a dedicated telephone line to the
controller. You do not have to type a number to dial. This
setting disables the other modem options.

* LineRTS: For radio or microwave modems with a dedicated
link to the controller. You don’t have to type a number to dial.
This setting disables the other modem options.

* Initialization: Some modems require special initialization
commands such as ATZ before they can be used. Type a sequence
of Hayes modem commands in this field for NxT to send to your
modem. Check your modem’s manual for the commands to turn
off error correction, compression, and software flow control and
turn on verbal word results.

* Dial Command: Type ATDT for tone dialing (default) or ATD for
pulse dialing. This prefix is sent to the modem along with the
phone number you type in the Select Device dialog. To instruct the
modem to pause for half a second, type a comma (,).

* Command Suffix: Characters appended to every command you
send to the modem, including the Initialization string and Hangup
command. The default is a carriage return and a line feed.

* Hangup Command: To hang up your modem, NxT sends the
standard Hayes modem command ATH. If your modem uses a
different command, enter it here. This command is prefixed with
mt++,,. Hanging up can take up to three seconds.

5. Click OK.
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Configuring Modbus Plus communications

To connect to a Modbus Plus network, your computer uses a network adapter
card such as an SA85.

Before configuring the Modbus Plus settings, make sure the card is installed

properly and has a unique Modbus Plus address assigned to it through its DIP
switches.

» To select and configure Modbus Plus communications:

1.

From the ProWORX NxT Title Screen or the Offline Network Editor,
on the Controller menu, click Communications Setup.

2. From the Interface list on the left of the Communications Setup dialog

box, select Modbus Plus.
These parameters affect
the PC Only- They must \ Interface: Modbus
match the parameters ® Modbus

set for the controller.

After you choose a com-
munication system from

the list on the left, its op-
tions appear on the right.

Port: [COM1 -]  Stop: [1 =l
Baud: | 9600 = | Iimeout: |010 :I:
Py Mode: | @ BT O Asci
Modem
Modem Type: TSN - |
itiakization:|

() Modbus Plus
) Ethemet Gateway
O TCPAP

/ To select Modbus
communications,
setthe Modem Type
to None.

Dial Command: [/»1 11

|
|
Command Suffix:[013 010 |
|

Hangup Command: |ATH

0K | Cancel |

3. Enter your settings, then click OK:

* Adapter: sets an identifying number for an SA85 Network Card.

Up to two SA85 cards, numbered 0 or 1, can be installed. A card’s
identifying number in NxT must be the same as in the Device
command in the PC’s CONFIG.SYS file. Default is 0.

Interrupt: Sets (in hexadecimal) the location in the PC’s memory of
a software interrupt for an SA85 Network Card. The interrupt
vector in NxT must be the same as in the Device command in the
PC’s CONFIG.SYS file. Default is 5C.

Timeout: Specifies the length of time the PC will wait for successful
communication with a controller before displaying an error
message. Default is 2 seconds.
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Configuring Ethernet Gateway communications

Select this option if Modicon’s EMBP Gateway bridges your computer’s TCP/
IP Ethernet to your controller’s Modbus Plus network. Once configured for an
Ethernet Gateway, NxT behaves as if it were connected directly to a Modbus

Plus network.

Your computer’s Ethernet address is set in Windows by your network
administrator (as is its sub-network mask address, if necessary).

» To select and configure Ethernet Gateway communications:

1. From the ProWORX NxT Title Screen or from the Offline Network
Editor, on the Controller menu, click Communications Setup.

2. From the Interface list on the left of the Communications Setup dialog
box, select Ethernet Gateway.

3. Enter your settings, then click OK:

* Gateway IP Address: The TCP/IP address of the computer linking
your PC’s Ethernet to your controller’'s Modbus Plus network.

* Timeout: Specifies the length of time the PC will wait for successful
communication with a controller before displaying an error
message. Default is 2 seconds.

Configuring TCP/IP Communications

Some controllers can be equipped with TCP/IP cards. Select this option if both
your computer and controller use TCP/IP networking, regardless of whether
they are on the same network or are connected by a gateway.

Your PC’s TCP/IP address is set in Windows by your network administrator (as
are the gateway and sub-network mask addresses, if necessary).

If you use TCP/IP networking to connect to your controllers:

*  The Select Device dialog box doesn’t accept controller addresses
unless they are in standard TCP/IP format: four numbers ranging
from 0 to 255 separated by periods (for example, 10.0.254.68 is valid).

* The Net Scan function in Select Device dialog boxes is unavailable.
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7
0‘0

You must install the TCP/IP Configuration Extension into your
controllers to set TCP/IP addresses for their communication cards.

For more information, see “TCP/IP extension” on page 79.

To select and configure TCP/IP communications:

1.

From the ProWORX NxT Title Screen or from the Offline Network
Editor, on the Controller menu, click Communications Setup.

From the Interface list on the left of the Communications Setup dialog
box, select TCP/IP.

In Timeout, enter a type that specifies the length of time the PC will
wait for successful communication with a controller before displaying
an error message. Default is 2 seconds.

Click OK.
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Selecting a device on the network

Before you can start programming, reading, or writing logic in the Online
Editor, you must first select or attach to the controller you want to work with.
Selecting a controller connects your PC to it so the Online Editor can read its
ladder logic, Traffic Cop information, and configuration, and write your
changes back to it. Unless you have selected Confirm Address on Entry in the
database’s setup, opening a database in the Online Editor connects you
automatically to its controller.

o

% For more information, see “Editing the setup of a database” on
page 19.

You cannot see or edit descriptors in the Online Editor unless you open a
@ controller's database as well as attach to it. Also, changes made to a controller’'s
logic as you work online do not appear in its database until they are read into it.

o,

+« For more information, see “Reading from a controller” on page 102.

You do not have to select a device to work in the Offline Editor because the
controller’s information is already stored in its database. You need to attach to
a controller only when you want to read its ladder logic, write changes to it,
monitor its health, or compare its logic to a database.

If your computer connects to your network through a Dial-Up or Dial-Chat
modem (and you do not have an active connection), NxT asks you for a phone
number to dial when you select a device. If your computer has a direct
connection to your network, the Select Device dialog box appears
immediately.

Ensure your communications setup is configured correctly before trying to select
,-_’ : 5 a device.

o,

% For more information, see “Setting up communications for your PC” on
page 35.
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» To select a device with a direct connection to a controller or network:

1. Do one of the following;:

¢ From the ProWORX NxT Title Screen, on the Controller menu,

click Select Device.

¢ From the Network Editor, on the Controller
Device.

NxT displays the Select Device window.

This title and some options — Y EEAETEETENT - E

menu, click Change

Click to see which devices

change depending on your
communication system.

Type the controller’s address
here.

are currently available (ex-
cept when using
TCP/IP networking).

V'
Met Scan... :l

Select Setup. ..

N\ Click to select a database.

o]

Cancel | Help |

2. In the Device field, type the address of a controller.

For

Type

Modbus

A Modbus address (1 to 247) for a controller on the local
network.

...a one-address Modbus “routing path”, if your Modbus
network is connected to a Modbus Plus network through a
controller in Bridge Mode or a Bridge Multiplexer. The
controller or BMS85 interprets the Modbus address as a
routing path using its internal Address Map or Implicit
Attach Addressing.

Modbus Plus

A Modbus Plus address (1 to 64) for a controller on the local
network.

...a five-address Modbus Plus routing path to a device on
another network. Type the address of the bridge first,
followed by addresses for additional Modbus Plus
networks, Modbus Plus devices on those networks, or
Modbus devices bridged to the Modbus Plus networks.
Separate the addresses in the routing path with commas (for
example: 10, 3, 21, 0, 0).
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For Type
Ethernet A Modbus Plus address (1 to 64) for a controller on the local
Gateway network or a five-address Modbus Plus routing path for a

device on another network, exactly as you would if your
computer had a direct Modbus Plus connection.

TCP/IP A TCP/IP address for a single device. In TCP/IP notation,
an address is four numbers from 0 through 255 separated by
periods (for example, 10.0.254.68 is a valid path).

* If you do not know the address of a device, but you do know the
location and name of its database, click Select Setup. Navigate to
the database, select it, then click OK. NxT automatically enters the
controller’s address in the Device field.

* If you do not know the address of a device or the name of its
database, click Net Scan to scan for devices on the network.

@ Net Scan is not available if you are using TCP/IP networking.

3. Click OK. Once NxT attaches to your controller, it displays the
Network Editor.

» To select a device with a modem connection to a controller or
network:

1. Do one of the following;:

¢ From the ProWORX NxT Title Screen, on the Controller menu,
click Select Device.

* From the Network Editor, on the Controller menu, click Change
Device.

* If your modem is already connected to a network or controller,
the Select Device dialog box appears.

Select a Modbus device just as you would with a direct connection.
Type:

* A Modbus address (1 to 247) for a controller on the local
network.
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A one-address Modbus “routing path”, if your Modbus
network is connected to a Modbus Plus network through a
controller in Bridge Mode or a Bridge Multiplexer. The
controller or BM85 interprets the Modbus address as a routing
path using its internal Address Map or Implicit Attach
Addressing.

To close the connection and dial a new phone number, click
Hangup.

* If you are using a dedicated line modem, NxT automatically
opens a connection. The Select Device dialog box appears.

D

®,
o

To use a dedicated line modem, select Line/J478 or LineRTS as your modem
type in the Modbus Communications Setup dialog box.

For more information, see “Setting up communications for your PC” on

page 35.

Select a Modbus device just as you would with a direct connection.

Type:

A Modbus address (1 to 247) for a controller on the local
network.

A one-address Modbus “routing path”, if your Modbus
network is connected to a Modbus Plus network through a
controller in Bridge Mode or a Bridge Multiplexer. The
controller or BM85 interprets the Modbus address as a routing
path using its internal Address Map or Implicit Attach
Addressing.

To close the connection, click Hangup.

* If NxT cannot find a modem connection or if you close an old
connection in the Select Device dialog, NxT displays the Enter
Phone Number window:

When you select a device, NxT waits for

you to type a phone number and an op-
tional description. Type the phone num-

ber first. Use only numbers and these

Speci
.

.

al characters:

Use a comma (,) to pause the di-
aling for half a second.

Use a dash (-) to separate the
prefix and number.

Use a space () to mark the end
of the phone number.

Enter Phone Number

NXT stores a list of the phone num-

bers you enter. Click to select from

|9,555-1 212 Remote Second Line Controller j’/ it.

Type a short description after the

Dial | Hangup

number so you can recognize it in
the list later. Separate the number

Cancel Help |

and description by a <space>.
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2. In the Enter Phone Number window, do one of the following:
* Select a number from the drop-down menu.

* In the field, type a phone number, then a short description for the
controller you want to connect to.

Separate the phone number and description with a space. The first
space in the field marks the end of the phone number, so do not use
spaces in the number itself. You can separate parts of the phone
number with a hyphen (-).

To pause dialing for half a second, type a comma. Don’t use any
other punctuation in the number.

3. Click Dial. NxT connects to the controller.

* If you have selected Dial-Up as your modem type, the Select
Device dialog box appears.

Select a Modbus device just as you would with a direct connection.

Type:
* A Modbus address (1 to 247) for a controller on the local
network.

* A one-address Modbus “routing path”, if your Modbus
network is connected to a Modbus Plus network through a
controller in Bridge Mode or a Bridge Multiplexer. The
controller or BM85 interprets the Modbus address as a routing
path using its internal Address Map or Implicit Attach
Addressing.

Click Hangup to terminate a connection. NxT automatically hangs
up if you type a new number and click Dial or exit NxT. Hanging
up can take up to three seconds.

* If you have selected Dial-Chat as your Modem Type, the Dial-Chat
window appears.

S If NXT connects to your network but the Select Device dialog does not appear,
K your network or modem may be expecting a password. Try changing your
modem type to Dial-Chat, then connect again.

+« For more information, see “Choose settings for your modem.” on page 39.

4. To terminate a connection, click Hangup. NxT disconnects you from
the controller. This process can take up to three seconds.
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To type a password in the Dial-Chat window:

25

If you've selected Dial-Chat as your modem type, the Dial-Chat window appears
as NXT connects to your network through a modem. It lets you type a password
S0 you can log on to your network.

% For more information, see “Choose settings for your modem.” on page 39.

- . ___—— [CONNECT 5600
The first line displays PASSWORD:

information about the
connection.

Type your password
when you are prompt-
ed for it.

Dial-Chat E

NXT sends each letter to the modem as you type
it. You cannot correct a mistake by pressing
BACKSPACE or DELETE, or overwrite an error by
moving the cursor back using the arrow keys. Al-
though these actions appear to work on the
screen, they do not actually correct the error.

To correct a mistake, press ENTER and type your
password again when you are prompted.

1. Inthe Dial-Chat window, carefully type your password when you are
prompted for it.

* Do not try to correct typing mistakes with pressing the BACKSPACE
or DELETE keys and do not use the cursor keys to move around the
screen. NxT sends each character to the modem as you type it, so
although these actions may appear to fix an error on the screen, the
modem does not understand the correction.

* To correct a mistake, press ENTER and type your password again
when you are prompted.

2. Click Close when your password is accepted.
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Performing a network scan

The Network Scan function finds controllers, bridges, bridge multiplexers,
and other devices attached to Modbus and Modbus Plus networks. NxT
displays the devices it finds by their address number and also shows their
type, mode, and status.

If you use TCP/IP networking to connect to your controllers, the Net Scan
function is unavailable.

» To scan for devices on your network:

1. In the Select Device window, click Net Scan. NxT displays the
Network Scan window and begins to search for devices.

To start a scan at a particular iNstvoikiscan [ <]
point, type a partial routing path Routing:
here, then press ENTER. Click 5 IE
Prev LAN to scan for devices
on the Local Area Network
(LAN) one level above the cur-
rent one.

Select a device, then click OK. \

Peri Part Stap

Click Print to print out the result
of a network scan.

Peri Port Stop

=
|

0K | Cancel | Scan |ErevLAN| Mnniturl Print | Help

You do not have to wait for NxT to interrogate each device address.
When NxT finds and displays the device you want, click Cancel to
stop the scan. To rescan the network, click Scan.

2. Double-click the graphic of a device to select it or click the graphic,
then click OK.

* If you selected Modbus Plus or Ethernet Gateway in the
Communications Setup dialog box, selecting a bridge or bridge
multiplexer scans the network attached to that device.
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To scan for devices one Local Area Network (LAN) above the current
one:

e (Click Prev LAN.

For example, if you typed 10, 15, 9 as the base routing path for a scan,
click Prev LAN to scan for devices with a base routing path of 10, 15.

To check that status lights in the graphics match your controllers:

1. Click Monitor. NxT scans the controllers continuously to make sure
that the status lights in the on-screen graphics show the actual
condition of your controllers. The graphics correctly show the Run
and Battery Low lights on the controller. Underneath the controller,
NxT shows whether the controller is OK or in Dim Awareness or if the
controller is stopped, the Stop Code.

2. To stop monitoring, press ESC.

Clicking Monitor in the Net Scan window is not the same as selecting Monitor
from the Tools menu. The first only checks the status lights of controllers. The
second monitors the health of controllers and 1/0 systems.

« For more information, see Chapter 15 Monitoring your Hardware on page
317.

To see more or fewer devices in the Net Scan display:
1. Click |4 to zoom out the view. You can see up to 30 devices at a time.

2. Click [=] to zoom in the view. NxT always displays at least 10 devices.
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Configuring a controller

Before you can put your controller to work, you need to configure it for your
network and I/O devices. Most of this is done in the Controller Configuration
dialog box.

The Controller Configuration dialog box is divided into five tabs, each with a
different set of options. Select a tab by clicking it. The options available under
each tab depend on the type of controller you selected for the database.

» To configure a controller:
1. Inthe Network Editor, from the Configuration menu, click
Configuration or click on the toolbar.
2. Click the tab for the options you want to configure:

* General: Configures a controller’s memory, including the number
of coils and registers, I/O cards and drops, the amount of memory
set aside for Configuration Extensions, and the number and size of
the ASCII messages you want to use.

* Ports: Configures the controller’s serial and ASCII ports.

* Controller: Configures your controller’s hardware options. You
can also select a new controller here, if needed.

* User Loadables: Moves user loadables from your Loadable Library
into your database so they can be used with a controller, or
removes them from the database.

* Loadable Library: Converts user loadables into NxT format and
adds or removes them from your Loadable Library.

3. Enter the new parameters.

Click OK to save your changes.

54 @ Configuring a controller



Chapter 4 Configuring a Controller

Controller configuration - General tab

This tab in the Controller Configuration window allows you to configure a
controller’s memory. It contains many important options, including the
number of coils, registers, segments of logic, and I/ O cards the controller will
use, the amount of memory it sets aside for configuration extensions, and the
number and size of its ASCII messages.

S

i Configuring a controller’'s memory can be time consuming. It's a good idea to
k keep the controller’s user's manual nearby in case you need to refer to it.

Before you begin, make sure you have the right type of controller selected for
your database. The controller’s type appears in the Status Bar at the bottom of
the Network Editor. The options that appear in the General tab depend on the
controller type, so if the wrong one is selected, you can spend time configuring
options your controller does not support.

®,

% To change the type of controller for your database, see “Controller
configuration - Controller tab” on page 64.

Select the value you want Controller Configuration [ %]
gon(éhange, then type a new General Ports | Controller | User Loadables | Loadable Library
. -
——— 110051 2| Total Messages: (0100 Battery Coil [Dx): (0D0O0DD
Axxxx: (00064 Meszage Words: (00100 Timer Register(4x): |D0000
Buxxx: (00099 ASCIl Ports: |00 Time of Day Clock [4x]): (D0DOD
Axxxx: (01800 Watch Dog Tm[*10ms): |DODO
The configuration options Segments: (02 Conf Extension Size: (00064
that appear depend on the 170 Drops[1K): |02 Config Ext Used: 00025
controller you select in the 170 Cards: [0022 ¥ Enable Skips
Controller tab. DCP Drop ID: |00

1] 4 Cancel Help |
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Set the following parameters for your controller:

Parameter

General tab — Left side of window

Registers

For each of the Oxxxx, 1xxxx, 3xxxx, and 4xxxx register
fields, type the number of registers the controller will use.
The controller polls all of these registers each scan, so to
keep your controller scanning quickly, set up only as many
registers as you need.

Segments

Type the number of logic segments the controller will use.

1/O Drops

Different controllers use different I/O drops:

* If you have a controller that uses Channels instead of I/O
Drops, type the number the number of channels the
controller I/ O will use. Channels always come in pairs,
so this must be an even number.

* If you have a Micro series controller in parent mode, type
the number of children (0 to 4) associated with it.

* If you have a Micro series controller in child mode, type
the Child ID (1 to 4).

1/O Words

Quantum controllers only: type the maximum number of
I/O words that will be available for programming in the
Traffic Cop. Check your controller documentation for the
appropriate values.

DCP Drop ID

680, 685, 685E, 780, 785, 785E or 785L controllers only: If
another computer uses this controller for distributed control,
type the controller’s Distributed Control Processor ID
number (0 to 32).

I/O Time Slice

Type the amount of time the controller will devote to
peripheral port communication, from 1 to 100 milliseconds.
The default is 10 ms for 984 A, B, and X controllers and 20 ms
for Quantum controllers.

Remote
Channels

984A-5901, 984B-5901, and 584 controllers only: Select from
2 to 32 remote I/O channels. Channels always come in pairs,
so this setting must be an even number.
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Parameters General tab — Center of window

Total Messages | Controllers that support ASCII messaging only: Type the
total number of ASCII messages the controller will use.

Message Controllers that support ASCII messaging only: Type the

Words length (in machine words) of your controller’s ASCII
messages. One machine word is equal to two ASCII
characters.

ASCII Ports Type the number of ASCII ports on the controller. This
setting must be an even number.

B984 Select the type of B984 controller you have: B884 or B886.

Controller

Input Latched | Select this option if you want the controller to freeze the
input state on power-down. Inputs remain frozen for one
scan when the controller is powered back up.

Settling Time Group Settling Time allows you to set parameters for input

digital filtering.

* Each input value is polled through a filter based on a time
window. You can set the duration of the time window
between 200 microseconds (us) and 19.8 ms (in 200 ps
increments).

* The module samples each input every 200 us and uses the
time window associated with the input to determine the
input state. If the scanned input state is OFF, the input
state is set OFF. If the scanned input state is ON, the input
state is set based on a history queue. If the input was ON
one time window ago, the input is set ON; if the input
was OFF, the input state is set OFF.

* The inputs are divided into four groups. The Settling
Time of each can be configured separately:

* Group 1: Inputs 1-4

¢ Group 2: Inputs 5-8

¢ Group 3: Inputs 9-12
¢ Group 4: Inputs 13-16
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Parameters

General tab — Right side of window

Battery Coil

Type the control address for the controller’s battery.

Timer Register

Type the register used to store the controller’s timer value.

Time of Day
Clock

Type the register used to store the controller’s clock value.

Watch Dog
Timer

Type the timeout delay for the Watch Dog Timer, in tens of
milliseconds. The controller adds 250 ms to the value you
enter. The default is 0000, which represents 250 ms.

Configuration
Extension Size

Type the amount of memory (in machine words) to be set
aside for Configuration Extensions. Use the following
information to calculate the minimum Configuration
Extension size:
* Configuration Overhead: 1 word
* Extension Overhead:

e TCP/IP: 100 words

* Data Protect: 8 words

* 5980 Address: 8 words

* Quantum Hot Standby: 17 words

* VME Bus: 9 words

* Profibus: Approximately 4096 words; check your

Profibus manual for details
¢ Peer Cop: 5 words
* Links: 3 words per link, plus:

* Global Output: 4 words per link

* Global Input: 2 words overhead plus, for
each of up to 64 devices, 1 + twice the
number of up to 8 sub-entries (max. 8). The
maximum is 2 + (64*(1+2*8)) = 1090 words.

¢ Specific Output: 2 words overhead plus 2
words for each of up to 64 devices. The
maximum is 2+(2*64) = 130 words.

* Specific Input: 2 words overhead plus 2
words for each of up to 64 devices. The
maximum is 2+(2*64) = 130 words.

* SY/MAX: 52 words

Skips

Select this option to enable skips (segments can be skipped
during solves).
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Smart Configurator (online only)

While online, when you change the settings for a previously- configured
controller, ProWORX NxT can attempt a Smart Configuration. This lets you
make configuration changes without losing any logic or Traffic Cop
information stored in the controller.

The Smart Configurator prevents you from saving changes to the controller if:

* Areduction in controller memory for a particular setting reduces it
below the amount used by logic.

For example, the controller might contain logic addresses up to 10160, but
you tried to reconfigure the number of Ixxxx addresses to 32.

*  Modules are deleted that are used in logic.
If this happens, you have two choices:

*  Make changes to your new configuration so that the addresses
currently used in the controller fall within the appropriate address
ranges; or

*  Send configuration changes to the controller without attempting a
Smart Configuration. You will lose all logic and Traffic Cop
information stored in the controller.

» To change your configuration without a loss of information:

1. The Smart Configurator dialog box displays the required address
ranges for a successful Smart Configuration. Make a note of the values
displayed in the “Conf” column.

2. Click Configurator to return to the controller configuration dialog
box.This resets the configuration values to their original values.

3. Allocate controller memory again, making sure the amount for each
address type meets or exceeds the values required.

For example, if you need 100 3xxxx registers, you would have to
allocate at least 100 addresses in the 3xxxx section.

Click OK. You're prompted to attempt a Smart Configuration.

Click Yes. The new configuration is saved, with no loss of logic data.
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» To change your configuration, accepting a loss of information:

1. Click Configurator to return to the Controller Configuration dialog
box. This resets the configuration values back to their original states.

Allocate controller memory again, using the values you require, then

click OK. You're prompted to attempt a Smart Configuration.

3. Click No. The controller is reconfigured. Logic and Traffic Cop
information will be lost.

Controller configuration - Ports tab

From this tab in the Controller Configuration window, you configure the
controller’s Modbus and ASCII ports. These settings do not affect the
communications setup of your PC in any way —only the controller’s.

The communication parameters for your PC and PLC must be the same. Set
communication parameters for your PC in the Communications Setup dialog

box.

e

% For more information, see “Setting up communications for your PC” on

page 35.

Select the Modbus
port to configure,
then click Setup Port.

Some controllers support Bridge Mode, which allows you to connect to a
Modbus Plus network through their Modbus ports 1. If a Bridge Mode check
box appears in the Controller Configuration - Ports Tab dialog, your controller
supports Bridge Mode while its MEM/DIP switch is in the MEM position.
Select to enable Bridge Mode.

Controller Configuration [<]
General Ports Ci | User Loadabl | Loadable Library
Mode Parity  Stop/Data  Baud Dex Addr  Delay
Modbus Port 1: RTU Even 1 9600 o0 )]
Modbus Port 2: RTU Even 1 9600 oo1 01
Modbus Port 3: RTU Even 1 9600 01 o

I Bridge Made!

COMM1

Setup Port

Micro Port Assignments:

COMM2

1/0 EXP

Modbus

ASCII

5]

If you have a Micro 311,
411,512, or 612 controller,
assign its ports with the
drop-down menu.

(114 |

Cancel |

Help
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To edit a communication port's parameters:

A

The controller's MEM/DIP switch determines if its communication parameters
are taken from memory or an internal DIP switch. If the MEM/DIP switch is in the
DIP position, the controller ignores the parameters you set here.

1. Double-click the parameters of the port or select the parameters for the
port, then click Setup Port.

2. For each parameter, select a value from its list:

Parameter

Description

Mode

Identifies which data protocol (Remote Terminal Unit or
ASCII) to use. Both the PC and controller must use the
same data protocol. Default is RTU.

If you select ASCII protocol for a port, you can only
configure its Parity, Stop/Data bits, and Baud settings.

Parity

Adds a check bit to a packet to make the number of
binary ones always either odd (Odd Parity) or even
(Even Parity). If parity is set to None, the check bit is not
added. The PC and controller must use the same parity.
Default is Even.

Stop/Data

Sets the number of bits at the end of a packet which
prepare the receiving device for the next packet.The PC
and controller must use the same number of stop bits.
Defaultis 1.

Baud

Sets the data transfer speed of the controller’s Modbus
port in bits per second. The PC and controller must be set
to the same baud rate. Default is 9600.

Head

Quantum controllers only: sets the slot number on the
local drop backplane where the CPU resides.

Dev Addr

Assigns the Modbus address for the port. Default is 1.
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Parameter

Description

Delay

Sets the amount of time in tens of milliseconds the
controller waits after receiving a message before sending
an acknowledgment. Default is 1 (10); max. is 20 (200).

Modbus Port 2
Type

Momentum M1 controllers only: Sets the port type of
Modbus Port 2, to either RS232 or RS485.

3. When you are finished, do one of the following:

* Press ESC. The lists for each parameter disappear.

* Click another port. The first port’s lists disappear.

* Click another Controller Configuration tab. The Ports tab closes.

* Click OK. The Controller Configuration window closes.

» To change Micro port assignments for 311, 411, 512, or 612

controllers:

*  Select port settings from the Micro Port Assignments drop-down list.

The assignments in the list are combinations of the controller’'s COM1,
COM2, and I/ O Expansion Link port. The assignments available
depend on which Micro I/O Mode you set in the Edit Details section
of the Controller tab in the Controller Configuration window.

page 65.

% For more information, see “Editing a controller’s hardware details” on

Configuring simple ASCII ports

Some Modicon controllers have RS-232 ports as part of Remote I/O drops.
Advanced programmers can use these ports (called simple ASCII or ASCII/
DAP ports), for serial communications between controllers and data terminal
equipment. In ladder logic, use the Block Move (BLKM) instruction to send
and receive Simple ASCII messages.
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Set communication parameters for simple ASCII ports in the Ports tab of the
Controller Configuration window.

of the General tab. Otherwise, the ASCII ports will not appear in this window.

:g Set the number of simple ASCII ports your controller has in the ASCII Ports field

< For more information, see “Controller configuration - General tab” on

page 55.

» To edit simple ASCII port parameters:

1. Do one of the following;:

* Double-click the parameters for the port to edit.

* Select the parameters for a port, then click Setup Port.

2. For each parameter, select a value from its drop-down list:

Parameter

Description

Parity

Adds a check bit to a packet to make the number of
binary ones always either odd (Odd Parity) or even
(Even Parity). If parity is set to None, the check bit is not
added. The PC and controller must use the same parity
setting. Default is even.

Stop/Data

Sets the number of bits at the end of a packet which
prepare the receiving device for the next packet.The PC
and con-troller must use the same number of stop bits.
Default is 1.

Baud

Sets the data transfer speed of the controller’s Modbus
port in bits per second. The PC and controller must be set
to the same baud. Default is 9600.

3. When you are finished, do one of the following:

* Press ESC. The drop-down lists for each parameter disappear.

* Click another port. The first port’s drop-down lists disappear.

* Click another Controller Configuration tab. The Ports tab closes.

* Click OK. The Controller Configuration window closes.
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Controller configuration - Controller tab

Click to change the
type of controller for
the database (in the
Offline Editor only).

T

This tab in the Controller Configuration window contains a summary of the
hardware options you have chosen for your controller, the amount of memory
it has available for logic (in machine words), and how many User Loadable
modules are currently loaded into it.

Contioller Configuration

General | Ports |

C ller Type

Ci

User Loadabl | L

C

dable Librarp

ler Details

Current Controller Type:

984-685

[ Summary

Total Logic: 05997

Modules: 00
Executive:

Exec Cartridge:
Memory Pack:
Extended Memory:
User Logic:

5908 Size:

Micro 1/0 Mode:

Edit Details

E685-904 Enhanced

8K
512 Byte

0K |

Cancel |

Help |

Click to specify the
hardware options for
your controller.

The controller tab also allows you to change your hardware options and
controller type, if needed.

@ You can only change your controller type in the Offline Editor.
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Editing a controller’'s hardware details

Many Modicon controllers accept executive cartridges or optional upgrades
such as memory packs. These hardware options should be specified in the Edit
Controller Details dialog box so that NxT can adjust your database for them.

» To specify hardware options for a controller (Offline Editor only):

1. Inthe Controller Tab, click Edit Details. NxT displays the options that
your controller supports.

2. Select a new value from the drop-down lists.

Parameter | Description

Executive Cartridges which determine the controller’s instruction

Cartridge set. Select the one installed in your controller.

Memory Pack | The amount of both Extended and User Logic memory in
the controller. Select the amount installed in your
controller.

Extended Additional memory providing 6xxxx registers. Select the

Memory amount installed in your controller.

User Logic Memory available for ladder logic. Select the amount of
memory you want to use for ladder logic from the total
amount available in your controller.

S908 Select either 512 or 1024 (1k) input and output points per
drop.

Micro I/0 Micro controllers only. Select:

Mode

* Single: The controller is independent, not in a
parent/child relationship.

* Parent: The controller is the parent in a parent/child
relationship.

* Child: The controller is the child in a parent/child
relationship.

3. When you are finished, click OK.
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Changing the type of controller for your database

Change your controller type. You may need to do this if you replace an older
controller with a new one (say, that is faster or handles more I/O) but want to
keep the same ladder logic, or if the wrong controller type was selected while
setting up a database. For example, you can convert a database from a 584
controller to a 984 controller, or from S901 remote /O to S908 RI1/O.

new controller or NxT does not allow the change.

« For information on adjusting the General tab settings, see “Controller
configuration - General tab” on page 55.

:g The settings in the Configuration Window - General tab must be valid for the

» To change the controller type for a database (Offline Editor only):
1. Inthe Controller tab, click Change Controller Type. The Change
Controller Type dialog box appears.

2. From the list on the left, select a controller group. A list of controllers
in that group appears on the right.

3. From the list on the right, select the type of controller for the database,
then click OK.
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Controller configuration - User loadables tab

User loadables are instructions that do not come with a controller. Instead,
they are supplied by Modicon or third-party vendors and must be copied into
a controller or database to be used.

:g You can only copy loadables that are already part of a loadable library. Using a

loadable is a two-step process: reading it into a loadable library, then copying it
from the library into the controller or database. To read a loadable from a disk,
translate it into NXT format and place it into a library.

e

% For more information, see “Controller configuration - Loadable library tab” on
page 69.

Select a loadable

In the User Loadables Tab, you copy user loadables from a loadable library into

a controller or database. You can also delete loadables from your controller or
database, if needed.

Controller Configuration

General | Ports | L | User Loadabl Loadable Library
Loadable Library Loadables in Datab
D-ALDADABLE\COMPACTY C:A\PROWORK\NXTADEMO _— Loadables in the

Library Type: -80 controller (Online
fromthe listand clicN ’ Editor) or database
Type Mame Opcode Name

Load to copy it into
your database (Of-
fline) or controller
(Online).

Click Select Library
to switch to another
library.

Opcode

USL_ #Z16_ [FF1 HMOT  (24) (Ofﬂlne Editor) are

USL #217  [FF) #DS1  (FF) listed here.

USL #MOT  [24)

UsL  #DS1  [FF) Load >> |

USL DIST  [5F) To delete aloadable,

WHL - #8850 (AR select it, then click
Delete.

Select Library... Delete | Select All |

(114 | Cancel | Help |
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» To copy a user loadable into a controller or database:

1. Inthe User Loadables tab, click Select Library. The Open dialog box
appears.

2. Type the path and file name of the library or navigate to it, then click
OK. NxT reads the loadables in the library, and displays them in the
left column.

Loadables are meant to be used only with a certain controller. If you try to copy
& a loadable into the wrong type of controller, you receive an error message. The
Library Type line tells you which family of controllers the library is meant for: 584,
A, B, X, or x80 (which includes controllers such as 381, 685, 785e, and so on).

3. Select the loadables you want to place into your database or controller
from the list.

4. Click Load. NxT copies the loadables into the database or controller,
then displays them in the right column.

Each loadable is identified in the controller by a unique number called an opcode.
@ If a loadable’s opcode is already used in the database or controller, NxT prompts
you to select a new one.

5. Click OK.

» To delete a user loadable from a controller or database:

You can only delete a loadable from your controller or database if it is not used
& anywhere in your ladder logic. If you try to delete a loadable that is still in use,
you receive an error message.

1. Inthe right column of the User Loadables tab (labelled Loadables in
Controller or Loadables in Database), select the loadable to delete.

Click Select All to delete all loadables in a controller or database.
Click Delete.

When NxT prompts you, click Yes to confirm the deletion or Cancel
to exit without deleting the loadables.
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Controller configuration - Loadable library tab

Before you can place a user loadable into a controller or database, it must be
read into a loadable library. A loadable library holds a set of loadables for you
so that you only have to translate them to NxT format once.

In Loadable Library tab, you read a loadable from disk, translate it to NxT
format, and move it into a library. You can read loadables from an existing
database, a third-party disk or a ProWORX .TLD library file.

Reading a user loadable into a loadable library does not copy it into your
@ controller or database. Using a loadable is a two-step process: reading it into a
loadable library, then copying it from the library into the controller or database.

®,

+« For more information, see “Controller configuration - User loadables tab” on

page 67.
Controller Configuration [ %]
General | Ports | Controller | User Loadables | Loadable Library

Loadable Library

CAPROWORXANXTALOADABLEY
Library Type: -80

Type MHName Opcode
USL CHS [FF]
usL #2217  (21)

USL HSBY  [28)
USL  #214  (FF)

Source of Loadables

C:APROWORXANXTS

O Database O 0Ild ProWDRX.TLD —
@ Modicon O Exe format

Mame Opcode

/ Select the type of file

1 to translate, then click

Browse to find the file.

| — Loadables in the

source file are listed
here. To add a load-
able to your library,
select it, then click
Transfer .

<<Transfer —1
Select Libraw... | Rebuild |
Edit Dpcode... | View Text | Browse
0K | Cancel |

Help

» To transfer loadables from a source file into a library:

1. Inthe Source of Loadables column, select the type of source file (the
file containing the user loadables) to translate to NxT format. You can
read loadables from an existing database, a third-party disk, or a
ProWORX .TLD library file.

2. Click Browse to navigate to the source file, then click OK. Most often,
source files from other vendors come on floppy disks. NxT reads the
loadables in the source file, then displays them in the right column.

3. Select the loadables you want to transfer to a library. You can select
more than one loadable at a time.
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4. In the Loadable Library column, click Select Library. The Open
dialog box appears.

5. Type the path and file name of a library or navigate to it, then click
OK. If NxT can’t find the path and library name you typed, a new
library is created with that name.

6. Click Transfer. NxT translates the loadables and copies them into the
library.

» To display the manufacturer’s notes for a loadable (if available):

1. Select a loadable from the Loadable Library column on the left.

2. Click View Text. If it is available, the manufacturer’s documentation
for the loadable appears.

3. To close the window, click OK.

Editing the opcode for a user loadable

An opcode is a unique number identifying a loadable in the controller or
database. Because each opcode must be different, they may need changing.

» To edit the opcode for a user loadable:
1. Select a loadable from the Loadable Library column on the left.

2. Click Edit OpCode. The Edit Opcode window appears, displaying the
Function Name, Current Opcode associated with the loadable, and a
list of additional opcodes to select from.

3. Select an opcode, then click OK.

Rebuilding a damaged library

On rare occasions, a library of loadables can become damaged (for example,
when a computer crashes and files are corrupted). NxT allows you to recreate
a library from its .USL and .MSL files.

» To rebuild a damaged library:

*  Click Rebuild. NxT recreates the damaged library. This operation
may take a few moments.

Don't rebuild libraries that are not damaged. Doing so may cause certain
loadables not to function or to function erratically.
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Configuring ASCII messages

ASCII messages let your controller report information to you in plain
language. Use them, for example, if you want to see a written alert on your
screen every time a motor switches on or a printout every hour of how many
items have passed by a counter.

Use NxT’s ASCII Message window to enter and edit the messages you want
your controller or database to send.

Start by configuring your controller or database to use ASCII messages:

Confirm that your controller supports them.
In the General tab of the Controller Configuration window:

* Set the Total Messages field to the number of messages you want
to use.

* Set the Message Words field to the number of machine words you
want to allocate for each message. One word is equal to two ASCII
characters. Remember that the SPACEBAR counts as one character.

For more information, see “Controller configuration - General tab” on
page 55.

Ensure your ASCII ports are configured correctly in the Ports tab of
the Controller Configuration window.

For more information, see “Controller configuration - Ports tab” on
page 60.

Use the ASCII Read Block (READ) and ASCII Write Block (WRIT) in your ladder
@ logic to send a message from a controller to your output device (such as a
screen, printer, or disk drive).
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» To display a controller or database’s current ASCII messages:

1.

To type a new message or
edit an existing one, selectit,
then click Edit Message .

» To remove the ASCIlI messages in the controller:

From the Network Editor, on the Configuration menu, click ASCII.
The ASCII Messages window appears.

ASCIl Messages

Used:
0001 of 0100

Words Used:
00010 of 00100

| Play Back I

Import |

Initialize |

Besize |

"Conveyor On',

N

Edit Message | 0K |
Cancel |

Cut | Copy

Paste | Delete Help |

T~ NxT displays the

codes for the selected
ASCIl message.

Select a message to view. The raw codes for the message appear on the

right.

Click Play Back. The Message Playback window appears, showing the
message as it will appear on a screen, on printer output, or in a text file
on a hard drive.

Click Next and Previous to scroll through the other messages in the
controller or database.

Click Close to close the Message Playback window.

Click Initialize. All the ASCII messages are deleted from the

controller.
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» To edit the ASCIl messages in a controller or database:

1. From the Network Editor, on the Configuration menu, click ASCII.
The ASCII Messages window appears.

2. Select a message to edit, then click Edit Message or double-click a
message to edit. The Edit ASCII Message window appears.

Edit ASCll Message

Xl choose whether new

Total Words Used: 00010 of 00100 FGroup instructions overwrite
@ Insert Replace existing ones or are in-
Current Mezzage: 0001 of D100 serted into them.

Words in Message: 010 of 134

"Conveyor On',

—ASCIH Tools
Text | Int |Leado|| [ These tools insert the

codes that make up

your ASCIl message

Bin Hex Oct

ASCII | Space | Repeat (see descriptions be-
<cr> | Control|  Flush low).
# Bytes| Incl Excl

1] 4 I Cancel | Delete | Play Back | Help |

3. Select Insert to add new instructions before the selected instruction or
Replace to overwrite the selected instruction with new instructions.

4. Enter your edits with the ASCII Tools:

Tool Description

Text Enters up to 128 text characters (except for 584 controllers,
which accept up to 254 text characters). Spaces at the end of
the text are ignored.

Int Inserts an integer field, a placeholder for an integer which is
defined in ladder logic by a WRIT instruction.

Lead 0 Inserts a leading zero integer field, a placeholder for a leading
zero integer which is defined in logic by a WRIT instruction.

Bin Inserts a binary field, a placeholder for a binary number
which is defined in ladder logic by a WRIT instruction.

Hex Inserts a hexadecimal field, a placeholder for a hexadecimal
number which is defined in logic by a WRIT instruction.

Oct Inserts an octal field, a placeholder for an octal number which

is defined in ladder logic by a WRIT instruction.
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Tool

Description

ASCII

Inserts an ASCII field, a placeholder for ASCII characters
defined in ladder logic by a WRIT instruction. You can also
use this function to send ASCII characters you cannot enter
into a text field (for example, line feeds and tabs).

Space

Inserts from one to 99 consecutive blank spaces. These are
represented in code by the number of spaces followed by the
symbol X (for example, the code for 42 spaces is 42X).

Repeat

Repeats an item. Click Repeat to start the function. NxT
prompts you for the number repetitions. Type the items to
repeat, then click Repeat again to end the function.

Control

Inserts a three-digit decimal control character (ranging from
000 - 255) or a three-digit octal control character (ranging
from 000 - 377).

<cr>

Inserts a carriage return, represented by the symbol “/”.

Flush

The message buffer contains a 256-byte data field. These
bytes contain data values ranging from 0 to FF hexadecimal.
The four Flush commands (Flush, # Bytes, Incl, and Excl) clear
the message buffer. The Flush clears all characters.

# Bytes

This flush command removes from 1 to 255 bytes from the
beginning of the message buffer.

Incl

This flush command clears specific groups of data from 1 to
255 times or until a match is found. The terminator value
determines how many times the buffer is flushed. The
controller stops the buffer flushing when it finds a match for
the terminating characters.

Excl

This flush command clears the buffer until a match is found
for the terminating character pair. It doesn’t flush the match
characters. Excl uses 2 registers: the first holds a type
identifier and the second hexadecimal values of the
terminating pair. Hexadecimal values range from 0000 to
FFFF. The controller searches for this range in the buffer. If
the second character of the matched pair is not a NUL (00),
the next character in the buffer must be equal or the search
continues. If the last character tests equal or null, the flush is
performed up to, but not including the matched terminators.
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Click Play Back to preview the message as it will appear on a screen,
on printer output, or in a text file on a hard drive.

Click OK to save your changes or click Cancel to exit without saving
your changes.

» To delete ASCIl messages from a controller:

1.

Confirm that the controller is stopped.
% For instructions, see “Stopping the controller” on page 110.
In the ASCII Message window, select a message to delete.

To delete a range of messages, select the first one, then hold the SHIFT
key and click the last one. All the messages in the range will be
selected.

Click Delete. NxT prompts you to confirm the deletion.

o
ﬁ In the Online Editor, click Initialize to delete all the messages in a controller.

In the Online Editor, you can adjust the amount of memory a controller has set
aside for ASCII Messages.

» To change controller memory for ASCII messages:

1.
2.

In the ASCII Message window, click Resize.

Type the amount of memory (in machine words) to set aside in the
controller for ASCII messages, then click Resize.

» To import ASCII messages from another database:

1.

From the Network Editor, on the Configuration menu, click ASCII.
The ASCII Messages window appears.

Click Import. The Import Messages window appears.

Select a database from the list, type the database’s path and file name,
or click Browse to navigate to it.

In the Source area, select a range of messages to import.

In the Destination area, type a location for the first imported message.
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The other messages follow sequentially. The range for this value is
from 1 through the maximum number of messages your controller can
support, less the total number of messages you are importing.

6. Select Replace Always to overwrite a message without being warned
or Prompt on Replace to receive a warning message when an existing
message is about to be overwritten.

7. Click Start Import. If you have enabled Prompt on Replace, a warning
dialog box appears when an existing message is about to be replaced
by an imported one. Click Yes to replace the current message or No to
skip the message and continue with the import.
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Using configuration extensions

Configuration extensions are utilities which can be loaded into a controller.

Before using a configuration extension, set the configuration extension size in
@ the General tab of the Controller Configuration window.

o

For more information, see Controller configuration - General tab on page 55.

Available configuration extensions include:

TCP/IP: Configures controllers to connect to a TCP/IP network
through a communication card.

Data Protect: Prevents specific blocks of Oxxxx and 4xxxx references
from being modified by general Modbus data write commands.

5980 Address: Specifies the S980 station address.

Quantum Hot Standby: Allows additional configuration of the
Quantum Hot Standby setup.

Peer Cop: Allows you to configure data blocks to be transferred
between controllers on a Modbus Plus network.

VME Bus: Configures a VME controller for communications with a
VME network.

Profibus: Configures a Quantum controller for Profibus
communications.

SY/MAX: Configures a Quantum controller for communication with
SY/MAX drops.

Cyclic Data Exchange: Allows you to configure data blocks to be
transferred between controllers on a TCP/IP network.
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» To add a Configuration Extension:

1.

The Tree Area shows the exten-
sions you have installed.

Click an extension to show its
parameters in the Details Area.

The Information Area shows the
amount of memory (in machine
words) the extension currently
uses.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions dialog box appears.

Configuration Extensions

Config Extensions

L o TR

Card Number: l:@

|~ Configure the

/ extension in the

Details Area.

Head Number El
Intemnet Address
SubNetwork Mask [10101057 |
Gateway Address
Words Used: 00101/00128
DK | Cancel |

The dialog box is divided into three areas:

* Tree Control: Shows the extensions are already configured for this

controller.

* Details: Displays extension-specific parameters.

* Information: Displays the machine words of memory used (out of
total words allocated).

Click Add Extension or right-click in the Tree Control area, then select
Add Extension. The Add Configuration Extension dialog box

appears.

Select the extension you want to add by clicking it, then click OK.
You're returned to the Configuration Extensions window.

Click OK to complete the addition.
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» To delete an extension:

1.

4.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions window appears.

Click Delete Extension or right-click in the Tree Control area, then
select Delete Extension. The Delete Configuration Extension dialog
box appears.

Click the extension you want to delete, then click OK. You are
returned to the Configuration Extensions window.

Click OK to complete the deletion.

TCP/IP extension

Before your controller can connect to a TCP/IP network, you must install and
set up the TCP/IP configuration extension. This extension lets the controller
recognize its TCP/IP communication card.

» To set up the TCP/IP configuration extension:

1.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extention dialog box appears.

In the Tree Control area of the window, click TCP/IP. The TCP/IP
configuration parameters appear in the Details area.

In the Card Number field, select a communication card to set up.

@ Different controllers support different numbers of communication cards:

*  Quantum 113 Rev. 2 and 213 Rev. 2 controllers support two
cards

* Quantum 424 Rev. 2 supports up to six.

*  MI1E Momentum controllers only support one card and the Head
Number is fixed at 1.

In the Head Number field, type the number (from 1 - 16) of the slot
where the communication card is installed. If you have not yet
installed a communications card or you do not want use an installed
card, type 0.

Type the TCP/IP address you want the card to have into the Internet
Address field.
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6. If your network uses a sub-network mask, type its address into the
Sub-Network Mask field. This address is assigned by your network
administrator when a network gateway is set up. It, in conjunction
with the TCP/IP address, identifies which network the controller is
on.

7. If a gateway connects the PLC to your PC’s network, type its address
in the Gateway field. A gateway connects two networks that would
not normally be able to communicate with each other. Its address is
assigned by your network administrator when the gateway is set up.

8. Select the framing protocol your network uses. Your network
administrator determines this protocol when the network is set up.

9. Click OK.

Data Protect extension

Data Protect is used to protect specific Oxxxx and 4xxxx references from being
modified by Process Monitoring and Control software. Write access is allowed
for all Oxxxx and 4xxxx references within the specified block.

References outside the ranges specified are protected from general Modbus
data write commands. By default, all Oxxxx and 4xxxx references are
unprotected.

» To edit a data protect extension:

1. From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions window appears.

If the Data Protection extension does not appear in the Tree Control area, it is
not yet installed.

2. In the Tree Control area of the window, click Data Protection. The
Data Protect dialog box appears in the Details area of the window.

3. In the Start (0X) field, type the first address in the unprotected range.

In the Length field (of the Ox area), type the number of references to be
left unprotected. NxT shows the address ranges left protected (the
ranges of addresses outside the range you just specified).

Suppose you type a Start value of 00017, and a Length of 1024. The first
protected range will be from 00001 (the first possible value) to 00016
(the last value before the Start value you entered).
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There will then be an unprotected range from 00017 to 01040 (00017 +
1024). All references above 01041 are also protected.

If you enter a length that is too high (goes beyond the addresses
configured for the controller) NxT automatically sets the value to
include all addresses above the Start field.

In the Start (4X) field, type the first address in the unprotected range.

In the Length field (of the 4xxx area), type the number of addresses to
be left unprotected. NxT shows the address ranges left unprotected
(the ranges of addresses outside the range you just specified).

Click OK. With Symbols turned on in system Preferences, when you
enter an address to be protected and the address has a symbol
reference, the symbol appears. If you forget the address for the symbol
displayed, you can disable the symbol function in system Preferences.

S980 Address extension

The S980 Configuration Extension stores the S980 station address. This
address is then used as part of the S980’s mismatch detection mechanism;
when the controller is powered up, the S980 checks to see if it has been moved
to a different 984.

5

If the S980 Address extension does not appear in the Tree Control area, it is not
yet installed.

To enter the S980 Address:

1.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions window appears.

In the Tree Control area of the window, click S980 Address. NxT
displays the current S980 address in the Details area of the window. If
this is the first time you have activated the S980 Address function, a
default address of 000000000 appears.

Type the new S980 address.
Click OK.
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Quantum Hot Standby extension

The Quantum Hot Standby extension allows additional configuration of the
Quantum Hot Standby setup. This lets you set the type of state RAM transfer
between the CHS110-00 modules. It also lets you set the Command Register
and the Non-Transfer Area.This area is only available on version 2.x Quantum
controllers that contain the CHS loadable in the configuration.

If the Quantum Hot Standby extension does not appear in the Tree Control area,
it is not yet installed.

» To configure the Quantum Hot Standby extension:

1.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions dialog box appears.

Select the HSBY extension from the tree control. If the HSBY extension
is not in the Tree Control, you have to add it, by clicking Add
Extension, then selecting Quantum Hot Standby.

In the Command Register Address field, type the 4xxxx address of the
command register used to configure the hot standby system. This
register must be transferred every scan and cannot be in the non-
transfer area.

The initial command register contains the settings that are loaded into
the controller when it is started. If any changes need to be made while
the controller is running, the command register must be used, and not
the initial command register. Settings such as port address swapping,
allowing an executive upgrade, setting the standby’s mode on a logic
mismatch, setting the controller’s modes and overriding the key
switch can be changed from the command register.

In the Non-Transfer Start Address field, type the starting address of
the range of registers that are not to be transferred from the primary
controller to the standby. This is commonly used to reduce scan time.

* Thefirst tworegisters are used in reverse transfer operations. These
registers allow information to be passed from the standby to the
primary controller.

* The third register is the Status register, which stores the status of
both controllers. This register provides information on how the hot
standby system is operating, such as the power flow of the CHS
instruction, position of the controller’s A /B switch, and whether
there is a logic mismatch between controllers.
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All registers following the third register are ignored (not
transferred) during the scan.

In the Non-Transfer Area Length field, type the length of the non-
transfer register range. This value can be from 4 through the total
number of registers configured in the controller.

Select one of the following State Ram Transferred options:

Default (12K): All Oxxxx and 1xxxx registers (up to 8192 each) are
transferred.

e If 10000 or fewer 3xxxx and 4xxxx (combined) registers are
configured, then all are transferred.

e If more than 10000 3xxxx and 4xxxx (combined) registers are
configured, then (up to) 1000 3xxxx registers and all 4xxxx (up
to a combined total of 10000) are transferred.

Routine only: All addresses defined in the routine transfer table
are transferred every scan. There must be a minimum of 16 4xxxx
registers to support the non-transfer area. The Routine Transfer
Table is a range of discretes and registers that must be configured
as a multiple of 16.

Routine and Extra: All addresses defined in the Routine Transfer
Table and in the extra tables are transferred. The range of each extra
table must be a multiple of 16. The extra tables can be transferred
over multiple scans.

All State RAM: All RAM configured in the controller is transferred
every scan.

In the Scans Needed to Transfer field, type the number of scans (1-
255) needed for the primary controller to transfer the extra transfer
tables to the standby, then click OK.
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VME Bus extension

The VME Bus extension lets a VME-424 /X controller control data transfers
between devices on a master/slave Quantum network. In a master/slave
protocol, one device (the “master”) has control over other devices (“slaves”).
As the network runs, each element can lose and gain master status, based on
negotiations with other members of the network.

@ If the VME Bus extension does not appear in the Tree Control area, it is not yet
installed.

» To configure an installed Quantum VME Bus extension:

1.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions dialog box appears.

Select VME Bus from the list.

Type the appropriate value in the Slave Interrupt Level field. Boards
on a VME Bus can send and respond to messages on seven interrupt
levels, numbered from 1 to 7. This field determines which interrupt
level the board uses when it’s acting as a slave.

Type a value between 1 and 255 in the Status ID field. When the VME
controller receives an interrupt while acting as a slave, this is the value
it sends.

Select an appropriate value for Master Release Mode. This field
determines when a board acting as a master relinquishes its master
status. Valid settings are Release on Request (ROR), Release When
Done (RWD), Release On Clear (ROC), or Bus Capture and Hold
(BCAP). The proper setting depends on how your Quantum network
is configured.

Select an appropriate value for Master Arbitration Type. This field
determines how the controller will operate. Valid settings are Not
System Controller, Primary Mode (PRI) or Round Robin Mode (RRS).

Select the appropriate value for Master VMEBus Request Level. This
field determines what priority the board has when trying to acquire
master status. It can range from BRO (the lowest) to BR3 (the highest).
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8. For each interrupt level from Interrupt1 to Interrupt 7, select whether
it should be Enabled or Disabled. These fields will only have an effect
when the VME acts as a master. If an interrupt level is:

* Enabled: The controller responds to any messages sent on that
interrupt.

* Disabled: The controller ignores them.
9. Click OK.

Profibus extension

The Profibus configuration extension allows you to communicate with a
Profibus network. In order to successfully install and configure the Profibus
configuration extension, you will have to use a total of three separate utilities:

*  The NxT Profibus utility

*  Softing’s PROFI-KON software, included with the Profibus hardware
*  Modicon’s SPU931 utility, also included with the Profibus hardware

:g PROFI-KON and SPU931 are not ProWORX NxT products. While every effort

has been made to ensure the accuracy of these instructions, users of PROFI-
KON and SPU931 do so at their own risk.

Installing the Profibus configuration extension

Step 1

Ensure your database is configured properly for your Quantum controller by
checking;:

Your controller has Revision 2.xx or later executive Flash RAM.

* Enough controller memory is set aside for configuration extensions. If

you do not have enough configuration extension memory available,
you will receive an error when you transfer your Profibus
configuration into your NxT database (Step 5).

*  Your Profibus DP or Profibus FMS card is configured in the Traffic
Cop.
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Step 2

Start the NxT Profibus Utility and create a Profibus Station from your NxT
database’s .MDF file.

A Profibus Station is a collection of Profibus configuration files contained in a

specific
L]
L]
L]

directory structure. These files contain such information as:
Controller configuration;

Profibus bus and communication parameters;

Profibus network topology; and

Profibus-to-Modicon address maps.

» To create the Profibus Station in the NxT Profibus Utility:

1.

Step 3

In the .MDF File box of the NxT Profibus utility, type the name and
path of your NxT database’s .MDF file or click Browse to navigate to
it.

In the Profibus Station area, select a drive for your Profibus Station
from the drop-down menu.

Do one of the following:

* Use existing Plant and Station Directories by selecting them from
the drop-down menus.

* Create new directories by typing a Plant name in the Plant
Directory box, then a Station name in the Station Directory box.

In the Options area, select Create a Profibus Station for use with the
SPU Software.

Click Start. The Profibus Utility creates a Profibus Station in the target
directories with information from the .MDF file. Its progress is
displayed in the Status box.

Start the PROFI-KON software you received with your Profibus hardware and
configure your Profibus network with it. Refer to its manual for more
information. Save your work as a .CNF file to use in Step 4.
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To set up a Profibus network, you must have Softing’s PROFI-KON software.
You received the correct version with your Profibus hardware:

Network Software Also called
Profibus DP PROFI-KON-DP SPU832
Profibus FMS PROFI-KON-FMS SPU932

When you save your work, PROFI-KON generates the .CNF file required by
the SPU931 software, which you use in the next step.

Use PROFI-KON-DP to:
* Load device-specific data from .DDB files;
*  Set Profibus Master/Slave communication parameters and addresses;
* Edit bus parameters; and
*  Check the configuration.
Use PROFI-KON-FMS to:
* Load device master data from .DMD files;

* Edit bus parameters, vectors, communication relationships, and object
dictionaries; and

* Define your network’s topology.

Step 4

Start the SPU931 software you received with your Profibus hardware.
Navigate to and open the Profibus Station you created in Step 2, then the .CNF
file you created in Step 3. Map Profibus addresses to Modicon addresses. Refer
to the SPU931 manual for more information. Save your work to your Profibus
Station.

To set up a Profibus network, you must have Modicon's SPU931 software. You
should have received the correct version of Modicon’s SPU931 software with
your Profibus hardware.

SPU931 requires two files:

* A .CFG file created by the Profibus Utility as part of your Profibus
Station; and

* A .CNF file generated by the PROFI-KON software.
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SPU931 can only save a Profibus configuration to an existing .CFG file, not
create a new one. Create a .CFG file with the Profibus Utility before
configuring your Profibus network with SPU931.

When you save your work, SPU931 updates the Profibus Station's .CFG file.
The Profibus Utility then imports the updated information from the .CFG file
back into your NxT database in Step 5.

Use SPU931 to:

*  Map Profibus I/O points and diagnostics to registers in your
controller's memory; and

*  Assign bus controllers and the map the topology of the bus.

Step 5

In the Profibus Utility, transfer information from the updated Profibus Station
into your NxT database. NxT now shows the Profibus configuration extension
in the Configuration Extensions area.

» To transfer a Profibus Station:

1. Inthe .MDF File box, type the name and path of your NxT database’s
.MDF file or click Browse to navigate to it. The Profibus Utility
transfers the Profibus configuration to this file.

2. In the Profibus Station area, select the drive where your Profibus
Station is located from the drop-down menu.

3. Select your Profibus Station’s Plant and Station Directories, from the
drop-down menus. The Profibus Utility reads the Profibus
configuration from the .CFG file in the Station Directory.

4. In the Options area, select Move Profibus configuration to
ProWORX database.

5. Click Start. The Profibus Utility transfers the Profibus configuration
from the Station Directory to your database’s .MDF file. Its progress is
displayed in the Status box. NxT now shows the Profibus
configuration extension in the Configuration Extensions area.

Editing your Profibus configuration
To edit your Profibus configuration:

*  Without changing your controller configuration, start again at Step 3.

* After changing your controller configuration, start again at Step 2.

88 @ Profibus extension



Chapter 4 Configuring a Controller

Peer Cop extension

The Peer Cop extension provides data transfer between two or more
controllers on a peer-to-peer network, as well as linking multiple networks
using the S985 communication card. Peer Cop configures data blocks to be
continuously transferred (once per scan) between nodes on a Modbus Plus
network. Data can be broadcast to all nodes on a single link (Global I/O) or
between specific Modbus Plus nodes on a link (Specific I/O). A maximum of
32 data registers or 512 (i.e. 32*16) I/ O points can be transferred to or read from
a controller at a time. Peer Cop is supported by the A145 and all E-Series and
Quantum controllers. Up to 3 Links of the Peer Cop can be configured and
edited.

Adding links in the Peer Cop extension

The Peer Cop extension can be configured for up to 3 links. When you add a
link you will have access to the 64 possible devices on another peer-to-peer
network.

¢ Link 1 is the internal link; all devices on the local Modbus Plus
network can be accessed from Link 1.

* Links 2 and 3 are remote links through 5985 cards.

» To add a Peer Cop link

1. From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions window appears.

2. Inthe Tree Control area of the window, click Peer Cop. Peer Cop
details appear in the Details area of the window

3. Click Add a New Link. When you add a new link, the new link is also
automatically added to the tree control display. Each link includes a
Global I/O and Specific I/ O transfer.
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Editing links in the Peer Cop extension
You can edit the following components of the link:
¢ General link information;
* GlobalI/O; and
*  SpecificI/O.

General link information

The three general components of a link are the Last Value, Timeout, and Head
Number.

* Last Value specifies whether or not to hold the last value. When On,
the input data area associated with an unhealthy transfer is left in its
previous state (i.e. the last value with a health of OK).

* Timeout specifies the health timeout interval. The default value is
500ms. This value specifies the minimum time period a Peer Cop
configured communication must fail before the associated health bit is
cleared. Valid timeout values range from 20ms to 2 seconds. If you
type a value too big, the value truncates to a multiple of 20. For
example, 230 truncates to 220 (it is not rounded up to 240).

* Head Number specifies the head number on a Quantum rack. If you
are using a Quantum Controller, you have the option of editing the
head number for the second or third link. The first link is internal,
therefore it cannot be edited.

Global I/0

Global I/O is one of two communication methods used by the Peer Cop
extension (the other is Specific I/O). Global 1/ O is a broadcast communication
method, where a message is broadcast (made available) to all controllers on
the Modbus Plus network. Global I/O data transfers do not require an
acknowledgment from the receiving controller, so there is no immediate
overhead placed on the receiving controller.

There are two components to Global I/O:

* Global Output broadcasts the specified range of discretes or registers
to the devices on the Modbus Plus network. Each device used to access
the data must also be configured to accept Global Input from the
broadcasting device (1-32).
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Global Input is used to receive global data from any device on a
Modbus Plus network. One entry (line) is available for each device (1-
64). Each device’s global data can also be received in pieces
determined by Subfields.

Global Output

Global Output broadcasts the specified range of discretes or registers onto the
Modbus Plus network. Each device used to access the data must also be
configured to accept Global Input from the broadcasting device.

» To edit the Global Output:

1. From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions window appears.

2. In the Tree Control, select the Global /O to edit by clicking it. The
Global I/O fields appear in the Details area of the window.

3. Do one of the following:
* Select the Global Output field by clicking it, then click Edit.
* Double-click the Global Output field.
The Global Output dialog box appears.

4. InLength, type the length (1-32) of the address range (i.e., the number
of registers to broadcast).

5. In Reference, type the starting address (5 or 6 digit) for the range to
broadcast.

6. Ifrequired, click BIN/BCD to toggle between binary and binary coded
decimal modes.

Global Input

Controllers use the Global Input function to receive global data from any
device communicating peer-to-peer on a Modbus Plus network.

» To set a Global Input:

1.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions dialog box appears.

@ Ensure the necessary Peer Cop links are defined before continuing.
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2. In the Tree Control, select the Global I/O to edit by clicking it. The
Global I/O fields appear in the Details area.

3. Selecta Global Input, then click Edit or double-click the Global Input
you want to edit. The Global Input dialog box appears.

In Index, type the starting point (1 to 8) of the broadcast data to read.

In Length, type the number of words (1 to 32) to read forwards from
the Index value.

For example, suppose the source controller is broadcasting 10 words
of data using the Global Output function, but the receiving controller
only uses words 3 to 7. You would type an Index value of 3 and a
Length of 5.

The length plus the index must be less than or equal to 33. In the
Reference field, type the destination for the received data (i.e., where
the received data is to be stored).

6. Select either BIN (default) or BCD. One entry is available for each
device (1-64).

Each device’s global data can also be received in sections determined by
Subfields. You can define a subfield for each block of the broadcast data that
you want the controller, to receive while ignoring the remainder.

> To edit subfields:

1. From the Configuration Extensions dialog box, select the Global I/O
of the link you want to edit by clicking it.

2. Click the global input you want to edit from the Global Input area of
the Configuration Extensions window.

3. Click Subfields. The Global Input Subfields window appears with a
list of the subfields for the selected input. Select the subfield you want
to edit.

4. Do one of the following:
* Select a subfield and click Edit.
* Double-click the subfield.
The Global Input dialog box appears when you.
Type the new global input parameters.

(Optional) Click Data to view the data currently in the input registers.
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Specific I/0

Specific I/O is one of two communication methods used by the Peer Cop
extension (the other is Global I/O). Specific I/O uses a one-to-one
communication method and requires an acknowledgment from the receiving
device, which creates a certain amount of overhead. When using SpecificI/O,
the destination controller must accept the entire block of data from the source
controller. This means that the Index value used in Global I/ O is not necessary.

Specific I/O allows you to configure multiple defined data blocks for
transmission to specific devices on the Modbus Plus network. The device
receiving the data must be configured for Specific Input from the broadcast
device. The length (in words) of the specific input (configured in the
destination controller) must be identical in length to the specific output
(configured in the source controller). The input data, however, can be stored
in any type of reference desired. That is, five words of 4xxxx data can be stored
into five words of Oxxxx memory area.

» To edit a Specific Output:

1. From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions window appears.

@ Ensure the necessary Peer Cop links are defined before continuing.

2. In the Tree Control, click the Specific I/ O to edit. The Specific Input
and Specific Output fields appear in the Details area of the window.

3. In the Specific Output list, select a source controller (i.e., the output
device) by clicking it.

4. Click Edit. The Specific Output window appears, with the selected
controller shown in the Device field.

5. In the Length field, type the length of the data block (1-32) to be sent
to the destination controller.

6. Inthe Reference field, type the starting address for the block of data
to be sent to the destination controller.

Click OK to close the Specific Output window.

If required, click BIN/BCD to toggle between binary and binary coded
decimal.

9. Click OK.

Peer Cop extension ® 93



ProWORX NXT User's Guide

» To edit a specific input:

1. From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions dialog box appears.

@ Ensure the necessary Peer Cop links are defined before continuing.

2. In the Tree Control, click the Specific I/O to edit. The Specific Input
and Specific Output fields appear in the Details area of the window.

3. In the Specific Input list, select a destination controller (for example,
the input device) and click Edit. The Specific Input dialog box appears,
with the selected controller shown in the Device field.

4. InLength, type the length of the data block (1-32) to be received from
the source controller.

5. In Reference, type the starting address of the block of data to be
placed from the source controller.

Click OK to close the Specific Input dialog box.

If required, click BIN/BCD to toggle between binary and binary coded
decimal.

8. Click OK.

» To view the data for a reference address:

1. Inthe Tree Control, click the Specific I/O to edit. The Specific Input
and Specific Output appear in the Details area of the window.

2. In the Specific Output or Specific Input box, select a reference and
click Data. Data associated with the reference address appears. This is
a read-only function— you cannot edit the data.
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Clearing and deleting links
There are two different functions available to reset or remove links:

* Clearing links deletes all Global I/O and Specific I/O entries within a
link, but does not delete the link itself.

* Deleting a link removes the link itself from Peer Cop.

» To clear all references within a link (keeping the link in the Peer Cop
extension):

1. From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions window appears.

2. In the Tree Control area, select the Peer Cop link you want to clear.
You can click the link itself, or the Global I/O or Specific I/O in the
link.

3. Click Clear Link. NxT will prompt you to confirm the operation.
Click OK.

» To delete a link from the Peer Cop extension:

@ You cannot delete Link 1, the internal link.

1. From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions window appears.

2. Do one of the following:

* Inthe Tree Control, select the link you wish to delete by clicking it,
then click Delete Link.

* Inthe Tree Control, select Peer Cop by clicking it, then click Delete
a Link.

The Delete Link window appears.
3. Select the link you want to delete by clicking it.

Click OK. The link is automatically deleted from the tree control
display along with its accompanying Global and Specific I/O.
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SY/MAX extension

The SY/MAX configuration extension allows you to properly access and
configure up to six SY/MAXRIO cards. This extension is only available when
using Quantum Rev. 2 or later controllers.

» To configure the SY/MAX extension:

1.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions dialog box appears.

Select the SY/MAX extension from the Config Extensions tree.

If the SY/MAX extension is not in the Config Extensions tree, you
have to add it. Select Config Extensions on the tree, click Add
Extension, then select SY/MAX.

In Card Number, select the particular SY/MAXRIO card you want to
configure. The Module Drop Number, Backplane Slot, Retry Count
and Timeout values change to reflect the current settings of the
selected card.

The actual value for the Card Number has no effect, as long as you choose a
different Card Number for each SY/MAX RIO card you configure.

In Module Drop Number, type the number of the drop that the
selected RIO card controls.

Type “-1” if the RIO card has no drop to control.

In Backplane Slot, type the slot number that the RIO card inhabits on
the local rack.

If set to 0, the SY/MAX extension assumes that no card exists.

In Retry Count, type the number of times the controller will try to
communicate with the RIO card before it gives up.

In Timeout, type the number of 10s of milliseconds the controller will
wait for communications from the RIO card before it gives up.

Click OK.
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» Toremove an RIO card from the SY/MAX extension:

1.

From the Network Editor, on the Configuration menu, click Config
Extensions.

The Configuration Extensions dialog box appears.
Select the SY/MAX extension from the Config Extensions tree.

In Card Number, select the number of the RIO card you want to
remove.

In Drop Number, type “-1”.
In Backplane Slot, type 0, then click OK.

Cyclic Data Exchange

The Cyclic Data Exchange (CDE) extension for provides data transfer between
two or more M1E controllers on a TCP/IP network. CDE allow you to
simultaneously configure up to 64 communication transactions. Because the
TCP/1IP connection is established only once and remains connected during an
entire session, it makes this type of cyclic communication very efficient.

>

To configure the Cyclic Data Exchange extension:

1.

From the Network Editor, on the Configuration menu, click Config
Extensions. The Configuration Extensions dialog box appears.

In the Config Extensions tree, right-click on Config Extensions and
select Add Extension.

Select Cyclic Data Exchange. The parameters for the CDE appear in
the details area.

Master IP Address [Slot) Health Block [1X/3X)
[ oo |

IP Address Unit ID  Health Rep Rate Read RefWwrite Ref
Timeout Master Master

002: Empty
003: Empty
004: Empty
005: Empty
D06: Empty
007: Empty
008: Empty
009: Empty
010: Empty
011: Empty
012: Empty
013: Empty
014: Emph; . .
015: Empty |_—Click this scroll
016: Empty bar to view all of
017: Empty — =

= : the parameters.
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4. In the Health Block field, type a 1xxxxx or 3xxxxx address.

All Ixxxxx addresses are based on a 16-bit boundary. For example, 100001,
100017, 100033, etc.

5. Double-click on an empty transaction to add a new transaction or
double-click on an existing transaction to edit it. The Transaction

dialog box appears.
Transaction [ %]
Server IP Addiess:
Unit ID [D-255): Health Timeout [0-50000): Repetition Rate [0-50000):
00000 | ms 00000 [ mS
Function:| Read/Write j
Read Ref Master: Read Ref Slave: Read Count [1-125):
[40001 ] [40001 |
write Ref Master: Write Ref Slave: Wwrite Count [1-100]:
[40001 ] [a0001 |
Cancel | Help |

6. Configure the transaction parameters.

Configuring the hardware (or time of day) clock
Many controllers have a built-in Time of Day clock. You can set these clocks if:

*  You have configured its starting register in the General tab of the
Controller Configuration window;

% For more information, see Controller configuration - General tab on
page 55.

* NxT is set to Program Mode; and

*  The controller is running.
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» To configure the hardware clock:

1. From the Network Editor, on the Configuration menu, click
Hardware Clock. The Hardware Clock dialog box appears.

Hardware Clock E

First Day Of Week: | CHEZTMNNNINNE
Controller Date: Wednesday (06-18-99
Controller Time:

Computer Date: ‘Wednesday D6-18-99

L

Computer Time: 14:11:55

0K | Cancel

Auto Set

Help |

2. In First Day of Week, type the day the controller will use as the first
day of the week.

3. Do one of the following:

* To synchronize the controller’s date and time with your computer,
click Auto Set.

* In Controller Date, type the date in mm-dd-yy format. In Controller
Time, type the time in hh-mm-ss format.

4. Click OK.

The Time of Day clock requires eight 4xxxx registers in your controller.

This register... Contains...

4xxxx Control information. From the left:
Bit 1: Set Clock Values
Bit 2: Read Clock Values

Bit 3: Done
Bit 4: Error
dxxxx+1 Day of the week (from 1 to 7)
xxxx+2 Month
4xxxx+3 Day
dxxxx+4 Year
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This register...

Contains...

4xxxx+5 Hour (in 24 hour format)
4xxxx+6 Minutes
Axxxx+7 Seconds
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Working with the controller

Reading from a controller

The Read from Controller function transfers memory contents from a
programmable controller into a designated database. It is strongly
recommended that you use this function to backup the contents of a controller
before working with it online.

» To read from the controller:

1.

Type the device address
here. Click Net Scan to dis-
play all currently available
devices.

From the ProWORX NxT Title Screen or the Network Editor, on the
Controller menu, click Read from Controller. The Read from
Controller dialog box appears.

Read from Controller E

Source: Destination: [Q 4247X]

[42 | [C:APROWORXANXTAQUANTUM ]

+ Type the path and file
Net Scan... | Browse... | name where the read in-
formationis to be stored.
You can click Browse to

Read Type: select an existing data-
‘ ® Regular C Extended Memory base.

Read | Cancel | Help |

In Source, type the Modbus Plus routing path or Modbus address. If
you're unsure of the routing path or address, click Net Scan.

In Destination, type the path and file name for the database.

If you're unsure of the path and file name, click Browse to navigate to
the database. If you have a database open, it becomes the default
destination database for the controller read. Ensure this is the
database you want to use before continuing.

Click the desired Read Type.

* Regular reads logic, traffic cop, configuration, loadables, ASCII,
state and disabled tables.

* Extended Memory reads only the extended memory registers.
Click Read.
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Writing to a controller

The Write to Controller function writes the contents of a database to a
controller. The controller must be stopped before you can write to it.

> To write to the controller:

1.

Type the path and file
name of the database to be
written to the controller.
You can click Browse to
select a database.

From the ProWORX NxT Title Screen or the Network Editor, on the
Controller menu, click Write to Controller. The Write to Controller
window is displayed.

fufnteltoltontroller ] Type the device address
s -0 4247%) Destination: h_ere. Select Net Scan to
view the currently avail-
[C:APROWORXHXTA\ISA_95 | [42 | able devices.
Browse. .. | Het Scan... |
Write Type: Regular:

""" Logic, traffic cop. configuration, loadables,
. ASCII, state tables. disabled address tables.
O Relocate Logic

O Extended Memory

Write.__ | Cancel | Help |

In Source, type the path and file name of the source database.

If you're unsure of the path and file name, click Browse and navigate
to the database. If you have a database open, it appears here

automatically. Ensure this is the database you want to use before
continuing.

In Destination, type the Modbus Plus routing path or Modbus
address of the destination controller. If you're unsure of the routing
path or address, click Net Scan.

You cannot write to a controller from a database that is associated with an
@ incompatible controller type. For example, you cannot write to a Quantum
controller from a database configured for a Micro controller.

4.

Click the desired Write Type.

* Regular writes logic, traffic cop, configuration, loadables, ASCI],
state and disabled tables. This option overwrites any existing
addresses.
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* Relocate Logic writes the contents of a database to the contents of
the controller as long as addresses and function blocks in logic are
supported in the destination controller. You can choose to update
either the Logic, Coils Used, ASCII and State/Disabled tables, or
just the Logic and Coils Used.

* Extended Memory writes only the extended memory registers.

5. Click Write. NxT displays the Database/Controller Validation
window before writing to a controller. Database/Controller
Validation compares the controller and the database to confirm that
they are compatible. Potential problems to consider are:

* The controller being written to may not have enough memory for
the logic being written.

* The controller address ranges many not be large enough
* The controller instruction set many not match the database

* The database may use duplicate coils, which most controllers do
not support

Ensure your controller and database match.
Click Write.

Initializing logic in a controller

Initializing logic erases the networks, register contents and ASCII messages in
a programmable controller. The controller must be stopped before you can
initialize logic.

It is strongly recommended that you read the contents of the controller to a
backup database before initializing logic.

» Toinitialize logic:

information stored in the controller, ensure that its contents have been read to a

j You are about to erase the contents of your controller. If you want to save any
database.

1. From the ProWORX NxT Title Screen or the Network Editor, on the
Controller menu, click Initialize Logic. A confirmation dialog box
appears.

2. Click Yes.
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Transferring memory contents to controller EEPROM

This function works only with Compact controllers. Do not attempt the
transfer operation if the controller’s battery is LOW as the processor contents
may be lost.

This function cannot be performed while the controller is running. You must
stop the controller first.

Memory Protect is a switch on your controller that stops you from altering the
controller’s contents. The Memory Protect switch should be ON or the card
overwrites memory on power up.

>

To transfer controller memory to EEPROM:

1. From the ProWORX NxT Title Screen or the Network Editor, on the
Controller menu, click EEPROM/Flash. The Transfer to Compact
Controller EEPROM dialog box appears.

Transfer to Compact Controller EEPROM E

t C

¥ After power down restore PLC to previous Run/Stop state
[~ Start PLC after download from EEPROM

¥ Save 4xxxx registers to EEPROM

v Dptimized Mode

Transfer | Cancel | Help |

A-series Compact controllers have four enhanced EEPROM options
which may be set prior to transferring:

DOptions for "A" Series L

* After power down, restore PLC to previous Run/Stop state.
 Start PLC after download from EEPROM.

* Save 4xxxx registers to EEPROM.

* Optimized Mode.

25

When Optimized Mode is selected, the controller can’t be edited while Online.

2. Click Transfer. You're prompted to stop the controller, if it is
currently running.
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Transferring memory contents to Flash RAM

This function copies the memory contents of a Micro controller to the
controller’s flash RAM.

When the Micro controller receives power, it first checks to see if a valid
configuration is present in the data memory. If not, the contents of the flash
RAM are re-loaded into the controller memory.

Flash RAM may be used as an alternative to the optional battery backup, or as
an extra backup of the logic and configuration.

» To transfer to Micro controller Flash RAM:

1. From the Main Screen or Network Editor, on the Controller menu,
click EEPROM/Flash. NxT displays the Transfer to Micro Controller

Flash dialog box.

Transfer to Micro Controller FLASH E
Save P of ller to FLASH RAM.
Thiz may only be done when the controllers is
stopped.

Stop | Cancel Help |

If the controller is currently running, click Stop.

3. Click Transfer. You are asked whether or not you want NxT to start
the controller after loading to flash RAM:

* Click Yes to have NxT automatically start the controller after
transferring memory contents to flash RAM.

* Click No to keep the controller stopped after transferring memory
contents to flash RAM.
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Transfer internal flash or PCMCIA to controller flash

This function copies the memory contents of a Compact TSX, Quantum 434, or
Quantum 534 controller to the controller's flash RAM or PCMCIA memory
card.

Do not attempt the transfer operation if the controller's battery is LOW as the
processor contents may be lost.

When the controller receives power, it first checks to see if a valid
configuration is present in the data memory. If not, the contents of the flash
RAM or PCMCIA memory card are re-loaded into the controller memory.

Flash RAM or PCMCIA memory card may be used as an alternative to the
optional battery backup or an extra backup of the logic and configuration.

This function cannot be performed while the controller is running. You must
stop the controller first.

Memory Protect is a switch on your controller that stops you from altering the
& controller's contents. The Memory Protect switch should be ON or the card
overwrites memory on power up.

» To transfer the controller's memory contents to controller Flash or
PCMCIA memory card:

1. From the Main Screen or Network Editor, on the Controller menu,
click Flash/PCMCIA. The Transfer to Controller FLASH dialog box

appears.

Transfer to Controller FLASH E
& Intemnal Flash [¥ Start PLC after download
- ;—‘CMCIA [¥ Save state ram

| Axxxxx registers to save: |9l]l]l] | |

Transfer LClear Flash

Stop | Cancel | Help |

If the controller is currently running, click Stop.

Select Internal Flash to transfer the current logic to flash memory or
PCMCIA to transfers the current logic to the PCMCIA memory card.

Transfer internal flash or PCMCIA to controller flash ® 107



ProWORX NXT User's Guide

4. Compact controllers have enhanced options that may be set prior to
transferring.

5. Set the parameters for internal flash and PCMCIA settings:

* Start PLC after download from: Automatically starts the controller
with the logic that was stored in flash memory or the PCMCIA card
during a power failure.

* Save state RAM: Saves the last state to flash memory or the
PCMCIA card in the event of a power failure.

6. Type the number of registers to save in the 4xxxx registers to save
field. The specified number of registers are saved to flash memory or
the PCMCIA card in the event of a power failure.

7. Click Transfer to transfer the logic to flash memory or the PCMCIA
card. You're prompted to stop the controller, if it is currently running.

@ Click Clear Flash to clear the logic stored in the flash memory or the PCMCIA
card.

Transferring the Flash RAM executive

Some devices store their executive firmware (the instructions that tell the
device how to work) in Flash RAM, rather than EPROM. You can copy a
controller’s Flash RAM Executive to and from disk as a backup to guard
against potential data loss. This may also come in handy if the manufacturer
releases an updated version of the controller's executive.

Saving the executive firmware to disk is a read operation. Copying an
executive from a disk file to a device is a write operation. Currently, the only
devices that contain their executive firmware in flash RAM are Quantum,
Micro, and E Series controllers and certain Quantum series Remote I/O and
Distributed I/O processors.

Itis highly recommended that you only attempt Flash RAM Executive operations
@ if you are directly connected to the device by:

*  The local Modbus or Modbus Plus port of the controller; or
»  The local Modbus port of the device.
You may not be able to establish the needed connection through any other port.
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» Toread a controller's Flash RAM Executive into a disk file:

1.

From the ProWORX NxT Title Screen, on the Controllers menu, click
Executive Flash. The Flash RAM Executive dialog box appears.

Click Read.

In the Source box, type the device number of the device whose
executive you want to copy to disk. Alternatively, click Net Scan to
scan the network for available devices.

Flash RAM operations are not supported over Ethernet networks — only Modbus
and Modbus Plus.

In Device Type, click the type of the device from which to read.

If you are reading from a Local Head or RIO Drop Card, in the
appropriate boxes, type the device’s Head Number and Drop
Number.

In Destination, type the full path and file name or click Browse to the
file to save the device’s executive. This file must have a .BIN extension.

& This file will be completely overwritten.

7.

Click OK. After a check to see if the specified device exists, you are
prompted to confirm the read operation. Click Yes and the device's
executive firmware is copied into a disk file.

> To write a device’s Flash RAM Executive from a disk file:

1.

From the ProWORX NxT Title Screen, on the Controllers menu, click
Executive Flash. The Flash RAM Executive dialog box appears.

Click Write.

In the Source box, type the full path and file name or Browse to the file
in which to save the device’s executive. This file must have a .BIN
extension.
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4. In the Destination box, type the device number of the device whose
executive you want to update. Alternatively, click Net Scan to scan the
network for available devices.

Flash RAM operations are not supported over Ethernet networks — only Modbus
and Modbus Plus.

In the Device Type section, select device type to which to write.

If you are writing to a Local Head or RIO Drop Card, in the
appropriate boxes, type the device’s Head Number and Drop
Number.

7. Click OK. ProWORX NxT checks to see if the specified device and file
exist.

8. You're prompted to confirm the write operation. Click Yes and
ProWORX NxT begins updating the executive firmware.

If you abort a Flash RAM Executive Write operation, the device will be unusable
& and will remain in Kernal Mode. To return the device to regular operation, start
and finish a Write Flash RAM executive operation from the beginning.

Stopping the controller

This function stops a controller from solving logic, or performing /O
functions. The controller remains in the ready state.

Stopping a controller may have a major impact on your process. Always
consider fully the possible consequences of stopping a controller (that is, is it
performing a critical operation?) before proceeding.

» To stop a controller:

1. From the ProWORX NxT Title Screen or the Network Editor, on the
Controller menu, click Start/Stop. If you're in a procedure which
requires the controller to be stopped, you may be prompted with a
dialog box to stop the controller. In this case you can select Stop from
the dialog box.

2. Click Stop. NxT displays a “Controller Stopped” prompt to tell you
the operation was successful. Click OK to clear the prompt. If the
operation is unsuccessful, an error message displays the problem.
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Starting the controller

» To start the controller:

1.

From the ProWORX NxT Title Screen or the Network Editor, on the
Controller menu, click Start/Stop.

(Optional) If you are using a 984 controller, select whether to start in
Optimized Mode.

In the optimized mode, the ability to edit or show power flow is
disabled. You may have to stop the controller to make logic changes.
The 685E and 785E controllers have a 2k buffer allowing editing
during optimized mode. Once this buffer is full, no further changes
can be made until the controller stops.

Click Start. NxT displays a “Controller Running” prompt to tell you
the operation was successful. Click OK to clear the prompt. If the
operation is unsuccessful, an error message displays the problem.

Starting the controller ® 111






6 Using the Network Editor

In this chapter

Using the Network Editor 114

Customizing the network display 117
Network editor panel descriptions 120

Power and Power/State flow toggle (Online only) 125
Setting the update rate (online only) 125
Editing instructions in logic 127

Using the Segment Scheduler 134

Moving networks in segments 136

Editing register contents 137

User Configurable Register editor 137
Extended Memory Register editor 148
Generic Register editor 152

Other Network Editor functions 158
Checking for used addresses 158

Global register replace (offline only) 161
Symbolic addressing 164

Searching logic 165

Setting bookmarks in logic 168

Inserting and deleting network items 170
Transferring logic blocks to and from disk (offline only) 171
Making logbook entries 173

Searching for duplicate coils (offline only) 174
Displaying disabled addresses 174

Locating coils from contacts 175

Rebuilding a database 175

Performing a sweep (online only) 175




ProWORX NXT User's Guide

Using the Network Editor

The Network Editor is used to enter logic elements, edit register values,
display input/output data, and add descriptors and comments to a network.
The Online Network Editor gathers its data from the controller instead of a
database (as Offline does).

In the Online editor, each instruction is sent to the controller as it is entered,
whereas in the Offline editor, an entire network is saved at a time.

¥ Prow ORX NxT M=l E3
Ele Edit View Search Data Controller Copfiguration Display Tooks  Help
i = oo T The Panel bar lets you
You can select |nstruc—\ mEENRAEEE #le [ (2] a~: ] I Iaaoer hbige ets f)i/ve
tions for yourogic from ™ ¢ m|-we e 0| swmwismm | awo svo mox o vore|  [ine [omedmmlTeon o0 oo vele he Data
the Instruction bar NETWORK 0001 network 1 page litle [0 BC] | Back Rererence p -
bypaz  belo Inivi P | -INI- D:01 R:3 §:04 Watch (onllne only), In-
orr e i sk () T o oo struction List, Back Ref-
' leate wenz] weihl I;[lllilt’;' I_‘::;,: : 1u00z i erencing, Symbol List,
Sarc  Imici  hesev Faine | bORE wawe UCTR DCTR| | rewz ok and Traffic COp pane|s‘
54 in urr orr orr an To T4 : 004 OFF
: Poen A I N O N s A Tav ao || R o
= ot o
Rt R ?’:‘1‘“}\
: . R e Ty [ e wn o Move the display be-
The Documentation v e [0 et . tween networks with this
Window lets you type\4 \ " 2| or cmen | s o scroll bar. If the entire
descriptors, short com- weiz  ealer |s - D:“ ':2: . network can be dis-
ments, and long com- e |=lror @ T played at once, this is
ments directly from the | Bezete™ege |se:grmisrer bl sk, L iar ol iz bi1e ies |5 beens | the only active scroll bar.
i h h ien. Th 1 i
Network EdltOr. S L : eg::a:j(:‘;::gn:"e mator can enly eperate in BT METR N
TEBLK
Symbol: START_PRESS 58] If the current network
. Le: doesn't fit in the screen,
The Status Bar dis- 2|3] II'b
. - [ a scroll bar appears
plays information abou here
the active database. NNT_DEMO | 3844145 | seq:m | Met0001/0034 |words Used: 01090/07265 | Program | Marks: 00 '

About the toolbar

Many common Network Editor functions are available from the toolbar. The
toolbar’s buttons depend on whether you are working online or offline and
whether there is an active database. Possible toolbar buttons are:

New Creates a new database.

Open Opens an existing database.
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Print Prints the active network.
=
Cut Moves the selected cells (or text in a field) to the
clipboard.
Copy Copies the selected cells (or text in a field) to the
= clipboard.
Paste Pastes the cells (or text) in the clipboard into the
selected cells in logic (or selected text field).
Change View E To’:gglesk between four configured views of the
88| | network.
Search Displays the Search window, where you can
search logic for specific items (addresses, data
values)
Global Replace Offline only. Allows global address changing.
Change Device @ Onlinel lonly. Lets you select a different
controller.
Traffic Cop Displays the Traffic Cop window, where you
configure your I/O.
Configurator o Opens the Controller Configuration window,
SE which has a set of tabbed pages used to select
and configure a controller.
Documentation @ Available only with an active database.
Editor Displays the Documentation Editor, where you
can edit all documentation components.
Register Editor @ Dilspla}clls tlhe Register Editor window for the
selected cell.
Goto Offline (Available in Online only) Switches NxT to

Offline Mode when running the Offline/Online
system.
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Goto Online (Available in Offline only) Switches NxT to
f] | Online Mode when running the Offline/Online
system.
Help E‘ Displays the NxT online help for the selected
window or item.

Shortcut menus

Several functions can also be accessed from a shortcut menu. Right-click
anywhere in the Network Editor and the shortcut menu appears. Functions
accessible from the shortcut menu are:

* Cut, Copy, and Paste
* Find

*  Set Mark

*  Documentation Editor
* Register Editor

* Instruction Help

About the status bar

The Status Bar displays helpful information about the open database or, in the
Online Editor, the selected controller.

In the Offline Editor, the Status Bar shows you...

. words used of number of bookmarks
active database current segment those available placed in logic
\
NeT_DEMOD | 9844145 [Seq 01 [Metooo2/0034 [wiords Used 01090/07264 | Progiam |Marks: 00
controller type current network editing mode

In the Online Editor, the Status Bar shows you...

number of bookmarks

active database controller type controller status placed in logic
NAT_DEMO | Device:0D | Mico384  |Seq:01 |Running | Fragram |Marks:00
7/
controller address current segment editing mode
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Customizing the

network display

The Network Display Setup dialog box tells NxT how to display each cell ina
network. There are four configurable display styles, called views, available.
These four views can be configured to display logic cells of user-defined size,
with or without symbols, descriptors, addresses, data values and back

referenci

» To configure a network view:

ng information.

1. From the Network Editor window, on the View menu, click Network
Display Setup. The Network Display Setup dialog box appears.

Select or clear to determine
where coils are displayed.

Select to force the display to
always show an entire network
at a time.

With Custom Screen Setup \

cleared, click to select one of
the configurable views, then
select one of six preset views.

These fields are positioned
above or below the instruc-
tion, where they would ap-

pear in the network display.

Network Display Setup

[~ Show coils in solve column

[~ Always fit 7 rows by 11 columns

Viewl View2 View3 View4 |

[" Custom Screen Setup

\\
Ll Siymbol 1 Siymbol |
Siymbol 2

Deseriptor ] ) ;
Descriptor 2 Deseriptor 1 Deseriptor |

w01 oo 200001

/

Column Width:

|~

Cancel
Click to select colors for Net-
Colors.. work Editor elements.

Cursor... .
r~ Click to select the cursor style

for the Network Editor.

|~ Type or select the display width
for each column of network logic.

EJEE

Help

Do one of the following:

* With Custom Screen Setup cleared, click one of the six preset

views.

* With Custom Screen Setup selected, set up your own view

manually.

Clear

-
Desc1 |«
-

Data

Addr |
Clear |

The symbol represents
an instruction block as it
appears in the Network
Editor.

Up to 5 lines are available for each element, 3 lines above the
instruction and 2 below it. For each line, select one of the following;:

¢ The instruction’s address.
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Back referencing information.
One of nine possible descriptors.
The address’s data.

Up to two lines of symbol text.
Clear (leave the line blank).

3. In Column Width, select the column width for the five lines of cell
description. Increasing the width allows less instructions to fit on the
screen, but more descriptor, data and symbol information to be
displayed.

4. Select or clear the Show coils check box:

If you select the check box, coils are shown where they are solved
by the controller.

If you clear the check box, coils are always placed in column 11,
attached to the solve column by dots.

5. Select or clear the Always fit check box:

If you select the check box, NxT adjusts the size of display elements
so that you always see a full network. The disadvantage is that
display elements may shrink beyond legibility, especially when
using lower screen resolutions.

If you clear the check box, scroll bars will appear when a network
is too large to display at once.

6. Click OK. Other than the Always fit option, changes made affect only
the view selected.

» To change views (toggle between the four views):

* Click in the toolbar.
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Customizing the Network Colors

This function allows you to select the display colors for:

Descriptors * Power Flow (Online only)

Symbols * Logic Foreground and Background
Back Referencing *  The Network Cursor

Data

You can also set the size of the Online Editor’s Power Flow display.

» To set the network colors:

1.

Power Flow Color, Power
Flow Size, and Offline
Edit Color appear only in
the Online editor.

From the Network Editor window, on the View menu, click Network
Display Setup. The Network Display Setup dialog box appears.

Click Colors. The Network Color Setup dialog box appears.

Descriptor Color:
Symbol Color: | Black j

Data Color: I\ This gives a preview of how

Back Reforence Color: [Biack = your color scheme appears.
Cursor Background Color:
Cursor Foreground Color: | Bright White d
Logic Background Color:
Logic Foreground Color: | Black j
Power Flow Color: | Black ﬂ
Power Flow Size: | Medium j
Offline Edit Color: [ {ight Blue =l

0K | Cancel | Default | Help |

For each Color box, select a color for the network item.

In Power Flow Size, select the width of the line used to show power
flow from the drop down box.

Click OK.
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Customizing the network editor cursor

The Network Editor cursor can be set to a solid block (default) or a rectangular
outline. In both cases, the color of the cursor and of selected text depend on
settings in the Network Color Setup dialog box, accessible from the Network
Display Setup window.

> To set the Network Editor cursor:

1. From the Network Editor window, on the View menu, click Network
Display Setup. The Network Display Setup dialog box appears.

2. Click Cursor. The Network Cursor Setup dialog box appears.

Click the style (Solid or Outline) you prefer for the Network Cursor,
then click OK.

Network editor panel descriptions

Back Referencing panel

The Back Referencing panel displays the I/O card, location and data (if they
exist) for a selected address in logic. The 800, Quantum and A120 cards (if
available) are also shown.

2w
[ nst | BRet [symb]1CoB]
#)| -10- | -B- ([ 4] Back Reference
“IP[- | -IH[- D:01 R:1 5:04
SKP [ )
-{L}- |OPEH| po ;10001 D0
oz ok
You can drag and drop ol oD @
these instructions right 10 [Toa T o The Back Reference panel keeps track of your
into your logic. T.01 ADD ::::: ::: physical I/O by obtaining the physical location of
SUB | MULT p—— an address used in the network logic.
oy R-2T W00E  DFF
T-2R T->T . . .
ETT ] If a physical location (for example, I/O point) ex-
FOUT sRCH ists, it is displayed in the form of Head (Quan-
STAT| AND tum), Drop, Rack and Slot for an S908 system or
OR _|CMPR Channel, Slot for a 584 or S901 system.
SENS MBIT
COMP XOR
BROT READ Al
WRIT XMWT L——
XMRD PID2 )
LAB JSR
RET EMTH E @
BLKT MSTR E E@
TEBLK CKSM
AD16 SU16 E
MU16 DY16 |( 3 @m

» To display the Back Referencing panel:
*  Click BRef (directly under the AR).
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Instruction List panel

The Instruction List contains all available logic instructions. You can use the

instruction list to drag and drop instructions into logic, or onto the instruction
bar.

» To display the Instruction List:
*  Click Inst (directly under the AR).

» To enter an instruction from the Instruction List:

* Inthe Network Editor, drag the instruction from the Instruction List
to:

* A cell inlogic, to enter the instruction there.
¢ A button on the Instruction Bar, to use that button as a shortcut for

inserting that instruction later.

Symbol Summary panel

The Symbol Summary panel displays user-defined symbols and their
corresponding addresses. Symbols let you assign names to addresses to make
them easier to remember. To work with symbols, the Symbols check box in
System Preferences must be selected.

» To display the Symbol Summary panel:
* In the Network Editor, do one of the following;:
* On the View menu, click Symbol List.
* Click Symb (in the panel toolbar).

% For more information, see “Symbolic addressing” on page 164.
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Data Watch panel

The Data Watch Panel (available only in the online editor) performs many of
the same functions as the Data Watch Window, but is displayed as a side panel
next to the Network Editor. With it, you can monitor changes in values stored
at up to 60 addresses at a time. Any settings you change or addresses you add
to the Data Watch Panel are saved when you leave the current database.

If the Add Watch/Track Data Info option in System Preferences is set to Data
Watch Panel, operations that would normally add addresses and tracking
information to the Data Watch Window will add them to the Data Watch
Panel. The following instructions assume this option is set to Data Watch
Panel.

% For more information, see “Using the Data Watch Window” on page
276.

D

i i You can edit binaries easily by just double-clicking on the bit to change it or click
k on it and enter a new value.

» To display or hide the Data Watch Panel:

*  On the View menu, click Data Watch Panel or click Data in the panel
toolbar.

» To add an address in the Network Editor to the Data Watch Panel:

1. Move the cursor to the address that you want to add to the Data Watch
Panel list.

2. Onthe Data menu, click Add Watch. The address is added to the Data
Watch Panel.

You can also track addresses and functions from the Data Watch Panel.

» To track a single logic element in the Data Watch Panel:
1. Move the cursor to the address or instruction that you want to track.

2. Onthe Data menu, click Track. The address or instruction is added to
the top of the Data Watch Panel.
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To track all addresses in the Data Watch Panel:

¢ Onthe Data menu, click Track Network. The first 60 addresses in the
network will be added to the Data Watch Panel. All other addresses
are ignored.

To track all discrete addresses in the Data Watch Panel:

¢ OntheDatamenu, click Track Discrete. The first 60 discrete addresses
in the network will be added to the Data Watch Panel. All other
addresses are ignored.

To make changes to a discrete address from the Data Watch Panel:

1. Click the discrete address you want to change in the Data Watch
Panel. Three buttons appear at the bottom of the panel: Force On,
Force Off, and Enable.

D

You can also right-click on a discrete address and select Force On or Force Off
from shortcut menu. This shortcut menu is available with or without a database
open.

2. Make the changes you want:

e Force On: Click to force the discrete state to on. This disables the
address.

e Force Off: Click to force the discrete state to off. This also disables
the address.

e Enable: Click to re-enable the address.

To make changes to an analog address from the Data Watch Panel:

1. Click the analog address you want to change in the Data Watch Panel.
Two buttons appear at the bottom of the panel: Edit and Radix.

2. To edit the value stored at the address, click Edit. To edit the radix of
the address value, click Radix. Addresses can be viewed as Decimal,
Hexadecimal, Binary, ASCII, Floating Point, Long Integer (32 bits),
Signed Integer and BCD.
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Traffic Cop Display panel

The Traffic Cop display enables you to place addresses from the I/O cards in
the Traffic Cop into your network logic. You can browse through the cards in
your Traffic Cop 800, A120 or Quantum series.

» To display the Traffic Cop panel:
*  Onthe View menu, click TCop List or click TCop in the panel toolbar.

ADD | SUB |WMULT DI¥ [ Tnst | BEei] Symb| TCop You can drag references
10 Card List ]| Drop:01 Rack:1 Slat:04 from I/O points directly into

Ot Switch 100017 & logic.
st Bwikch $PENC 10002

ind 1 10003
Belt 2: Low Senzar 10004
$PENO 10005
H Station 1 Home Lmt 10005
g Station 1 LoadLme 10007
Roll Form Station 10005

imil 10009
i 10010
10011

Station 2 Home Lt 10012
Station2 LoadLmt 10013
Punch Stn Lowar Lt 10014
walding On Switch 10015
FTASHEC 10016
Initiate Transfer 00001

00002
o 00003

Eiclt 2: High Sensor 00005 ¥

Prev
Close
Tree... |

» To place an address or symbol into logic from the Traffic Cop panel:
1. Inthe Traffic Cop panel, navigate to the I/O card you want:
* Next: Click to go to the next programmed card.
* Prev: Click to go to the previously programmed card.
* Tree: Click to display the I/O card list, then click a card to select it.
Click the symbol/address to insert. Keep the mouse button pressed.

Still holding the mouse button down, drag the symbol/address from
the Traffic Cop panel to its destination in logic.

124 @ Network editor panel descriptions



Chapter 6 Using the Network Editor

Power and Power/State flow toggle (Online only)

This function lets you toggle the Network Editor display between power flow
and a combination of power/state flow:

* Power flow: An instruction only passes power (is selected) if it solves
true and if the instructions to the left of it also pass power.

* State flow: An instruction is selected if it solves true, regardless of
whether instructions “upstream” are passing power. State flow lets
you see the state of each contact or coil immediately, without having
to use the Data Watch window.

State flow is slightly slower than power flow because it requires NxT to poll
the PLC and determine the state of each instruction.

» To toggle between Power flow and Power/State flow:

¢ On the View menu, click State Flow.

Setting the update rate (online only)

Online allows the update rate (or poll rate) to be specified for data/server
updates. This Update Rate is used by all data gathering functions in NxT (but
not directly in the Data Watch window) such as the traffic cop, terminal block,
and register editors.

Some systems may become sluggish with requests for data happening as fast
as the system can manage. These multiple requests will slow the system
response speed down. By setting the Update Rate lower (scrolling to the left),
you free your system to respond to other tasks.

The Update Rate set in the Network Editor effectively limits the Update Rate
in the Data Watch window. This is because the Data Watch window polls NxT
(not the controller directly) for data. This means that the actual update rate of
the Data Watch Window (despite what it may be set at) can only be as fast as
the Update Rate set in NXT (which is providing the data). Typically, users

should maintain a higher Update Rate in NxT than in the Data Watch window.

Realistically, the fastest update rates will approach 55 ms. This is because of
overhead from concurrent processes (for example, the operating system).
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» To set the update rate:

1. From the Network Editor, on the Edit menu, click Update Rate. The
Screen Update Rate dialog box appears.

Screen Update Rate E

Selecting a fast screen update rate may slow
down system performance; causing sluggish
response by the system. If your system is

periencing sluggish behavior, slow down
the screen update rate.

Slow Fast
e RN
1] 4 | Cancel | Help |

* Change the rate in the scroll bar by moving the scroll box. You can
move the scroll box by clicking and dragging it with the mouse,
clicking in the scroll bar, or by pressing — or —. To slow
down the update rate, move the scroll thumb to the left. To speed
up the update rate, move the scroll slider to the right.

2. Click OK.
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Editing instructions in logic

Editing modes in the ProWwORX NXxT online editor

There are three editing modes in NxT Online:

Program Mode: Allows you to edit the controller’s logic and
configuration in real time.

Monitor Mode: Shows a view-only display of the controller’s logic
and configuration.

Offline Edit Mode: Lets you perform minor edits on one network
without updating the controller in real time. You can only edit logic in
Offline Edit Mode if NxT is also in Program Mode.

» To toggle between Program Mode and Monitor Mode:

From the Network Editor, on the Edit menu, click Program Mode or

click the Program/Monitor area - EMlc_lﬁ in the status bar.

About Offline Edit mode

Offline Edit Mode lets you make changes (e.g., entering instructions with
undefined addresses or duplicate coils) to network logic in the Online Editor
without updating the controller in real-time. This gives you some breathing
room when performing small edits without having to go offline.

» To switch to Offline Edit mode:

From the Network Editor, on the Edit menu, click Offline Edit Mode.

While you are in Offline Edit Mode, the network appears in bright
blue, with no power flow or state flow shown. The status bar will
display “Offline Edit Mode” in bright blue. As long as you are in the
Offline Edit Mode, changes made to the network won’t be sent to the
controller. Instead, they will be kept in a temporary buffer until you
exit the Offline Edit Mode or change networks.
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» To edit logic in Offline Edit mode:

*  Use the same editing conventions and procedures as the NxT Offline
editor does.

Remember, however, that you cannot edit more than one network
without either cancelling the edit or writing the edit to the controller.

The Program Mode/Monitor Mode rules still apply to Offline Edit
Mode. (You cannot edit logic in Offline Edit Mode unless NxT is also
in Program Mode.)

> To exit Offline Edit mode:
1. Do any of the following:

¢ From the Network Editor, on the Edit menu, click Offline Edit
Mode.

¢ Exit the Network Editor.

* Access another section of ProWORX NxT (for example, the Traffic
Cop).

2. NxT then prompts you about writing your changes to the controller:

* If you click Yes, NxT will check the new network for undefined
addresses and duplicate coils. If none are found, NxT deletes the
original network in the controller, and sends the new network
(created in Offline Mode) to the controller.

* If you click No, NxT returns to Program Mode.
 If you click Cancel, NxT returns to Offline Edit Mode.

Entering instructions

You can enter instructions into your network logic using the Instruction Bar,
Instruction List, and Assembly Register (AR).

» To enter instructions using the Instruction toolbar:
1. Select the cell where you want the instruction to be entered.

2. Click the instruction in the Instruction toolbar.

@ If the instruction is not on the toolbar, you have the option of adding it.
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» To place an instruction in the Instruction bar:

* Drag the instruction from the Instruction List to the instruction bar.

» To enter instructions using the Instruction list:

* Drag the instruction to insert from the Instruction List to its
destination cell in the network.

» To enter instructions using the assembly register:
1. Click the Assembly Register. The cursor appears in the AR field.
2. Type the instruction mnemonic.

3. Select the cell in logic (by clicking it) where you want to place the
instruction, then press ENTER.

» To enter addresses using the assembly register:
1. Click the Assembly Register. The cursor appears in the AR field.
2. Type the address into the AR.

If the Back Referencing panel is currently displayed, you can enter the
address by clicking numbers in the numeric keypad at the bottom of
the panel.

3. Press CTRL+ENTER or drag the instruction from the AR field title to its
destination cell in the network.

Undoing changes to a network (offline only)

When you make changes to a network, always keep in mind that you can only
undo the last change you made. Also, you can only Undo an action while you
remain in the same network. If you move to another network, the Undo
command is not available.

» To Undo an action:

¢ On the Edit menu, click Undo or click @ in the toolbar.

If you use the Undo command to cancel an action, selecting Redo on the Edit
menu performs the action again, cancelling the Undo command.
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About address entry in NxT

NxT formats most register addresses automatically. For example, if you type 4
then 7 in a blank address field, a colon delimiter is added between the type and
value as well as padding the value with zeroes. The colon is used to select the
destructive wrap mode in operation: if after the 7 a 1 is typed, the address field
will contain 4:0071. Any additional digits will wrap the value.

In wrap mode, when the backspace key is pressed, the last character entered is
removed from the right end of the value and a zero is inserted as the first digit
in the value. For example, 4:0071 results in 4:0007.

When pressing the HOME, END, —, or — keys the colon is removed. For
example, 4:0007 results in 40007.

» To edit an instruction in your logic:
1. Do one of the following;:

¢ (lick the instruction to edit, then on the Edit menu, click Edit
Instruction.

¢ Double-click the instruction to edit.

* If you have the Display Editor for New Instructions option
selected in the system Preferences, simply add the new instruction
to the network.

The Instruction Edit dialog box appears, containing;:

Instruction Edit

Top
Middle Cancel

Function

Bottom
Used. .

Yalid Address Types: Doc Editor...

00001-004597 Summary...
10001-10049
30001-30099
40001-41800
Inst. Help

[X Display for new instiuctions Help

e

* An entry field for each instruction node. The number of nodes you
can edit depends upon the instruction. Click Inst. Help for details
on a particular instruction.
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* Valid Address Types for the selected entry field.
* The function name.
Click the box of the node to edit.

For each node, type the address, symbol (if the Use Symbols option is
selected in the system Preferences), or value.

* If the value begins with a pound sign (#), NxT assumes you are
entering a value rather than an address.

* If you type a non-numeric character or a value outside of 0 - 9 in an
address field, NxT assumes you are entering a symbol, and allows
up to 32 characters in the field.

* Click Doc Editor to open the Documentation Editor to edit the
instruction’s documentation.

* NxT also provides a table showing which addresses and coils are
used. To display the table, click Used. You can double-click an
address in the table to type it in the selected instruction node.

If the Address Used table does not appear, then it hasn’t been built yet. From the
@ Display menu, click Used Table .

o,

< For more information on the Address Used Table, see page 158.

* To edit or display documentation for this instruction, click
Summary.

4. Click OK.

» To edit a multiple subfunction instruction:

1. Follow steps 1-3 for editing an instruction.

2. For the bottom node for EMTH, MATH and DMTH, click the arrow to
the right of the entry field. A list of all valid subfunctions appears.

The PCFL instruction has its subfunctions on the top node of the
instruction.

3. Select a subfunction, then click OK.
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Moving instructions

You can move an instruction from one area in the network to another area by
holding the ALT key down and dragging the instruction to its new destination.
When you select the instruction while pressing ALT, your cursor changes to
the instruction’s icon. While pressing ALT, move the cursor to the cell in logic
where you want to place the instruction, then release the mouse button.

You can also cut, copy, and paste an instruction (or a block of instructions) by
selecting it and clicking the Cut, Copy, or Paste command from the Edit menu

(or clicking , , or in the toolbar).

Deleting instructions

To delete an instruction or block of cells from logic, simply select it and press
the DELETE key.

Configuring mnemonics for instructions

In NxT, all instruction mnemonics are configurable, so you can use mnemonics
you are already familiar with.

» To edit a mnemonic:

1. From the Network Editor, on the File menu, click Utilities then click
Mnemonics. The Configurable Mnemonics window appears.

When you select a mnemonic, a short description of the instruction
appears at the bottom of the window.

No_ Function Mnemonic

o1 1r WO .

02 -IM- NC

03 -IP[- PTC

04 -IN[- NTC

05 IOPEN YTOD

06 ISHRT ¥T15

07 -SHRT HSH

08 1) CHR

09 -[L)- CR

10 SKP SKP

11 UCTR ucT

12 DCTR DCT

13 T1.0 T1

14 T0.1 T0

15 T.01 T. -
Normally open contact

(114 | Cancel Edit | Help |
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Select the mnemonic to edit and click Edit or double-click the
mnemonic to edit.

Type in the new mnemonic.
Click outside of the field or press ENTER.

If you try to type an existing mnemonic, NxT displays a warning and
will not continue the edit.

Click OK.
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Using the Segment Scheduler

The Segment Scheduler governs when each segment of logic is solved and
controls which I/O drops are updated after each segment is solved. The
number of segments in the database is set in the General tab of the Controller
Configuration window.

By default, the segments are solved in numerical order (segment one first,
segment two next, and so on). The drop input/output numbers correspond to
the segment number.

» To edit a row in the table:

1. From the Network Editor, on the Display menu, click Segments. The
Segment Summary dialog box appears.

2. Click Scheduler. The Segment Scheduler window appears. The table
shows the numeric order of solve (for example, whichever segment is
in row 1 of the table is solved first, row 2 is solved second, etc.).

3. Do one of the following:
* Click the row to edit then click Edit.
* Double-click the row to edit. The Edit Entry window appears.

MXT_DEMO Segment Summary
Seg) t N ks Words D Seg t N ks Words D
m LD S egment Scheduler
02
Table Control In Segment Drop In Drop Out
01 Continuous (111 (111 (111
02 Contir Edit Entry -
Control Input Continuous j
Drop Input
Diop Dutput
Goto | J
[11.4 | Cancel | Help |

0K | Cancel

Edit... I Insert | Delete

Help |

4. Select the Control Input:
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* Continuous: Sets the segment in this row to be solved every scan.

* Set Control: Sets the segment to be solved only when a discrete
address is in a specific state. If you select Set Control, you must also:

*Type the discrete address in the Address field, which controls
whether the segment in this row is to be solved.

*Select whether the segment in this row is to be solved when the
control discrete is On or Off.

* Watchdog Timer Reset: Inserts a Watchdog Timer.

5. In Segment, type the segment to be solved in this row. The valid range
is 1 to the number of segments configured.

6. InDrop Input, type the input drop associated with the segment in this
row during the solve.

7. In Drop Output, type the output drop associated with the segment in
this row during the solve. Depending on what controller you are
using, drops or channels may be used. The valid range for drops/
channels is 1 to the number of configured drops/segments.

8. Click OK.
Click OK.

> To add a row to the table:
1. Select the row ahead of where you want the new row to be inserted.

2. Click Insert. NxT adds a row, with a Watchdog Timer Reset as the
default control. You can then edit the row as required.

> To delete a row from the table:
1. Click the row to delete.
2. Click Delete. NXT prompts you to confirm the deletion.

3. Click Yes to confirm the deletion. The rows following the deleted row
are shifted up.
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Moving networks in segments

» To move networks across segment boundaries:

1. From the Segment Summary window, select the segment containing
the network you want to move.

Click Move. The Move Networks in Segment window appears.
Type the number of the networks to move.

Do one of the following:

* Forward: Click to move the network to the next segment.

* Backward: Click to move the network to the previous segment.
5. Click OK.
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Editing register contents

The Register Editor lets you edit register contents in a table format. You can
enter data for the register as binary, hexadecimal, ASCII, IEEE floating point,
or 5-digit decimal.

Some instructions have special data representations. For example, EMTH
shows the equation and results in floating point form, and a maximum of 10
variables per equation are allowed. The IEEE floating point number (used with
instructions supporting 32-bit floating point registers) is represented by two
consecutive input or holding registers.

So, in the IEEE Floating Point column the value displayed for register 40005 is
the floating point representation of the 32-bit number stored in registers 40005
and 40006; the value displayed for register 40006 is the value stored in 40006
and 40007, and so on. This is why editing a floating point number in one
register also affects the display for the next register as well.

There are three types of register editors:
* User Configurable Register editor
* Extended Memory Register editor

*  Generic Register editor

User Configurable Register editor

The User Configurable Register editor is used to edit instruction-specific data
that you format in a .UREF file. There is a .UREF file for each instruction, which
contains all the text and formatting information needed to display the register
edit screen and the desired register values. The .UREF file also contains the
register where the operation mode is stored.

» To edit a register value using the edit window:

1. From the Network Editor, select the instruction to edit.

2. On the Data menu, click Register Editor, or click @ The Register
Editor window appears, with an instruction-specific template.
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BLKM REGISTER EDITOR [<]
Description ‘ Address/Symbol | Data -
\Sowce 0001 ...} 40033 00050 Dec
Source 0002 40034 00200 Dec
Source 0003 40035 00090 Dec
Source 0004 40036 00034 Dec
Source 0005 40037 00078 Dec ~|
Description ‘ Address/Symbol | Data -
Destination 0001 40100 00050 Dec
Destination 0002 40101 00200 Dec
Destination 0003 40102 00092 Dec
Destination 0004 40103 00034 Dec
D estination 0005 40104 00078 Dec ~|
Degtination ¥alues
250
20
150
100
]
)
1 23 4 35 6 7 & 6 1011 1212 141516 1718 186 0 21 22
40033 Start of 22 Timer Registers
Close | Edit.__ | Doc... | Operation:.- BRadix. .. | Help |

3. Do one of the following:

* Select the row (either the Description, Address/Symbol, or Data

field) of the register to edit and click Edit.

* Double-click the row (either the Description, Address/Symbol, or

Data field) of the register to edit.

An edit window appears, specific to the radix of the your selection (the
radix of each register is displayed in the table’s Data field).

4. InRegister Value, type the value to be placed into the register (using

the appropriate radix).

If you are typing a binary value, you cannot type in the new value
directly. Instead, set the state of individual bits by selecting it and
clicking either Set (1) or Reset (0). You can also click Set All to set all

bits to 1, or Reset All to set all bits to 0.
5. Click OK.
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» To edit a register value using the Assembly Register:

1. From the Network Editor, on the Data menu, click Register Editor.
The Register Editor window appears.

2. Click in the AR box.

3. Type the new register value.

(described above). If you try to enter an AR value into the binary field, it will be

:g You can't use the AR to enter values in binary. Instead, use the edit window
treated as a decimal value.

4. Do one of the following:

* Select the data field in the register where the value is to be placed,
then press CTRL+ENTER.

* Click the AR field title (beside the entry field), and hold the mouse
button down. Still holding the mouse button down, drag the cursor
to the appropriate radix of the destination register, then release the
mouse button.

5. Click OK.

» To edit documentation for registers:

1. From the Network Editor, on the Data menu, click Register Editor.
The Register Editor window appears.

Select the register for the documentation you want to edit.

Click Doc. The Documentation Editor window appears. Type your
documentation.

» To edit the operation for a register:
1. From the Register Editor window, click Operation.
2. Select an operation.
3. Click OK.
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» To change the radix of a register value:

1. From the Register Editor window, select the register you want to
change the radix for.

Click Radix.
Select the new radix.

Click OK. The value in the data field is automatically displayed in the
new radix.

» To display a single bit for a register value:

1. From the Register Editor window, select the register you want to
change the radix for.

Click Single Bit.

3. Type the bit number (between 1 and 16) you want to display, then
click OK. The value in the data field is automatically displayed in the
new radix.

» To print a screen of register contents:

*  From the Register Editor window, click Print. The addresses, symbols
and data currently displayed on the screen are sent to the default
printer.

Printer settings can be changed with the Printer Setup dialog box in
the Lister window (see page 263), they cannot be changed from inside
the Register Editor dialog box.

Creating a .URF file for an instruction

There is a .UREF file for each instruction, which contains all the text and
formatting information needed to display the register edit screen and the
desired register values.The .UREF file also contains the register where the
operation mode is stored. These .UREF files must be stored in the same
directory as the NxT application.
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» To create a template:
1.

Launch a text editor application and create a text file. The text file
usually has the instruction name for a file name, and must have a .URF

extension.

Type the text and formatting information for the instruction according
to the following template:

Text

Description

BASE VALUE

Location of the register to display. Set to T, M, or B,
representing Top, Middle, and Bottom nodes
respectively.

BIT TO MODIFY

If the data type is set to T (bit) then this value
determines which bit you want to display. This
may be from 1 to 16, with 1 being the Most
Significant Bit, 16 being the Least Significant Bit.
Set to 0 if not a bit data type.

COLUMN

Column number on screen to place the register. Use
a number between 1 and 78. If the total length of
the displayed register data exceeds the available
column space, the starting point of the column is
moved to the left so the entire column fits on the
line.

DATA TYPE

Sets the radix of the data type. Use the following
characters to represent the following data types:
Floating Point

ASCII

Signed Integer

Hexadecimal

Binary

32-bit (Long) Integer

Integer

Bit

H=C® T O

ERRORFIELD

Gives you the ability to report any errors on the
instruction. Errorfield has the same format as the
Windowtable.

User Configurable Register editor ® 141



ProWORX NXT User's Guide

Text

Description

FUNCTION "XXX"

Begin the template with this line. Within the
quotations, insert the name of the instruction for
which the template is intended. Save the template
by this name with a .URF extension.

GRAPHFIELD

Allows you to graph data. A Graphfield line has
the following format:

GRAPHFIELD, R,C, T,H, B,O, M, P

where:
R = Row
C = Column
T = Typeof graph
1 - 2 dimensional pie graph
2 - 3 dimensional pie graph
3 - 2D bar graph
4 - 3D bar graph
H = Graphheight
B = Maximum number of entries in the
window, the B represents the bottom node
O = Offset
M = Number of points on the graph
P = Offset

HEIGHT #

This refers to the height of the register function
block. A height of one refers to a single node
instruction (for example, SKP). A height of three
refers to a three node instruction (for example,
ADD).

NUMLINES #

#,"XXX" The first digit stands for the line number of
the location of the text on the screen. For example:
Using the number 8 places the line of text on the
eighth row of the screen. Put text within the
quotation marks. To place the text in columns,
insert spaces between the first quotation mark and
the first character. A maximum of 18 text lines may
exist, each up to 78 characters long.

NUMPAGES #

Sets the number of pages for the function or
subfunction. NUMPAGES must always have a
value of at least one and has no maximum.
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Text

Description

NUMREGS #

You must define the number of registers you are
placing on the page. You may place from 0 to 50
registers. Each register is defined as follows:
ROW, COLUMN, BASE VALUE, OFFSET,
DATA TYPE, BIT TO MODIFY, SYMBOL FLAG

NODE XXX

Use this line if the function contains subfunctions.
This sets where the subfunction number is defined
in the Network Editor. The three possible settings
are TOP, MIDDLE, BOTTOM. For example, NODE
would be set to BOTTOM for the EMTH function.

OFFSET

Offset of base value for displaying implied
registers.

OFFSET #

Use this line if the function contains subfunctions.
If the subfunction is defined by the contents of an
implied register, the offset is set to the register's
implied address. For example, if the bottom node
has 40001 entered, but the actual subfunction is in
the implied register 40003, then the OFFSET would
be set to 3.

OPERATION-
FIELD

Allow you to change the mode of operation within
the Register Editor. Operationfield is formatted the
same as Errorfield and Windowtable.

PAGE #

This defines the beginning of a new editor page.
The number corresponds to the page number.
There must be an equal number of page number
lines as defined in the NUMPAGES line and they
must appear in sequential order. An END PAGE
must mark the end of each page.

PAGETITLE "XXX"

You may give each page a unique title. If you wish
to leave the title blank, put nothing between the
quotes.

REGISTERINFO

Marks the beginning of register definitions for the
page. An END marks the end of the
REGISTERINFO definitions.
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Text

Description

ROW

Row number on screen to place the register. Use a
number between 1 and 18.

SCREENINFO

Marks the beginning of user defined screen text. An
END must mark the end of SCREENINFO text
lines.

SUB #

Use this line if the function contains subfunctions.
This defines the beginning of a set of editor pages
for a new subfunction. The number corresponds to
the subfunction number. There must be an equal
number of SUB # lines as defined by the
SUBFUNCS line and they must appear in
sequential order. An END SUB must mark the end
of this set of pages.

SUBFUNCS #

Certain functions, such as EMTH, may be
configured to perform a variety of tasks or
subfunctions. This setting refers to the total number
of subfunctions this function can perform. For
example, EMTH may perform any one of 38
different subfunctions. Therefore, SUBFUNCS is
always set to 38 for an EMTH user configured
template. If the function has no subfunctions (e.g.,.
ADD), set SUBFUNCS to 0.

SYMBOL FLAG

Defines whether or not to display an address or a
symbol. Set to Y to display a symbol, or N to
display an address. If no symbol is available, the
address is used.
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Text

Description

WINDOWTABLE

Creates a scrollable window enabling you to list
registers. Use this function if you have a data list
that cannot be contained on one screen. Allows you
to define the row, column, the nodes setting top,
middle or bottom, the offset, labels you can re-use
and labels you want to use. Format your line in the
template like:

WINDOWTABLEL1 R,C, M,0,B,ES,L,V,

where:

R = Row

C = Column

T = From which register to start. You can use
T = top node (most common), M = middle
node, B = bottom node.

O = Offset to node. Use zero to include only
one window table.

Z = Maximum number of entries in the
window table.

N = The number of registers in the window
table.

S = The number of registers to be displayed.
One or more than “N” to a maximum of
17. When 17 registers are used, a scroll bar
appears. You can display a scroll bar for
less than 17 registers by entering a
number that is less than or equal to “N”.

L = Indicates if you are going to reuse label.

V = The number of levels to follow are

indicated when not reusing the label. A
maximum of 50 can be used.

For example: WINDOWTABLE1
2,19,1,0,Z,10,11,0,10,
Source, 1 = This line defines the label.
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.URF template example

FUNCTION "function name"
HEIGHT 3
SUBFUNCS 0
NUMPAGES 2
PAGE 1

PAGETITLE "function name page 1 of 2"
SCREENINFO
NUMLINES 0
END

REGISTERINFO
NUMREGS 0
WINDOWTABLEL1 2,19,T,0,2,9,10,0,9

Description of 1stregister in decimal,
numbers are the default radix."

Description of 2nd register in hexadecimal,
Description of 3rd register in binary,
Description of 4th register in ascii,
Description of 5th register in floating point,
Description of 6th register in 32 bit integer,
Description of 7th register in signed integer,
Description of 8th register in single bit,

, 0 "blank description, no radix"

WINDOWTABLE?2 11,19,M,0,B,0,8,1,1
Source,1

OPERATIONFIELD,1,19,T,0,3
00001 Write Registers
00002 Read Registers
00003 Get Local Statistics
ERRORFIELD,18,19,T,1,2
04097 User initiated abort
08193 Invalid operation type
END
END PAGE
PAGE 2
PAGETITLE "Demo Page 2 of 4"

1 "the bolded

2
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SCREENINFO
NUMLINES 0
END

REGISTERINFO

NUMREGS 0

WINDOWTABLEL1 2,19,T,0,2,4,5,0,4
MSTR Operation Code,1

Error Status,2

# of Registers Transferred,1

Func Dependant Info,1
WINDOWTABLE?2 11,19,M,0,B,0,5,1,1
Source,1

OPERATIONFIELD,1,19,T,0,2
00001 Write Registers
00002 Read Registers

ERRORFIELD,18,19,T,1,3
04097 User initiated abort
08193 Invalid operation type
08194 User parameter changed

END
END PAGE
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Extended Memory Register editor

The extended memory register editor lets you modify the contents of the 6xxxx
registers directly. Some 984 controllers contain up to 96K of optional extended
memory that can be used. These registers are accessible from the logic with the
READ (XMRD) and WRITE (XMWT) blocks.

The extended memory area is divided into a maximum of 10 files each
containing up to 10,000 registers. You can enter data in 5-digit decimal,
hexadecimal, binary or ASCII radices.

» To edit a register value using the edit window:

1.
2.

From the Network Editor, select the instruction to edit.

On the Data menu, click Extended Memory. The Extended Memory
Register Editor dialog box appears.

% Extended Memory Register Editor
File Register
Extended Memory File: AR:I:'
Register | Binary |Dec | Hex ‘ ASCH
&01.0000 00000000-00000000:00000, 0000 .- B
501.0001 00000000-00000000 00000 | 0000
£01.0002 00000000-00000000 00000 0000
£01.0003 00000000-00000000 00000 0000
501.0004 00000000-00000000 00000 | 0000
£01.0005 00000000-00000000 00000 0000
£01.0006 00000000-00000000 00000 0000
501.0007 00000000-00000000 00000 | 0000
£01.0008 00000000-00000000 00000 0000
£01.0003 00000000-00000000 00000 0000
501.0010 00000000-00000000 00000 | 0000
£01.0011 00000000-00000000 00000 0000
£01.0012 00000000-00000000 00000 0000
501.0013 00000000-00000000 00000 | 0000
£01.0014 00000000-00000000 00000 0000 -
£01.0015 00000000-00000000 00000 0000 i -
601.0000
Close | Edit__. | Doc.. | Help |

In the Extended Memory File field, select the memory file containing
the registers you want to edit.

Select the radix value of the register to edit and click Edit or double-
click the radix of the register to edit. The Edit window appears for the
radix selected.

In Register Value, type the value to be placed into the register (using
the appropriate radix), then click OK.

If you are typing a binary value, you cannot type in the new value
directly. Instead, set the state of individual bits by selecting one and
clicking either Set (1), or Reset (0). You can also click Select All to set
all bits to 1, or Reset All to set all bits to 0.
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» To edit a register value using the Assembly Register:

1. From the Network Editor, on the Data menu, click Extended Memory.
The Extended Memory Register Editor dialog box appears.

2. Click in the AR field.

3. Type the new register value.

(described above). If you try to type an AR value into the binary field, it will be

:g You can't use the AR to type values in binary. Instead, use the edit window
treated as a decimal value.

4. Do one of the following:

* Select the radix field in the register where the value is to be placed,
then press CTRL+ENTER.

* Click the AR label (beside the entry box), and drag the cursor to the
appropriate radix of the destination register.

Be careful to drop the value in the correct radix field. For example,
don’t type a decimal value in the AR, then drag it to the hexadecimal
field. Doing so will enter the value as hex, not decimal.

» To edit documentation for extended memory registers:

1. From the Network Editor, on the Data menu, click Extended Memory.
The Extended Memory Register Editor window appears.

Select the register for the documentation you want to edit.
Click Doc. The Documentation Editor dialog box appears.
Type your documentation.

Click OK.

AR N

» To display a specific register:

1. From the Extended Memory Register dialog box, on the Register
menu, click Goto. The Goto Register window appears.

2. Type the register (0000-9999) you wish to display.
3. Click OK. NxT displays the register in the middle row of the window.
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» To search for a register value:

1. From the Extended Memory Register Editor dialog box, click Register
then click Search. The Search for Data dialog box appears.

Type the five digit decimal value to search for.

3. Click OK. NxT searches down from the currently selected register for
the data value.

4. To search for the next occurrence of the value, press F3.

Extended Memory utilities

The Extended Memory utilities let you move or copy register contents. You
can also fill a block of registers with a data value.

The difference between a move and a copy is that NxT clears the source
registers after a move, but does not clear the source registers after a copy.

You can cancel the move, copy, or fill operation while it is in progress by
clicking Cancel; however, the register contents that were moved before you
cancelled the operation are not reset. They remain moved. You will have to go
to the destination block and move the contents back to their original locations.
Cancelling the move, fill, or copy operation while in progress is not
recommended.

» To move the contents of one block of registers to another block:

1. From the Network Editor, on the Data menu, click Extended Memory.
The Extended Memory Register Editor dialog box appears.

2. From the Extended Memory Register Editor window, on the File
menu, click Utilities. The Extended Memory Utilities dialog box

appears.
Extended Memory Utilities [ %]
@®iCopy! Source Stait:  |0000
O Move Source End: 0000
OFi Source File:
Destination Stait: 0000
Destination End: oooo
Destination File:
Start | Cancel | Help |

3. Click Move.
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In the following boxes:
* Source Start: Type the first register of the block to be moved.
* Source End: Type the last register of the block to be moved.

* Source File: Type the number of the file containing the source
registers.

* Destination Start: Type the first register of the destination block.
* Destination End: Type the last register of the destination block.

* Destination File: Type the number of the file containing the
destination registers.

Click Start.

When finished, click Cancel to close the window.

» To copy the contents of one block of registers to another block:

1.

From the Network Editor, on the Data menu, click Extended Memory.
The Extended Memory Register Editor window appears.

From the Extended Memory Register Editor dialog box, click File then
click Utilities. The Extended Memory Utilities dialog box appears.

Select Copy.

Enter the following fields:

* Source Start: Type the first register of the block to be copied.
* Source End: Type the last register of the block to be copied.

* Source File: Type the number of the file containing the source
registers.

* Destination Start: Type the first register of the destination block.
* Destination End: Type the last register of the destination block.

* Destination File: Type the number of the file containing the
destination registers.

Click Start.
When finished, click Cancel to close the dialog box.
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» Tofill aregister:

1. From the Network Editor, on the Data menu, click Extended Memory.
The Extended Memory Register Editor dialog box appears.

2. From the Extended Memory Register Editor dialog box, click File then
click Utilities. The Extended Memory Utilities dialog box appears.

3. Select Fill.
In the following boxes:
* Range Start: Type the first register in the block to be filled.
* Range End: Type the last register in the block to be filled.
* File Range Start: Type the first file of the block to be filled.
* File Range End: Type the last file of the block to be filled.

* Fill Value: Type the value to place in the contents of each register
in the block.

Click Start.
When finished, click Cancel to close the dialog box.

Generic Register editor
The Register Editor is used to edit register contents in a table format.

Data may be typed in binary, 5 digit decimal, hexadecimal, ASCII or IEEE
floating point. The data contained in the registers is displayed in all
appropriate formats.

S

5 You can edit binaries easily by just double-clicking on the bit to change it or click
k on it and enter a new value.
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» To edit a register value using the edit window:

1.

From the Network Editor, on the Data menu, click Register Editor, or

click @ in the toolbar. The Register Editor dialog box appears.

% Register Editor
File  Begister
() 3uxxx @ dxxxx [ Floating Point AH:I:'

Reqister Binary |Dec ‘ Hex ‘ ASCI
40001 00000 io0o0 - =
4000z 00000000-00000000 | 00000 o000

40002 00000000-00000000 | 00000 ooog

40004 00000000-00000000 | 00000 anog

0005 0OO00000-00000000 | 00000 anog

40008 00000000-00000000 | 00000 aoog

40007 0O000000-00000000 | 00000 ooog

40005 0OO00000-00000000 | 00000 anog

40003 00000000-00000000 | 00000 o000

40010 00000000-00000000 | 00000 ooog

40011 00000000-00000000 | 00000 anog

001z 0OO00000-00000000 | 00000 anog

4001z 00000000-00000000 | 00000 aoog

40014 0O000000-00000000 | 00000 ooog

40015 0OO00000-00000000 | 00000 anog

40016 00000000-00000000 | 00000 0000 - -

40001
Close | Edit___ | Doc.___ | Print ‘ Help |

Select which register type (3xxxx, 4xxxx) to display.

Select or clear the floating point check box to display or not display
floating point values.

Select the radix of the register to edit and click Edit or double-click the
radix of the register to edit. The Edit window appears for the radix
selected.

In Register Value, type the value to be placed into the register (using
the appropriate radix).

If you are typing a binary value, you cannot type in the new value
directly. Instead, set the state of individual bits by selecting it and
clicking either Set (1), or Reset (0). You can also click Set All to set all
bits to 1, or Reset All to set all bits to 0.

Click OK.
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» To edit a register value using the Assembly Register:

1.

From the Network Editor, on the Data menu, click Register Editor.
The Register Editor window appears.

Select which register type (3xxxx, 4xxxx) to display by clicking the
corresponding radio button.

Select or clear the floating point check box to display or not display
floating point values.

Click the AR box.

Type the new register value.

(described above). If you try to type an AR value into the binary field, it will be

:g You cannot use the AR to type values in binary. Instead, use the edit window

treated as a decimal value.

Do one of the following;:

* Select the radix field in the register where the value is to be placed,
then press CTRL+ENTER.

* Click the AR label (beside the entry box) and drag the cursor to the
appropriate radix of the destination register.

Be careful to drop the value in the correct radix field. For example,
don’t type a decimal value in the AR, then drag it to the hexadecimal
field. Doing so will enter the value as hex, not decimal.

» To edit documentation for registers:

1.

AR N

From the Network Editor, on the Data menu, click Register Editor.
The Register Editor dialog box appears.

Select which register type (3xxxx, 4xxxx) to display.
Select the register for the documentation you want to edit.
Click Doc. The Documentation Editor dialog box appears.

Type your documentation.
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To display a specific register:

1.

From the Register Editor dialog box, click Register then click Goto.
The Goto Register window appears.

Type the register (0001-maximum) you want to display.
Click OK. NxT displays the register.

To search for a register value:

1.

From the Register Editor dialog box, click Register then click Search.
The Search for Data window appears.

Type the five-digit decimal value to search for.

Click OK. NxT searches down from the currently selected register for
the data value.

To search for the next occurrence of the value, press F3.

To print a screen of register contents:

From the Register Editor dialog box, click Print. The addresses,
symbols and data currently displayed on the screen are sent to the
default printer. Printer settings can be changed with the Printer Setup
dialog box in the Lister dialog box, they cannot be changed from
inside the Register Editor dialog box.

For more information on printing, see “Printing selected data (Lister)”
on page 263.
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Register Contents utilities

The Register Contents Utilities let you move or copy register contents within a
file or between files. You can also fill a block of registers with a data value.

» To move the contents of one block of registers to another block:

1. From the Network Editor, on the Data menu, click Register Editor.
The Register Editor window appears.

2. From the Register Editor dialog box, on the File menu, click Utilities.
The Register Contents Utilities dialog box appears.

Register Contents Utilities E

Source Start: 40001
Source End: 40001
Destination: 40001

Start | Cancel | Help

3. Click Move.
In the following boxes:
* Source Start: Type the first register of the block to be moved.
* Source End: Type the last register of the block to be moved.
* Destination: Type the first register of the destination block.
Click Start.
When finished, click Cancel to close the dialog box.
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» To copy the contents of one block of registers to another block:

1.

From the Network Editor, on the Data menu, click Register Editor.
The Register Editor dialog box appears.

From the Register Editor dialog box, click File then click Utilities. The
Register Contents Utilities dialog box appears.

Select Copy.

In the following boxes:

* Source Start: Type the first register of the block to be copied.
* Source End: Type the last register of the block to be copied.

* Destination: Type the first register of the destination block.
Click Start.

When finished, click Cancel to close the window.

To fill a register:
1.

From the Network Editor, on the Data menu, click Register Editor (or
Extended Memory). The Register Editor dialog box appears.

From the Register Editor window, click File then click Utilities. The
Register Contents Utilities dialog box appears.

Select Fill.

In the following boxes:

* Range Start: Type the first register in the block to be filled.
* Range End: Type the last register in the block to be filled.

* Fill Value: Type the value to place in the contents of each register
in the block.

Click Start.
When finished, click Cancel to close the dialog box.
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Other Network Editor functions

Checking for used addresses

The Address Used table lists currently-used register and discrete addresses
and is updated continuously. Use the Address Used table to type an address
into the assembly register (AR) or directly into an instruction.

When Display Traffic Cop Used is cleared, addresses are marked only as
unused addresses (. ), used addresses (X), or used coils (u). When Display
Traffic Cop Used is selected, the table displays information on used or unused
addresses in the Traffic Cop. Below are the marks for each address:

Mark

Meaning

X

Address appears in logic.

u

Addpress appears in logic as an output coil.

Address does not appear in logic.

Address appears in the traffic cop and in logic.

Address appears in the traffic cop and in logic as an output coil.

Address appears in the traffic cop (but not in logic).

When Display Peer Cop Used is selected, you can check for the currently-used
and discrete addresses in the Peer Cop. Below are the marks for each address.

Mark

Meaning

Address appears only in the Peer Cop.

Address appears in the Peer Cop, in logic, and as an output coil.

Address appears in the Peer Cop and in logic.

Address appears in three or more different locations.

| Z| 0| O|©

Address appears in the Traffic Cop and in Logic.
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» To type an address into the assembly register:

1.

From the Network Editor, on the Display menu, click Used Table.
The Address Used table appears.

Addiess Used

‘ [ Display Traffic Cop Used

At [ Display Peer Cop Used

‘ Bunnx ‘

[T

s

[Tz [T T

00080
80650 |u . |u

80180 |u ulu/uu/u/uuulu
00150

80280 |u ulu/uulu/uuulu
80250 |uulu
80380 |u ulu/. u/u/uuulu

88358 |. . ujuuujuuuu

BE488 |. . . |uuujuuuu
ge458 |. . .. L)L

T NNNRRRRRRENNNNAREE TR
BECEGHEECNNEEEEEL DN NEEBEEROE AN EEREGREED
.

wul L EEENTARREN S]]

Luuuue wuue g EEEARNRRN

#=Used u=Coil used .=Unused

D .
00001 Initiate Transfer

Close | Find Free_.. ‘

Help

Select the address type (Oxxxx, 1xxxx, 3xxxx, 4xxxx) to display by
clicking its corresponding tab.

Double-click the address you want to use. You're returned to the
Network Editor. The address you selected in the table is placed in the
AR. You can then use the assembly register to work with the address.

» To enter an address directly into an instruction:

1.

From the Network Editor, do one of the following:

* Select the instruction you want to edit, then on the Edit menu, click
Edit Instruction.

* Double-click the instruction you want to edit. The Edit Instruction
dialog box appears.

Select the instruction node where you want to enter the address by
clicking it.
Click Used. The Address Used Table appears.

Double-click the address you want to add to your instruction. The
address is placed in the node field you selected in the Edit Instruction
dialog box.

If the Address Used Table is not current, a message asks you whether
you want the table rebuilt. Click OK.
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Finding free addresses

» To find a free address:

1. From the Address Used dialog box, click the tab of the address type
(Oxxxx, 1xxxx, 3xxxx, 4xxxx) to search for.

2. Click Find Free. The Find Free Block dialog box appears.

Find Free Block E

Block Size:
Start Search At: (00001

Start | Cancel

Help |

3. Select or type the size of the contiguous block of addresses you want
to find.

4. Type the address you want to start searching from.

NxT allows you to start a search from any address. However, I/O
functions typically require a word boundary, so you will have to
manually adjust the Start Search At value to be on a 16 + 1 boundary.

5. Click Start. NxT marks the free addresses it finds with an asterisk (*).
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Global register replace (offline only)

The Global Replace function lets you move or copy register descriptors and/
or register contents from a source —not necessarily an active —database to the
active database.

» To perform a Global Replace:

1. From the Offline Network Editor, on the Search menu, click Global

Replace or . The Global Replace dialog box appears.

Global Replace

Source Database:

‘ ‘E:\PH OwWORXANXTADEMODB\NXT_DEMO

| Browse. .. |

Source Address Range:

Dest Address Range:

Metwork Range:

Start: [10001

Start: [10001

End: 10001

Descriptors:

Discrete States:

From:

Mode:

|Move j‘ |Move j‘ (® Continuous
Reg Contents: Forced/Disabled:
| N LT
X Automatic Coil Table Rebuild
Start ‘ Cancel | Help |

2. Use the following information to set the parameters.

Source database
Type the path and file name of the database from which you want to move or
copy descriptors and/ or register contents or click Browse to navigate to it.
Source address range
Set the block address range:

* In Start, type the starting address of the block to copy or move.

* In End, type the final address of the block to copy or move.

The following registers can be used as source addresses:

*  Oxxxx, Ixxxx, 3xxxx and 4xxxx registers can be used when copying or
moving addresses.
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o Oxxxx, Ixxxx, 3xxxx, or 4xxxx registers can be used when copying or
moving descriptors.

*  Only 4xxxx registers can be used when copying or moving register
contents.
Dest address range

Type the starting address of the block (in the active database) to be overwritten
by the copy/move operation in Start.

NxT calculates the ending address of the block based upon the size of the block
you specified in the Source Address Range area.
Network range
Set the block network range:
* Type the starting network of the block to be copied/moved in From.
*  Type the final network of the block to be moved in To.

Descriptors
Select whether the descriptor contents are to be moved, copied, or ignored:

* Move: Register contents are transferred into the destination block in
the active database. If this is an internal move (moving only within the
active database) the source contents are deleted.

* Copy: Register contents are transferred into the destination block in
the active database.

* Ignore: Descriptors are not transferred to the active database.

Reg contents

Select whether the register contents are to be moved, copied, or ignored. This
option is unavailable if you have selected a block of discretes.

* Move: Register contents are transferred into the destination block in
the active database. If this is an internal move (moving only within the
active database) the source contents are deleted.

* Copy: Register contents are transferred into the destination block in
the active database.

» Ignore: Register contents are not transferred to the active database.
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Discrete states
Select whether to move, copy, or ignore the discrete states:

e Move: Relocates the state of each discrete source address to the new
destination address.

*  Copy: Duplicates the state of each discrete source address to the new
destination address.

* Ignore: Leaves all discrete states as they are.

Forced disabled

Select whether to move, copy, or ignore discrete forced or disabled state
information:

e Move: Relocates the disabled state of each discrete source address to
the new destination address.

*  Copy: Duplicates the disabled state of each discrete source to the new
destination address.

* Ignore: Leaves all discrete addresses that are forced or disabled as
they are.
Mode
Select a mode of replacement:
* Continuous: Performs all changes without individual confirmation.

* Step: Confirms every change.

Automatic coil table rebuild

*  When selected, the coils are updated in the Address Used Table after
the global replace is complete and a check for duplicate coils is
performed.

*  When cleared, the Address Used Table is not updated and no search
for duplicate coils is performed.
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Symbolic addressing

Symbolic addressing equates a numeric address with text. This lets you use
more meaningful symbols (e.g., push_btn) in place of numerical addresses.

Before working with symbolic addressing, be sure that the Symbols check box
in the Preferences window is selected.

» To display the Symbol Summary panel:

In the Network Editor, on the View menu, click Symbol List or click
Symb in the toolbar.

» To add a symbol to the Symbol Summary panel:

1.

In the Network Editor, double-click the Symbol Summary panel or On
the Display menu, click Documentation Editor. The Documentation
Editor appears.

In the Navigate By area, select Reference, then type the address to be
associated with this symbol.

You can either type the address in manually, or use the arrow keys to
scroll through the address list.

In Symbol, type the new symbol text.

Click OK. The symbol and its associated address are added to the
Symbol summary panel, sorted alphabetically.

» To add a symbol using the Instruction Edit window:

1.

A N

In the Network Editor, double-click an instruction with the address to
which you want to assign a symbol. The Instruction Edit dialog box
appears.

In the address field, type the new symbol text.
Click OK. The Add Symbol dialog box appears.
Type the address to associate with this symbol.

Click Create. The symbol, and its associated address are added to the
Symbol summary panel and sorted alphabetically.

» To place an address or symbol in the network logic:

Drag the address or symbol from the Symbol Summary panel to its
destination in logic.
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Searching logic

You can search networks in a database for a specific address, instruction, or
address/instruction combination. You can also search for disabled addresses
or duplicate coils (Offline only).

» To search for logic elements:

1.

In the Network Editor, on the Search menu, click Find or click in

the toolbar. The Search dialog box appears.

Search

Search Type Search Range Search Mode

®) Address Network From: ® Continuous

) Address/Function To: O Step

C Function

C Disabled

© Duplicate Coils ‘ Address: 100001 11 LI
Search | Results... | Cancel | Help

Select the search type and the value(s) for that type:

Address: Select to search for the address you specify in Address the
address field.

Address / Function: Select to search for the address you specify in
the Address field and function you specify in the Function field.

Function: Select to search for the instruction block you specify in
the Function field.

Disabled: Select to search for disabled contact or coil.

Duplicate Coils: (Offline only) Select to search for coils with
duplicate addresses.

If you are searching for an address, function, or address/function
combination, enter the following:

Search Range: Type the starting network for the search in the From
field and type the ending network for the search in the To field.

Search Mode: Select Continuous to search the entire range of
networks, displaying all matches in the Search Results Table or
select Step to search only for the next match.

Click Search.
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Viewing the search results

The search results table consists of all the search matches found by the search
function. Before the Search Results Table can be displayed, you must first
perform a search.

» To display the search results table:

If you selected Continuous search mode, the Search Results dialog box is
displayed automatically when the search is completed.

1. Perform a search.
2. Click Results. The Search Results Table is displayed.

Address - 10001
Match: 001/008

00011 1- . 00031-][- 00041-][- |00051-1] =
0006.1-][- |0007.1-][- 00081-][- 00091 -]

Goto | Close | Help

Each match from the search is displayed in a cell of the table with the
format NNNN.R YYYY, where:

NNN is the network number;

R is the row within the network; and

YYYY is the function name.

» To go to a search result:

1. From the Search Results Table, select the result to whose location you
want to go.

2. Click Goto. NxT displays the network and segment with the matching
cell selected.

3. To return to the search results table, click Results.
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Retracing searches

The Search panel appears in the top right corner of the Network Editor after
you Goto a location in the Search Results table. The Search panel can be
dragged by the title bar to a different location. Once positioned, the panel will
remain in place until you exit ProWORX NxT.

Match: 0027008

Prev | Hest This panel allows you to
navigate through logic
from search match to
Results Table search match.

Cancel |
Help |

» To view locations of search matches using the search panel:
Do any of the following:
* Prev: Click to move to the logic location of the previous match.
* Next: Click to move the logic to the next search match.

* Mark: Click to add the logic location of the current search match to
the mark table.

* Stay: Click to stay at the current logic location and cancel display of
the search panel.

* Cancel: Click to quit using the search panel. You are returned to the
Network Editor in the logic location you were in before the search.
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Setting bookmarks in logic

You can set bookmarks in your network logic so you can quickly return to a
cell or series of cells.

The Set Mark, Unmark, Goto Marks, and Retrace functions allow quick
viewing of non-consecutive areas of logic. By marking multiple cell locations
on different networks, (up to 42 marks are allowed) you can use the mark table
or the Retrace Mark panel to quickly jump between the marked locations.
Marks may also be set after a search.

> To set a mark:

1. From the Network Editor, select the address or instruction you want
to set the mark for.

2. From the Search menu, click Set Mark.

Going to marks
» To go to a mark:

1. From the Network Editor, on the Search menu, click Goto Mark. The
Goto Mark dialog box appears, showing a list of current marks.

Goto Mark
Network| Row |Column_[Instiuction | Addiess
1 1 1 11- 10001
8 1 1 11- 10001
17 1 1 BLKM 40092
Goto | Cancel | Help |

2. Click a mark to go to, then click Goto or double-click the mark.
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Retracing marks

You can use the Retrace Mark panel to quickly jump from mark to mark.

Retrace

Mark: 02/03

Frev | Hext |
ﬁlayl Clear

oto Mark

Cancel |
Help |

This panel allows you
to navigate through
logic from mark to
mark.

> To retrace your marks:

1.

From the Network Editor, on the Search menu, click Retrace Marks.

The Retrace panel appears in the top right corner of the Network
Editor. You can drag the Retrace panel by the title bar to a different
location by the title bar. Once positioned, the panel will remain in
place until you exit ProWORX NxT.

Do any of the following:

Prev: Click to move to the previous mark. The network window is
repositioned to this mark.

Next: Click to move to the next mark. The network window is
repositioned to this mark.

Goto Mark: Click to return to the Goto Mark dialog box to select a
different mark.

Stay: Click to close the Retrace Mark panel and disregard the
remembered logic position.

Clear: Click to clear all marks from the list.

Cancel: Click to return to the network to the location prior to the
start of the Goto Mark function. The Retrace Mark panel is
removed.
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Inserting and deleting network items

Inserting network items

You can insert columns, rows and networks.

» Toinsert a column, row or network:

1.

From the Network Editor, click the location in logic where you want
to insert the new item.

On the Edit menu, click Insert, then do one of the following;:

Column: Click to insert a new column to the right of the cursor.
Row: Click to insert a new row above your cursor.

Previous Network: Click to insert a new network above the current
network.

Next Network: Click to insert a new network below the current
network.

Deleting network items

You can delete an element, column, row or network. You cannot delete a row
or column while it contains an element (instruction). You must first clear the
row or column, then delete it.

» To delete an element, column, row, or network:

1.

From the Network Editor, click the cell in logic where you want to
delete an item.

On the Edit menu, click Delete, then do one of the following;:

Element: Click to delete the element in the currently selected cell.

Column: Click to delete the column containing the currently
selected cell. Columns to the right of the deleted column are shifted
left.

Row: Click to delete the row containing the currently selected cell.
Rows beneath the deleted row are shifted up.

Network: Click to delete the current network. NxT prompts you to
confirm the deletion of a network. Click Yes to proceed.
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Transferring logic blocks to and from disk (offline only)

Saving blocks of logic to disk (offline only)

You can save a block of cells into a separate file.

» To save a block of logic:

1.

Select the block to save.

To select a block, click to select the cell where you want the block to
start, then drag the cursor to the final cell of the block. To select an
entire network or series of networks, on the Edit menu, click Blocking
then click Network Range.

On the Edit menu, click Blocking then click Save. The Block Save
dialog box appears.

METWORK 0001 network 1 page title
O Bupasse Belt#2  Initiate
1 —
10001

10028 onz1z oot
Startaf 2 Initiate Fieset_Sw  Paint Danz Krer  Home

00001 ooz ooz ooz oo
D303 Krer  Belt #2 Station 1

Block Save

| ]
| L W EIERIC- A PROWORXANXTADEMODBANXT _DEMO.BLK

5 0K | Cancel | Browse | Help |

Type the path and file name of the file to contain the block of cells or
click Browse to navigate to the file.

A default file name is created based on the active database. The file
must have a .BLK extension.

Click OK. If the .BLK file exists, it's replaced. If the file does not exist,
it’s created.
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Loading blocks of logic from disk (offline only)
You can load a block of cells from a .BLK file into the active database.
» To load a block of cells into the active database:
1. Click the starting cell where the block is to be inserted.

2. On the Edit menu, click Blocking then click Load. The Block Load
window appears.

Block Load
Block File:
| ‘ | Browse
[
Soulce:l H | Dest:l ‘
Tuxnx
Soulce:l H | Dast:l ‘
Junxy
SDUICEZl H | Desl:l ‘
L
Snulce:l H | Deslzl ‘
[¥ Load Descriptors  [¥ Load Register Contents
(114 | Cancel ‘ Help |

3. Type the path and file name (with a .BLK extension) of the block file
to load or click Browse to navigate to it. If the block file exists, address
range are set to the ranges for the block database. If the block file does
not exist, the ranges are blank.

4. For each address type (Oxxxx, 1xxxx, 3xxxx, 4xxxx), type the first
address in the destination block.

5. To load descriptors associated with the register addresses, select
Descriptors.

6. To load register contents of the addresses, select Register Contents.

Click OK. The block is loaded into the database of the network being
displayed if all checks for address ranges and valid instructions pass.
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Making logbook entries

The Logbook is a general purpose note holder that is attached to a database
name, but not linked to any database record. It can be used as a scratch pad to
remember information, as a daily journal, or a reminder pad to pass
information between different shifts. You can set the Logbook to automatically
display the next time the Network Editor is started. This forces the next user
(for example, the following shift) to review the logbook.

» To add a logbook entry:

1. From the Network Editor window, on the Display menu, Logbook.
The Logbook window appears.

Logbook [ <]

Log Humber: [0001 3] Activate Auto Display L0 #:0001/0003
Log Author
Log Date: [Mar29, 1939 ~ Click to scroll through

Log Mote: || added a new drop to the traffic cop. the Iogs.

[1] 4 | Cancel | Delete

Insert | Help |

2. (Optional) In Log Number, type the identification number for this log
entry. The Log Number defaults to the first unused log number (in
increments of one).

3. In Log Author, type your name or employee number.

In Log Date, type the date that this log is entered. The Log Date can be
20 characters, so you can type any information in any format you want
(the time of day, shift number and so on). The default is the system
date.

5. InLogNote, type alog of up to 200 characters in length, then click OK.

» To delete a logbook entry:
1. Select an entry from the Log Number list.

2. Click Delete. NxT prompts you to confirm the deletion.
3. Click Yes.

» To display the logbook automatically at startup:

*  From the Logbook dialog box, select the Auto Display Activate.
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Searching for duplicate coils (offline only)

You can search for coils which have been assigned to a duplicate address. If
you find any, you can look up the offending coils using a search function.

» To search for duplicate coils:

1.
2.
3.

On the Search menu, click Find.
From the Search dialog box, select Duplicate Coil Search.

Click Search. If duplicate coils are found, the duplicate coils table
appears.

Duplicate Coils Table [ %]
00001 00340 I
Find Coil | Close | Help |

Select the address you want to go to by clicking it.

Click Find Coil. A search for the coil address is performed and a
Results Table appears. All locations in logic with the found addresses
are displayed.

Displaying disabled addresses

You can search for disabled discrete addresses. If any are found, the Disabled
Address table dialog box is displayed.

» To display the Disabled Address table:

1.

AR S N

From the Search dialog box, click Disabled Table.

Click Search.

If disabled addresses are found, NxT displays the Disabled Table.
Click the address you want to go to.

Click Find Addr. A search is performed for the disabled address and
the Results Table is displayed.
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Locating coils from contacts

The Locate Coil function allows you to find contact and coil relationships. To
locate a coil in this case means to search for the output coil associated with a
selected contact.

» To locate a caoil:
1. From the network window, select a contact with a coil address.

2. On the Search menu, click Locate Coil.

Rebuilding a database

The Rebuild Database function reconstructs the descriptor pointer file ( DPF)
from the existing descriptor data file (DDF). This may be necessary if the .DPF
file is ever corrupted or accidentally erased.

> To rebuild a database:

1. From the Network Editor, on the File menu, click Utilities, then click
Rebuild Database. You are prompted for confirmation.

2. Click Yes.

Performing a sweep (online only)

The Sweep function is a powerful diagnostic tool that lets you solve logic for a
set number of scans or solve logic continuously with a constant time between
scans.

Constant sweep mode

The Constant Sweep mode sets the controller to scan and solve logic and
update I/O continuously, but with a constant time interval between scans. If
the actual scan time is less than the imposed scan time, the controller waits for
the imposed scan time to elapse before performing the next scan. If the actual
scan time is more than the imposed scan time, the controller finishes the scan,
then continues on with the next scan. This lets you slow the scan time to when
debugging logic, so that the controller doesn’t solve logic too quickly for you
to catch errors.
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» To perform a Constant Sweep:

1. From the Online Network Editor, on the Configuration menu, click
Sweep. The Sweep Mode dialog box appears.

Sweep Mode E

Sweep Mode: Parameters:

(Ol | Time (10-200 ms): [00_|(x10)
O Single Sweep
© None Register [4xxxx): (0000

1] 4 | Cancel | Help |

In Sweep Mode, click Constant Sweep.
In Time, type the target time (in tens of milliseconds) for each scan.

In Register (4xxxx), type a 4xxxx register to hold the target time value.
The actual time taken for each scan is placed in the next register, so a
total of two registers are used here.

5. Click OK.

Single sweep mode

Single Sweep mode sets the controller to scan and solve logic, and update I/ O
for a set number of scans only. When the sweep is finished, the controller stops
solving logic and updating I/O, waits until you manually trigger the sweep.

The Single Sweep function should not be used to debug controls on machine

& tools, processes, or material handling systems when they are active. Once the
set number of scans is solved, all outputs are frozen in their last state. Since no
logic solving is occurring, all input information is ignored. This can result in
unsafe, hazardous, and destructive operation of the machine or process
connected to the controller.
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» To perform a Single Sweep:

1. From the Online Network Editor, on the Configuration menu, click
Sweep. The Sweep Mode dialog box appears.

Sweep Mode E
Sweep Mode: Parameters:
O Constant Sweep Time (10-200 ms): [00_|(x10)
: Scans (1-15): [1_|
1] 4 | Cancel | Help |

2. In Sweep Mode, select Single Sweep.
3. In Time, type the target time (in tens of milliseconds) for each scan.

the target scan time to elapse before performing the next scan. If the actual scan
time is more than the target scan time, the controller continues on with the next
scan. This lets you slow the scan time when debugging logic so that the controller
doesn't solve logic too quickly for you to catch errors.

:g If the actual scan time is less than the target scan time, the controller waits for

4. In Scans, type the number of scans (from 1 through 15) to be
performed during the sweep then click OK.

5. When you are ready to perform the sweep, on the Configuration
menu, click Sweep. The Single Sweep dialog box appears.

Single Sweep E

Single Sweep Options:  Parameters:

O Invoke
@ Trigger Scans (115 [1_]
O Turn OFf

Cancel | Help |
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6. Select one of the single sweep options:
* Invoke: Select to start the sweep.
* Trigger: Select to set a trigger for the sweep.

* Turn Off: Select to shut off the sweep.

7. Click OK. The controller performs the scans (unless you selected Turn
Off), then stops solving logic with all outputs frozen in their last state.

You can then browse register contents and perform other diagnostics
using this “snapshot” of the solving process.
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Traffic Cop overview

The Traffic Cop is used to configure the 1/O drops, racks, and slots. Often,
more than one Traffic Cop series can be configured in your database.

For example, you can have a 800 Series drop, a DCP Series drop, and a 900
Series drop configured in the same database. A120 and Micro Series devices
are exceptions.

Drops, racks, and slots

Your Modicon control system involves a certain amount of Discrete and
possibly Analog I/O (Input/Output). Each I/O point is physically wired to a
terminal of an I/O card in a rack somewhere on your plant floor.

Modicon I/O can be set up either locally (attached directly to the backplane of
the main controller rack) or as Remote I/O (through the use of a Remote I/O
processor in the main controller rack.) Remote I/O, though not supported by
all controller types, allows the greatest flexibility and capacity for your system.

I/Ois serviced by the controller in groups called drops (or channels). A single
drop of I/O can consist of multiple racks of I/O and must be scheduled to be
scanned (in the Segment Scheduler) during the controllers” scan of the logic.
For controllers with local I/O, it is always drop #1.

Remote drops of I/ O communicate with the main controller through a Remote
I/O processor in the main controller’s rack. Several I/O families exist for
Modicon 984 /584 controllers.
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Using the Traffic Cop display

The tree control area of the Traffic Cop window lets you select different drops
(or racks within drops) in the Traffic Cop tree.

» To display the Traffic Cop:

From the Network Editor, on the Configuration menu, click Traffic

Cop or click on the toolbar.

7:'_ Traffic Cop

Dizcln Disc Out Analog In

Analog Out  ntel [40  Interface  Power

v
The tree provides a/

hierarchical view of
configured drops and
racks. Selectadrop or
rack to see its configu-
ration.

= Drop 1[800 Series
MRack 1
WRack 2
MRack 3
MRack 4

MRack 5
[=iIDrop 2(800 Series)

WRack

MRack 2

MRack 3

MRack 4

MRack 5
[+{#Drop 3(800 Series)
[+{D rop 4(800 Series)

55908 Traffic Cop -
1 1 i

— Edit Drop:

ﬂ

Hold Up Time:E ASCII Eolt:El

K>

30005-30008 [BIN |B873-200/4, Themo, RTD, Strain

Edit.. | Temminal | Card Help |
|In 02801024 |Dut: 02081024 | P &vall +5:17228 4320117 51734
(114 | Cancel Doc... | Insert___ | Delete... | Auto Addlessing...l Help |

To navigate through a tree:

* C(Click to move up one visible row in the tree.

e (lick Mto move down one visible row in the tree.

* Click to move up one level in the tree (for example, from a rack up
to its parent drop.

* To expand the racks in a drop, click * to the left of the drop.

To collapse the racks in the drop, click [l to the left of the drop.

* Toselect a drop fDrop or rack ElRack, click on it.
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Using the Traffic Cop data display

The Data Display window is available only in the 200, 900, and DCP series
Traffic Cop. It shows a list of all programmed references and data.

» To display the programmed references and data:

*  From the Traffic Cop window, click Data. The Data Display window

appears.
Data Display E
Reference Data (HaibE
T <] |@Decimal
10002 Off ) Hexadecimal
10003 1]}
10004 off O ascll
10005 Off Q Binary
10006 Off ) Floating Point
10007 1]}
10008 1]}
10009 1]}
10010 1]}
10011 1]}
10012 1]}
10013 0Off hd
D p
10001 |
Cloze | Goto Doc Help |

Discretes are displayed as ON or OFF (DON, DOFF if disabled) and registers are
displayed in the selected Radix.
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Auto addressing in the Traffic Cop

The Auto Address function lets you set default addresses to be entered when
programming a new card into Traffic Cop. The addresses are automatically
incremented for each new card added.

» To set the default addresses for new cards:

1. From the Traffic Cop window, click Auto Addressing. The Auto
Addressing window appears.

Auto Addressing [ %]
Oxxxx: [[IIG] | 00001-00512 OK

Txxex: [10001 | 10001-10064
Bunn: 30001-30099
Axex: 40001-41800 Cancel

These are the addresses which
will be provided as the default
when a new card is being
programmed into the traffic cop.
These addresses will automatically
increment for the next new card. Help

bl

Last Used

2. For each reference type (0Oxxxx, Ixxxx, 3xxxx, 4xxxx), type the default
starting address.

3. Click Last Used to recalculate the next available address for a Traffic
Cop card. This prevents duplicate addresses from being used.

4. Click OK.

Displaying the terminal block (800, Quantum, A120)

The Terminal Block dialog box displays the card currently selected, with
programmed references, data values, symbols (if selected) and their
descriptors. If Symbols are turned on in Preferences, then an additional
column containing all the symbols is displayed.

If you're working Online, I/O points are monitored and updated.
» To display the terminal block for a programmed card:

1. Inthe Traffic Cop, click the card you want to display.

2. Click Terminal. The Terminal Block window appears with the
location (drop, rack, slot) of the selected card displayed in the title bar.

* Next: Click to display the terminal block of the next card in the
currently selected rack.
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* Prev: Click to display the terminal block of the previous card in the

currently selected rack.

Doc: Click to edit the documentation for the currently selected
address in the Doc Editor.

Goto: Click to search for an address in logic that corresponds with
the I/O point. If a match is found, you can exit the Traffic Cop and
go directly to the Network Editor, where a complete address search
of the logic is performed.

Configuring a drop

If a drop has not been configured yet, Configure is displayed in the drop
overview area. The Traffic Cop tree control cannot be expanded until the drop
type has been chosen.

» To configure a drop:

1. Click the drop in the tree control.

2. Click Configure. The Drop Configuration dialog box appears with the
previous default selections.

Drop Configuration

Drop #01 has not been configured. Pleage et the interface.

@ 800 Series - PAJ89x Remote 170 Interface

O Quantum - Quantum Remote 170

O 2004500 - 12902291 Remote 170 Interface

) DCP/DROP - D908 Distributed Control Processor

{C) 900 Series - Motion Contiol Diop (IC 410, 3220, 3240)

Cancel | Help |

3. Select the interface corresponding to your topology.
4. Click OK.
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800 Series Traffic Cop
This Traffic Cop is used to configure an 800-series drop.

Racks associated with the drop (and the cards configured in the racks) are also
displayed to the right of the tree control. The racks can be displayed in two
views and both allow you to edit slots:

* Drop Edit: Displays all racks in the drop.

* Rack Edit: Zooms in to display only the currently selected rack. This
view also lets you configure the rack type and size.

» To configure an 800 Series drop:
1. From the Traffic Cop tree control, select the 800 Series drop to edit.
NxT displays the Edit Drop view in the right side of the window.

2. In Hold Up Time, type the number of seconds for this I/O drop to
hold its I/ O values if communication from the 984 is lost.

3. In ASCII Port, type the ASCII Port used for ASCII messaging on this
drop.

If the racks haven't been configured for the drop yet, click Configure and select
an interface, then click OK to continue.

» To insert a slot, rack, or drop:

1. From the Traffic Cop window, click Insert. NxT displays the Insert
Traffic Cop Item window.

Select the item to insert.
Click where it should be placed:

* Insert before: The currently-selected item is shifted right if it is a
slot or down if it is a rack or a drop.

* Insert after: [tems after or below the currently selected item are
shifted right or down.

You can press the INSERT and DELETE keys to insert or delete heads, drops,
racks, or slots.
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» To clear or delete a slot, rack, or drop:
1. From the Traffic Cop window, select the item to delete.
2. Click Delete. NxT displays the Delete Traffic Cop Item window.

3. Select whether you are deleting a slot, rack, drop, or all drops in the
Traffic Cop.

4. Select an action, then click OK.

* Delete: Removes the item, shifting the remaining items up (rack or
drop) or left.

* Clear: Clears the item and leaves it empty, without shifting
neighboring items.

You can press the INSERT and DELETE keys to insert or delete heads, drops,
racks, or slots.

» To move a card from one slot to another:

* Drag the card from its current slot to the destination slot.

> To edit a slot:

1. From the Traffic Cop display, select a slot and click Edit or double-
click the slot. The Slot Edit window appear.

Slot Edit - Drop 1 Rack 1 Slot 2 [ %]

Card oK

B853-016 115 VAC/125 VD[ j

Cancel
Selecting a card displays the
power supply loading and
mechanical keying for the
card. Select a card from the
drop-down list, then click OK.

IN: 10017 - 10032

Voltage Keying

Card +5 +43 5§
Curmrent !
(mA) > 40 1 15

Help

2. Select the card to insert in the slot (selected in the Traffic Cop window)
from the drop-down list. Selecting a card displays the power supply
loading and mechanical keying for the card.

3. Inthe address field (In or Out), type the starting address for the
address range assigned to this card, then click OK.
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For example, suppose you are configuring a B828 card with 16
outputs. The address field will be entitled Out and you must type the
initial address of a 16 address table (0Oxxxxx) for this card. The final
address in the table is automatically displayed.

25

The table must begin on a word boundary. If you type a starting address that is
not on a word boundary (16+1), NxT automatically adjusts the address down to
the nearest boundary. The address table is automatically provided if you have

selected Auto Addressing.

Some cards have other values which are configured at this level.
Selecting a B863-001 (4 Channel In). For example, lets you toggle
between BIN and BCD.

DCP Series Traffic Cop

The DCP Series Traffic Cop is a four-page display showing the addresses used
to transfer data to and from a D908 tied to an S908 system. The D908 is a
distributed control processor available for 680/685/780/785 systems. The
controllers use a D908 for a remote drop to the master S908 system.

» To edit DCP drops:

1. From the Network Editor, on the Configuration menu, click Traffic

Cop or click in the Toolbar.

% Traffic Cop

MDrop 5()
MDrop 6()
MDrop 7()
MDrop 8()
D rop 9()
@Drop 10()
@Dop 11()
D 1op 12[)
D op 13()
#Diop 14()
D op 15[)
D op 16()
D op 17()
D rop 18()

1]
Discln Diec Out Analogln Anslog Out Intel /00 Interface Power
— — r Edit Drop:
5908 Traffic Cop . 2
EEID rop 1800 Series) Hold Up Time:[3 | ASCII Por:[0 |
j Page #1 - 01/0 Modules Programmed

ﬂ Page #2 - 01/0 Modules Programmed
ﬂ Page #3 - 01/0 Modules Programmed

Page #14 - 01/0 Modules Programmed

[DCP Seiies

0K |

Cancel

Doc... | |_nsen,,,| Delete..

Auto Addressing. | Help |
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Selecting a rack from the tree control displays the corresponding page, where

:g The four pages of the drop are displayed as racks in the tree control as racks.
you can edit individual slots.

2. Click the corresponding button of the Page you want to configure (for
example, click El to configure Page #3). The Traffic Cop display

switches to Edit Rack mode, showing the slots for a single page.

% Traffic Cop
Dizcln DiscOut Analogln Analog Out  Intel 1/0 [nterface  Paower
r Edit Rack-
b
30001 - Option State 30002 - Write Count
Page Slot Local Address Length Remote Address
T 04 0000100016 __ 1 3000330003 C
1 05 0001 7-00048 2 30004-30005
1 06 0
1 o7 o
1 08 o
1 09 0
1 10 o
1 11 o
fBDrop 10()
M Drop 11[]
MDrop 12{)
Drop 13()
Drop 14{)
Drop 15()
Drop 16()
Drop 17() >
fDrop 180) Edit... Data... I
[ [ mwsz | owwsz |
0K | Cancel Doc_.. | Insest | Delete._ | Auto Addressing._ | Help |

* The HB field displays the health status for each slot: OK appears if
the card is fine or ?? appears if the card is unhealthy.

e To view data for a local address table, select the table and click
Data.

* To type or edit documentation for a slot, select the slot and click
Doc.

3. Double-click the slot to configure or select the slot and click Edit.
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4. Double-click Local Address, or select it and click Edit. The slot edit
dialog box is displayed. The location of the currently selected slot is
displayed in the Title Bar in the format Drop/Rack/Slot.

Drop 4 Rack 1 Slot 5 E
Lenglh:

0K | Cancel |

5. In Address, type the starting address for the Local Address table.

In a DCP system, registers are automatically exchanged between the
supervisory PLC and the distributed control drop. The supervisory
PLC writes Oxxxx or 4xxxx information to the distributed drop and
reads 1xxxx or 3xxxx information from the distributed drop. This step
sets the registers to be used for the exchange.

6. In Length, type the length (in words) of the Local Address table.

ProWORX NxT automatically sets the remote address to the length
corresponding to the word length entered for the Local Address.

Addresses 300001 and 300002 are reserved for the Option State and
Write Count, respectively.

7. Click OK.
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Quantum Traffic Cop

Quantum I/O can be set up for Local I/ O or Remote I/O (RIO). In addition,
Distributed I/O (DIO) is controlled via the Modicon Modbus Plus network.

Like other Modicon I/ O, Quantum I/ O is organized based on drops and racks.
However, in addition to drop number and rack number, Quantum I/O
devices also have a head number. Since Quantum controllers can have up to
four I/O systems (one RIO and three DIO), each I/O system is given a head
number. The head number is the slot where the card is located on the local rack
where the I/O system is connected.

DIO Processor RIO Processor Drop 64 Head 6

Head 2 Head 3
Power oI MB+address B4
Supply DIO drops connected to a
DIO processor occupying
CPU {Head B) Head 2 (slot 2) of the local
todbus Plus Coaxial Drop 1 Quantum backplane. All of
Rack 1 Rack 2 Head 3 those drops belong to
800 Series RIO Head 2.
| Rackq Drop 2 Head 3
Drop 1 MEraddress 1 Guantum RIO The DIO drop connected to
Moo 2 o (Only 1 rack allowed) the CPU, which is in the
Drop 2 MB-+address 2 31 drops maximunr @ Frocessor sixth slot of the 6 slot back-
Head2 e o 5 & Quantum DIO plane is designated as
+
Drop 3 anness (1 rackfdrop permitted) Drop 64, Head 6.
Head 2 MB+address 4
Drop 4
Head 2
DIO

63 drops maximurm

» To configure the Quantum Series Traffic Cop:

1. Inthe Traffic Cop tree control, select the Quantum Series drop to edit.
NxT displays the Edit Drop display in the right side of the window.

2. InHold Up Time, type the amount of time (in seconds) for this I/ O
drop to scan its I/ O if communication from the 984 is lost.

3. In ASCII Port, type the ASCII Port used for ASCII messaging on this
drop.

If the racks haven't yet been configured for the drop, click Configure and select
an interface, then click OK to continue.
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3xxxx Status Register

When using the Quantum Series Traffic Cop, you can set a 3xxxx Status
Register for your drop.

» To set the 3xxxx Status Register:

1. Inthe Status area of the Traffic Cop window, click Edit. The Quantum
Drop Status dialog box appears.

Ruantum Drop Status [x]
3xxxx status legistel:l:l

— | l:ancel -

2. Type the register to store the controller status bits, then click OK.

If you are using the Quantum Series Traffic Cop and you are using Distributed
I/0O (DIO), you can set the directions in which 3xxxx status register
information travels. To activate the DIO Read/Write Status, on the tree
control, click the appropriate distributed drop.

» To set the read/write status:

1. Inthe Status area of the Traffic Cop window, click Edit. The Quantum
Drop Status dialog box appears.

Quantum Drop Status [ %]

3xxxx status reqister: l:l

@ Read/write Drop
) Read Only Diop

2. Select one of the following, then click OK:

* Read/Write Drop: Data is passes both to and from the drop and the
DIO processor.

* Read Only Drop: Data is passed only from the drop to the DIO
processor.
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» Toinsert a slot, rack, or drop:

1.

In the Traffic Cop dialog box, click Insert. NxT displays the Insert
Traffic Cop Item dialog box.

Select the item to insert and where it should be placed:

* Insert before: Currently selected item is shifted right (slot) or down
(rack or drop).

* Insert after: [tems after (below) the currently selected item are
shifted.

racks, or slots.

@ You can press the INSERT and DELETE keys to insert or delete heads, drops,

» To clear or delete a slot, rack, or drop:

1.
2.
3.

In the Traffic Cop dialog box, select the item to delete.
Click Delete. NxT displays the Delete Traffic Cop Item dialog box.

Select whether you're deleting a slot, rack, drop, or all drops in the
Traffic Cop.

Select an action, then click OK:

* Delete: Removes the item, shifting the remaining items up (rack or
drop) or left.

* Clear: Clears the item and leaves it empty, without shifting
neighboring items.

» To edit a slot:

1.

Select the slot to edit, then click Edit or double-click the slot to edit.
The Slot Edit window appears with a list of available cards.

Select the card to insert in the slot (selected in the Traffic Cop window)
from the drop-down list. Selecting a card displays the power supply
loading and mechanical keying for the card.

In the address field (In or Out), type the starting address for the
address range assigned to this card, then click OK.

For example, if you are configuring a DAI340-00 card with 16 inputs.
In the IN address field, type the initial address of a 16 address table
(Ixxxxx) for this card. The last address in the table is displayed.
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For some cards, the table must begin on a word boundary. If you type a starting
@ address that is not on a word boundary (16+1), NxT automatically adjusts the
address down to the nearest boundary. The address table is automatically

provided if you have selected Auto Addressing .

Some cards have other values which are configured at this level.
Selecting a MSB101-00 (Motion Inc Enc). For example, to toggle

between BIN and BCD.

Configuring Quantum cards

Most Quantum cards require additional parameters to configure.

» To configure card-specific options:
1.

From the Quantum Traffic Cop, select the card to configure.

2. Click Card Config. The Card Configuration dialog box appears.

Head 00, Drop 01. Rack 1. Slot 02 Card Configuration

EHC-202
High Speed Counter

216 with Qutput = |

Comm lost output assert override: OFf j

Counter 1 Mode Control: Incremental j

DOutput Coil 1A mode:

Number of counters. output assertion:

Setpoint

Output Coil 1B mode:

[ K

Setpoint

Counter 2 Hode Control:
Dutput Coil 2A mode:
Output Coil 2B mode:

Incremental j
Setpoint

i<

Setpoint

Counter Mode Parameters

2x%16 with Dutput
1x32 with Dutput
2%32 No Dutput I
Rate Sample Mode

| 114 I Cancel | Terminal... | Help

3. Type or select the card-specific parameters, then click OK. Consult the
card’s manual for details. For example, Setting up an Interbus-S

NOA611-00 Card in the Quantum Traffic Cop

Quantum Traffic Cop ® 193



ProWORX NXT User's Guide

ProWORX NxT supports Interbus-S I/O devices through a Quantum
NOA611-00 Card. NxT communicates with a Quantum controller, which
relays information to and from the NOA611-00. The card then receives data
from and transmits instructions to the Interbus-S I/O devices. Set up the
NOA®611-00 card through the Quantum Traffic Cop.

» To set up an NOA611-00 card in the Quantum Traffic Cop:

25

Before continuing, you must have configured your database for a Quantum
controller (see Controller configuration - Controller tab on page 64).

1. From the Network Editor, on the Configuration menu, click Traffic
Cop or click in the toolbar. The Quantum Traffic Cop appears.

% Traffic Cop

Discln DiscOut Anlln AnlOwt Intl0  Motion Per QFX08 Controller

NOKM211-00

i~ Edit Drop:
; ! NOMZ1210  Fime:[3 | ASCHPoe[d ] L2
Example: To place an [~ #Drop 1[Huantum] i e———————
NOA611-00 card, selecN\ MAack 1 EAP93200 BEEEEEER
the local drop and the slot \ Eiﬁiiéﬂﬂ -
where it will be placed, then CRAZ11-10 hbled _Edit |
click NOA611 on the IO CAR4211-20 -
CRAZIZ10 wi
Adpt menu . CRAZI220 avail:
CH5110-00
You can also select a slot, ~L NOEZ11-00
click Edit, then choose the NOE 251-00
NOA611-00 from the drop-
down list. 300001-300267 400001400264 | BIN | NOAG11-00 Interbus-5 Master Madule
[T Edit. | Teminal | Card Help | Card Confia]

In: 0000024 Dut: 000024 |

Pawer Await 3780mA

0K | Cancel | Doc... | Insert.. | Qelete...l AutuAddle:sing...l Help |

2. In the Traffic Cop window, click the Quantum Series local drop to
select it. The NOA611-00 must be placed in a local drop. Note that the
drop must be configured before you can place items into it.

7

% For instructions on configuring a drop, see Configuring a drop on
page 184.
3. Click the slot where the NOA611-00 will be placed to select it.

4. Click IO ADAPT then click NOA611-00. The NOA611-00 icon
appears in the slot.
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5. Double-click the NOA611-00 icon or with the NOA611-00 icon
selected, click the lower Edit. The Slot Edit dialog box appears.

Slot Edit - Head 0 Drop 1 Rack 1 Slot 3
Card
0K
o
‘ NOAET1-00 [EUS S Maste =
Cancel |
IN: [300006 - 300272 | - gep
DUT:[400003 - 400266 | ® BIN
Current Keying

Card
Current
[mA] --> 700

Help

6. Edit the NOA611-00 settings as necessary, then click OK.

* For both In and Out, type an initial address for the range assigned
to the card. NxT provides an address table automatically.

* Click either BIN (Binary) or BCD (Binary-Coded Decimal). See
your NOA611-00 user’s manual for more information.

Click Card Config.

Configure the Output Timeout State according to the NOA611-00
user’s manual, then click OK. The Card Configuration window closes.

9. To close the Traffic Cop, click OK.
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Micro 300 Series Traffic Cop

The Micro Drop Summary displays a summary of currently configured I/O
modules. Each drop in the Micro Traffic Cop is described as single, parent, or

child.

% Traffic Cop

MRack 4

r Edit Rack:

Type Card References Data

DISE 170
INT/CTR
TMR/CTR
ANALOG
DATA TRAN

_iMIC137 10001-10016 00001-00012 DISC

K

Edit.. [ Data..

| Card Help I

MIC1 37

0K |

Cancel |

Doc... | Insert... | Qelete...l Auto Addressing...

Help

> To edit a slot:

Micro 512 and 612 Series
controllers can have A120
Series I/O cards pro-
grammed in racks 2 to 4.

1. From the Micro Traffic Cop, select the slot to edit and click Edit or

double-click the slot. The Edit window appears.

Drop 1 Rack 1 Slot 1 E

(ILHEMICT 37 16 IN. 12 OUT j
Input: (10001

l]ulpul l]l]l]l]1

O BIN
O BCD

0K

| Cancel |

2. Inthe Card field, select the card to insert in the slot. Selecting a card
displays the power supply loading and mechanical keying for it.

3. Inthe address (In or Out), type the starting address for the address

range assigned to this card, then click OK.

For example, if you configure a B828 card with 16 outputs, the address
field is entitled Out. You must type the initial address of a 16 address
table (Oxxxxx) for this card. The final address in the table is displayed.
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used thatisn’t on a word boundary (16+1), the address is adjusted to the nearest

:g For some cards, the table must begin on a word boundary. If starting address us

boundary. The address table is provided when Auto Addressing is selected.

Some cards have other values which are configured at this level.
Selecting a MIC141 (4 Channel In/2 Channel Out). For example, lets
you toggle between BIN and BCD.

200/500 Series Traffic Cop

The 200/500 Series I/ O screen is an S908 representation of the connection to a
J290/]291 interface device. The 200 Series drop contains racks 2 to 5. For each
slot in the rack, NxT displays the slot number, type (input or output), reference
address range (the associated addresses in logic), data type (discrete or

analog), and the health status (OK or ??) of the card. The health status is only
available if the controller is running and channels are not explicitly displayed.

» To configure a slot:

1.

Select the drop and rack containing the slot you want to edit from the
tree control. The rack appears in the Edit Rack area of the window.

Select the slot to edit and click Edit or double-click the slot.

Type the first address of the table associated with this input or output
point, then click OK.

For example, suppose you are entering an address table for a 16 IN slot
on a J290. You must associate this slot with a 16-bit table of discretes,
or one 16-bit register.

If you are entering a register, select the input type (binary or BCD).

Other functions

Data: Click to view the address contents (the register value or the state
of each discrete in the table).

Doc: Click to edit documentation for each slot.
Insert: Click to delete an item (slot, rack, or drop) from the Traffic Cop.

Auto Addressing: Click to set the default addresses for new cards
configured into the Traffic Cop. NxT automatically increments the
addresses for each new card configured.
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200/500 Series slot edit

» To configure a slot:

1.

4.

Select the drop and rack containing the slot you wish to edit from the
tree control. The rack is displayed in the Edit Rack area of the
window.

Select the slot to edit and click Edit, or double-click the slot.

Type the first address of the table associated with this input or output
point.

For example, suppose you are entering an address table for a 16 IN slot
on a J290. You must associate this slot with a 16-bit table of discretes,
or one 16-bit register.

If you are entering a register, enable the input (binary or BCD).
Click OK.

900 Series Traffic Cop

The 900 Series I/O displays the Traffic Cop screen for a motion control I/O
drop. The Traffic Cop allows a bi-directional 8 register slot for data transfer. A
900 Series drop is always a remote drop and only found in conjunction with an
S908 remote I/ O processor. If the controller is running, NxT Online displays
the controller health status (OK or ??) in the HB field.

> To edit a slot:

1.

AN L

In the tree control, select the drop to edit. NxT displays the single slot
for the drop, the card entered (if any), as well as the input and output
reference numbers, data type, and description of the card.

Select the slot and click Edit, or double-click the slot. NxT displays the
Edit dialog box, with the drop, rack, and slot shown in the title bar.

In Input, type the starting register reference number.
In Output, type the starting register reference number.
Click the proper Data Type (binary or BCD).

Click OK.
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A120 Series Traffic Cop

This Traffic Cop Series is used with A series compact and new Micro series
controller.

The Slot Edit function for the A120 Series Traffic Cop allows you to edit a
configured card or type a new card into a slot.

> To edit the card:
1. Click the = to the right of the card entry box. A list of valid cards for
the drop type you are using appears.
Select a card from the drop down list.

3. InInput (or Output), type the starting address of the address table
associated with the I/O points on this card.

Momentum M1 I/O systems

Momentum I/O systems differ from those of other Modicon controllers. A
Momentum I/ O system grows from a single Momentum I/ O base unit. An M1
Processor Adapter (for example, a controller) is mounted on a Momentum I/
O base. If a Momentum Option Adapter is used, it is mounted between the
Processor Adapter and the I/O base.

<=
el i
iy

Option Adapter Processor Adapter
(optional) (controller)

Momentum 1/O base card

Option Adapters add a time of day clock and one or two additional Modbus
ports, depending on the Adapter model. Features of an Option Adapter are
configured along with the Processor Adapter; as far as controller configuration
is concerned, the division between the two is transparent.
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I/OBus

The M1 760-00 Processor Adapter also provides a way to control a network of
Interbus-S cards over an I/OBus. The M1 760-00 becomes a master on the
Interbus network. Slave devices on a network of this type can be standard
Interbus cards (including Modicon cards configured for Interbus
communications) or Momentum I/O bases with Interbus Communication
Adapters mounted on them.

e b A e

M1 760-00 Interbus-compatible
controller (master) devices (slaves)

In an I/ OBus, each Interbus-S card is connected to its neighbor in a string.
Signals are passed from one card to the next card in line. Node addresses are
based on a card’s virtual position in the I/ OBus network. The first card
connected to the I/OBus master (the M1 760-00) has an address of 1.
Subsequent cards are numbered 2, 3, and so on. A maximum of 128 cards can
be on your I/ OBus network.

M1 Traffic Cop

% Traffic Cop [ ]
Base Modules  Modicon lbus  Generic lbus

P

¥ Traffic Cop

Base Modules  Modicon lbus  Generic |bus

The 1/O base

[IADI 348 -88 24 ¥OC 16 Point IfP Module
[ (IBUS-8531 OFT 1 Mord Output Module
MIBUS-8382 DFT 3 Word Input Medule

Cards on the I/OBus

| 140 Bus Node 001 I | 40001-40005 EIN | Interbus-5 1D 00531
Edit.. | Data | cardConfig] BIN/BCD | Card Help |
[ [ 10 Points: 0128/2048 | ‘wiords Used: 00037/ 0053

DK | Cancel

Doc. | ln:ell,,,l gelele,,,l gulnAdd.essing,,,l Help |

The main window of the M1 Traffic Cop lists all modules currently inserted
into the Momentum network. For M1 7x0-x0 controllers, there is only a single
entry, the LCL or LoCaL node. This is the I/ O base onto which the controller
is mounted.
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With M1 760-00 controllers, you can also add Interbus-S cards in a string of
nodes (that is, slots) called the I/ OBus. These can be Modicon cards configured
for Interbus communications, other Momentum 1/O bases with an Interbus
adapter, or third-party Interbus-S cards.

» To view the configuration of a particular slot:

From the Momentum Traffic Cop, either double-click the slot or select
the slot and click Edit. The Slot Edit dialog box appears.

The LCL, or LoCalL. node, is the I/ O base onto which the M1 controller
is mounted. When using M1 7x0-x0 controllers, this is the only node
you can configure.

When selecting a node on an I/O Bus connected to an M1 760-00
controller, you can only select slots greater than one if a card exists for
all previous slots in the string. For example, you can only add a card
into slot 3 if cards have already been added for slots 1 and 2.

» To add a card to the I/OBus:

1.

From the Traffic Cop, select the card in the position following the one
where the new card will be inserted. To add a card to the end of the
I/O Bus, select the blank line following the last card on the list.

Click Insert. The Slot Edit dialog box appears.

Configure the slot card as described in the following instructions.

» To configure a slot card in the Slot Edit dialog box:

1.

If necessary, in the Card box, select the card for this slot.

If you are configuring cards in slots other than the LCL (LoCaL) node,
this list will include supported Interbus-S cards. Otherwise, you will
only be able to insert Momentum I/O bases.

In the address boxes (IN and OUT), type the starting address for the
address range assigned to this card. If Auto Addressing is turned on,
a set of address ranges are selected for you automatically.
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For example, if you configure an ADI540-00, a Discrete Input card
with 16 inputs. In the IN field, type the initial address of a 16-address
table (Ixxxxx) for this card. The final address is calculated.

boundary. That is, it must be one more than a multiple of 16, like 300001 or
100017. If you type a starting address that is not on a word boundary, NxT will
adjust the address down to the nearest boundary.

:g On some cards, the initial address for a table of 1/0 points must begin on a word

3. Ifnecessary, click BIN or BCD, depending on how the integer value is
stored.

BIN indicates straight binary representation and BCD indicates
Binary-Coded Decimal.

4. Click OK.

To replace the card within a particular slot, use the Traffic Cop card menus. Click
@ the slot you want to replace, then select a card from the Base Modules ,
Modicon Ibus and Generic Ibus menus at the top of the Traffic Cop dialog box.
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Using the 1/O Drawing Generator

The I/O Drawing Generator is used to create CAD drawings of 800, Micro,

Quantum and A120I/0.

» To activate the 1/0 Drawing Generator:

*  From the Network Editor, on the Display menu, I/O Drawing
Generator. The I/O Drawings Generator dialog box appears.

170 Drawings Generator

Dy

| " Intermediate " Final

Directories:
Symbaol: |C:\PHDWDHX\NXT\DHAWINES\JIC ‘ Browse. ..
Master: |[2:\FHUWUHX\NXT\DHA\VINES\JIE ‘ Browse._ .

Intermediate: |C:\PHDWDHX\NXT\DHAWINGS\INTER‘ Browse. ..

Final: [C-\PROWORX\NXT\DRAWINGS\FINAL | Browse

Options:

I” Dverwrite Existing Drawings

" Ignore Missing Master Drawings

" Save Above Settings on Close

Controller Prefix: |:|

Close I ﬁenelatel Display | Help |

The Traffic Cop default setting for the drawings is Intermediate and
the default directories are those directories previously used.

* Click Browse to change the directories. The File Open dialog box

appears.

* Click Generate to generate the drawing.

There are different symbols you can use to represent real world
devices in your I/ O drawings. Type these symbols into the descriptor,
starting with a dollar sign ($).

Descriptor:

Descriptor

for 30016

- ——

This is the descriptor field in the Documentation Editor.
Type symbols by preceding the symbol text with a $.
See below for a list of symbols and their corresponding
text. The symbol can be in any descriptor field.
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The following is a list of all symbols you can use:

®4®_@ (A——=r0— @—O\DD—@
LTR LSNC FLSNO
LTG FSNC FLSNC
@ —I—D = & @—OFD—Q @
PBNO r<ho o
P—alo—0O @—O’Qr'ﬂ—(z
PENC 05 o
PSNC
TGSNO
o— b—o ooy o ;
CRNO PSNO @——{:lLF—AZ
o—stfo—o0 o o TGSHC
CRNC &
Efﬁ TASNO o
HORN
O O TASNC PRSNC
LSHO

Displaying 1/0 drawings
» Todisplay I/O drawings:

1. From the Network Editor, on the Display menu, I/O Drawing
Generator. The I/O Drawing Generator dialog box appears.

2. Click Display. The I/O Drawing Display dialog box appears.

1/0 Drawing Display
HEAD O DROP 1 RACK 1 sloT 4
ATI 030 00 - § CHANMEL THERMOC OUPLE INPUT
g cne__
Ing oo Bhom
@
Zoom | Zoom Out |

Help |

Once the final .DXF drawings are created, they can be imported using
your CAD program.
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To pan across the drawing:
1. Click Pan.
2. Click at the location you want to be begin your pan view.

3. Drag the cursor to another location in the drawing and release the
mouse button. The view pans from the start location to your end
location.

To zoom into the display:
1. Click Zoom.
2. Click at the start location where you want to begin your zoom.

3. Drag your cursor to mark the area. A rectangle appears to define the
section of drawing you want to zoom in on.

4. Release the mouse button.

To zoom out of the display:
* (Click Zoom Out.

To select a different .DXF drawing:

1. From the I/O Drawing Display window, click Open. The File Open
dialog box appears.

2. Select the .DXF to display, then click OK.

To print a drawing:

*  From the I/O Draw Display window, click Print. The drawing is
printed to your default printer.
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Documenting your PLC

Symbolic Addressing, Address and Bit Descriptors, Short and Long
Comments, Network Comments and Page Titles are available for
comprehensive database documentation.

You can attach text descriptions to logic element addresses, register bits,
segments, networks, labels, and subroutines as well as all of your hardware
including I/O points, racks, power supplies, drops, and more. These
descriptions can be viewed while programming logic or configuring I/O, and
are also included in printed output of the various parts of your control system.

There are four components to documentation in ProWORX NxT:

Documentation Window: Used to edit short comments, long
comments, and descriptors from within the Network Editor.

Documentation Summary: Used to review symbols and descriptors,
as well as search for a specific documentation record.

Documentation Editor: Used to edit all documentation components,
including page titles and long comment placement on printouts.

Documentation Utilities: Used to move, copy and delete some or all
documentation for a selected range of references, as well as clean up
unused documentation records.

The types of documentation available are:

Symbols: A maximum of 32 characters long. They are text
representations of numerical addresses. Symbols are displayed in
upper case and can begin with any character other than a number
between 0 and 9.

Descriptors: Short descriptions of a reference. You can have five to
nine rows of 9, 12, or 15 characters each.

Short Comments: More detailed descriptions of the reference. A Short
Comment is four lines long and each line contains up to 48 characters.

Page Titles: A single 64 character line. Only specific types of
references support Page Title documentation. Page titles are used to
label sections of logic.

Long Comments: Are up to 32,000 characters in length. The maximum
number of Long Comments in a database is 5000. Long Comments can
also be printed in network listings.
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Each reference type supports different kinds of documentation. The
Documentation Table (below) shows the kinds of documentation that can be
entered for different types of references:

& &e‘\@ o é\é\@
‘\\Q\O S S &
o & & O N
Type of Reference |Format K® 2N QT O 2
Coil Oxxxx ° . . . °
Discrete Input Ixxxx ° ° .
Register Input 3XXXX . . .
Holding Register 4xxxX . . °
Bit Descriptor 4xxxx bits . .
Network Nxxxx . . . °
Labels Lxxxx . . . °
Segments Sxxxx . .
Program P1 . .
Drop Dhhdd . .
Rack Rhhdd . °
Slot Thhddrss . °
Extended Memory 6ff xxxx ° °
Constants # .
S901 Channel Ccc . °
5901 Input Slot Tecls . .
5901 Output Slot TecOs . .

Documenting your PLC ® 209



ProWORX NXT User's Guide

Using the Documentation window

The Documentation Window lets you enter descriptors, short comments, and
long comments for cells or networks without leaving the Network Editor. If
Symbols is selected in system Preferences, the window also displays the
Symbol associated with a selected address in logic.

You can add documentation for Oxxxx, 1xxxx, 3xxxx, and 4xxxx references, as
well as the network itself (Nxxxx).

» To edit documentation in the Documentation Window:

1. If the documentation window does not appear in the Network Editor,
on the View menu, Documentation Window. The Documentation
Window is displayed, and a checkmark appears beside the
Documentation Window option in the View menu.

If the Documentation Window in the View menu is grayed out, you do not have
an active database selected. Open or create a database before continuing.

Descriptor field — |Dezcriptor: 000118 sC:The punch station motor up control moves the Short Comment
Belt punch up away from a part. The punch station / freld
Forward upper limit {18818} is used to limit the travel.
Long Comment field Movment Punch down request must not be on {0O117}.

LC: s
¥
4 ¥

2. Select the instruction in logic to document. If you select a blank cell in
logic, the documentation you type applies to the network itself. Any
existing documentation for the selected is displayed.

3. Click the box containing the documentation (descriptor, short
comment, or long comment) you want to edit.

4. Type the new text.

S You can use the Cut (CTRL+X), Copy (CTRL+C), and Paste (CTRL+V)
K between fields. For example, select text from a short comment, copy it, then
paste it into the long comment

Do not use the cut, copy, and paste buttons on the toolbar, these functions only
operate on the instructions themselves.

5. When finished, click outside of the field to save the changes. If you
don’t want to save your edits, press ESC to exit the field.
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Using the One-Line Documentation window

The One-Line Documentation window shows your descriptors of logic
elements but takes up very little space on your screen, leaving you room to
view complex networks.

» To use the One-Line Documentation window:

1. On the File menu, click Preferences. The Preferences window
appears.

Select the One-Line Doc Window Enabled check box.
Click OK.

If the Documentation Window is not visible in the Network Editor, on
the View menu, click Documentation Window. The One-Line
Documentation Window replaces the On-Screen Documentation
Window in the Network Editor.

Descriptors appear here.

Double-click this bar to bring 000013 Weld Stn Prozimity Senszor
up the device's comments in | |
the Documentation Editor. 154_35 Quanturn 424/ Seg:M ,u

Documentation summary

The Documentation Summary provides a view-only display of descriptors,
short comments and symbols (if the Symbols option is selected in Preferences)
for all available references.

The Documentation Summary also shows whether a symbol associated with a
reference is made visible to Process Window. Process Window is an MMI
application that is available from Total Control Products (Canada) Inc.

» To display the Documentation Summary window:

1. From the Network Editor, on the Display menu, click Documentation
Summary or from the Documentation Editor, Instruction Editor,
Equation Network Editor, or Add Symbol window, click Summary.
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Documentation Summary [ %]

Dxxxx I Txxnx Bunxx | Anxrx |§fl,xm¢x| MNxxxx I Lxxx I Sxx | Macro |§II Symhulsl

Reference Descriptor

0 T

Reset Switch $FBNC
Paint Statien Senser $FSNC

Belt 2: Low Sensor #CRMO

$PSNO

Station 1 Home Lmt Switch $FSNO
Station 1 Load Lmt Switch $LSNO
Roll Form Station Sensor $LSNC
Punch Stn Proximity Sensor $CRNC
Belt 4: Low Senser $50L

FTGSNC

Station 2 Home Lmt Switch $TGSNO
Station 2 Load Lmt Switch $FLSNO
Punch Stn Lewer Lmt Switch $PRSMO
10015 Welding On Switch $FLSNO -

Short Comment:
|Conveyor belt number 1 motor contrel, This belt transfers parts past|

ok | ocancel | Edt. | Seach. | Help |

2. Select the reference type you want to view from the horizontal tab list.

* Reference: Click to view all references of one type (regardless of
whether the reference has any documentation).

* Symbol: Click to view only references which are associated with a
symbol.

If Symbols are turned off in System Preferences, the Symbol and
MMI columns don’t appear.
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Searching for specific documentation

The Documentation Search function allows you to search for references,
descriptors, blank descriptors and symbols.

» To activate the search from the Documentation Editor:

1.

On the Display menu, click Documentation Editor. You can also click
Edit from the Documentation Summary dialog box. The
Documentation Editor window appears.

Click Search. The Documentation Search dialog box appears.

Documentation Search E
8 Lol Search/Mext I
' Reference
" Descriptor Cancel |

" Blank Descriptor

£ 15pmbol

Search For:
Lo66l

Help

» To search by reference:

1.
2.

In Search By, click Reference.

If you have performed a search before, the address for the previous
search appears in the Search For. If necessary, type a new address or
reference.

Click Search/Next. After the search is performed, the search results
are displayed in the documentation fields in the Documentation
Editor or selected in the Documentation Summary list. If the search is
successful, the previous dialog box (either the Documentation
Summary or the Documentation Editor) is repositioned to the
matching record.

» To search by descriptor:

1.
2.

From the Documentation Search dialog box, click Descriptor.

Type the descriptor text in Search For. Unlike Search By Symbol, the
descriptor does not have to begin with the specified text in order for a
match to be found.

Click Search/Next. If the search is successful, the previous dialog box
(Documentation Summary or the Documentation Editor) is
repositioned to the matching record.
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» To search by blank descriptor:
1. From the Documentation Search dialog box, click Blank Descriptor.
2. Click Search/Next.

If the search is successful, the previous dialog box (either the
Summary or Editor) is repositioned to the next record that does not
have any documentation associated with it.

» To search for a symbol:
1. From the Documentation Search dialog box, click Symbol.
2. Type the symbol in Search For.
3. Click Search/Next.

The symbol must begin with the specified text for a match to be found.
Documentation Summary or Documentation Editor is repositioned to
the matching record.

Because a search continues from the last matched record, it’s possible
you won't find a match between the current position and end of the
database. In this situation, you're given the option to continue the
search from the beginning.

Using the Documentation editor

The Documentation Editor lets you describe in detail your logic addresses,
Traffic Cop Configuration and other references. You can document addresses,
networks, segments, labels, drops, racks and slots.

This documentation can be displayed automatically whenever the reference is
used in programming logic, configuring I/O, and generating printer listings.
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» To display the Doc Editor:
*  From the Network Editor, on the Display menu, click Documentation

Editor, or click @ from the tool bar. The Documentation Editor
window appears.

Documentation Editor  [10001) E

Descriptor: Symbol:

Belt 2: |BELT_2:_HIGH | | MMI

High

Sensor
Short Comment:

beltzhi
Conveyor belt number 2 forward motor control.
This conweyor transfers parts to and from load
station number 1. Motor forward control meves
parts to the roll and punch station belt.

Page Title:

‘Conveyor Belt #2 Control and Station #1 LoadsUnload Control |

Long Comment: HNext Available | 1 Leading ¢ Trailing Expand

(Coil 99033 in the 68%) sets the model in a manual control mode‘ﬂ

Navigate By |ets\8tat1’on number 1 and conveyor belt #2 can be controlled manually

you toggle between =
navigating by Ref- Navigate By:
erence in sequen- ¥ Reference B Copy Record | Cut Record
tial order or by " Symbol — ~® Paste Record | Delete Record
Symbol in alpha- -
betical order. 0K Cancel | Summary... | Search... | 0. | Add Bits | Help
A ~
/

The Entry field control lets you type a
reference or symbol. NXT automatically
takes you to the selected record.

These buttons display
records relative to the
current record.

When you click jll or type a reference or symbol to move to a new
record, changes made in the previous record are automatically saved.

» To go to logic at the currently-displayed reference:

*  Click Goto to return to the Network Editor and search for the address
or symbol displayed in the Navigate By area. From there, you can
select any occurrence of that address in logic.
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» To enter Descriptors, Short Comments, Page Titles, and Symbols:
1. Click the respective field to place the cursor there.

2. Type your text. You can cut (CTRL+X), copy (CTRL+C), and paste
(CTRL+V) selected text within a field, or among fields. For example,
you can select text from Short Comment, copy it, then paste it into
Long Comment.

If the text you have typed does not fit in the first line of the field, text
in the Descriptor and Short Comment boxes wraps onto several lines.

3. Click anywhere outside the field to record your changes.

> To enter long comments:

1. From the Doc Editor, type the reference type associated with the
comment. When you type the reference type in Navigate By, the
documentation accompanying the reference is displayed.

Comments can be associated with multiple references. Only one long
comment can be associated with a reference; however, a single long
comment can be associated with any number of references within the
database. Long comments can be as many as 32,000 characters long
and can be printed in network listings.

¢ If the Long Comment number is greater than 0, you can expand its
display. Click Expand to show the Long Comment dialog box.

* To find the next unused Long Comment number, click Next
Available.

Long Comment Editor  [#2] E

(Coil DEO33 in the B85) sets the model in a manual control mode. e
Station number 1 and conveyor helt #2 can be controlled manually
from OuickPanel #7

216 @ Using the Documentation editor



Chapter 8 Documenting your PLC

2. Enter your changes.

If you are deleting a Long Comment, be aware that there may be other

@ references associated with this Long Comment. Deleting the text of the comment
may also affect other references. As an alternative, you can set the Long
Comment number to zero. This breaks the association of the current reference
with the Long Comment while leaving the text of the comment intact.

Click OK. The edit box is updated to the next blank Long Comment
and the text in the Long Comment dialog box is cleared.

Select where in the Lister printout the Long Comments are to appear:
* Leading: The comment printed before the network;

* Trailing: The comment printed after the network.

Moving, copying, and deleting multiple records

All documentation for a single reference is stored in a database record. There
are four operations you can perform on a record:

Copy Record: Copies all documentation, except the Symbol and MMI
fields.

Cut Record: Copies all documentation, except the Symbol and MMI
fields, and deletes the record.

Paste Record: Pastes all documentation fields from the most recent
Copy Record or Cut Record operation. Paste overwrites only the
enabled fields of the currently selected reference with the exception of
the Symbol and MMI fields. You can paste the same record into
multiple references.

Delete Record: Deletes all the documentation for the current record.

» To insert text from one reference into another reference:

Ll N

Type the reference to copy in the Navigate By entry field.
Select the text to copy and press CTRL+C.
Type the reference where you want to paste the text.

Select the documentation field you want to paste the text into and
press CTRL+V. You can paste text into multiple references, by selecting
one reference at a time and repeating Step 4.
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» To copy a long comment number into multiple records:

1.

Type the reference where the Long Comment is located. Remember
the number of the Long Comment you want to tie to the different
references. The number is located in the entry field beside Next
Available.

Click jll to find the reference where you want to associate the Long
Comment to.

In Long Comment, type the Long Comment number.

Press TAB or click out of the entry field. As soon as you select another
reference number, the Long Comment is automatically tied to the
previously selected reference.

> To copy a long comment:

1.

AL N

From the Long Comment box, select the text to copy.

Press CTRL+C.

Type the destination reference in Navigate By.

Click Next Available.

Click in the Long Comment box.

Press CTRL+V. The Long Comment is duplicated each time you paste.

Adding 4xxxx Bit descriptors

The Add Bits functions is only enabled if the current reference is a 4xxxx
address.

» To add bit descriptors for a specific 4xxxx address:

1.
2.

Type a 4xxxx address in the Navigate By entry field.
Click Add Bits. The button is replaced with Remove Bits.
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Documentation utilities

Normal database editing functions may require you to move, copy, or delete
documentation.

Moving documentation

Move lets you select a range of documentation records to a new location.

» To move documentation records:

On the Display menu, click Documentation Utilities. The
Documentation Utilities dialog box appears.

Documentation Utilities [ %]
@ Move Source Range Start 1
O Copy Source Range End l:l
C Delete Destination l:l

- ﬁlall - Cancel | Cleanup | Help |

Select Move, if it’s not the selected function.

Type the starting address of the source range in Source Range Start.
A Source Range End is automatically entered. To move more than one
record, change the Source Range End.

Click Start. Documentation records within the entered range are
deleted from their old locations and placed in the new ones. Existing
documentation records in the destination range, they are overwritten.

For example, you can select records associated with addresses 40125
through 40150 and move them to 40250. When complete, new records
are created containing the documentation from the source range of
records for 40250 through 40275. The records associated with 40125
through 40150 are deleted. If records exist for any of the destination
range records, they are overwritten with the new documentation data.

You can also move documentation from one type of database record
to another (for example, NOOO1 to 00001).

If you move, delete, or add new records to the database, click Cleanup when
you've finished to eliminate empty records in the database structure.
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Copy documentation

Copy Records works the same as Move, except the source records are not
deleted. They retain their original contents; only copies of the documentation
text are placed into the new range of records.

» To copy documentation records:
1. On the Display menu, click Documentation Utilities.
2. If Copy is not the selected function, click Copy.

3. Type the starting address of the source range in Source Range Start.
The Source Range End is automatically entered. To move more than
one record, change the Source Range End.

4. Click Start. The Copy operation makes an identical copy of the source
records without changing the source records in the new location.

Delete documentation

Delete Documentation lets you remove documentation records within a
specified range.

» To delete documentation:
1. On the Display menu, click Documentation Utilities.
2. From the Documentation Utilities dialog box, click Delete.

3. Type the starting address of the range of records you want to delete.
An ending address is automatically added. The start and end range
descriptor record types must be the same.

4. Click OK. Documentation records within the range are marked as
deleted. To free up disk space, use the Cleanup function.

» To clean up moved or deleted records:

* (Click Cleanup to remove all data from records marked as deleted and
decreasing the DDF file size.

Importing/exporting databases

NxT imports and exports database documentation in several formats. The
Documentation Import feature lets you bring documentation from existing
files or databases into NxT without having to retype. Documentation Export
lets you edit documentation in a separate word processing or spreadsheet
program.
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Importing database documentation into ProWORX NxT

You can import descriptors and comments from files and other databases into
your current database.

j This function does not import controller logic.

®,

”oe

Q

For information about importing logic, see “Opening an existing database” on
page 17 or see “Loading blocks of logic from disk (offline only)” on page 172.

NxT can import documentation from these types of files:

ProWORX ASCII (.FIL): files containing descriptors, short comments,
and page titles exported from databases.

When importing an .FIL file, you can add the new information to your
database without overwriting any existing data. Overlay the new
information onto your existing data, overwriting it where necessary or
replace all existing data with the new information.

ProWORX Symbol (.FIS): ProWORX products generate this type of
file when exporting symbol and controller address information.

Updoc ASCII: NxT requires both the .ASN and .ASR files from the
Updoc database to import the documentation successfully.

Updoc descriptors overwrite all information in the first six descriptor
fields of your NxT database. If your database has fewer than six
descriptor fields, an error message appears during the import process.
To change the number of fields in your database, on the File menu,
click Utilities then click Database Setup.

For more information, see “Editing the setup of a database” on
page 19.

Graysoft: NxT requires both the .LAB and .HDR files from the
Graysoft database to import the documentation successfully. Graysoft
descriptors overwrite all information in the first three descriptor fields
of your NxT database.

Ladder Doctor: NxT requires the .TXT file from the Ladder Doctor
database to import the documentation successfully.

Ladder Doctor descriptors overwrite all information in the first four
descriptor fields of your NxT database. The five-character Ladder
Doctor names are imported into the first descriptor field of the NxT
database and the eight-character descriptions fill the remaining three
fields.
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Spreadsheet Data Interchange Format (.DIF): You can import .DIF
files created by spreadsheets as your database documentation.
However, you must take special care when importing databases from
Microsoft Excel.

For more information, see “ Appendix E - .DIF Files and Excel”.

Spreadsheet descriptors overwrite all information in the first nine
descriptor fields of your NxT database. If your database has fewer
than nine descriptor fields, an error message appears during the
import process. To change the number of fields in your database, on
the File menu, click Utilities, then click Database Setup.

For more information, see Editing the setup of a database on page 19.

dBaselV Database (.DBF): You can import .DBF files created by
dBaselV or other data management and spreadsheet programs
(including Microsoft Excel).

For best results, configure the .DBF file for nine descriptor fields
before you import it into NxT, regardless of how many descriptor
fields your database uses. Although, you will not receive an error
message during the import if the .DBF has fewer fields, its short
comments may become garbled.

When you import a .DBEF file, you can choose to add the new
information to your database without overwriting any existing data;
overlay the new information onto your existing data, overwriting it
where necessary; or replace all existing data with the new
information.

Traffic Cop (.TEF): Importing a .TEF file overwrites the existing
Traffic Cop data. Exporting creates a .TEF file of the current Traffic
Cop data. NxT requires both the .TEF and .DEF files to successfully
import the documentation.

If a mismatch occurs between the database and the import file, a
message box appears displaying the mismatch in yellow.
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» To import database documentation:

1. From the Network Editor, on the File menu, click Utilities then click
Import/Export. The Import/Export Utilities dialog box appears.

Import/Export Utilities [ %]
@® Import Filename: [C:\PROWDRX\NXT\NEWDATA/FIL |
OExport | | File Iype: [PraWORX/ASCII (FIL) =l

Options
@ Add Imported D to Datab

O Overlay Imported Descriptors

O Create New Datab uzing Imported D p
Start | Cancel | Browse | Help |
Click Import.

Type the path and file name of the database to import or click Browse

to navigate to it.

Select the File Type of the database to import from the drop-down list.

the new data will enter your database.

If you're importing a ProWORX .FIL or dBaselV .DBF file, choose how

* To add the imported descriptors to the database without changing
any of its existing descriptors, click Add Imported Descriptor to

Database.

* To overwrite the database’s existing descriptors with new ones
from the imported file, click Overlay Imported Descriptors. Empty
fields in the imported file will not erase descriptors in the open

database.

* To erase all descriptors from the open database except those from
the imported file, click Create New Database Using Imported

Descriptors.

Click Start. The documentation is imported into your database.
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Exporting database documentation from ProwWORX NxT

You can export descriptors and comments from your database to an ASCII file.
You can then edit your documentation in the word processor or spreadsheet

program you use.

f This function does not export controller logic.

3

*

For information about exporting logic, see “Saving blocks of logic to disk (of-
fline only)” on page 171.

ProWORX NxT exports documentation in a database to these formats:

ProWORX ASCII (.FIL): files for exchanging data easily. By default,
NxT creates this type of file for documentation.

When exporting information to a ProWORX ASCII file, you can
choose whether you want the data written to the file sequentially
(slower to create, but generally less confusing to edit because the
information is in order) or randomly (faster to create, but sometimes
more confusing to edit because the information in whatever order
NxT finds it).

ProWORX Symbol (.FIS): files for exchanging symbol and controller
address information.

Spreadsheet Data Interchange Format (.DIF): NxT creates standard
.DIF files. Most spreadsheet programs can this format without
difficulty. However, you must take special care when transferring
data to and from Microsoft Excel in .DIF files.

For more information, see ““ Appendix E - .DIF Files and Excel” on
page 369”.

dBaselV Database (.DBF): NxT creates standard .DBF files for use
with Ashton-Tate’s data management program dBaselV. Most other
data management and spreadsheet programs (including Microsoft
Excel) can read this format without difficulty.

When exporting a database to a .DBF file, each descriptor field and
short comment becomes its own record. NxT generates nine records
for your descriptor fields regardless of how many you have
configured in your database.
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* Traffic Cop (.TEF): Importing a .TEF file overwrites the existing
Traffic Cop data. Exporting creates a .TEF file of the current Traffic
Cop data. NxT requires both the .TEF and .DEF files to successfully
import the documentation.

If a mismatch occurs between the database and the import file, a
message box appears displaying the mismatch in yellow.

» To export database documentation:

1. From the Network Editor, on the File menu, click Utilities then click
Import/Export. The Import/Export dialog box appears.

Import/Export Utilities [ =]

O Import Filename: |C:\PRDWDRX\NXT\NEWDATA.FIL ‘

® Export

Descriptor Order

) Seguential [Slow)
@ Random [Fast)

) Spreadsheet _DIF file

Symbol FIS file
Cse [" Export Extended Memory Doc

Start | Cancel | Browse | Help |

Select Export.

Type the path and file name of the file to export your database to or
click Browse.

Click the File Type to create.

If you are exporting to a ProWORX ASClI file, choose how the file data
will be written.

* Sequential writes are slower, but the file may be less confusing to
edit as NxT sorts the information before exporting it.

* Random writes are considerably faster, but may be confusing to
edit as the information is exported in whatever order NxT finds it.

6. Click Start. NxT tells you the status of the export.
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Introduction to Equation Networks

An Equation Network provides an easy way to program complex math
functions, with values stored in register locations. Equations in an Equation
Network are presented in a regular, left-to-right format, technically known as
“infix” notation. You program Equation Networks and set its enable contact
and output coil(s) in the Equation Network Editor.

Equation Networks were introduced in Quantum Rev. 2 controllers; not all
controllers support Equation Networks. The easiest way to see if your
controller supports Equation Networks is by trying to create a new one — if
your controller doesn’t support it, the Equation Network option on the Insert
menu won’t be available.

» To create a new Equation Network:

1. Inthe main Network Editor, move to the logic network where you
want the new Equation Network. Each Equation Network takes up an
entire network’s worth of logic.

2. Click Edit, then from the Insert menu, click Equation Network. The
Equation Network Editor display appears and a blank Equation
Network is inserted into your logic.

» To edit an existing Equation Network:

1. Inthe main Network Editor, move the cursor to the top row of the
Equation Network you want to edit.

2. From the Edit menu, click Edit Equation Network. (When the cursor
is on an Equation Network, this option replaces Edit Instruction in the
Edit menu.)

-Or -

Double-click anywhere in the Equation Network.
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The Equation Network Editor display
The Equation Network Editor display looks like this:

Each element of an 4

equation takes up a
certain amount of
space, measured in
“nodes”. This text tells
you how much space

you have left.

You select an enabl
contactand its register
address in this panel.

Edit Equation Network E
Modes Used: 14781 Coils | Ops | Funcs | Symb
Enable Contact: Tlllgll]&]ﬁ:ml]l]zu + COS(40003UL) = #.000135F / _@_ Solved UK\\ These buttons
switch be-
- Pesul <0 tween four
Ao Y different pan-
/- @ nC '@' els in the
Result > 0 Equation Net-
e -®- W?)rk Editor:
— — () 0Open _®_ Error Coils
(shown), Op-
/ erators, Func-
tions, and
1].4 /l Cancel Used. .. | Summary... I\ Help | SymbOIS-
yA N\
/
The equation appears in this Click for a list of Click to view the
editor. You can type the equa- previously-used Descriptor Sum-
tion in directly, if you wish. addresses. mary.

The register addresses for the Equation Network’s output coils are set in the
Coils panel. While you can type in the equation from the keyboard, three list
panels. For example, the Operators, Functions and Symbols panels —let you

insert items directly into your equation.

» To add an item from a list panel to your Equation Network:

1. Select the list panel from which you want to add an item.

2. Move the equation cursor to where you want to add the item.

3. Inthelist box, double-click the item you want to add. If any text within
the equation is selected, the new item will replace it.

-Or -

Drag the item from the panel onto the equation or address box.
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Coils panel

You set addresses for the output coils in the Coils panel. There are five possible
output coils for an Equation Network:

Solved OK is set when the equation is being solved without errors.

Result<0 is set when the equation result is less than zero.

Result=0 is set when the equation result is equal to zero.

Result>0 is set when the equation result is greater than zero.

Error is set when errors have occurred while solving the equation.
While online, if the Error coil receives power, an error message will
appear under the coil describing the error.

Q9 ®0e

» To change an address for one of the output coils:

*  From the Equation Network Editor, click the appropriate text box in
the output coils panel and type the register address for that coil. You
can enter either the direct address (in X:Y numeric format) or a
symbolic address. You can also insert addresses from the Symbols list
panel, Used Register Address table and the Descriptor Summary.

i If you don't want to use a particular output coil, leave the address for that coil
K blank (or erase one already typed in). That coil will not be included in the
Equation Network.

Operators list panel

The Operators list panel contains a list of mathematical operators recognized
by the Equation Network Editor. This includes operators for addition,
multiplication, exponentiation, boolean, and comparison operations. You can
insert an item from the Operators panel directly into your equation.

% Foracomplete list of operators and their meanings, see “Mathematical
operations in equation networks” on page 233.
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Functions list panel

The Functions list panel contains a list of standard math functions you can
include in your equation. Each of these functions takes one argument enclosed
in brackets following the function name. The argument can be any valid value
or expression. For example, COS(#35+40001) returns the cosine of 35 plus
the number stored at address 40001. You can insert a function from the
Functions panel directly into your equation.

7

% For a complete list of functions, see “Mathematical functions in
equation networks” on page 237.

Symbols list panel

The Symbols list panel contains a list of all previously-defined symbols for use
in an Equation Network. You can insert an item from the Symbols panel
directly into your equation, an output coil address box or the enable contact
address box.

% For more information on symbols, see “Symbolic addressing” on page
164.

Equation format

ProWORX NxT expects equation elements to appear in a specific format.
Operations and functions each have their own format. Also, for each value,
you must specify what kind of value it is (register address, constant or symbol)
and its data type (signed integer, unsigned integer, etc.).

Equation values and data types

Each value can refer to a constant, register address or symbol. The Equation
Network Editor determines which one it is based on the following format:

Format Meaning Example
Default Register address | 40001

(no # sign or single quotes)

Prefixed by # Constant #123
Enclosed in single quotes Symbol "HEIGHT’

Equation values and data types ® 231



ProWORX NXT User's Guide

The actual data type of a value is determined by its suffix, as shown in the

following table:
Suffix Meaning Example
None 16-bit signed integer #38
U 16-bit unsigned integer 400010
L Long (32-bit) signed integer #-123L
UL Long (32-bit) unsigned integer | “HEIGHT'UL
F 32-bit floating point (real) #+1.45E-4F

Typically, you'd first indicate the register address where the calculated result
is to be stored, followed by an equal sign (the “assignment operator”),
followed by the calculation itself. For example:

40001 = 40002U + COS(40003UL) * #+1.35E-4F / 'HEIGHT'L
* 40002U is an address of a 16-bit unsigned integer.

* COS(40003UL) calculates the cosine of a long (32-bit) unsigned
integer value stored at address 40003.

*  #+1.35E-4F is the floating point value of 0.000145, given in
exponential notation.

* 'HEIGHT'L isasymbol of the name HEIGHT, representing the
address of a long (32-bit) signed integer.

e 40001 = indicates that the result of the calculation is to be stored in
register address 40001 as a 16-bit signed integer.

Everything to the right of the assignment operator also constitutes an
expression. An expression is any part of an equation that can be evaluated to
a single value. This can be a single constant or register address, or a complete
mathematical operation. For example, #35 is an expression, as are LOG(#10)
and 40002U + COS(40003UL) . Complex expressions can contain other
expressions within them, as in #3 * (40002U + COS(40003UL)) . For the
most part, any operator or function can be performed on any expression, no
matter how complex.

S Itis good programming practice to enclose all expressions in parentheses, even
K when they’re not actually needed. This makes the equation easier to read and
ensures that operations in an equation are solved in the correct order.
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Exponential notation
Floating point numbers are normally specified in exponential notation, as in:
+1.35E-4

This represents 1.35 times 10 to the -4th power, or 1.35 times 0.0001. Thus, we
would shift the decimal place four places to the left to get 0.000135. The “-4 ”
part is called the exponent (note the preceding “E”) and can be a positive or
negative number.

In the Equation Network Editor, you must also indicate:
*  That these numbers are constants; and
*  Their data types. For example, integers or floating point numbers.

The default data type is unsigned 16-bit integer. So, since the above value is a
fraction (and therefore must be a floating point number), it would have to
appear as #+1.35E-4F

With no data type suffix, numbers in exponential notation are assumed to be
integers. For example, #+1.35E+2 represents the unsigned 16-bit integer
value 135. Exponential notation is particularly useful for very large integers.

Mathematical operations in equation networks

The following table lists the mathematical operations you can include in your
equation.

Assignment operator = Assignment.
The assignment operator = is used to
assign a storage place for the results of
the equation. All equations will use
the assignment operator. The format
is:

ADDRESS = EXPRESSION
Where ADDRESS is a valid register
address and EXPRESSION is a valid
value or expression assigned to the
address.
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Unary operators

“Unary” means “single”, so unary
operators are used on only one value.
The unary operator is placed just
before the value or expression to
which it is applied. For example, -

Negation. The result is -1 times the
value.

Ones complement. This works on
the binary representation of a value:
all 1s are changed to Os and vice

(30002) returns -1 times the number versa.

stored at address 30002.

Exponentiation operator * Exponentiation.
Takes values to a specified power.

40001**3  returns the (integer) value

stored at 40001, taken to the third

power.

Arithmetic operators * Multiplication
These require two values, one before .

and one after the operator. These / Division
values can be any valid expression.. + Addition

For example, #4 * 40003  results in

four multiplied by the value stored at | - Subtraction

address 40003.
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Bitwise operators & AND. The single bit result of an
Bitwise operators work on binary AND operation is only true (1) if
(base 2) representations of values. both bits are set to 1.
¢ Inthe case of AND, OR and XOR, - -
the computer applies the operator | OR. The smgle bit re§ul’F of an OR
to each digit in the two values: operation is true (1) if either bit is
010 XOR 011 (2 XOR 3 in set to 1. The result is false (0) only if
decimal numbers) results in 001 both bits are set to 0.
(Iin decimal). o A XOR, short for “exclusive or”. The
¢ Inthe case of shl.ftmg op.er.atolrs, single bit result of an XOR
the cgmputer shifts aH. digits in operation is false (0) if both bits are
the binary representation of the the same, true (1) otherwise.
number the given number of
places to the left or right. Digitson | << | Left shift. The result of 40001<<#2
one side of the number are lost, is the binary representation of the
and zeros fill in the blanks on the number stored at 40001 shifted left
other side. For example, for 8-bit two (#2) places. Zeros are added on
numbers, 77 <<2  means the right to fill in the gap.
01001101 shifted left two digits.
The binary result is 00110100, or | >> | Right shift. The result of
52 decimal 40001>>#2 is the binary
representation of the number stored
at 40001 shifted right two (#2)
places. Zeros are added on the left
to fill in the gap.
Relational operators < Less than.
These operators describe a comparison
between two values or expressions. <= | Less than or equal to.
The result is always true (1) or false _ Equal to.
(0). For example, #35 <= #42
evaluates to 1 (true). <> | Not equal to.
Relational operators are used in
Conditional expressions. => | Greater than or equal to.
> Greater than.
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Conditional operators ?: | Used in a conditional expression.
See page 236 for details.
Parentheses ()

Used to set precedence in solving
equations. To make sure certain
operations are solved before others,
enclose those operations in
parentheses.

Conditional expressions
In Equation Networks, conditional expressions take the following form:
EXPR1 RELOP (EXPR2) ? (EXPR3) : EXPR4

EXPR1 through EXPR4 can be any address, value or expression. If EXPR2 or

EXPRS3 are not single values or addresses, they must be enclosed in brackets.

RELOP can be any relational operator, such as > (greater than) or <> (not equal
to).

When solving a conditional expression, the computer first compares EXPR1
and EXPR2, based on the relational operator. If the comparison is true, the
value of the conditional expression is the result of EXPR3. If the comparison is
false, the value of the conditional expression is EXPR4.

— It is especially good programming practice to enclose all expressions within a
K conditional expression in parentheses, even when they’re not actually needed.
This makes the equation easier to read and ensures that operations are solved
in the correct order.
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Mathematical functions in equation networks

The following table lists the pre-defined math functions you can include in
your equation. Each of these functions takes one argument enclosed in
brackets following the function name. The argument can be any valid value or
expression. For example, COS(#35+40001) returns the cosine of 35 plus the
number stored at address 40001. In this table, X refers to a function’s argument
(as in “COS(X)").

ABS(X) Absolute value of X (i.e. negative numbers become positive).
ARCCOS(X) | Arc cosine of X radians.

ARCSIN(X) | Arc sine of X radians.

ARCTAN(X) | Arc tangent of X radians

COS(X) Cosine of X radians.

COSD(X) Cosine of X degrees.

EXP(X) Calculates e (approximately 2.7182818) to the Xth power.
FIX(X) Converts floating point number X to an integer.
FLOAT(X) Converts integer X to a floating point number.

LN(X) Natural (base ¢) logarithm of X.

LOG(X) Common (base 10) logarithm of X.

SIN(X) Sine of X radians.

SIND(X) Sine of X degrees.

SQRT(X) Square root of X.

TAN(X) Tangent of X radians.

TAND(X) Tangent of X degrees.
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Using register address lists

Click the Used to bring up a list of previously-used addresses — register
addresses that have been used elsewhere in your logic database.

Click the Summary to bring up the Descriptor Summary display for the
address currently selected. This includes addresses for output coils and the
enable contact. If the cursor does not highlight a register address, the
Descriptor Summary will jump to address 00001.

Addresses from both tables can be inserted directly into the equation.

» Toinsert an address from the Previously-Used Address table or
Descriptor Summary:

1. Move the cursor to the spot in the equation (or to a coil address box)
where you want to insert the address.

Click Used or Summary. The appropriate table appears.

Navigate through the table until you find the address you want to add
to the equation.

4. Double-click that address. The address is inserted at the current cursor
position. If any text was selected, it will be overwritten.
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Setting up an enable contact

An Equation Network’s enable contact, when set, activates the Equation
Network. If an enable contact passes current, the Equation Network will be
solved. You change settings for the enable contact in the Enable Editor display.

» To select a type for the enable contact:

Select the symbol of the enable contact that corresponds with your
chosen type. An enable contact can be a normally-open contact(-] }-),
normally-closed contact (-}f}-), horizontal short ( ), or a
horizontal open (= =).

» To select a register address for the enable contact:

In the Enable Contact address field, type the direct address (in X:Y
numeric format) or symbolic address for the enable contact coil. This
field is only available if the enable contact type is a normally-open or
normally closed contact.

-Or -
Insert an address into the Enable Contact address field from the

Symbols list panel, Used-Register Address table, or the Descriptor
Summary.
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Equations displayed within the Network Editor

When you scroll to an Equation Network from the main Network Editor, the
display will show the text of the equation you created, along with any input or
output coils. There are several things to keep in mind when viewing Equation
Networks from the main Network Editor:

Blocking: Blocking operations on Equation Networks are limited to
single cells or full network blocks. The only blocking operation not
allowed is a block save —saved blocks cannot have Equation
Networks.

Cursor movement: You can only move the cursor onto the input
contact or output coils of an Equation Network.

Cut and Paste: You can Copy part of the Equation Network into the
clipboard, but you cannot Paste into it. Similarly, the Cut operation
will copy material into the clipboard, but will not delete anything. The
Equation Network Editor must be used for modifying Equation
Networks.

Display menu: Tables and lists created using commands from the
Display menu will include items used in Equation Networks.

Find, Locate Coil and Global searches: All search operations will find
(and replace) searched-for items within Equation Networks. The
search result tables will show “Eqn” for any addresses that are part of
the actual equation of an Equation Network.

Instruction Speed buttons: These have no effect when viewing
Equation Networks.

Online mode: Power flow is shown using settings from the Network
Display setup dialog box. Any contact or coil receiving power will
show power flow. If the enable contact passes power, the equation box
will also change to show power flow.

Forcing an Equation Network output coil on or off affects how power is passed

@ through that coil; however, the power flow of the output coil itself is still displayed
based on the status of the Equation Network. For example, “Result>0" will still
show power if an Equation Network’s Result is greater than 0. This may make for
some strange visual effects, such as an output coil that seems to be passing flow
but doesn't affect anything that follows.
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The following Network Editor features are disabled when you move the
cursor onto an Equation Network:

* Assembly Register (AR) operations that modify parts of an Equation
Network. Functions that force discrete variables will work as usual.

* Insert Row/Column
* Delete Element/Row/Column

* Drag and drop operations from side panels.
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Introduction to the PCFL editor

The PCFL Editor simplifies the entry of PCFL instruction block data. It
replaces the Register Editor for PCFL blocks.

The PCFL instruction block is a multi-function block. There are many different
PCFL subfunctions that use the same basic instruction block. While each PCFL
instruction block uses a similar arrangement of registers and status flags, the
registers and flags for each subfunction have different meanings. The PCFL

Editor provides a way to configure a PCFL block without concern for which
register to set.

The PCFL Editor also simplifies editing of the PCFL Equation subfunction. The
PCFL Equation block stores the equation as a series of registers, in a format
that may not be intuitive to a database developer.

» To open the PCFL Editor:
1. Move the network cursor onto the PCFL block you want to edit.
2. Do one of the following:
* On the Data menu, click Register Editor.
* Press CTRL+R.

* Right-click the PCFL block, then select Register Editor. The PCFL
Editor dialog box appears.

The title bar displays the

name of the PCFL sub- — CNTILa This table di
function you are editing. A 1S ?h er 'Si'
Description |Add|essf5ymhol |Dala pd plays Z beg f]
Raw Input 40001 00010001-11011010 ters used by the
Status Dutput 40003 00000000-00000000 subfunction and
Status Input 40004 00001010-00000000 the type of infor-
This diagram shows how High Engineering Hange 40005 3Jooo mation they hold.
the subfunction appears in Low Engineering Range 40007 2500
app Manual Input 40009 30
the Network Editor. Auto Input 40011 100
Scaled Engineering Output | 40013 25
Input Flags...
Dutput Flags.._
40013 |
Close | Edit... | Doc... Badix___ Inst Help Help |
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Editing PCFL registers

The PCFL Editor dialog box contains a table showing a PCFL function’s
register addresses, along with their labels and current values. A register’s
current value is displayed in an appropriate radix (the base of a number system
used by ProWORX NxT to refer to a value’s data type). The radix of each data
item can be changed to allow display in a variety of number formats.

Depending on the specific PCFL instruction, up to three buttons might also
appear to the left of the register table:

Input Flags: Click to view and edit a PCFL instruction block’s input
flags.

Output Flags: Click to view a PCFL instruction block’s output flags.

Eqn Edit: Click to edit the equation in a PCFL Equation instruction
block.

These functions are covered further later in this chapter.

» To change the displayed data type of a PCFL register:

1.

In the table, click the Description, Address/Symbol or Data of the
register you want to reformat. The selected register’s Address/
Symbol and the first line of its Descriptor (if any) appear at the bottom
of the register table.

Click Radix.
Select the desired radix from the Radix Options box and click OK.

» To edit the value of a register:

1.

In the table, click the Description, Address/Symbol, or Data of the
register you want to change. The selected register’s Address/Symbol
and the first line of its descriptor (if any) appear at the bottom of the
register table.

Click Edit. An Edit dialog box appears based on the radix of the
register you want to edit. The Edit dialog box for binary values is
especially different from that of other radixes.

For information on editing binary values, see page 246.
Do one of the following, then click OK:
* Type the new input value for the register.

* Type binary values bit-by-bit in the Edit Binary dialog box.
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* Type values in other radixes in the supplied text box.

To get help on a specific PCFL instruction, click Inst Help for help on the
currently-displayed PCFL instruction block function.

» To edit a binary value:
1. Inthe Binary box, click the bit you want to change.
2. Do one of the following, then click OK:
* Set: Click to change the bit to 1.
* Reset: Click to change the bit to 0.
You can also change all the bits at the same time:
* Set AlL Click to change all bits to 1.
* Reset All: Click to change all bits to 0.

Editing PCFL input/output flags

The Input and Output flags of many different PCFL subfunctions are stored in
the same register. However, each subfunction interprets the flags differently.
When editing Input/Output flags, the PCFL Editor automatically determines
the meaning of each flag for the PCFL subfunction being edited.

Most PCFL flags use one bit of information and can be set to only two values
(usually “on” and “oft”).

Input flags with more than two settings use multiple bits. The PCFL Editor
determines how to change each bit automatically. For example, within the
input flags for the PCFL Analog Input instruction block is the Module Output
Format, which takes up five bits of information. When setting the Module
Output Format, you don’t have to change the five bits individually. Instead,
you select a Module Output Format from a list and the PCFL Editor changes
the appropriate bits.

®,

% To customize the display and flag list for a subfunction’s input and
output flags, see Customizing the PCFL Configuration File on
page 255.
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» To view a PCFL block’s input flags:

*  From the PCFL Editor, click Input Flags. The Input Flags dialog box
appears.

Input Flags

» To edit a PCFL block’s input flags:

1. From the Input Flags dialog box, click Set. The Set Inputs dialog box
appears.

Set Inputs
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2. The Set Inputs dialog box displays every input flag used by the
instruction, along with a list box for each flag. To change a particular
flag, select the new setting from its box.

3. Click Apply to confirm your changes.

4. When you're done, click Close. You are returned to the Input Flags
dialog box. Your new settings should be reflected in the Input Flags
display.

» To view a PCFL block’s output flags:

*  From the PCFL Editor, click Output Flags. The Output Flags dialog
box appears.

Output Flags
Dutput Flags
’7400003 ‘
M5B L5B
| 0000 OD10 - 1100 00DO0OD |

While online, output flag

labels that are On (1) \ Math Exror

appear yellow. Crossed limits

Under Range

Help
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Editing the PCFL equation block

The PCFL Editor provides two different methods of editing equations in the
PCFL Equation block: as a series of registers and as a line of text.

» To edit a PCFL equation:
1. Move the cursor onto a PCFL Equation instruction block.

2. To open the PCFL Equation Editor dialog box, do one of the
following:

* On the Data menu, click Register Editor.

* Press CTRL+R.

* Right-click the PCFL block, then select Register Editor.
The PCFL Editor dialog box appears.

3. Click Eqn Edit. You can edit the PCFL equation in either infix (left-to-
right) or postfix notation. A toggle button at the bottom lets you
change between the two formats.

* Click Equation to switch to regular, left-to-right infix notation. This
is the easiest way to edit PCFL equations. This is the default mode.

ABS = absolute + = addition

! = division EXP = exponent

LN = natural log LOG = logarithm

SQRT = square root = = subtract

SIN = sine = = multiply

= = negate - = power

Cos = cosine TAN = tangent

ARCSIN = arc sine ARCCOS = arc cosine

ARCTAN = arc tangent

A = variable a B =variable b

C = varnable c D =variable d
‘[[(#32]'5]!9] ‘

(1] 4 | Cancel Edit... Post Fix Help |
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* Click Postfix Entry to edit the equation registers directly.

Equation
40015 VAR A 40032 NOP 40049 |NOP
40016 Int 16 Bit 40033 NOP 40050 | NOP
40017 32 40034 NOP 40051 | NOP
40018 SUB 40035 NOP 40052 | NOP
40019 Int 16 Bit 40036 NOP 40053 | NOP
40020 5 40037 NOP 40054 | NOP
40021 MULT 40038 NOP 40055  NOP
40022 Int 16 Bit 40039 NOP 40056  NOP
40023 9 40040 NOP 40057 |NOP
40024 DIV 40041 NOP 40058  NOP
40025 NOP 40042 NOP 40059 | NOP
40026 NOP 40043 NOP 40060  NOP
40027 NOP 40044  NOP 40061 | NOP
40028  NOP 40045 NOP 40062  NOP
40029 NOP 40046 NOP 40063 | NOP
40030 NOP 40047 NOP 40064  NOP
40031 NOP 40048 NOP 40065 HOP ™
0K | Cancel | Edit... | Equation | Help

Editing the PCFL equation as text

With the PCFL Equation Editor, you can enter an arithmetic formula in a
regular, left-to-right format, technically known as “infix notation”. The PCFL
Editor converts the equation to the format expected by the PCFL block, storing
it in the equation registers.

» To enter a PCFL equation as a string of text:
1. From the PCFL Editor, click Eqn Edit.

If the PCFL Equation Editor dialog box shows a table of registers, click
Equation. The Equation Entry dialog box switches to Equation mode.

Type your equation in the text box.
3. Click OK.

If the PCFL Editor locates errors in the equation, you're returned to the Equation
dialog box.

PCFL editor equation text format

An equation is an expression, composed of operands and operators.
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Operators are the mathematical operations that you perform on
values. For example, an asterisk (*) is an operator representing
multiplication.

Operands are the values that an operator works on. Operands can be
any valid expression. Most operators require two operands; the
exception is negation (the “- ” operator) which requires one.

In a PCFL equation, functions are predefined calculations performed
on single expressions. For example, ARCTAN(B*3) calculates the arc
tangent of three times the value stored in variable B.

Expressions normally refer to an operator together with its required
operands. It can also be a constant value, a variable, or a function. For
example, 3 + SIN(A*2) is a valid expression, as are SIN(A*2) ,

A*2 and A.

To ensure expressions are calculated in the correct order, enclose all
relevant expressions in parentheses. For example, 3 * (4 + 2) s
calculated as 3 times 6, or 18, while (3 * 4) + 2 is calculated as 12
plus 2, or 14.

The PCFL Equation block supplies four variables: A, B, C and D.

Equation Operators

You can use the following operators in your equation:

Operator | Meaning Example Result
- negation -3 negative 3
- subtraction 3-2 1
/ division 3/2 1.5
+ addition 3+2 5
* multiplication 3*2 6
N power (exponentiation) 3n2 9 (thatis, 3 * 3)
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Functions are applied to a single expression enclosed in parentheses after the
function name. You can use the following functions in your equation:

Function Meaning
ABS absolute value
LN natural log
SQRT square root
SIN sine

COSs cosine
ARCSIN arc sine
ARCTAN arc tangent
EXP exponent
LOG logarithm
TAN tangent
ARCCOS arc cosine

Editing PCFL equation registers

PCFL instruction block’s middle node holds the address of a series of 64
consecutive registers, a 4x register referred to as 4yyyy. In a PCFL Equation
block, the first 14 registers hold status information and equation inputs, while
the equation itself is stored in registers 4yyyy+14 through 4yyyy+64. The
Postfix Entry mode of the PCFL Equation dialog box lets you edit those
registers directly.

polish notation”. This is different from infix notation, the left-to-right equation

:g The PCFL equation is stored in postfix notation, sometimes called “reverse
format you're probably used to.

« For more information on postfix notation, see “About Postfix notation” on
page 254.
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» To edit the PCFL equation registers directly:

1. From the PCFL Editor, click Eqn Edit.
2. If the PCFL Equation Editor dialog box displays a list of functions and

operators, (ABS, division and so on), click Postfix Entry.

» To change a specific equation register:

1. Click the address of the register you want to change.

2. Click Edit.
3. Click the Postfix Code that you want to place in the selected register.
4. Click OK.

Postfix codes

The Postfix Codes have the following meanings:

Code Meaning g:er?gﬁ(;gf
NOP nothing (no operation) n/a
ABS absolute value function 1
ADD addition operator 2
DIV division operator 2
EXP exponent function (to the power of e) 1

LN natural log function (base e) 1

LOG logarithm function (base 10) 1

MULT multiplication operator 2
NEG negation operator 1
POW power operator 2

SQRT square root function 1
SUB subtraction operator 2
SIN sine function 1
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Code Meaning Number of
operands
COS cosine function 1
TAN tangent function 1
ARCSIN | arc sine function 1
ARCCOS | arc cosine function 1
ARCTAN | arc tangent function 1
Float Indicates that the following two registers contain a n/a
floating point number. To change that number, click
the first of those two registers on the table, then click
Edit.
Integer Indicates that the following register contains an n/a
integer number. To change that number, click that
register on the table, then click Edit.
VAR A variable A n/a
VAR B variable B n/a
VAR C variable C n/a
VAR D variable D n/a

About Postfix notation

Postfix notation differs from regular infix notation in that the operator is
placed after the operands. The operator is a symbol indicating a specific
mathematical operation —multiplication, division and so on. The operands are
the elements that the operator acts on—the actual values to be added or
multiplied.

The equations you're probably familiar with are written in infix notation.
When using infix notation, the operator is placed between the two operands
on which it works.

For example, suppose you want to multiply the numbers 24 and 11. In the two
notations, this would look like:

24*11 in infix notation

2411+ in postfix notation.
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Postfix equations are evaluated using a stack. The computer reads the
equation from left to right (in the PCFL instruction block, from lower-
numbered registers to higher-numbered registers). When it reaches a value, it
adds the value to the top of the stack. When it reaches an operator, it removes
the top one or two items from the stack, applies the operator to those items,
and adds the result to the top of the stack.

In the following example, the underlined portion in the “Equation” column
indicates the section of the equation being evaluated.

Equation Stack Comments

421*33+ Stack is empty.

421*33+ 4 Add 4 to the stack.

421 *33+ 4,21 Add 21 to the stack.

421* 33+ 84 Apply * operator (multiplication) to 4 and 21,
adding the result to the stack.

421*33__+ 84, 33 Add 33 to the stack.

421*33+ 117 Apply + operator (addition) to 84 and 33,
adding the result to the stack. This is the final
result of the equation.

This equation would be written as (4 * 21) + 33 in infix notation.

Customizing the PCFL configuration file

Customizing the PCFL Editor configuration file lets you change register
names, input/output flag names and the input/output flag diagrams.

Changing the PCFL configuration file is an advanced operation. Before you
make any changes, make a backup of the original file.

The PCFL configuration file is called PCFL.DAT and is stored in the
ProWORX NxT installation directory. You can edit it with any text editor, such
as Windows Notepad.
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The PCFL.DAT file contains a section for each subfunction of the PCFL
instruction block. In the following format description, a field enclosed in
angled brackets (< and >) should be replaced by the appropriate value without
the brackets. A carriage return at the end of a line is indicated by <\n> .

The format for each subfunction is:

<Function name> <\n>

<Function title> <\n>

<Number of registers in the main PCFL Editor dialog box> <\n>
<Register description> , <Register radix> , <Register offset> <\n>
Input Flags, <Input Flag Register offset> ;<\n>

<Input Flag diagram format> <\n>

Option " <Flag description> " <First bit> , <Last bit> ;<\n>

<Bit field> , <Bit field description> <\n>

End Input Flags<\n>

Output Flags, <Output Flag Register offset> <\n>

<Output Flag diagram format> <\n>

Option " <Flag description> " <First bit> , <Last bit> ;<\n>
<Bit field> , <Bit field description> <\n>

End Output Flags<\n>

PCFL field descriptions
The following table describes each field in the PCFL configuration file.

Field Description

Function name | A unique identifier for each PCFL subfunction. The PCFL
Editor uses this identifier to find the entry for a particular
subfunction.

NOTE: Don’t make any changes to this PCFL subfunction
name. If you do, the PCFL Editor won't be able to find the
proper subfunction entry.
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Field Description

Function title The subfunction name which appears in the title bar of the
PCFL Editor dialog box. For example, the Function title for
the PCFL Analog Input instruction block is Analog Input.
You can use this field to find the entry for a desired

subfunction.
Number of The number of registers that appear in the table of registers
registers in the | on the PCFL Editor dialog box. Statistics for each table entry
main PCFL appear in following lines, one for each register.
Editor dialog
box
Register The label for a single entry in the PCFL subfunction register
description table. These register descriptions appear in the Description

column of the table on the PCFL Editor window.

Each entry in the PCFL subfunction register table has a
single line with a Register description, Register radix and a
Register offset.

Register Radix | A number indicating the data type for a register used by the
PCFL subfunction. This value indicates the format used to
display and edit values in the Data column of the register
table on the PCFL Editor window. The data type is indicated
by number:

1 = Decimal (integer)

2 = Hexadecimal

3 = Binary

4 = ASCII

5 = Floating point

6 = 32-bit integer

Register offset | The offset for the register, calculated from the beginning of
the register table. This value is used to calculate the address
that appears in the Address/Symbol column in the table on
the PCFL Editor dialog box.

For the actual offset values, see the online instruction help
for the specific PCFL subfunction.

Input Flag The offset of the register where the PCFL subfunction’s
register offset | input flags are stored.
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Field

Description

Input Flag
diagram
format

This section describes how the PCFL Editor draws the lines
that connect bits to the flag descriptions in the Input Flags
and Output Flags dialog boxes.

% For more information on this field, see the section
following this table.

Flag
description

This section of the configuration file contains entries for each
flag in the Input Flags/Output Flags dialog boxes. Each
entry is one line. This part of the flag entry contains the
name or description of the flag. This description appears in
the Input Flags or Output Flags dialog box and (for Input
Flags) as the option label in the Set Inputs dialog box.

First bit

The bit offset for the first bit in the series of bits that make up
the input/output flag described by this line. For example, if
the setting for this flag was stored in bits 2 and 3, the first bit
would be 2.

Last bit

The bit offset for the last bit in the series of bits that make up
the input/ output flag described by this line. For example, if
the setting for this flag was stored in bits 2 and 3, the last bit
would be 3. If the flag is composed of only one bit, don’t
include the last bit and its preceding comma for this entry.

Bit field

The values of individual bits within an input flag often
indicate different things. These lines of the configuration file
indicate the possible settings for each flag and the bits that
must be set to indicate that setting. The Bit field contains a
series of Os and 1s that indicate the bit pattern for this value.

For example, in the PCFL On/Off Control instruction block,
bits 6 and 7 of the input status register comprise the
“Manual Forcing” flag. If bit 6 is on (1) and bit 7 is off (0),
this sets the Manual Forcing mode to "Manual, forced OFF".
The Bit field for this setting would be 10.
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Field Description
Bit field The values of individual bits within an input flag often
description indicate different things for different subfunctions. These

lines of the configuration file indicate the possible settings
for each flag and the bits that must be set to indicate that
setting. The Bit field description contains a description of
what the setting indicated in the preceding Bit field means.
Values in the Bit field description appear in the list box in the
Set Inputs dialog box for the appropriate Input flag.

Output flag The offset of the register where the PCFL subfunction's
register offset | output flags are stored.

Output flag This section describes how the PCFL Editor draws the lines
diagram that connect bits to the flag descriptions in the Input Flags
format and Output Flags dialog boxes.

o

< For more information on this field, see the section
following this table.

Input/output flag diagram formats

This section describes how the PCFL Editor draws the lines that connect bits
to the flag descriptions in the Input Flags and Output Flags dialog boxes.

The “Input/Output flag diagram format” line in the PCFL.DAT file consists of
a string of 16 digits. Each digit indicates how a line should be drawn for the bit
in that position. The possibilities are:

2 Draw aline from this bit to its label.
3 Draw aline from this bit to the line coming from the following bit.
4 Leave this spot blank.

For example, the Input Flags diagram format line for the PCFL Analog Input
block is 4443333222244444 . The Input Flags diagram looks like this:

M5B L5B
0000 ODOOO0O - 0DODODO0 DODOOD

L
Extended Range <Mo>
Manual/Auto Mode <Auto>

Process Square Root <Mo>
Module Output Format <Res 0/4096>
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Printing

In general, NxT has three methods of sending information about your
database or controller to a printer:

Online, with no active database: Prints the currently displayed
network only.

Online, with an active database: Prints the currently displayed
network and documentation from the database.

Offline: Prints the currently selected network or a configurable list of
networks, documentation, configuration data, mismatch tables, and
formatting (cross-references, indices, page titles, and page
numbering). In previous versions of NxT and ProWORXPLUS, this
was referred to as the Lister option.

Printouts from a Register editor are sent to the default printer, as specified in the

:g You can also print data from the User Configurable and Generic Register editors.

Print Setup dialog box (page 274).

”e

For more information, see “User Configurable Register editor” on page 137
and “Generic Register editor” on page 152.

Printing a network

You can print a single network in Online or Offline. The printout displays a
line drawing of the network elements, with or without descriptors and other
documentation.

» To print a single network:

1.

From the Network Editor, on the File menu, click Print Network. The
Print dialog box is displayed.

Select any printer-specific options you may have. Consult your
printer’s documentation for details.

Click OK.
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Printing selected data (Lister)

NxT Offline can print any part or all of the database information.

» To select data to print:

1. From the Network Editor, on the File menu, click Print Setup. The
Lister dialog box appears.

Lister

Current Settings: Description:

Each button takes you to
section of data. For each
section, select the data to
print.

Some Choose the range of networks, with descriptors, backref,

Metworks !
crossrefs, and titles.

Lol

Doc Tables Some Print d i . short long and

The Current Settings col- g Print configuration. traffic cop. register contents, ASCII.
umn provides a Su?nmary Conitrolles Tables ome digables, segment scheduler/order of solve, and used tables.
of your prmt choices. MisMatch Table: None Print references that are used in logic but are not described.

Print references that are described but not used in logic.
Click to save or load back Format Some Select cross reference limits, indexes, page
. . - titles and page numbering.
custom print settings.
Quick Picks Use Quick Picks for choosi defined print

Print Setup | Font Setup | Close Help

Print | Save Settings

2. For each section, select items to print:
* Networks (see page 264).
* Doc Tables (see page 265).
* Controller Tables (see page 267).
* MisMatch Tables (see page 268).

3. Click Format to adjust page titles and numbering, and select cross
reference limits and indexes (see page 269).

Click Print Setup to choose a printer or adjust printer settings.
Click Font Setup to change or adjust the output font.
Click Print.

@ You can also click the settings in the Current Settings column to change them.
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Network printing options
Use this option to set how networks of ladder logic are printed.
» To select the networks to print:

1. From the Network Editor, on the File menu, click Print Setup. The
Lister dialog box appears.

2. Click Networks. The Networks dialog box appears.

Metwaork Listing Dptions

Metworks [[INTEEERA [ Start Doc at Net : [ One Net Per Page

[ Symbols [ Cross Refs [ Back Refs

Print Format

15 char desc

15 char desc Paper too narrow or font
15 char desc too large. Descriptors will

15 char desc be truncated.

15 char desc

e
Dxxxx
NOTES BELDW NETWODRK

1] 4 | Toggle All | Cancel | Help

3. Click an option to select or clear it. As you select different parameters,
the print format area changes to show your new formatting.

@ Click Toggle All to select or clear all options.

* Type a range of networks to print. The maximum range is the
number of networks that have been programmed. If you enter a
value higher than that or that is nonsensical (such as 1,123), the
entry appears as 1 - Max. Any entry that contains spaces or is empty
is set to “None.”

* Select the network number where you want to start printing
documentation.

* Print Symbols, Cross-References (Cross Refs) and/or Back
References (Back Refs) for your logic.
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Documentation tables

The Documentation Tables consist of all the documentation from the Logbook,
Short Comments, Page Titles, Long Comments, Symbol and Descriptor Tables.

» To activate the Doc Tables:

1. On the File menu, click Print Setup. The Lister dialog box appears.
2. Click Doc Tables.

Doc Tables
" Tog Book! [ Short Comments [~ Titles [ Long Comments [~ Symbol Table
Options Ranges
Ofa Gl
Cross References: Mets
@ Column O Wrap Subs
Brxxn file
Include in tables: 1 |Nnne | & |NﬂnE |
[ Items Used In Logic 2 |Nune | 7 |Nune |
[ Items With Descriptions 3 |Nune | 8 |Nune |
™ &ll ltems 4 [None | 8 [None |
5 |None | 10 |None |
[1] 4 | Toggle All | Cancel | Help |

3. Click an option to select or clear it:

@ Click Toggle All to select or clear all options.

* Types of documentation (Log Book, Short Comments, and so on)
to print.

* Under Commentary, Full, or Brief documentation.

* Under Cross References, Column, or Wrap format.
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Cross-references provide a way of relating references in ladder logic. Any coil
with an associated contact is cross-referenced to the contact location.
References used in function blocks and elsewhere in the logic are cross-
referenced to their locations.

A new cross-reference is performed if logic or PLC configuration has changed
or cross-reference files do not already exist. You can select these items to
include in your printout.

NNNN.R -11- Normally Open Contact

NNNN.R -IM- Normally Closed Contact
(NNNN.R) Coil

NNNN.R S(XXXX) function block, Source (name)
NNNN.R D(XXXX) function block, Destination (name)
NNNN.R P(XXXX) function block, Pointer (name)

You can select ranges for address types Oxxxx, 1xxxx, 3xxxx and 4xxxx as well
as ranges for networks and subroutines. The maximum range value you can
enter for Oxxxx, 1xxxx, 3xxxx and 4xxxx is the maximum value currently set in
your controller configuration. The maximum range for networks is the
number of networks that have been programmed, and the maximum range for
subroutines depends on the controller type.

If the controller you are using supports extended memory, you have the choice
of selecting a range for 6xxxx. There are up to 10 extended memory files
available for 6xxxx. Use the files your controller has configured for you.

266 @ Documentation tables



Chapter 11 Printing

Controller tables

The Controller Tables consist of controller configuration information, such as
the configuration extensions you have installed as well as the Address Used
Tables and Register Contents for 4xxxx address types.

> To activate the Controller Tables:
1. On the File menu, click Print Setup. The Lister dialog box appears.
2. Click Controller Tables. The Controller Tables dialog box appears.

Controller Tables
WG Fapretiten Used: O Full @ Brief FReaister Content Ranges:
[ Config Extensions [ Dxxxx [ 1xzxxx
@ Full O Brief T T
[ Data Protect [ Disable References 1
[ Peer Cop 2
3

[ Segment Scheduler
[~ ASCIl Messages
X Traffic Cop
C Full C Brief ® Visual

-
= - - T R T L B

LTI

(1] 4 ‘ Toaggle All | Cancel | Help

3. Click an option to select or clear it. You can set these parameters:

@ Click Toggle All to select or clear all options.

* Configuration Extensions: Select the configuration extensions to
print and whether you want a full or brief printout of the
documentation. When Full is selected, you can also select:

* Data Protect to print the Data Protect Extension information.
*  Peer Cop to print Peer Cop Extension information.

* Segment Scheduler: Select to print the Segment Scheduler
information.

* ASCII Messages: Select to print the ASCII Message information.
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* Traffic Cop: Select to print the Traffic Cop information and further
select:

*  Full to print the entire Traffic Cop and any attached
documentation.

*  Brief to print the Traffic Cop and a summary of the
documentation.

* Visual to print a graphical representation of the brief option.

¢ Address Used Tables: Select Oxxxx, 1xxxx, 3xxxx, or 4xxxx address
types and select Full to print the addresses used in Logic, Peer Cop,
and Traffic Cop or Brief to print only addresses in Logic.

* Register Contents: Select the range for the 4xxxx Register Contents
you want to print. The maximum range value you can enter for
4xxxx is the value currently set in the controller configuration. If
you enter a value higher than that or that is invalid (such as 1,123),
the entry appears as 1 - Max. Any entry that contains spaces or is
empty is set to “None.”

Mismatch tables
A Mismatch Table is a table of reference points used but not documented or
references documented and not used.
» To select mismatch tables for printing:

1. From the Network Editor, on the File menu, click Print Setup. The
Lister dialog box appears.

2. Click MisMatch Tables. The MisMatch Tables dialog box appears.

Described But  Used In Logic But
Mot In Logic Not Described

e [ Dxxx
™ dxoaex [ Axxxx
™ Faxx [~ 3xxxx
[ [ Axxxx
OK | Cancel | Help |

3. For each address type, select to print Descriptors without
corresponding element in logic and/or Elements in logic without
descriptors, then click OK.
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Formatting a printout

After selecting data to print, use this feature to determine how the printout
will look. You can adjust page titles and numbering, and select cross reference
limits and indexes.

» To format a printout;

1. From the Network Editor, on the File menu, click Print Setup. The
Lister dialog box appears.

2. Click Format. The Format dialog box appears.

Format [ %]

General Options

[ iiimit Humber of Fross Helerences to! [211 perltem [ Title Page
[~ Mixed Pitch Margins [0-2.00in): Top Leit

Metwork Options

Page Titles [~ Page Numbers
@® Title Every Page Eirst Page Humber
C Only New Titles
C No Titles ™ Index
D ion, C . MisMatch Options

[ Limit Mumber of Cross References PRINTED to per ltem
[ Page Mumbers

First Page Number [ Index

DK | Cancel | Help

3. The following formatting options are available:

Mixed Pitch: For cleaner and clearer looking printouts.
Page Titles: Prints a page title associated with the current network.

Title Page: Prints a summary of all listing options and the database
configuration.

Page Numbering: Prints the page numbers.
Network Index: An index of networks by their titles.
Table Index: An index of all tables.
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Quick picks
Quick Picks let you select from a list of commonly-configured print options.
» To print using Quick Picks:

1. From the Lister dialog box, click Quick Picks. The Quick Picks
window appears.

Quick Picks E

System | User Configured ]

Click here to see commonly

" used printing options.
[All networkstables with full d i =

1] 4 | Cancel | Help |

2. Select a pre-configured option or a user-configured file (see below),
then click OK.

Using custom quick picks

You can save your custom print settings to a file, then select the file from the
Quick Picks window.

» To save custom print settings to a file:
1. From the Network Editor, on the File menu, click Print Setup.
2. Configure your print settings.

3. Click User Configured. The Quick Picks dialog box appears.

Quick Picks

System | User Configured

File: | Browse. .. |

Cancel | Save... | Help |

Click User Configured.
Click Save. The Save to User Configured OPT File window appears.

Type the path and file name (with the .OPT extension) of the file to
save, then click OK. If the file does not exist, it is created. If the file
already exists, you're prompted to overwrite it.
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» To open a custom print settings file:

1.

2.
3.
4

From the Network Editor, on the File menu, click Print Setup.
Click Quick Picks. The Quick Picks dialog box appears.
Click User Configured.

Select a settings file to load from the drop-down list or type its path
and file name (with the .OPT extension), then click OK.

» To modify a custom Lister settings file:

1.

4.

Print preview

Open the .OPT file you want to modify (see above for steps on opening
the file).

In the Quick Picks window, click OK. You're returned to Lister.

Make the modifications to the Lister settings. See above for
information on changing the Lister settings.

In the Lister window, click Save Settings.

Print preview lets you see your data looks before you send it to the printer.

» To display a document in Print Preview:

1.

While Offline, select Print Preview on the File menu. The Print setup
dialog box appears.

Select the printer settings you want, then click OK. A status dialog box
appears while the NxT sets up the preview with your settings.

You can do the following from Print Preview:

e (Click to select whether to print the entire document, the
current page, or a specific range of pages.

* Click to fit a full page of information within the viewable area.

e (Click or select Full Screen on the View menu to maximize
Print Preview by removing it’s toolbar, menu bar, and borders.

* Select Goto on the View menu to display a specific page of data.

* In the Zoom list on the toolbar, select or type a magnification
between 10 through 500 percent.
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Print to file

You have the option to print your data to a file. This feature allows you to print
your data to a DOS based text (.TXT) file to be viewed in a text editor such as
Microsoft’s Notepad.

Print 2]

Printer: Default Printer [HP Laser)et 4000)
Series PCL 6

Print range ﬂl

o All Setup... |

) Selection

) Bages

Print guality: IHigh 'l LCopies: l:l
" Print to file " Collate copies

» To print data to file:

1. While Offline, select Print on the File menu. The Print setup dialog box
appears.

Select the print settings you want.

Select Print to file, then click OK. The Select Print File dialog box
appears.

Navigate to the folder where you want to store the text file.

Type a file name or choose the default file name, then click OK. The
current data is saved to the file.

@ By default, NXT chooses the name of the current database as the text file name.
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Changing the printout font

Changing the printout font alters the look of your printout as well as the
amount of information you can fit on one page.

» To change the font;

1. From the Network Editor, on the File menu, click Print Setup. The
Lister dialog box appears.

Click Print Setup. The Print Setup dialog box appears.
3. Adjust the settings as necessary, then click OK. The Font dialog box

appears.
Font 21=]
Font: Font style: Size:
Andaleld Mono LineDraw IReguIal
=l Courier - 0
' Courier Mew Italic |
T | etter Gothic MT Bold

Andaleld Mono LineDra Bold Italic

Script: —Sample

Symbol LI
| ool

This iz a TrueType font. Thiz zame font will be used on both
your screen and your printer.

4. Select the font and font size.

Only True Type fixed spaced fonts can be used in the Lister. ProWwORX NxT
@ installs the font Andaleld Mono LineDraw, which is the recommended True Type
font. Font style does not affect the look of the printout.
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Changing the print setup

You can select a printer and choose a paper type and orientation in the Print
Setup dialog box.

» To change the Print Setup:
1. On the File menu, click Print Setup. The Lister dialog box appears.

2. Click Print Setup. The Print Setup dialog box appears.

Print Setup EHE

 Printer
[ Laserlet 4M Net [Adobe P5) on \\Hp_Im\d lop)
" Specific printer: Options....

_Gptions |
I j Network. . |

— Ori

Cancel |

Paper

. Potrait Size: |[Letter81/2x11in 7|
¢ Landscap 5 :IAnclnTlay j

3. Select the Printer, Paper type and paper Orientation you want, then
click OK.
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Using the Data Watch Window

The Data Watch Window lets you examine register contents and discrete
values as they change over time. This powerful analysis tool provides four
different views of your data and lets you record the displayed data to a file for
future reference.

You can adjust the sample rate, set triggers, and condense data by clamping
the sample within or outside a value range. Together, these features help you
zero in and isolate sporadic problems in your process or step back and see the
whole picture. You can display up to ten “child” windows simultaneously
inside the Data Watch window.

ProWORXPLUS users will find the Data Watch Window quite familiar, as NxT
uses the same 20 row x 3 column display, provides address fill operations, and
imports Full Page (.TFP) files.

The Data Watch window includes the following views:

* Data Watch view: Used for full-page data display, tracking, and data
watch operations. The Data Watch window is also used to define the
addresses to view or log.

* DataLogger view: Used to record (but not edit) data values to file and
view them.

* Trend view: Used to show a graphical representation of data points.

* Spreadsheet view: Used to show multiple data points over time in a
spreadsheet form.

*  Graphical view: Used to create a graphical representation of register
contents and discrete values.

The Data Watch panel

Many of the functions present in the Data Watch View can be used in the Data
Watch Panel, accessible from the Network Editor. The Data Watch Panel
provides a convenient place to keep track of data without cluttering the screen
with lots of separate windows.

% For more information on the Data Watch panel, see page 122.
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About the Address/Contents table

The Address/Contents table displays the addresses (or symbols, if Symbolic
Addressing has been turned on in the NxT Preferences window).

In the Trend view, each address/content pair in the table is assigned a unique
color, which corresponds with the pen color used to plot the data point on the
trend. The pair is also underlined with the pen style used to plot the data
value.

You can set up the addresses to be viewed in the Data Watch View, or you can
select one of the tracking functions available from the Data menu in the
Network Editor window.

» To enter an address into the Address/Contents table:

1. From the Network Editor, on the Data menu, double-click Data Watch
Window. The Data Watch window appears, showing the Data Watch
view. You have the option of selecting a different view.

2. Type the address that you want to track.

@ You can't enter a symbol, Data Watch Window allows reference numbers only.

3. Click the cell in the Address/Contents table where you want the
address displayed.

4. Press ENTER.

About the Assembly Register in the Data Watch Window

The Assembly Register (AR) in the Data Watch dialog box is used to enter
addresses into the Data Watch dialog box.

This is separate from the Assembly Register in the Network Editor. You're not
entering addresses directly into the Network Editor.

About the Address/Contents table ® 277



ProWORX NXT User's Guide

Displaying the Data Watch Window

There are several methods of displaying the Data Watch Window from the
Network Editor Data menu:

Clicking Data Watch Window opens the Data Watch Window, and
lets you enter the addresses to be tracked by the Data Watch Window
application. You cannot select addresses from the Network Editor.

Clicking Add Watch opens the Data Watch Window, then places the
address of the currently-selected network into the Address/Contents
table.

Clicking Track then clicking Instruction opens the Data Watch
Window, then enters all addresses associated with the instruction in
the currently selected cell in logic (in the Network Editor) into the
Address/Contents table. You can then go to the Network Editor and
select different instructions to track by clicking them.

Clicking Track then clicking Address opens the Data Watch Window,
then enters the address associated with the cell currently selected in
logic into the Address/Contents table. You can then go to the
Network Editor and select different addresses to track.

Clicking Track then clicking Network opens the Data Watch Window
and places all addresses in the currently selected network into the
Address/Contents table.

Clicking Track then clicking Discretes opens the Data Watch
Window, and places the addresses of all discretes in the currently
selected network into the Address/Contents table.
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General procedures

There are several procedures which are common to some or all Data Watch
Window views:

*  Setting the sample rate;

* Filling cells in the Address/Contents table with addresses;
* Deleting addresses from the Address/Contents table;

*  Setting the font size;

* Changing the radix of data in the Address/Contents table;

* Creating, opening, importing, and exporting Data Watch Window
files;

* Exporting a DWW file to a .DIF file;
*  Setting triggers;

* Clamping data;

* Disabling/forcing discretes;

* Editing register contents.

Setting the sample rate

The Sample Rate function lets you set how often the Data Watch Window will
sample data provided by the separate NxT application. Note that this does not
directly set the rate at which NxT samples data from the controller. The
frequency can be set in either milliseconds or seconds.

Note that the sample rate is a target value only. Depending upon how busy the
system is, the actual sample rate may be slower. Factors which commonly slow
up the sample rate are:

*  The number of addresses tracked by the Data Watch Window;
¢ The refresh rate set in the Network Editor;

*  Other concurrent processes (applications, operating system tasks,
etc.).
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» To set the sample rate:

1. From any view of the Data Watch Window, click Settings then click
Sample Rate. The Sample Rate dialog box appears.

Sample Rate

(114 | Cancel | Help |

In Frequency, type the target sample rate (in seconds or milliseconds).

From the units drop down box, select whether the sample rate is in
milliseconds or seconds, then click OK.

Adding addresses to the Address/Contents table

You can fill the next cell, previous cell, or an entire column (20 rows) in the
Data Watch view with consecutive addresses.

» Tofill the next or previous cell with a value:
1. Select the cell to use as a base for filling.
2. Do one of the following:

* Click Fill then click Next to type the next consecutive address
below the currently selected address.

* Click Fill then click Previous to type the previous consecutive
address above the currently selected address.

overflow values are shifted up when Next selected on the Fill menu at the bottom
row of the table or down if Previous on the Fill menu is selected at the top row

of the table.

:g Filled values don’t carry over to the next column in the table. Instead, the

> Tofill a column of cells with values:

1. Type the starting address into the AR field, select the cell where you
want it displayed, then press ENTER.

2. Click Fill then click Column. NXxT fills the rest of the column (down)
with consecutive addresses.
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Deleting addresses from the Address/Contents table

Data Watch and Trend views only

You can delete a single cell or a group of cells (by row or column) from the
Data Watch Window.

» To delete a single address:

1. Select the address in the Data Watch window to delete.
2. Click Edit, then either click Delete or press DELETE.

» To delete multiple addresses:

1. Select an address in the Data Watch window within the range of
addresses you want to delete.

From the Data Watch Window, click Edit then click Delete Multiple.
3. Do one of the following:

* Column: Click to delete the entire column.

* Row: Click to delete the entire row.

* Down: Click to delete all addresses beneath the cell (down the
column).

* Up: Click to delete all addresses above the selected cell (up the
column).

* Page: Click to delete the entire page of 60 addresses.

Setting the font size

You can change the font size for the cell display. The default display uses the
maximum font size (6.75 pt) available. You can reduce this size to 6 or 5 points
to use a smaller portion of your screen for the display.

» To set the font size:

1. From the Data Watch window, click Font Size on the Settings menu.
2. Select either 5, 6, or 6.75 point.
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Changing the radix

You can set the radix in which data values will be displayed for individual
registers in the Data Watch window.

» To change the radix of an individual cell:

¢ From the Data Watch Window, click Edit then click Radix, then select
the radix to display.

Creating and using Data Watch Window files

Each time you open the Data Watch Window from the Network Editor, NxT
creates a new, untitled window. You can create new windows, then save them
as a file. Later, you can record a stream of data to this file and save the Data
Watch Window configuration (addresses entered, clamp settings, etc.).

in the Track window because NXT will overwrite your edits as soon as the cursor

j The window called Track is updated automatically by NxT. Avoid defining data
is placed on a new cell in logic.

» To create a new Data Watch Window file:
1. From the Data Watch Window, click File then click New.
2. Type a path and file name (with a . DWW extension), then click OK.

» To open an existing Data Watch Window file:
1. From the Data Watch Window, click File then click Open.
2. Select a file to open, then click OK.

> To save a Data Watch Window file:
1. From the Data Watch Window (any view), click File then click Save.
2. Type a path and file name (with a .DWW extension), then click OK.

» To save a file to a different path or with a new name:

1. From the Data Watch Window (any view), click File then click Save
As.

2. Type a path and file name (with a . DWW extension), then click OK.
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» To close a “child” window:

e Select the window to close, then click File then click Close.

» To exit the Data Watch Window application:

*  From the Data Watch window (any view), File then click Exit.

Exporting a .DWW file to a .DIF file

You can convert a Data Watch Window log file (DWW) into a Data
Interchange Format (.DIF) file for importing into a third-party spreadsheet or
database application.

» To export a recorded .DWW file to a .DIF file:

1. From the Data Watch window, click File then click DIF Export. The
DIF export window appears.

2. In Data File, type the path and file name of the DWW file you want
to convert.

3. In DIF File, type the path and file name (with a .DIF extension) of the
.DIF file to open or create.

@ If you select an existing .DIF file, the previous data in the file will be overwritten.

4. Click Start.
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Setting triggers

The Trigger Setup window lets you configure an address in logic to act as a
trigger for recording data in the Data Watch window (Data Logger, Trend, and
Spreadsheet views).

» To set a trigger:

1. From the Data Watch Window, click Settings then click Trigger. The
Trigger Setup dialog box is displayed.

Trigger Setup E

Trigger Address: 00001
Trigger State: D

' Less Than (® Greater Than

‘ [ Trigger Enabled

1] 4 | Cancel | Help |

2. InTrigger Address, type the Oxxxx, 1xxxx, 3xxxx, or 4xxxx address to
use as a trigger.

3. In Trigger State:

* For discretes, type the state of the discrete (0 or 1) which will
activate data display/capture in the Data Watch window.

* For registers, type the register data value threshold which will
activate data display/capture in the Data Watch window. Then
select whether the trigger will spring when the register value is
greater than or less than the threshold.

. Select the Trigger Enabled check box.
5. Click OK.
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Clamping data

Clamps let you specify a range of analog data values to capture and display.
You can specify whether analog data values inside or outside the range will be
captured.

» To set up a clamp:

1. From the Data Watch Window, on the Settings menu, click Clamps.
The Clamp Setup dialog box is displayed.

Clamp Setup E

Hi Clamp:
Lo Clamp:

(® Capture Inside O Capture Dutside

| [ Clamps Enabled

1] 4 | Cancel | Help |

In Hi Clamp, type the maximum analog data value in the range.
3. In Lo Clamp, type the minimum analog data value in the range.
Do one of the following:

* Capture Inside: Click to capture data values within the entered
range.

* Capture Outside: Click to capture data values outside the entered
range.

5. Select Clamps Enabled. Clamps will be shown as blue horizontal lines
on the trend.

6. Click OK.

Clamping data ® 285



ProWORX NXT User's Guide

Disabling and forcing discretes

You can force a discrete to the ON or OFF state. This removes control of the
discrete from logic: it remains in the fixed state until the force is removed.
Enabling a discrete removes the FORCE ON or FORCE OFF, placing control of

the discrete back in logic.

one, the original address remains FORCED. However, if an address is forced,

j If you force an address either on or off, then overwrite the address with a new
deleting it removes the force unless the address is referred to elsewhere.

» To force a discrete ON:

1. From the Data Watch view, select the discrete you wish to force ON.
2. (Click Data, then click Force ON.

» To force a discrete OFF:

1. From the Data Watch view, select the discrete you want to force OFF.
2. (Click Data, then click Force OFF.

» To return control of a discrete’s state back to logic:

1. From the Data Watch view, select the discrete that you want to enable.
2. (Click Data, then click Enable.

Editing register contents

You can edit the contents of a register from the Data Watch view.
» To edit the register contents:

1. From the Data Watch view, select the register to edit.

2. Click Data, then click Register Contents. The Edit Data dialog box
appears.

3. Type the new register value. This value must be in the same radix as
the previous value. The radix is displayed beside the value in the Data
Watch window.

4. Click OK.
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Working with the views

Data Watch view

The Data Watch view is used for full-page data display, tracking, and data
watch operations.

@ You can change the radix for individual addresses by selecting Radix on the Edit
menu.

NxT begins tracking the data for this address. In this view, only the current
value for each address is displayed. Use the Trend, Data Logger, or
Spreadsheet view to see historical data.

B Data Watch Window - [C:\PROWORXANXTATEST1.DWW] M= E
&L Fle Edit Yiew Data Fill Settings Upsation:  MWindow Help - |E'|5|

AR N L
Addre=iSymbol | Data [PddressiSumbol [ Data [AddressiSumbel _[Data > Click in the AR and type
LT 100077 oI 401513 00000 Do the address you want to
[ on 100073= o 401514 00000 Dee track, then select the cell
004003 ok 100073= o 01515= 00000 Dec :
004004 o 100080= oif 401516 00000 Dec where you want to display
0040052 an 10008 1= o 401517= 00000 Dec that address and press
004008= ok 100082= o 01518 00000 Dec ENTER. Avoid using the
004007= [ 100083= o 401513- 00000 Diec .
004008= o 100084= o 401520 00000 Dec Track window, as your ed-
004009= O 100085= oK 401521= 00000 Dee its will be overwritten.
004010 o 100086= o 401622 00000 Diec
004011= o 1000572 o 401523 00000 Diec
004012 o 100083= o 401524 00000 Dee
004013 ok 100083= o 01525= 00000 Dec
004014 [ 100090= o 401526- 00000 Diec
004015= o 100031= o 401527= 00000 Dec
004016= ok 100092= o a01528- 00120 Oee
004017 [ 100093= o 401523- 00120 Diec
0040182 o 100034= o 401530 00120 Dec
004013= O 100038- o 401531= 00120 Dec There are two status bars:
004020= Ok 10003E= 1} 401532= 00120 Dec ,7one for the Data Watch

Window itself, and a sec-
ond one for each “child”
window.

00000000 | 000%00.001 | Dats Record: O00372/000373 | Trigger: Disabled | Clamps: Disabled
‘ Quantum 21344 |Hunning |F‘rngram

You can fill a single cell or an entire column with incrementing addresses from
the Fill menu.
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Using the Data Logger view

The Data Logger view is used to record data values to file and view them. The
addresses that are logged are defined in the Data Watch view. Log Files from
the Data Logger have an extension of . DWW.

Setting up the log file

The Log File Setup window lets you configure the maximum size of your log
file and determine what NxT should do when the maximum file size is
reached. The log file size determines the number of records (tracked addresses
changes) that can be stored. Generally, the file has 40 records of overhead, plus
three records per address tracked. Each record requires 21 bytes, so to track 10
addresses (for example), would require a maximum file size no less than:

(40+10*3)*21 Overhead bytes

+

(number of data records) *21  Data bytes

doesn’t write based on sample rate. You can find the above equation useful in

:g A data record is written to the file each time the data changes for an address. It
estimating how many records (data changes) a given file size can hold.

» To set up the log file:

1. From the Data Watch Window, on the Settings menu, click Log File.
The Log File Setup dialog box appears.

Log File Setup [ %]

Mazx File Size: KB

‘When Max Size Reached: m

(114 | Cancel Help |

2. InMaxFile Size, type the maximum size (in KB) of the log file. Ensure
the maximum file size doesn’t exceed available storage space
(although this typically won’t be a problem).

3. In When Max Size Reached, select Stop to halt the recording process
or Reset to initialize the log file, empty all contents, then restart
recording.
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Recording data to the log file

Although the Data Logger view is provided specifically for recording data to
a file, you can also record data from the Trend and Spreadsheet views.

You record data to the currently open . DWW file. To set the maximum size of
this file, click Settings then click Log File Setup.

25

You cannot append a recorded file. You can only overwrite the file. If you are
writing data to a file which already contains records, you will be prompted to
confirm the overwrite.

To record data to the log file:

*  From the Data Watch Window (Data Logger, Trend, or Spreadsheet
views), click Record to File on the Operations menu. You can also
click the Rec button.

To pause the recording:

*  From the Data Watch Window (Data Logger, Trend, or Spreadsheet
views), click Pause on the Operations menu or

To stop recording:

*  From the Data Watch Window (Data Logger, Trend, or Spreadsheet
views), click Record to File on the Operations menu or click the Rec
button.

To move through the records:

* To set the recording to the first data record, click First on the
Operations menu or click [_j4_]-

* To set the recording to the previous record, click Previous on the
Operations menu or click L]

* To set the recording to the last data record, click Last on the
Operations menu or click .

* To set the recording to the next data record, click Next on the
Operations menu or click [_¢_].
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Using the Trend view

The Trend view is used to show a graphical representation of data points. You
can view both discrete states and register values, create setpoints and alarm
values (as references), and record data from this view. You can adjust the x-
and y-axis values to “zoom” the trend display in or out.

» Todisplay the Trend View:

¢ From the Data Watch Window, click Trend on the View menu.

Setting up the Trend display

The Trending Setup window lets you configure how data points are to be
displayed in the Trend View window. Note that this affects the display only -
not the data values.

» To set up the Trend View:

1. From the Data Watch window (any view), click Trending on the
Settings menu. The Trend Setup dialog box is displayed.

Trending Setup E
vhvisMinl | LoAlam:[100 |
YAuis Max:[1000 | HiAlam:[900 |

Setpoint: [500 | Resolution:[250 |
0K | Cancel | Help |

2. InY-Axis Min, specify the base value for the Y axis. This is the bottom
range of the values displayed.

3. In Y-Axis Max, type the top range of the values to be displayed.

In Setpoint, type the Y-Axis value of a setpoint. The setpoint is for
reference only, and is drawn in the trend with a green line.

5. In LoAlarm, type the Y-Axis value for the LoAlarm. This value is for
reference only, and is drawn in the trend with a red line.

6. In HiAlarm, type the Y-Axis value for the HiAlarm. This value is for
reference only, and is drawn in the trend with a red line.
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7. InResolution, type the time (in ms) range to display across the X axis.

Decreasing the Resolution value is equivalent to “zooming in”, and increasing the

:g The X axis (and therefore this time range) is subdivided into 200 samples.

value is equivalent to “zooming out” the display. For example, a 100 ms
resolution * 200 samples gives you an X-axis range of 20 000 ms (20 seconds)
in “width.” You could “zoom out” the view by setting the resolution higher (e.g.
1000 ms * 200 samples = 200 000 ms “wide”).

Reading the trend

When you enter the Trend view, all addresses in the Address/Contents table
are plotted. You can also add or delete addresses “on the fly”.

window.

@ Create setpoints and alarms from the Settings menu in the Trend Settings

Addresses are shown
in the color they are
plotted. The line style
(e.g., dots, dashes) is
shown under each
address.

| You can record logged
data to file directly from the
Trend view.

2% Data Watch Window - [C:\PROWORX\NXTATEST1.DWwW]
&% Fle Edit View Dsta Fil Settings Operations Window Help

fg/ | —The vertical cursor is
|, o o o P Sioei- on shown at the leading edge
100] 004005- o of the trend. You can go
ZE — - - - — — backwards through the
o _trend by pressing . Do-
ing so moves the trace bar
13:52:31.175 13:53:20.925 back through the trend,

and the sample time/data
values are shown in the
status bar.

059051957 | 135320441 | Data Record 0003734000373 | Trigaer Disabled | Clamps: Disabled
| Quantum 213/4 |Hunming |F‘|ngram |

set to 1/9 the height of the trend display. For more than nine discretes, the square

@ You can plot up to 60 values at a time. For up to 9 discretes, square waves are

waves are resized as necessary to fit.

Each plotted line has a unique color which corresponds to the address being
plotted.

Discretes are plotted as on or off, producing the expected square wave. Note
that discretes are spread out vertically across the trend. If you plot nine or

fewer discretes, each discrete is shown at one-ninths the height of the display.
If you plot more than nine discretes, the trend sizes the square waves evenly.
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There are time values at the bottom left and bottom right corners of the trend.
These values show the range of time over which the trend is plotted. You can
adjust the time range shown on the trend in the Settings menu.

You can zoom in the view to see the trend over a shorter length of time by
adjusting the value in the Resolution field in the Trending Settings window.

You can adjust the minimum and maximum values displayed in the y axis by
adjusting the values in the YAxisMin and YAxisMax fields in the Trending
Settings window.

Using the Spreadsheet view

Use the Spreadsheet to show data similar to the Data Logger view, but in the
form of a spreadsheet (for example, more than one data sample is shown at a
time). This lets you view timestamped historical data for several addresses at
a time.

» To display the Spreadsheet View:

*  From the Data Watch Window, click View then click Spreadsheet.
The Spreadsheet view appears.

2= Data Watch Window - [C:A\PROWORX\NXTATEST1.DWw] =1
&L Fle Edit Yiew Data Fil Settngs Operations Window Help =7 5[
sRec| _n_|| AR
Time | Date | 100077= | 100078 | 100078= | 401613= [401514- [401515-

143402766 | (3-05-1397 | OF [ i 00008 Dec 00005 Diec 00000 Dec
14:24:02.150  09-06-1997  OF on =l 00003 Dec 00002 Dec: 00000 Dec:
14:24:02636 03-06-1987 O On O 00008 Dee 00002 Dec: 00000 Dee:
14:34:02.919 | 09-05-1997 | OF [ i 00009 Dec 00008 Diec 00000 D
14:34:04 306 03-06-1397  OF On OFf 00003 Dec: 00003 Dlec: 00000 Dec:
14:24:04.752  09-06-1997  OF on =l 00003 Dec 00002 Diec: 00000 Dec:
14:34:05.129 | 09-05-1997 | OF [ i 00003 Dee 00008 Diec 00000 D
143405516 | 09051397 | OF [ i 00003 Dec 00005 Diec 00000 Dec
14:24:06.900  03-06-1997  OF on =l 00003 Dec 00002 Dec: 00000 Dec:
14:24:08.286 03-06-1997 O On O 00008 Dee 00002 Dec: 00000 Dee:
1434:06.669 | 09-05-1997 | OF [ i 00009 Dec 00008 Diec 00000 D
14:34:07.056  03-06-1397  OF On OFf 00003 Dec: 00003 Dlec: 00000 Dec:
14:24:07.442 09-06-1997 O On O 00008 Dec: 00002 Diec: 00000 Dec:

L

|

| | Data Recard: 0003734000373 | Triager Disabled | Clamps: Disabled

| Guantum 21374 | Furning | Frogram ‘

You can record data to file in the Spreadsheet view. See Using the Data Logger
view on page 288.
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Using the Graphical view

Use the Graphical viewer to create graphical representations of register
contents and discrete values.

You can add your own bitmaps or choose from the library of bitmaps that
are included with the Graphical viewer.

» To access the Graphical viewer:

1. From the Network Editor, select Data Watch Window on the Data
menu.

2. Onthe View menu, select Graphical. A blank window appears with a
bitmap cell in the right uppermost corner.

Click anywhere to . ERati Sl HEER
place the bitmap

cell. 14020=0ff  00809=0n 10024=0ff
The bitmap cellis ! Fluid Valve Tank
where your bitmap

will appear.

00809=0n

10024=0fF |

Data Record: 000264/000265 = Trigoer: Disabled Clampg: Disabled

Like the other viewers, the Graphical viewer also includes Settings
and Operations menus to allow you to set triggers, trending, logging,
etc.

» Toinsert a bitmap:

1. Click anywhere in the Graphical viewer to place the bitmap cell where
you want your bitmap.

2. Right-click on the cell and select Properties. The Properties dialog box
appears.
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Select to add a bitmap
to the current cell and
configure its settings.

Select to include text

with the bitmap or pIa@

text in a cell anywhere
in the window.

Select to include a

register or discrete T~

value to a bitmap or
place a value in a cell
anywhere in the window.

3.

"~ [X Bitmaps Enabled:

Properties B

[X Enable Editing X Stietch Bitmap!

Address:
Bitmap: Browse__ |

OFF Bitmap: Browse._. |
ON Bitmap: Browse... |

[~ Text Enabled:

Alignment: C Top () Middle & Bottom
Color: Sample! Background |
" Watch Enabled:

Address:

Alignment: ® Top O Middle ) Bottom
Color: Sample|

Window Setup:

‘ Background Color: [l Background

Cancel |

Foreground |

Background | Foregiound |

Help

Configure the properties using the following information.

Bitmaps enabled

Below are descriptions of the bitmap properties:

Address: Type a Modicon discrete or analog address.

25

If you use a discrete address, you can select bitmaps to represent the off and
on states. If you use an analog address, you can specify a range of data values,
a linear scaled value, and a range of bitmaps to represent different data values.

Enable Editing: Select to allow changes in the address data state.

Stretch Bitmap: Select to fill the cell with the bitmap or clear to add the
bitmap at it’s original size.

Bitmap: Type the path and file name of the bitmap you want to add to
the cell or click Browse to navigate to it.

OFF Bitmap: Type the path and file name of the bitmap you want to
represent the off state or click Browse to navigate to it.

ON Bitmap: Type the path and file name of the bitmap you want to
represent the on state or click Browse to navigate to it.

Range: Type a range specifying the low to high data values for the
analog address. For example, 1 - 100.
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Scale Range: Type a range specifying the low to high values of the
linear scaled value.

For example, with the range set to 0 - 100 and the scale set to 0 - 4096,
the scaled range will be 50% (2048 as a value) when the analog value
is 50.

# of Bmps: Type a number of bitmaps to represent data values in the
range you specified.

For example, when the following conditions are applied:
* The bitmap “meter.bmp” is selected;
* Therangeissettol-5; and
e The # of Bmps is set to 5.

The Graphical viewer displays the bitmap “meterl.bmp” when the
data value is 1, then displays meter2.bmp when the data value is 2,
and so on.

Text enabled

Below are descriptions of the text properties:

Text box: Type the text you want to appear.
Alignment: Select where you want the text to appear in the cell.
Background: Click to select the background color of the text.

Foreground: Click to select the color of the text.

Watch enabled

Below are descriptions of the data value properties:

Address: Type the Modicon address of the value you want to monitor.
Alignment: Select where you want the value to appear in the cell.
Background: Click to select the background color of the text.

Foreground: Click to select the color of the text.

Window setup

Click Background to change the color of the entire window background.
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PID and PID2 blocks: an Overview

PID and PID2 blocks are software programming blocks that allow a process to
be controlled with no changes or additions to hardware. “PID” stands for
“Proportional Integral Derivative”. While the PID2 is a more advanced version
of the PID, both operate in the same manner.

Unless indicated, operations given in this chapter that can be performed on a PID
@ can also be performed on a PID2.

o,

++» For more information on the differences between PID and PID2 blocks, see
the ProWORX NxT online help.

Process Input

Set Point (SP) — g CaIcE:aDLtion Output Value (OV)

A

Process Variable (PV) Process

Measurement

\

Process Output

The PID calculation compares a process variable (PV) with a desired control
point called the set point (SP). The calculation uses the difference between the
set point and the process variable to adjust the PID output value (OV),
sometimes called the control variable. This output value is used to manipulate
an input to the process so that, eventually, the measured process variable
equals the desired set point.
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PID blocks are highly complex pieces of logic. While they can be very useful,
they can also be quite difficult to work with. ProWORX NxT includes a PID
display with the following functions that make online programming of PID/
PID2 blocks easier:

The PID Tuner/Face Plate display.

The PID Summary display.

The PID View Networks display.

Quick access to the Data Watch Trend Window.

Quick access to the Documentation and Register editors.

Not all controllers support PID blocks, and even fewer support the more
advanced PID2. If your controller doesn’t support PIDs, you won't be able to
add them into your logic database or access the PID display.

» To view the PID monitoring displays:

From the online Network Editor, on the Data menu, click PID
Summary.

You can switch between the Summary, Tuner/Face Plate and View
Networks displays by clicking the appropriate buttons along the top
rOwW.

To return to the Network Editor, click Close.

PID display shortcuts

To open the Register Editor for a PID block, select the PID and click
Tune.

To open the Documentation Editor for a PID’s process variable, select
the PID and click Doc.
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The PID tuner/face plate display

Sometimes it can be difficult to predict exactly how a PID’s parameters will
affect its behavior. “Tuning” a PID refers to the process of adjusting a PID’s
parameters until it operates the way you want. Often, the easiest way to
determine the best PID settings is by observing changes in the PID’s operation
as they happen.

The PID Tuner display provides PID faceplates for up to three PID/PID2
blocks at a time. This provides fast access to features necessary to monitor,
control and tune each block. Each PID face plate display looks like this:

Process  Set The bar graphs indicate where the Process Variable and Set Point

Variable Point are between the low engineering range and the high engineering
Mode: range. The higher the percentage, the closer it is to the high engi-
Auto neering range. The Process Variable is likely to change over time.
R You can change the Set Point using the Adjust button.
67%  |66%
Adjust

This area lists the register address (left) and cur-
[ Force Input Contact / rentvalue (right) of the PID’s Process Variable, Set
PV = 40200 00267 Point, and Output Variable.
SP= 40201 00264
OV = 40202 00843
Blt Movement Timer Reg!

The PID’s descriptor, as entered in the Documentation
/ Editor, see Chapter “8 Documenting your PLC” on
page 207.

From the PID face plate you can:

* Click Manual to toggle the PID’s operating mode between Auto and
Manual.

*  Click Adjust to modify the PID’s Set Point (in Auto mode) or Output
Value (in Manual mode).

* Click Trend to open up a Trend window for this PID.
* Select Force Input Contact to force on the PID’s input contact.

Switching to Manual mode temporarily halts the self-correcting operation of
the PID block. This lets you manually change the register settings to get a
better idea of how your PID works. Switching back to Auto mode returns the
PID to regular programming,.

» To access the PID Tuner/Face Plate display:

1. If you aren’t looking at the PID Summary or PID View Networks
displays, on the Data menu, click PID Summary. The PID monitor
dialog box appears.
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2. The PID Tuner is one of three displays that can be shown in this
window. If the PID Tuner display isn’t the one that appears, click the
Face Plate button. The PID Tuner display appears.

3. If your logic database has more than three PID/PID2 blocks, use the
vertical scroll bar on the right to move to the one you want.

Adjusting a PID’s set point

The Adjust Set Point dialog box (which appears when you click the Adjust
button in the PID Tuner/Face Plate display) functions differently depending
on whether the PID is in Auto and Manual mode. In Auto mode, it changes a
PID’s set point; in Manual mode, its output value.

Mode Adjustment value Value restrictions
Auto Set Point (SP) Between the High and Low Engineering
Ranges

Manual Output Value (OV) PID blocks: 0-4096, PID2 blocks: between the
high and low clamp values, normally set to 0
and 4095 respectively.

Before adjusting the Set Point, check the High Engineering Range and the Low
Engineering Range. The Set Point bar graph appearing in the PID’s Face Plate
is based on where the set point value falls within the Engineering Range.

For example, if the Low Engineering Range is 100 and the High Engineering
Range is 300 and you change the set point to 200, the Set Point bar graph would
read “50%”.

To close the Adjust Set Point dialog box and confirm your changes, click
Apply. To close the dialog box without making any changes, click Close.

Tracking PID values in the Data Watch Window

Clicking a PID Face Plate’s Trend button from within the PID Tuner display
brings up a Data Watch trend window for that PID. The trend window tracks
the PID’s register values —including its process variable, set point, and output
variable —over time, plotting them on a graph. You can have Trend windows
for multiple PIDs open at the same time.

o

% For more information on Trend windows, see page 290.
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PID Summary display

The PID Summary window displays a table with the following information on
each PID and PID2 block in the logic database:

The location of the PID in the network;

The register address for the PID’s process variable, set point and
output variable; and

A description of the PID, as entered from the documentation editor
(see page 214)

» To view the PID Summary display:

1.

If you aren’t looking at the PID Tuner or PID View Networks displays,
on the Data menu, click PID Summary. The PID monitor dialog box
appears.

The PID Summary is one of three displays that can be shown in this
window. If the PID Summary display isn’t the one that appears, click
Summary. The PID Summary display appears.

302 e PID Summary display



Chapter 13 Working with PID/PID2 blocks

PID View Networks display

The PID View Networks display provides a quick look at where PID/PID2
blocks are located in your logic networks. You can’t edit any logic from here,
but it does let you jump from one PID to another very quickly.

» To view the PID View Networks display:

1. If you aren’t looking at the PID Tuner or PID Summary displays, on
the Data menu, click PID Summary.

2. The PID View Networks is one of three displays that can be shown in
this window. If the PID View Networks display isn't the one that
appears, click View Net. The PID View Networks display appears.

» To move the network view to a different PID:

*  Click Previous or Next to cycle through the PID/PID2 instruction
blocks located in your database.
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Introduction to macros

When writing logic networks, you may find yourself reusing pieces of code
again and again, changing addresses only for a few of the variables. In these
cases, subroutines might not be suitable —such as when large numbers of
variables are involved or when you want to reuse the same piece of code in
different projects. What you're looking for is a macro.

Macros are generic pieces of logic networks you create with parameters
instead of actual addresses. Macros are programmed offline in the Network
Editor. When you insert a macro in your main logic database, you map the
parameters to real addresses. You can insert the same macro in several places
with different sets of mapped addresses each time. The addresses change but
the logic stays the same.

The main logic database retains its link to the inserted macros. This means
ProWORX NxT notices if you make changes to a macro and informs you when
you view it in the Network Editor.

Creating a new macro

Macros can only be created while offline and working in the Network Editor
or from the ProWORX NxT startup screen. Macro creation is similar to
database creation, except you select New Macro instead of New on the File
menu.

A macro’s controller (selected from the Select Controller Type dialog box) should
have the same logic instruction set as the controller used by the main logic
database. It isn't’ necessary for the controller type to be identical, as long as the
instruction sets matches.

o

% For information on creating a new logic database, see “Creating a new
database” on page 13.
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Opening an existing macro

You must be offline and working in the Network Editor or be at the ProWORX
NxT startup screen to open an existing macro database.

» To open a previously-created Macro:
1. From the File menu, select Open Macro.

2. Navigate to and select the file name of the macro database you want
to open. You are taken directly to the Network Editor.

Saving a macro

Normally, changes made to the macro database are saved as you make them,
so you don’t have to explicitly save your work. You can make a backup of your
macro database the same way you would a regular logic database.

% For more information, see “Backing up and restoring a database
(offline only)” on page 22.
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Editing a macro

In general, you edit a macro with the same tools you use in the Network
Editor. However, several Network Editor functions are disabled when editing
a macro database. Among them are:

*  The Traffic Cop

* Config Extensions

* ASCII functions

* Extended memory

* Segment Summary

* 1/0O Drawing Generator
*  Goto Segment

¢ Loader functions from the Controller menu

Using macro parameters

While in the Macro Editor, you can assign macro parameters in place of
register addresses or symbols. These are the addresses that will change for
each insertion into the main logic database.

Macro parameters use this format @txx

* The “t ” represents the type of address: 0 for Oxxxx, 1 for 1xxxx, 3 for
3xxxx and 4 for 4xxxx.

* The “xx” represents the parameter number, which can be from 1 to 50.

For example, a macro parameter of @304would represent the fourth
programmable address of the form 3xxxx. Note that @304and @404refer to
different parameters and are mapped to totally different addresses.

You can have a total of 200 parameters in your macro database — 50 for each
address type.
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Adding and removing macros from your logic database

You insert macros into your logic network while working in the Network
Editor. You can only insert macros while working offline.

» Toinsert a macro into a database:
1. On the Edit menu, click Insert then click Macro.

2. Select the name of the macro you want to insert. The Macro
Parameters dialog box appears.

DATESTINGANXTDBAMACRO1 Parameters /Type the register address

This column lists the sym-

bolic name, if any, assjgned Parameter Symbol Name Parameter  Address you want maPPEd toeach
to the macro parameter \‘\ @001 ﬂ macro parameter_
i 002
from the Macro Editor. o
@003

@004
@005
@101
@301
@302
@401
@402

Click to insert the macro
into your database. When \ |
the macro is inserted, all oc-

currences of each parameter

S
are replaced with its foer | Concel | M

3. For each macro parameter in the Parameter Symbol Name column,
type a Modicon address in the Address column. You can enter the
same address for more than one parameter if needed.

4. When all the parameters have been mapped to Modicon addresses,
click Insert. ProWORX NXxT checks each address to ensure it’s valid
for the macro parameter’s address type and range. If invalid addresses
are found, you are returned to the Macro Parameters dialog box.
Otherwise, the macro’s logic is inserted into your logic database and
you are taken to the Macro Overview screen.

S You can automate macro insertions with CODEGEN, a batch file utility included
K with ProWORX NXT.

o,

« For more information, see “Automating macro insertions with Codegen” on
page 313.
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» Toremove a macro from a database:

1. While in the Network Editor, move the cursor onto the macro you
wish to delete. The Macro Overview screen appears.

2. On the Edit menu, click Delete then click Macro. A confirmation
dialog box will appear.

3. Click Yes and the macro will be deleted from the logic database.

Deleting a macro from a database doesn’t erase the macro file from your hard
drive —it just removes an inserted macro’s logic from your main logic
database. To remove a macro completely from your hard drive, first remove it
from the database as described above, then delete its associated files with
Windows Explorer or some other file manager.

The Network Editor's macro overview display

The Macro Overview display appears in the main Network Editor when you
move the cursor onto an inserted macro. It also appears just after inserting a
macro into a database. This display gives the macro’s file name, description (a
“very long description” as entered from the documentation editor), status, and
a list of its parameters and the Modicon addresses or symbols to which they
are mapped.

Macro status

% ProwDRX NxT
File Edit “iew Seach Data Contoller Configuration Display Tools Help

MEERAEEEREE N EE

S10- | M- | WP | CINE | ) | | -SHRT| ISHRT| | ADD | SUB |MULT| Di¥ ] E:: Blell Symﬂ TCnpl

Macro NETWORK 0002 H Bl
file name \ Macro Overview
Macro Mame: D-ATESTINGANXTDBAMACRO1 [Rec:002)
/ Description: Macrol
Macro
. Parameter Addiess/Symbol
descrip- .
@0m 00002
@002 00003
@003 00305
@004 00306
@005 00093
@im 10033
@3m 30033
@302 30033
@40 40023
@402 40024
Paramete%
mapping

Descriptor: HODO2 | SC:-
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The macro status can be one of three things:

Rec: xxx: The macro hasn’t been changed since it was inserted into the
main logic network.

Macro has changed: The macro has been changed since it was inserted
into the main logic network. You may want to update the inserted
macro to reflect the changes made to the macro database it is linked to.
See the next section, “Making changes in macros”.

Macro not found: The macro database file either no longer exists or
has been moved to a different directory.

to only to assist customer support with any troubleshooting you might need.

@ Don’t worry about the exact meaning of the numbers in “Rec: xxx”. They are just

Making changes in macros

If you make changes to a macro database after it has been inserted into a main
logic network, you'll have to update each copy of it within that logic network.

There may also be times when you want to make changes in logic to a single
macro insertion without changing the original macro database. In this case,
you'll have to unlink that macro insertion. Unlinking a macro removes its
connection to the original macro database; the logic in that macro insertion
becomes part of the regular main database logic.

Once a macro insertion has been unlinked it cannot be re-linked. Changes
made to the macro database will no longer be detected by the Network Editor.

» To update a macro in a database:

1.

While in the Network Editor, move the cursor onto a macro that needs
to be updated. The Macro Overview screen appears, with a status that
reads “Macro Has Changed.” (If the macro status reads “Rec: xxx”,

where “xxx” is a series of numbers, then you don't need to update it.)

From the Edit menu, select Update Macro. The macro’s logic is
reinserted into the logic network and the status changes to “Rec: xxx”.
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» To unlink a macro from a database:

& Once you've unlinked a macro(s), you can’t relink it.

1. While in the Network Editor, move the cursor onto the macro you
want to unlink. The Macro Overview screen appears.

2. From the Edit menu, select Unlink Macro. A confirmation dialog box
will appear.

3. Click Yes. The macro is unlinked. The Macro Overview display
disappears and you are returned to the Network Editor.

Unlinking a macro removes all connections between it and your main logic

@ database, leaving the macro's logic behind as regular network logic. This affects
a single macro insertion only — if the same macro appears elsewhere in the
same logic network, its bond remains.

» To unlink all the macros from a database:

¢ From the Offline Network Editor, select Unlink All Macros on the
Edit menu.
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Automating macro insertions with Codegen

Codegen is a separate batch utility that automates the process of appending
macros to your logic. To use Codegen, first create a special .CGF batch file that
specifies which macros to insert into the database. Codegen takes this batch

file and appends the macros to the end of your main logic database.

Codegen can be used with a program consisting entirely of macros. Write
several macros at once, create a .CGF script, then use Codegen to insert the
macros into your main database. When you build up a large enough macro
library, most of your programming is done.

main logic database. It does not check to see if those macros already exist

f When Codegen runs a script file, it just appends new macros to the end of the

elsewhere within the main logic database. Thus, if you run Codegen twice on the
same logic database, two sets of macros are inserted at the end of your logic.

Appending a macro and database

Start Codegen from either the ProWORX NxT program group or using the
Windows Run command.

If an error occurs while inserting a macro, Codegen skips that macro and

jumps to the next macro entry. The information about what it did is saved to
the file codegen.log and can be viewed with the Log File Viewer a text editor
like Microsoft's Notepad.

» To create a .CGF file for Codegen:

1. Click Start, point to Programs, then select ProWORX and click
Codegen. Codegen appears.

Select an existing .CGF
file or create a new one.

/
Select a destination data-
base.

Click Start to process the
selected .CGF file and
database.

Click Save .CGF to save

!’E Prow0ORX Macro Processing Ulility

M=

Macro Configuration File [CGF): |

| [Browse... |

ProWORX Destination D atabase: |

| Browse... |

CGF Script Editor

the current .CGF data to

Start Save CGF View Log

Close Help
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2. In the Macro Configuration File (CFG) field, type the path and the
name of the macro or click Browse to navigate to it.

3. Inthe ProWORX Destination Database, type the path and file name
of the database or click Browse to navigate to it.

4. Inthe CGF Script Editor, type your macro using the following format:
<Mode>
# MacroName PathToMacro
ParameterName Address
ParameterName Address

#MacroName PathToMacro
ParameterName Address
ParameterName Address

5. Click Start. The .CGF file and database are processed.

» To compile a macro and database without opening Codegen:

1. From the Windows Run feature, click Browse to navigate to the
Codegen executable. Codegen.exe should now appear in the Open
field of the Run dialog box.

2. Using the default format below, type the path and file names of the
macro configuration (.CFG) and the database (.DCF) files.

Codegen /cgf.c:\proworx\nxt\<Filename>.cgf /
db:c:\proworx\nxt\databasename.dcf

*<Filename> contains the name of your .CGF file.

*<ProWORX NxT database name> contains the full path and file
name of your database.

3. Click OK. Codegen appends the .CGF and .DCF files as a background
task.

» To display a macro’s log file:

1. Create a .CGF file and compile it.
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2. Click Log View. The Log File Viewer appears with information about

Select an existing

.CGF file.

the compiled .CGF file.

%= ProwORX Macro Processing Utility

[_[O]]

Macro Configuration File [CGF): |C:\FHI]WI]HX\NXT\TEST1.EGF

Browse... ‘

Browse... ‘

/ ProWORX Destination Database: |C:\FRI]WI]RX\NXT\NXT_DEMU.DCF

Select a destination

database,

Click Start to pro-
cess the selected
.CGF file and data-

base.

Log File Viewer

CODEGEN ProwoORX Macro Processing Utility
Version: 1.46

Macro Script CiAProWoORXANXTATESTL. CGF
ProwORX Database C:\ProWORX\NXT\NXT_DEMO
Date 04-13-1999

Time 12:01:58

Processing Macro 1/2
ERROR: C:\DATABASE\MACRO\MAC_1

Processing Macro 2/2
ERROR: C:\DATABASE\MACRO\MAC_1

cannet be found in the lecatien specified.

cannot be found in the location specified.

=

]

|

stat | | VieweoF | Ciose |

Help

The Log File Viewer displays logged information about a compiled .CFG file.
This information includes:

The macro script path and file name;

The ProWORX database path and file name;

The date and time the macro and database were processed; and

Whether the processing was successful or the location of any errors;

.CGF batch file descriptions

Below are the descriptions for the formats for a .CGF batch file:

Mode can be one of three things:

¢ <Create New>: Clears the source database of all documentation
and logic and inserts macros at the beginning of the logic.

* <Overlay>: Leaves the documentation for the source database, but
the macro documentation can overwrite the source database's

documentation.
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e <Add To>: Leaves the documentation for the source database, but
the macro documentation that matches the source is ignored.

*  MacroName: The file name of the macro you want to insert.

* PathToMacro: The path name to the macro database, including the
back slash \ character at the end of the path.

* ParameterName: An identifier for the macro's parameter. This can be
either the parameter name (such as @001) or the symbol for it.

* Address: The Modicon address that is substituted for the parameter
preceding it on the same line.
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Monitoring the health of your hardware

With ProWORX NxT, you can easily monitor the health of your controllers and
I/0O systems. You can continuously monitor one device, schedule routine
checks of your entire network, log health data to a file, and see the status bits
of a controller’s memory. Together, these features alert you to changes in
controller health and help you track down intermittent faults.

Monitoring the health of one device

Use this feature to monitor a controller’s health from your PC instead of
manually checking status words or hardware indicators. In this mode, the
Monitor polls the controller’s health continuously until you stop it. The
Monitor displays any changes in a controller’s health on the screen and
records them to a log.

25

The Monitor only shows changes in a controller’s health status as the Monitor
runs, not what the status is when monitoring begins. For example, suppose you
begin monitoring an unhealthy controller. When you start the Monitor, it does not
notify you that the controller is unhealthy, but does let you know if the controller
changes from unhealthy to healthy.

To continuously monitor the status of one controller:
1. On the Tools menu, click Monitor then click Monitor Device.

* If you have selected a controller in the Main Screen with the
Controller menu’s Select Device command, the Monitor analyzes
that controller.

* If you have selected a controller in the Network Editor with the
Controller menu’s Change Device command, the Monitor
analyzes that controller.

* If you haven’t selected a controller, the Select Device dialog box
appears. Type the address of the controller to analyze or click Net

Scan to select one from a graphical display.

25

The Net Scan window has a separate Monitor function to check that its graphical
depiction of status lights matches the controllers.

+« For more information, see Performing a network scan on page 50.
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The Monitor Bar shows the number.
of words you are monitoring, the \

number of state changes in thosi
words, the number of times they
have been checked, and the

amount of time in seconds it takes

to complete one check.

Changes in controller health status/

are reported, date and time
stamped, then logged to a file.

The Status Bar displays the name of
the log file and the controller’s ad-

dress, type, and state.

The Monitor Status window appears.

Monitor Status

[

AN

| Qt Words: 29

Status Words
[¥ Controller Health [¥ 1/0 Health ¥ RIO Health |

e

Mizcompares: 3 Loop Count: 94 Loop Time :l].l]l]9

Word |Description

0065 |Run Light is ON

0067 Controller status word has changed
0069 Controller Stopped

Log #|Date Time

10:27:51
10:27:51

0002 | 05-06-1997
0003 | 05-06-1997

Micro 51271

)

Help |

Device: 001 | Running

\'\(MDNITDH.MDN |

View | Het Scan

Close |

Print | Delete |

Select the status words to monitor:

Controller Health: Monitors words such as 984 status, 911 states,
stop codes, EOL pointers, R I/O timeouts, ASCII message status,
and run status.

I/O Health: Monitors the Module Health Table.
* R I/O Health: Monitors the Drop or Channel Status Table.

Click Start. The Monitor begins continuously checking the health of
your controller. The Start button changes to Stop.

If a status change occurs, the Monitor displays it on your screen and logs it to a
file. This file usually has the same name as the current database with the
extension .MON. If you're working from the Startup Screen or Online Editor with
no open database, the file is called MONITOR.MON. If the Monitor finds a .MON
file for your database (or a MONITOR.MON file if you don’t have a database), it
prompts you to add to the existing file or create a new one.

4. To stop monitoring the controller, click Stop.
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» To select another controller to monitor:

& Changing to a new controller clears your log file.

Click Net Scan. The Select Device dialog box appears.

Type the address of the controller to analyze or click Net Scan to select
a controller from a graphical display.

The Net Scan window has a separate Monitor function to check that its
graphical depiction of status lights matches the controllers.

®,

% For more information, Performing a network scan on page 50.

» To print the current log:

*  Click Print. The log prints to your default printer.

» To delete the current log:

This command deletes the entire log, not just a selected entry in it. A deleted log
file is unrecoverable.

e (lick Delete.
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Viewing status words in detail

When the health of a controller changes, the Monitor records the event in the
controller’s log. The View Status Word window lets you see the changes in bits
of the status word. The function of each used bit is described, and the changed
bit is selected.

» To view a status word in detail:

1. From the Monitor Status window, click the status word to select it.

2. Click View. The View Status Words window appears.

984 STATE [X]
Status Word
’VSlalus Word 1t 001 - 984 State
MSB BASE LSB
[onooo l]l]l]1—1l]11l]l]l]1||HEX=l]lB1|
When a bit changes, its LMemow Config Flag [1=down size]

description is selected.
The word’s unused bits

are not labelled. 1= Battery Failed [0 for Micro/455/251)

- 1= Memory Protect Off
1= AC Fower On
1= 16 Bit User Logic (Max 2048 reference system)

= Single Sweep Invoked
Constant Sweep Invoked

Cloze | Help |

3. To see how the bits changed over time, click Toggle. The status word
bits are displayed in three states:

lugg|e

* Previous: two scan cycles before the change occurred;
* Base: one scan cycle before the change occurred;
* Next: immediately after the change occurred.

When the View Status Bits window opens, the Monitor shows the bits
as they appeared before the change took place (the BASE condition).

4. Click Close when you have the information you require.
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Checking the health of all controllers on a network

This feature checks the health status of all the controllers on your network,
then displays any changes on the screen and records them to alog. You can set
the LAN Monitor to repeat its scan at regular intervals.

The LAN Monitor only shows changes in your controllers’ health status from the
@ last time the Monitor ran, not the current status of the controllers. For example,

if you set the LAN Monitor to scan at one-hour intervals, when you start the

Monitor, it won't tell a controller is unhealthy or one hour later if the controller is

still unhealthy. The LAN monitor will tell you the controller has changed from
unhealthy to healthy in that hour.

» To scan the health of a network of controllers at regular intervals:

¢ On the Tools menu, click Monitor then click Monitor LAN. The
Monitor LAN window appears.

Monitor LAN IX]|  The Status Indicator

shows whether the
Time Delay: h[s min sec [ AutoPrint Monitor LAN Status: STOPPED Monitor LAN timeris

running or stopped.

When the LAN Monitor.

d te tt e tat I'O] to \ NumhellDevice ‘Addlexs |Ehangex ‘Dale |Time |:I

detects a status change 1 Micro 51271 001 00000 05031997 17:06:00

in a controller, it notes

the event in the log.

ﬁlaltMonllolLAN Yiew Log | Restart Monitor

Close | Help |

The LAN Monitor immediately scans your entire network for controllers. For
each controller located, the LAN Monitor creates a log file containing baseline
controller, I/O, and RI/O health information. This scan may take several
minutes, then displays the result in the Monitor LAN window.

You can do the following from the Monitor LAN dialog box:
*  Start Monitor LAN: Click to start the timer counting down.

When the timer reaches zero, the LAN Monitor analyzes the health of all

@ controllers on your network. It records any changes in a controller’s health to the
controller’s log file, then resets the timer and starts it counting down for the next
cycle. The LAN Monitor continues cycling until you stop it.

*  Stop Monitor LAN: Click to stop the timer.
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* Time Delay: Set the time delay between network scans with the
Hours/Minutes/Seconds fields.

* AutoPrint: Select to print changes in controller health as they occur.

*  Restart Monitor: Click to reset the LAN Monitor’s logs and timer. The
LAN Monitor deletes the old controller logs, then immediately begins
scanning your network for controllers, just as it does when the LAN
Monitor first opens.

* View Log: Click to see the changes in the controller’s health status
bits.

Viewing a controller’s health log

The LAN Monitor records changes in health status words for each controller
and its I/O and R I/O. The changes are listed in the View Log window. In it,
you can select changes in health status words to see in detail or delete the log.

» To view a controller’s health log:
1. Do one of the following;:

¢ From the ProWORX NxT Title Screen or the Network Editor, on the
Tools menu, click Monitor then click View Status. The Open
Monitor File dialog box appears. Type the path and file name of the
file to view or navigate to it. Click OK.

* From the Monitor LAN window, select a controller’s log, then click
View Log. The View Log dialog box appears.

Log #|Date Time ‘Word |Description -

Drop 01 Rack 1 Slot 02 Health Bad
0002 05-02-1997 |13:54:25 0000 Drop 01 Rack 1 Slot 06 Health Bad
0011 05-02-1997 13:54:26 | 0DOD S5S908 Statusz has changed
0012 05-02-1997 13:54:26 0001 Cable A Framing Error Count changing
0013 05-02-1997 13:54:26 0001 Cable A DMA Overrun Count changing

Each entry in the log is date 0014 05-02-1997 13:54:26 0002 Cable A Receiver Error Count changing
and time stamped, and the 0015 05-02-1997 |13:54:26 0002 Cable A Bad Drop Reception Count
change described. 0016 05-02-1997 |13:54:26 0065 Run Light is ON

0017 05-02-1997 13:54:26 0067 Controller status word has changed
The Status Bar displays the 0018 05-02-1997 13:54:26 0069 Controller Stopped =
current LAN Monitor log and
the controller's address, type, ‘P TEST1.MON MB Address: 0 Micro 512/01 STOPPED

and state. If you are viewing a

previously- saved log, the
Status Bar shows only the log Yiew | Delete Close Help |

name and controller address.
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You can do the following from the View Log dialog box:
*  (Click Close to return to the Monitor LAN window.

& When you delete a log file, it can’t be recovered.

*  Click Delete to delete the entire log.

¢ Select an event to see in detail, then click View. The View Status
Words window opens.
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Using the compare function

ProWORX NxT’s Compare function finds differences in logic and
configuration between a database and a controller or between two databases.
This powerful tool lets you be sure that your controllers are using the right
logic and are configured properly, and that a local database is the same as your
operation’s master database. You can compare elements manually or schedule
routine checks.

The Compare function examines any or all of these elements:

* Networks of logic * Coils used

* Controller configuration * Coil state

* Present user loadables * Input state

* Traffic Cop I/O settings * 3xxxx registers

* Segment Scheduler settings | ¢ 4xxxx registers

* ASCII port parameters * Coils disabled

* ASCII messages ¢ Inputs disabled

Using the on-demand compare function

This Compare function finds and highlights differences between a database
and a controller’s memory or between two databases. When the comparison is
complete, NXxT displays the findings on-screen and records them to a log, and
can send them to a printer.

To use the compare function, select the database and controller or the two
databases to compare, start the comparison, then view its results.

» To select a master database for a Comparison:
1. On the Tools menu, click Compare then click Compare again.

2. If you have a database open, the Compare function automatically
selects it as your master database; otherwise, you are prompted for a
database. The Open dialog box appears.
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3.

Type the path and file name of the database to use or navigate to it,
then click OK. The Compare dialog box appears.

File To File Compare Compare Settings:
Master Database:
C:APROWORXANXTATEST2 B |
‘ | LA ® Compare All
Compare To:
@ To File: [CAPROWORXANXTATEST3 | Browse... | O Compare Selected
C! To Conl - || Select.. |
Close | Help |

» To change the database from the default database:

1.
2.

Click Browse. The Open dialog box appears.

Type the path and file name of the database to use or click Browse to
navigate to it, then click OK. The name appears in Master Database.

» To compare your master database to another database:

1.
2.

Click To File.

To choose your second database, click Browse. The Open dialog box
appears.

Type the path and file name of the database to use or navigate to it,
then click OK. The name appears in To File.

» To compare your master database to the memory of a controller:

1.
2.

Select To Controller.

To choose a controller, click Select. The Select Device dialog box
appears.

Type the address of the controller or click Net Scan to select a
controller from a graphical display.

% For more instructions on using Net Scan, see “Performing a
network scan” on page 50.

Click OK. The type of the controller appears in To Controller.
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> To choose parameters to compare:

1.
2.

Select parameters to
compare by clicking
them.

Click to start the
comparison.

To compare all parameters, select Compare All.

To choose parameters to compare, select Compare Selected. The
Compare dialog box expands.

File To Controller Compare

Master Database:

Compare Settings:

[C:APROWORXANXTATEST2

Compare To:

B
| ﬂl O Compare All

[X Traffic Cop

X Segment Scheduler
[~ ASCIl Port Parameters
[~ ASCIl Messages

O Ta File: [ || Browse)- | @® Compare Selected
®) Ta Controller: [Micro 51271 | setect... |
~ X Networks [X Coil Used [00001-00128
[X Controller Configuration X Coil State |l]l]l]l]1 -00128
[X User Loadables [ Input State [10001-10016

[ 3xxxx Registers [30001-30001

X 4xxxx Registers |4l]l]l]1 -40109

[ Coil Disable  [00001-00128

[ Input Disable  [10001-10016

Close |

Help |

’/Click the ranges to

edit them.

Select the parameters you want to compare. The column of parameters

on the right require address ranges to be set.

Click the text box of a range to edit it. The Range Selection dialog box

appears.
Range Selection E
Range 1 00001-00512
Range2 [ | Youcanenerup
to four ranges per
Range3 [ || parameter,
0K | Cancel |

Click Start Compare. NxT reads the controller’s memory or the
second database and compares it to the Master database.
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When the comparison is complete, the Compare Summary window

appears.
Compare Summary
Master Database: Compare:
[C:APROWORXA\NXTATEST ] [Miero 51271 ] |
Click a miscompare Print Section Miscompares  Print Section Miscompares Select the mlscom-
summary to select it — . pare summaries’
. . X h { UD N
then click View to see u T T— Yes e ED': gsed NE’ Print” boxes, then
details. [ Controller Configuration es [ Coil State o click Print Selected
[X User Loadables No [ Input State No to print their details.
[® Traffic Cop No [® Input Register Contents No
X Segment Scheduler No [ Holding Register Contents  Yes
[X ASCIl Port Parameters N7A [X Coil Disable No
[® ASCIl Messages M/A [® Input Disable No
Print Selected Close | Help |

i Press TAB, then the arrow keys to move the selection bar to the miscompare to
k view. Press ENTER to view it. Press SPACEBAR to select or clear its Print box.

®,

% For more detailed instructions about this window, see “Using the
Compare Summary window” on page 333.

Scheduling comparisons to repeat automatically

Like the On-Demand Compare function, the Timed Compare finds and
highlights differences between a database and a controller’s memory.
However, the Timed Compare does not compare two databases.

Once configured, the Timed Compare repeats the comparison automatically at
the interval you set. When the comparison is complete, NxT displays the
findings, records them to a log, and, if you want, sends them to a printer.

Follow these three steps to perform a Timed Compare:
1. Create comparison entries.
2. Setand start the interval timer.

3. View the results of the comparison.

@ Up to 1,000 database/controller comparisons can be defined.
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» To create a new entry in the comparison list:

1. On the Tools menu, click Compare then click Timed Compare. The
Timed Compare dialog box appears.

Timed Compare [ ] /Set the number of
Type the time and date for .~ hours until the com-
. N 5 Y - 7
the comparisons to start in \ Current  03:32.07 05/06/1997 Compare Interval: hrs parison repeats.
these fields. Start Al |DS 26:02 ‘ |U5'D|5'1 937 ‘ Compare Status:  STOPPED
Each comparison Device Address Databaze Compare [MizCompares
parison between a Micro 51271 C:\PROWORXANXTATESTAI
controller and database
N

makes up one entry in this
list. You can define up to
1,000 comparisons.

Edit Entip | Bemove Enllyl

Start Compare

Close | Yiew | Print | Help |

2. Click Add Entry or double-click an empty slot in the list. The Open
window appears.

3. Type the path and file name of the database to use or navigate to it,
then click OK. The Compare window appears with the name in

Master Database.
File To Controller Compare Compare Settings:

Master Database:

C:APROWORX\NXTATEST2 B |
| | fowse (® Compare All

Compare To:

O Compare Selected

® To Controller: | | Select. .. |
5| |

4. Click Select to choose a controller. The Select Device dialog box
appears.

5. Type the address of the controller or click Net Scan to select a
controller from a graphical display, then click OK.

% For more instructions on using Net Scan, see “Performing a
network scan” on page 50.

330 @ Scheduling comparisons to repeat automatically



Chapter 16 Using the Compare Function

Select parameters to
compare by clicking
them.

Click to start the
comparison.

9.

> To
1.

Click Compare All to compare all parameters or click Compare
Selected to choose parameters to compare. The Compare window
expands.

File To Controller Compare Compare Settings:
Master Database:
C:\PROWORXANXTATEST2 1]
| | Lowse O Compare All
Compare To:
O To File: \ | Browse . || @ Compare Selected
® To Controller: [Micro 51271 | Select... | _|~Click the ranges to
edit them.
~ X Metworks X Coil Used [00001-00128 \
[X Controller Configuration X Coil State ‘l]l]l]l]l -00128 ‘
[X User Loadables [ Input State [10001-10016 |
[ Traffic Cop [X 3xxxx Registers [30001-30001 |
[® Segment Scheduler ¥ 4xxnx Registers ‘40001 -40109 ‘
[ ASCIl Port Parameters [ Coil Disable [00001-00128 |
[ ASCIl Messages [ Input Disable  [10001-10016 |

Close Help

Select the parameters you want to compare. The column of parameters
on the right require address ranges to be set.

Click the text box of a range to edit it. The Range Selection dialog box
appears.

Range 1 00001-00512

Range2 [ ] You can enter up

Rases [ ] | tofourranges per
parameter.

0K I Cancel |

Click OK. You are returned to the Timed Compare dialog box.

edit an entry in the Timed Compare list:

In the Timed Compare dialog box, select entry to edit, then click Edit
Entry or double-click the entry to edit. The Compare window appears.

Change the entry.

Click OK. You're returned to the Timed Compare window with the
edited entry in the list.
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» To delete an entry from the Timed Compare list:

& Deleted entries cannot be recovered.

1. Inthe Timed Compare dialog box, click the entry to remove.

2. Click Remove Entry.

» To set the start time and interval for a Timed Compare:

1. Inthe Timed Compare dialog box, type the time and date for the
comparisons to begin in the Start At fields.

* In the left field, type hours/minutes/seconds.
* In the right field, type month/day/year.

2. Click = to set the interval between comparisons (in hours). The
interval cannot be less than one hour or more than 9999 hours.

» To start or stop a Timed Compare:

1. Inthe Timed Compare dialog box, click Start Compare. There must be
at least one entry in the Comparison list before the timer starts.

When the Start At time and date match the actual time and date, NxT
performs the comparisons in the Entries list. The results are recorded
to log files.

NxT then starts a timer and waits the specified interval time. When the
time expires, NxT performs the comparison again, then resets the
timer.

2. To stop the Compare function, click Stop Compare.

» To view a compare log for an entry in the Timed Compare list:
1. Inthe Timed Compare window, select the entry to view.

2. Click View. The Compare Summary dialog box appears.
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Using the Compare Summary window

When a comparison is complete, the Compare Summary window

appears.
Compare Summary
Master Database: Compare:
[C:APROWORXA\NXTATEST ] [Miero 51271 ] |
Click a miscompare Print Section Miscompares Print Section Miscompares /SeIeCt the mlscom-
summary to select it — . pare summaries’
. . ! A “p i
then click View to see (X i S— Yes o ED': gsed NE’ Print” boxes, then
details. [ Controller Configuration es [ Coil State o click Print Selected
[X User Loadables No [ Input State No to print their details.
[® Traffic Cop No [® Input Register Contents No
[ Segment Scheduler No [® Holding Register Contents ~ Yes
[X ASCIl Port Parameters N7A [X Coil Disable No
[® ASCIl Messages M/A [® Input Disable No
Print Selected Close | Help |

i Press TAB, then the arrow keys to move the selection bar to the miscompare to
k view. Press ENTER to view it. Press SPACEBAR to select or clear its Print box.

» To print the results of the comparison:
1. Inthe Compare Summary dialog box, click the miscompares to print.

* For all miscompares except Networks, this option prints the same
information that is displayed by the View button.

* For Networks, this option prints a brief list of miscompares. To
print the details of Network miscompares (including networks of
logic), click Print in the Network Compare window.

o

% For more information, see page 336.

2. Click Print Selected. The summaries print to your default printer.
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» To view the details of any miscompare except Networks:

The contents of this window
change depending on the
parameter you select to
view in the Compare Sum-
mary window.

NXT provides descriptions
of the miscompares to help
you either correct them or
locate additional informa-
tion in your controller's
manual.

In the Compare Summary window, select a miscompare and click
View, or double-click the miscompare. The View Results window
appears.

View Results [ %]
\ Controller Configuration

Description Master Compare

09128
aea16
aeaa1
09345
09345

216009
Qaz256
Q3099
Qan0g
Qan0g

Number
Number
Humher
Config

of Bxxxx configured
of lxxxx configured
of Fxxxx configured
Extension Size
Extension Size
Extension Changed

Config
Config

Help

» To view the details of Network miscompares:

Information about the
master database is in
the left of the column;
the second database or
controller appears on
the right.

Column entries list the —T

number of a network in
one database and its
condition in the other.
Entry 4, for example,
says that Network 8 in
the master database
does not exist in the con-
troller.

In the Compare Summary window, select Networks and click View
or double-click Networks. The Network Compare window appears.

Network Compare E

Master Database: TEST3 Compare: Micro 512

Mast vs Comp ‘Masl ¥s Comp |Ma:l ws Comp ‘Masl ¥s Comp |Ma:l ws Comp
0001 BLANK. ~ NOT FND 0013
0005 SIM D005

0007 BLANK

0008 NOT FND

0009 MOV 0008

0010 MOV 0009

0011 MOV 0010

0012 MOV 0011

0013 MOV 0012

0014 NOT FND

NOT FND 0001

NOT FND_0007

Help

Mot Found | Print | Close |

Network Compare reports the following errors:

Blank: One database has logic in a network while the other has
nothing. The Compare function lists the number of the mismatching
network.

Moved: Identical logic appears in both databases, but in different
networks. The Compare function lists both network numbers.
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* Similar: Closely matching (but notidentical) logic appears in the same
network in both databases. The Compare function lists the network
number.

* Not found: Logic in one database doesn’t appear in the other. The
Compare function lists the number of the network containing the
logic.

These errors often appear in pairs. For example, if two databases each contain
different logic in Network 12, the Compare function reports that one network
of logic in the first database does not exist in the second, and one network of
logic in the second doesn’t exist in the first.In the table, you see this result:

MAST VS COMP

0012 NOT | FND

NOT END | 0012

Not Found errors also frequently appear when networks of logic have been
moved in one database but not another. Suppose a master database is used to
program a controller, then the logic originally in Networks 3 and 4 of the
master database is moved to Networks 4 and 5. If the database is now
compared to the controller, these results appear in the table:

MAST VS COMP

NOT FND | 0003

0003 MOV | 0004

0004 MOV | 0005

0005 NOT | FND

The third network in the controller no longer appears in the master database
(because, in the database, that logic has been moved to the fourth network).
Similarly, the fifth network in the master database does not appear in the
controller (because, in the controller, that logic is still in the fourth network).
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» To print Network miscompares:

1.

In the Network Compare window, click Print. The Network Print
dialog appears.

Do one of the following:

Summary: Click to print a concise list of all network miscompares.
Similar: Click to print the logic of networks similar to each other.
Moved: Click to print the network logic that only differs in location.

Not Found: Click to print the logic of all networks found in one
database, but not the other.

» To see networks of logic resembling each other but not identical:

1.

Differences between the two
databases (or the database
and your controller) appear in
red.

In the Network Compare window, click Similar. The View Similar
screen appears.

View Similar Networks

Master Network: 0001

| I
I 1
10001 o028 00212 00 1

[ [
0001 o2 00003 00033 o101

00033 00044

[
00033 o1y

Close I Toggle | Mext Match

Help |

Clear Match

2. Do one of the following:

* Toggle: Click to switch views between the master database and the

second database or controller. Switching between the networks of
logic makes it easier to spot any differences.

Next Match: Click to move to the next pair of similar networks. At
the end of the list of matches, click Next Match again to go to the
start of the list.

Clear Match: Click to remove the current pair of networks from the
Similar list. This doesn’t delete the networks of logic themselves,
only their entry in the Network Compare window.
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» To see networks appearing in one database but not the other:

1. Inthe Network Compare window, click Not Found. The View Not
Found Networks dialog box appears.

Yiew Mot Found Networks =]
Compare Network: 0005

T e -
1oooat | ooo16z iz
Y e e o
000020 000119 100017 [ilinigE}
N ,,,,e™$™”e et
000013 0001Z0 100016 im0

I e O
100018 002 1
1 T -
100003 000015

S O
00001E

(e B e F -
ono1s  ooot2o 100016 ooao20

Close | i Toggle | Mext Match Set Match | Help |

2. Do one of the following:

* Toggle: Click to switch views between the master database and the
second database or controller.

networks present in the master database but not the second database or
controller, and another for networks present in the second database or controller
but not the master database. Click Toggle to switch between these lists.

@ The Compare function generates two independent Not Found lists: one for

* Next Match: Click to move to the next Not Found network of the
current view. Clicking Next Match only affects the current view:

each of the two Not Found lists operates independently of the
other.

¢ Set Match: Click to remove the current network from the Not
Found list.
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Configuring a BM85 Bridge multiplexer

A BMB85 Bridge Multiplexer allows you to connect up to four Modbus devices
or networks of Modbus devices to a Modbus Plus network.

You can use ProWORX NXxT to configure a BM85’s Modbus ports (either
manually or from files you create and load) and edit the BM85’s Address
Routing Map.

Reading or loading a BM85 configuration

Before configuring the Modbus ports of a BM85, NxT must read the current
configuration of the BM85 or load a previously-saved MUX file from disk.

You can also load a MUX file after reading the current configuration, but loading
one directly can save you time.

» To read a Modbus port configuration from a BM85:

1. From the ProWORX NxT Title Screen or the Network Editor, on the
Tools menu, click BM85 MUX Setup. The Read BM85 Configuration

dialog box appears.

1. Set MODBUS Port Configuration switches on BM85 to:
CONFIGURE. PORT 1. 9600 BAUD. NO PARITY_ 1 STOP BIT
[All off)

2. Connect cable to MODBUS PORT 1 on BM85.

3. If BM85 was already in CONFIGURE mode. click the Configure
button. If not or not sure, turn BM85 OFF, and then ON.

| Configure I Cancel | Load MUX File | Help |

2. Follow theinstructions as they appear to connect your computer to the
BMS5.

3. Click Configure. NxT looks for a BM85 until it finds one. If your PC is
not connected to a BM85 or is connected incorrectly, press ESC to
return to the Network Editor.

NxT reads the current configuration of your BM85, then displays it in
the BM85 Port Parameters window.

% For more information, see “Configuring the Modbus ports of a BM85”
on page 342.
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» Toload a MUX file for editing:

1.

From the ProWORX NxT Title Screen or the Network Editor, click
Tools then click BM85 MUX Setup. The Read BM85 Configuration
dialog box appears.

FRead BM85 Configuration E

1. Set MODBUS Port Configuration switches on BM85 to:
CONFIGURE. PORT 1. 9600 BAUD. NO FARITY. 1 STOP BIT
[All off)

2. Connect cable to MODEUS PORT 1 on BMB5.

3. If BM85 was already in CONFIGURE mode. click the Configure
button. If not or not sure. turn BM85 OFF. and then ON.

Configure

Cancel | ELoad MUX Fileé Help |

Follow the instructions as they appear to connect your PC to the
BMS5.

Click Load MUX File. The Select MUX Setup File window appears.

Type the path and file name of the MUX file or navigate to it, then click
OK. NxT loads the MUX file, then displays it in the BM85 Port
Parameters window.
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Configuring the Modbus ports of a BM85

With ProWORX NxT, you can configure each of a BM85’s four ports, edit the
ports” Address Routing Maps and save your settings to disk as a MUX file
which can be loaded later.

After reading the configuration from a BM85 or loading a saved MUX file from
disk, the BM85 Port Parameters dialog box appears with the configuration

information.
BMBES5 Port Parameters [ %]
| MUX Version: 1.01 MB+ Address: 58
Parameter Port 1 Port 2 Port 3 Port 4
Type |Maxle[ j‘ |S|ave j‘ |Nel|m]rk j‘ |XMaxlEl j|
A N o R e R
Baud Rate [6o0 =] | [300 =] | [so0 = 120 7]
SwpBits | [1 e = [ =l [ zl
Parity [Even =] [odd =] | [None ]| [Even =]
Mode [Ru =] [ascu 7] [RTu =] [ascn 7]
Priority [t N E = [ AR =l
Modem Booster |No j‘ |No j‘ |Yes j‘ |Nu ﬂ|
Routing Save File | Load File Help |

Below are the descriptions for each port parameter in the BM85 Port
Parameters dialog box:

* Type: Selects the Modbus device that attaches to the port.
¢ Master: Select for a master device, such as a PC.
* XMaster: Select for devices in Silent Master mode.
¢ Slave: Select for a slave device, such as a PLC.
*  Network: For a network of slave devices connected through a modem.

* Address: Sets the address of a slave device from 1 to 247. This option
is not available unless the port type is set to Slave.

* Baud Rate: Sets the speed of data transmission in bits per second. The
default is 9600.

* Stop Bits: Sets the number of bits at the end of a packet which prepare
the receiving device for the next packet. The default is 1.
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Parity: Adds a check bit to a packet to make the number of binary ones
always either odd (Odd Parity) or even (Even Parity). If parity is set to
None, the check bit is not added. The PC and controller must use the
same parity. Default is even.

Mode: Selects a communications mode for the port, RTU or ASCIL
The default is RTU.

Priority: Determines the order in which the BM85 checks the ports,
with 1 the highest priority and 4 the lowest. All ports must have
different priorities.

Link Timeout: Sets the maximum time in multiples of 100
milliseconds that the BM85 waits for slave devices to respond to
commands before it sends an error message.

Modem Booster: Determines whether the BM85 maintains a
dedicated connection to a slave device until it completes a command
or transparently processes other network traffic while it waits. This
option is not available unless the port type is set to Network. Note that
this option should be set to No for ports attached to 584 controllers
operating in SAFE84 Mode.

To configure the Modbus Ports of a BM85:

1.

For each port, select or type the parameter values using the parameter
descriptions above.

Click Load File to load a MUX file from your disk. The Select MUX
Setup File window appears.

Type the path and file name of the MUX file or navigate to it, then click
OK. NxT loads the MUX file.

Click Save File to save the current port settings into a MUX file. The
Save MUX File window appears.

Do the following:

* Type the path and file name of the MUX file, then click OK. NxT
saves the MUX file to your disk for a network of slave devices
connected through a modem.OK. NxT saves the MUX file to your
disk.

* Click Routing to edit the BM85’s address routing map.

To write your changes, click OK to the BM85 for a network of slave
devices connected through a modem. It may take a few moments to
configure the BM85’s ports according to your settings.
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Editing a BM85’s address routing map

Each of the four Modbus ports on a BM85 has its own Address Routing Map.
When the BM85 receives a message at a Modbus port, it compares the address
of the message to the appropriate address routing map. The BM85 then
redirects the message to a Modbus Plus network or device according to the
routing information it finds. Use NxT to view and edit the BM85’s address
routing maps.

You must set a port’s Port Type to Master or XMaster in the BM85 Port
Parameters window before the BM85 will use its address routing map.

» To edit the Address Routing Map of a BM85:

1. From the ProWORX NxT Title Screen or the Network Editor, click
Tools or click BM85 MUX Setup. The Read BM85 Configuration
dialog box appears.

2. Follow the instructions on your screen to connect your computer to
the BM85.

3. Click Configure. NxT reads the current configuration of your BMS85,

then displays it in the BM85 Port Parameters window.

25

If your PC is not connected to a BM85 or is connected incorrectly, press ESC to
return to the Network Editor.

4. Click Routing. The BM85 Address Routing Map window appears.

The BM85 reroutes messag-
es addressed to the Modbus Port 1 Port 2 Port 3 Port 4
Address to the associated Addr Routing Addr Routing Addr Routing Addr Routing

Modbus Plus device.

Modbus Modbus Plus
Address Device
\
14 14 140,000
15 15 15,0,0,0,0
16 16 160,000
17 17 170,000
12 18 120,000

Edit

Delete |

Help

You can see the first
18 routing paths of
the 64 available for
each Modbus port.
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The Edit Address Routing dialog box appears when you do one of the
following:

* Select a routing path to delete, then click Delete.
* Select a routing path to edit, then click Edit.
* Double-click a routing path to edit.

Edit Address Routing E

Port: 1
Table Index: 1

Address: IEI
Routing Path: |1.0,0.0.0

0K | Cancel |

In the Address field, type the reference Modbus address.

In the Routing Path field, type the Modbus Plus address to which the
message will be rerouted, then click OK. The Edit Address Routing
dialog box closes.

Select another address to edit, then click OK. You're returned to the
BMS85 Port Parameters dialog box.

When you are satisfied with your changes, click OK. It may take
ProWORX NxT a few moments to configure the BM85’s ports
according to your settings.
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Configurable mnemonics

Use mnemonics to enter ladder logic instructions in the Network Editor. To
edit a mnemonic, on the File menu, click Utilities, then click Mnemonics.

No. Mnemonic Description
01 NO -11- Normally Open
02 NC -I\[- Normally Closed
03 PTC -1P[- Off to On
04 NTC -IN[- On to Off
05 VTO | OPEN Vertical Open
06 VTS | SHRT Vertical Shunt
07 HSH -SHRT Horizontal Shunt
08 CNR -()- Normal Coil
09 CR -(L)- Latched Coil
10 SKP SKP Skip Function
11 UcCT UCTR Up Counter
12 DCT DCTR Down Counter
13 T1 T1.0 Timer (seconds)
14 T0 T0.1 Timer (tenths)
15 T. T.01 Timer (hundredths)
16 ADD ADD Addition
17 SUB SUB Subtraction
18 MUL MULT Multiplication
19 DIV DIV Division
20 RT R->T Register to Table
21 TR T->R Table to Register
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No. Mnemonic Description
22 TT T->T Table to Table
23 BLK BLKM Block Move
24 FIN FIN First-In
25 FOU FOUT First-Out
26 SRC SRCH Table Search
27 STA STAT System Status
28 AND AND Logical And
29 OR OR Inclusive Or
30 CMP CMPR Logical Compare
31 SEN SENS Logical Bit Sense
32 MBI MBIT Logical Bit Modify
33 CcoOM coMP Logical Complement
34 XOR XOR Exclusive Or
35 BRO BROT Logical Bit Rotate

Configurable mnemonics ® 349






Appendix B - File Extensions




ProWORX NXT User's Guide

File extensions

NxT requires many different types of files to operate. You can determine the
purpose of files in the NxT directory by their extensions.

The files marked with an asterisk(*) make up a database.

Database files

Extension Type of File

.CML* Comment (long) data file

.CPF* Comment (long) pointer and length file
.DCF* Database configuration file

.DDF* Descriptor data file

.DPF* Descriptor pointer file

.LGF* Log book note file

NDF* Short comment file

.TDF* Title data file

TSF* ProWORX symbol file

Controller memory files

Extension Type of File

.LDF* Logic data file

.LPF* Logic pointer file

.MDF* Memory data file

XDF* Extended memory data file
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Report files
Extension Type of File
.LOG Text log file from utilities like CODEGEN
JIXT Print-to-file output

Loadables
Extension Type of File
.MSL MSL loadables
.USL USL loadables

Additional files
Extension Type of File
.BLK Block data file
.CDT Temporary long comment data file
.CGF Codegen batch file for automating macro insertions
.DDB Descriptor data file used with blocking
.DIF Data interchange file
.DPB Descriptor pointer file used with blocking
.DSF Data setup file
.DSU Data setup file for entry to network display
FIL ProWORX format export file
HLP Help file
.LPB Logic pointer file used with blocking
.MDB Memory data file used with blocking

Report files
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Extension Type of File

.NDB Short comment file used with blocking

.OPT List module option file

.RDF Cross-reference data file

.RUF Address Used Tables reference file

.RPF Cross-reference pointer file for database listing
.SRC Search data file

.TDB Title data file used with blocking

.TFP ProWORX full page data file

.URF User Configurable Register editor file
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The Modbus cable kit

The Modbus Cable Kit contains the materials you need to connect an IBM or
compatible computer to a Modbus device. The kit consists of:

* A 9-Pin Adaptor for use with 9-pin serial ports (used on IBM AT and
compatible computers). This cable has one 9-pin female DE9S
connector and one 25-pin male DB25P connector. The 9-Pin Adaptor
may be used to adapt any PC/XT compatible serial cable for use with
an AT-style serial port.

*  Modbus Cable for use with 25-pin serial ports (used on IBM PC, PC/
XT, PS/2, and compatible computers). This cable has one male 25-pin
DB25P connector and one female 25-pin DB25S connector.

* 584 Adaptor Module for use with Modicon 584 controller and W190
cable. This adaptor has two female 25-pin DB25S connectors enclosed
in a plastic housing.

* 680 Adaptor Cable for use with Modicon 984 x80 and x85 models. This
cable has a female 25-pin DB25S connector and a male 9-pin DE9P
connector.

IBM AT or PS/2 to Modicon 984A, 984B, or 984X

The Modbus Cable and 9-Pin Adaptor combination are used to connect an AT
computer with a male, 9-pin DE9P serial port to a 984A, 984B or 984X
controller. Plug the 9-pin female connector of the 9-Pin Adaptor into your
computer’s serial port and the 25-pin male connector into the Modbus Cable’s
female connector. Plug the Modbus Cable’s male connector into the
controller’s Modbus port. Modbus port 1 is normally used.

IBM AT to Modicon 984 x80 or x85, Quantum, or Compact Series

The Modbus Cable, 9-Pin Adaptor and 680 Adaptor Cable are used to connect
an AT computer with a male, 9-pin DE9P serial port to a 984 Model x80 or x85
controller. Plug the 9-pin female connector of the 9-Pin Adaptor into your
computer’s serial port and the 25-pin male connector into the Modbus Cable’s
female connector. Plug the Modbus Cable’s male connector into the 680
Adaptor Cable’s female connector. Plug the 680 Adaptor Cable’s male
connector into the controller’s 9-pin Modbus port.
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IBM AT to Modicon 584

The Modbus Cable, 9-Pin Adaptor and 584 Adaptor Module are used to
connect an AT computer with a male, 9-pin DE9P serial port to a 584 processor.
A Modicon W190 Cable (the cable used to connect a 584 to a P190
Programming Terminal) is also required.

Plug the 9-pin female connector of the 9-Pin Adaptor into your computer’s
serial port and the 25-pin male connector into the Modbus Cable’s female
connector. Plug the Modbus Cable’s male connector into either end of the 584
Adaptor Module. Plug the other end of the 584 Adaptor Module into the W190
Cable. Plug the W190 Cable’s circular connector into the 584 controller’s
Modbus port.

IBM PC/XT or PS/2 to Modicon 984A, 984B, or 984X

The Modbus Cable is used to connect a PC/XT or PS/2 computer with a 25-
pin male DB25P serial port to a 984 processor. Plug the Modbus Cable’s female
connector into your computer’s serial port, and the male connector into the 25-
pin Modbus port on the 984. Modbus port 1 is normally used.

IBM PC/XT or PS/2 to Modicon 984 x80 or x85, Quantum, or
Compact Series

The Modbus Cable and 680 Adaptor Cable are used to connect a PC/XT or PS/
2 computer with a 25-pin male DB25P serial port to a 984 Model x80 or x85
series controller. Plug the Modbus Cable’s female connector into your
computer’s serial port. Plug the Modbus Cable’s male connector into the 680
Adaptor Cable’s female connector. Plug the 680 Adaptor Cable’s male
connector into the controller’s 9-pin Modbus port.

IBM PC/XT or PS/2 to Modicon 584

The Modbus Cable and 584 Adaptor Module are used to connect a PC/XT or
PS/2 computer with a 25-pin male DB25P serial port to a 584 processor. A
Modicon W190 Cable (the cable used to connect a 584 to a P190 Programming
Terminal) is also required.

Plug the Modbus Cable’s female connector into your computer’s serial port,
and the male connector to either end of the 584 Adaptor Module. Plug the
other end of the 584 Adaptor Module into the W190 Cable. Plug the W190
Cable’s circular connector into the 584 controller’s Modbus port.
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Using other computers

Follow the directions on the preceding pages if your computer has a serial port
that is compatible with an IBM AT, PC/XT, or PS/2 computer. If not, your
computer dealer may be able to supply an adaptor cable that terminates in a
PC-compatible connector. Connect the cable to your computer, then follow the
instructions on the preceding pages.

Always verify the connector location, type and pinout before connecting
anything to your computer.

Both serial and parallel ports may be terminated in 25-pin connectors, and
both serial and video ports may be terminated in 9-pin connectors. If you are
in doubt about which port to use, consult the documentation included with
your computer or your computer dealer.

Some computers may be configured as Data Communications Equipment
(DCE) rather than the Data Terminal Equipment (DTE) configuration used by
IBM. Contact Customer Support about obtaining a DCE to DTE adaptor if you
have such a computer.
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Cable wire diagrams

These drawings illustrate needed cable connections for connecting a PC-
compatible computer to a Modicon controller or associated device.

25-Pin Serial Port to Modicon 984A, 984B, or 984X
25 -pin female DBEES
Computer |0 1235qo OOOOOOOO...O.O.O.O.O.OO?1 ; o
[ 11
23458 7 6 820
13 24 a8 7T B 820
Shield J L L1 |
Cortroler | 11(.o.o.o.o.o.o.o.ooooooooooPLS o

28-pin male DB 26F

25-pin 25-pin
female e

. ——%—1 1

9-Pin Serial Port to Modicon 984A, 984B, or 984X

9-pin fermale DB9S
Computer [0 5931 o]
T 111

1

12 3 4 5 6 7 8
203 7
Shietd |

lieseeeee®CCOOO)

Contraller | IMS
25-pin male DBEZ25F

9-pin 23-pin

CF—4—1

45 76 820
L L1

o]
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25-Pin Serial to Modicon 984 x80 and x85

28-pin female DEZRS

013
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9-Pin Serial to Modicon 984 x80 and x85

Computer
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female

]

3-pin female DB3S

u]

o

9-pin male DBAF

S-pin
e

[T

%
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25-Pin Serial to Modicon 584 with W190 cable

25-pin fermale DB255

T
HMooCooO e eeeeeec)
@WMWOQAOOOOOQOOOOOOA4O

1 1
457 B 5120

23
23

457 6 520
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1
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%

9-Pin Serial to Modicon 584 with W190 Cable

3-pin female DBSS
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25-Pin Serial to Modicon E Series, Quantum, or Compact

25-pin female DBZ5S

I T
HMoocoooo e eeeeec)
Computsr |0 zs;oooooooooooogm o
1

Shield 7

1 5
Contraller O BQ o]

3-pin male DBAF
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9-Pin Serial to Modicon E Series, Quantum, or Compact
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1 5
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3-pin male DBAF

S-pin S-pin
female e
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25-Pin Serial to Modicon Micro 311 or 411

28-pin female DBZ5S
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25-Pin Serial to Modicon J478 modem

25 pin female DB258
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IBM 5531 to Modicon 984A, 984B or 984X

IBM 5331 Modicon 934A,
984B, or 984X
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"] 25 CF
/N N
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IBM 5531 to Modicon x80 and x85
IBM 5531 Modicon x80 and
%85 Series
[ 1] (1]
|2 | ey
B Iy
4 7
Al H[?
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3 4
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"] 25 CF
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hood cover 2 pr. shielded conductor hood cover
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IBM 5531 to Modicon 584 with W190 cable

IBM 5531 Modicon 584 with
W190 Cable
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Loopback connectors
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Editing .DIF files with Microsoft Excel

NxT exports database documentation in two formats which Microsoft Excel
can read:

dBase4 (.DBF): Use this database format if possible as Excel reads and
writes it correctly. When you export a database to a .DBF file, each
descriptor field and short comment becomes its own record.

Data Interchange Format (.DIF): When Excel imports a .DIF file, it
converts the controller addresses in the first column of the database
into numerical values which NxT cannot read. Excel also exchanges
the rows and columns of the database in the .DIF file’s header. Unless
you correct these problems, an error appears when you try to import
a .DIF file back into NXT after you have changed it in Excel.

If you prefer to use .DIF files instead of .DBF files and want to use Excel to edit
documentation, follow these seven steps:

» Step 1: Set the size of your descriptor fields for Microsoft Excel.

1.

Open your database in ProWORX NxT.

% For more information, see “Opening an existing database” on
page 17.

From the Network Editor, on the File menu, click Utilities then click
Database Setup.

Change the Descriptor Field Width to 15.
Change the number of Descriptor Fields to 9.

Click OK. A dialog box prompting you to expand your database may
appear. Click OK.

» Step 2: Export your NXT database as a .DIF file.

1.

From the Network Editor, on the File menu, click Utilities then click
Import/Export.

Select Export.

Type the path and file name of the file to export your database to or
click Browse to navigate to it.

Select .DIF as the File Type to create.
Click Start.
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» Step 3: Open and edit your database in Microsoft Excel.
1. Open the .DIF file in Microsoft Excel. The spreadsheet looks like this:

A C D E F K
Address 1 D Desc. 1 Desc. 2 Desc. 3 Desc. 4 Desc. 9
Address 1 S Comment1 | Comment2 | Comment3 | Comment4

Address 1 L Lookup 1

Address 1 T Page Title

Address 2 D Desc. 1 Desc. 2 Desc. 3 Desc. 4 Desc. 9

The number in Column A tells you what controller address the row
describes. The letter in Column B tells you what information the next
cells in the row contain.

If the letter in Column B is... | The following cells in the row contain...

D (for Descriptors) descriptors 1 through 9 in columns C through K.

S (for Short Comments) short comments 1 through 4 in columns C through F.
L (for Long Comments) a long comment lookup number in column C.

T (for Page Title) the page title in column C.

2. Make your changes to the documentation.

» Step 4: Convert the controller addresses from numbers to text.
1. Find an unused column in the spreadsheet.

This temporary column holds information during the conversion
process.

2. Inthe first cell of the unused column, type: =TEXT(A1,“00000”). This
formula converts the numerical value in cell A1 into a text value which
NxT can read. When you press ENTER, the text value appears in the
cell where you entered the formula.

3. Select the cell.
On the Edit menu, click Copy.
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5. Select the temporary column by clicking its header.

For example, if you entered the TEXT formula into the first cell of
Column M, now select all of Column M.

6. Onthe Edit menu, click Paste. This operation pastes the TEXT formula
copied from the first cell of the temporary column into all the other
cells in the column.

Click Yes if a warning message appears telling you that the selection
is too large for Undo.

The temporary column now contains the same values as Column A,
but formatted as text instead of numbers.

Select the entire temporary column again.
On the Edit menu, click Copy.
Select Column A.

10. On the Edit menu, click Paste Special, then click Values. The text
values from your temporary column replace the numerical values in
column A.

Click Yes if a warning message appears telling you that the selection
is too large for Undo.

11. Select the entire temporary column.

12. On the Edit menu, click Clear then click All. The values in your
temporary column disappear.

Click Yes if a warning message appears telling you that the selection
is too large for Undo.

» Step 5: Export the Microsoft Excel spreadsheet as a .DIF file.
* Save the edited database as a .DIF file.
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» Step 6: Correct the rows and columns in the .DIF header.

1.

2.

Open the .DIF file with a text editor.

Microsoft’'s WordPad in Windows ‘95 or Write in Windows 3.1 open
.DIF files.

Switch the “VECTORS” and “TUPLES” values in the header of the
.DIF file.

TABLE

01
“EXCEL”
VECTORS

urr

Swap these values

TUPLES

“rr

@ “XXXX" and “X” will be numbers.

3.

Save the edited database as an ASCII .DIF file.

» Step 7: Import your database back into ProwORX NxT.

1.

AR N

From the Network Editor, on the File menu, click Utilities then click
Import/Export.

Click Import.

Type the path and file name of the Excel database.

Select .DIF from the File Type box.

Click Start. The open database is overwritten by the Excel database.
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I/O cards supported (in alphabetical order)

A120 cards

Card Description Card Description

ADU 204 |4 Channel Register Input (+/-0.5V) DEO 216 |24 VDC 16 Point Input Module

ADU 205 |4 Channel Register Input (+/-10V) DEP 208 |230 VAC 8 Point Input Module

ADU 206 |4 Channel Register Input DEP 209 |120 VAC 8 Point Input Module

ADU 211 |8 Channel Analog Input Module DEP 210 |115 VAC 8 Point Input Module

ADU 212 | 8 Channel Analog Input Module DEP 211 | 115 VAC 8 Point Input Module

ADU 214 |4 Channel Multi Range A/D Input DEP 214 |12-60 VDC 16 Point Input Module

ADU 216 |8 Channel Thermocouple DEP 215 |5 VDC TTL 16 Point Input Module

CM900 | Auto Interface DEP 216 |24 VDC 16 Point Input Module

DAO 216 |24 VDC 16 Point Output Module DEP 217 |24 VDC 16 Point Input Module

DAP 204 |24 VDC 4 Point Relay (NO) Module DEP 218 |115 VAC 16 Point Input Module

DAP 208 |24 VDC 8 Point Relay (NO) Module DEP 220 | Fast 24 VDC 16 Point Input Module

DAP 209 |120 VAC 8 Point Output Module DEP 296 |60 VDC 16 Point Isolated Input Module

DAP 210 |24-230 VAC 8 Point Output Module DEP 297 |48 VDC 16 Point Isolated Input Module

DAP 212 |24 VDC 8 Point Input/4 Point Output M7251 | Programmable Limit Switch

DAP 216 |24 VDC 16 Point Output Module M7350 | Resolver Decoder Function Module

DAP 217 |5-24 VDC 16 Point Output Module MOT 201 |1 Slot 1 Axis Motion Control Module
Encoder

DAP 218 | 24-240 VAC 16 Point Output Module MOT 202 |2 Slot 1 Axis Motion Control Module
Resolver & Encoder

DAP 220 |24 VDC 8 Point Input/Output Module |VIC200 |4 High Speed Pulse or 4 VRC Inputs

DAP 252 | LowTemp 24 VDC 8 Point Input/4 Point | VIC 205 |4 High Speed Pulse or 4 5V TTL Inputs

Output
DAP 253 | LowTemp 110VDC 8 Point Input/4 Point | VIC 212 |4 High Speed Pulse or 12 VDC Inputs
Output

DAP 292 |60 VDC 8 Point Input/4 Point Output VIC 224 |4 High Speed Pulse or 24 VDC Inputs

DAU 202 |2 Channel Register Output (+/-10V) ZAE 201 |High speed Counter/Positioner (2 Relay)

DAU 204 |4 Channel Analog Output, Opto-Isolation | ZAE 204 |4 Channel High speed Counter/
Positioner

DAU 208 |8 Channel Register Output (+/-10V)
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B80O0 cards
Card Description Card Description
B802-008 |115 VAC 8 Point Output Module B863-032 |4 Channel Register Input (TTL Level)
B803-008 |115 VAC 8 Point Input Module B864-001 |8 Channel Register Output (TTL Level)
B804-016 |115 VAC 16 Point Output Module B865-001 |8 Channel Register Input (TTL Level)
B804-116 | 115 VAC 16 Point Output Module B868-001 |8 Channel Register Output (TTL Level)
B805-016 |115 VAC 16 Point Input Module B869-001 |8 Channel Register Input (TTL Level)
B806-032 |115 VAC 32 Point Output Module B872-002 |4-20 mA,1-5V 4 Channel Analog Output
B806-124 |24 VAC 32 Point Output Module B872-011 | Selectable 4 Channel Voltage Output
B807-032 |115 VAC 32 Point Input Module B872-100 |4-20mA 4 Channel Current Output
Module
B807-132 |115 VAC 32 Point Input Module B872-200 | Selectable 4 Channel Voltage Output
B808-016 |230 VAC 16 Point Output Module B873-001 |4-20mA,1-5V 4 Channel Analog Input
B809-016 |230 VAC 16 Point Input Module B873-002 |4-20mA,1-5V 4 Channel Analog Input
B810-008 |115 VAC 8 Isolated Output Module B873-011 [-10V to 10 V 4 Channel Analog Input
B814-001 | NO Power Relay 8 Point Output Module |B873-012 |-10V to 10 V 4 Channel Analog Input
B814-002 | NC Power Relay 8 Point Output Module |B873-200 |V/A, Thermo, RTD, Strain Gauge Input
B814-108 | NO/NC Power Relay 8 Point Output B875-001 |4-20mA, 1-5V 8 Channel Analog Input
Module
B817-116 |115 VAC 16 Point Isolated Input Module |B875-002 |4-20mA, 1-5V 8 Channel Analog Input
B817-216 |230 VAC 16 Point Isolated Input Module |B875-011 |-10 V to 10 V 8 Channel Analog Input
B818-032 |24 VDC 32 Point Output (True High) B875-012 |-10V to 10 V 8 Channel Analog Input
B819-232 | 230 VAC 32 Point Input Module B875-101 |Fast selectable 8 Channel Analog Input
B820-008 |10-60 VDC 8 Point Output (True High) B875-102 | Fast selectable 8 Channel Analog Input
B821-008 |10-60 VDC 8 Point Input (True High) B875-111 | Select. 8 channel Differential Input
B821-108 |10-60 VDC 8 Point Input (True High) B875-200 |V/A, Thermo, RTD, Strain Gauge Input
B824-016 |24 VDC 16 Point Output (True High) B877-111 | Select. 16 channel Single Ended Input
B825-016 |24 VDC 16 Point Input (True High) B881-001 |24 VDC 16 Point Latched Input (True
High)
B826-032 |24 VDC 32 Point Output (True High) B881-108 |115 VAC 8 Point Protected Output
Module
B827-032 |24 VDC 32 Point Input (True High) B881-508 |125 VDC 8 Point True High Output
Module
B828-016 |5V TTL 16 Point Output B882-032 |24 VDC Diagnostic Output Module
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B80O cards
Card Description Card Description
B829-116 |5V TTL 16 Input (Fast Response) B882-239 | 0-30 kHz 2 High Speed Up-Counter
Module
B832-016 |24 VDC 16 Point Output (True Low) B883-001 |0-50 kHz 2 High Speed UP/Down
Counter
B833-016 |24 VDC 16 Point Input (True Low) B883-101 |4 kHz CAM ABS Encoder Input,8 Disc
Out
B836-016 |12-250 VDC 16 Point Output Module B883-111 |1 kHz CAM with Velocity compensation
B837-016 |24 VAC/DC 16 Point Input (True High) | B883-200 |10 Thermocouple Input Module
B838-032 |24 VDC 32 Point Output (True High) B883-201 |8 RTD Input Module
B840-108 | NO/NC Reed Relay 8 Point Output B884-002 |2 Loop, PID Control Module
Module
B842-008 | NO/NC Reed Relay 8 Point Output B885-002 | ASCII/BASIC Module
Module
B846-001 | Analog MUX (16 voltage to one output) [B885-100 | Motion Module
B846-002 | Analog MUX (16 current to one output) [B885-110 | Motion Module
B849-016 |48 VAC/DC 16 Point Input Module B886-000 | High Speed Logic Solver
B853-016 |115 VAC/125 VDC 16 Input (True High) |B887-000 |12 Register Bidirectional
B855-016 |12 VDC 16 Point Input (Intr. Safe) B888-100 | Datalogic CM1000 AutoID interface
B862-001 |4 Channel Register Output (TTL Level) |B984-100 |High Speed Logic Solver
B863-001 |4 Channel Register Input (TTL Level) B984-102 | High Speed Logic Solver
Quantum cards
Card Description Card Description
ACI030-00 Analog 8 Channel Unipolar Input DAO840-10 | 24-115 VAC 16 Output
ACO020-00 |4-20 mA Analog Output Module DAO842-10 | 100-230 AC 16 Output Module
AMMO090-00 | Analog In/Out 4Ch/2Ch DAO842-20 |24-48 VAC 16 Output
ARI030-10 8 Channel RTD DDI153-10 5 VDC 4x8 Input Module
ATI030-00 8 Channel Thermocouple DDI353-00 24 VDC 32 Input Module
AVI030-00 8 Channel Bipolar, Analog Input DDI353-10 24 VDC True Low 32 Input Module
AV0O020-00 Analog Voltage Output Module DDI1673-00 125 VDC 24 Point I/P Module
CHS110-00 Hot Standby DDI841-00 10-60 VDC 16 Input Module
CPs-111 115/230V AC Power Supply 3A DDI853-00 10-60 VDC 32 Input Module

378 @ Quantum cards



A

ppendix F - /0O Cards Supported

Quantum cards

Card Description Card Description
CPs-114 115/230V AC Power Supply 8A DDM390-00 |16/8 Bidirectional 24 VDC
CPS-124 115/230V AC Power Supply RED 8A ] DDM690-00 | 125 VDC 4 Input/4 Output HPO
Module
CPs-211 24 V DC Power Supply 3A DDO153-10 |5 VDC 4x8 Output Module
CPs-214 24 V DC Power Supply 8A DDO353-00 |24 VDC 32 Output Module
CPS-224 24 V DC Power Supply RED 8A DDO353-10 |24 VDC True Low 32 Output Module
CPs-511 125V DC Power Supply 3A DDO843-00 | 10-60 VDC 16 Output
CPs-524 125V DC Power Supply 8A DDO885-00 | 125 VDC 12 Point O/P Module
CPU-113-2 Controller DRA840-00 |16 Output Relay
CPU-113-3 Controller DRC830-00 |8 Output ISO Relay
CPU-213-4 Controller EHC105-00 |High Speed Counter 5 Channel
CPU-424-X Controller EHC202-00 |High Speed Counter
CPU-534 Controller ESI062-10 2 Channel ASCII Interface
CRA211-10 DIO Drop MB+ GPS100-00 IRIG-B Time Sync Interface
CRA211-20 DIO Drop MB+ HLI340-00 Hi-Speed/Latch/Interrupt
CRA212-10 DIO Drop MB+ MMB102-00 | Two axis motion with incremental
CRA212-20 DIO Drop MB+ MMB104-00 |Four axis motion with incremental
CRA931-00 RIO Drop 5908 MMC120-0X | 2-Axis Motion Control
CRA932-00 RIO Drop S908 MMD102-00 | Two axis absolute motion
CRP811-00 Profibus DP Interface Module MMD104-00 | Four axis absolute motion
CRP931-00 RIO Head S908 MSB101-00 | Motion Inc Enc
CRP932-00 RIO Head S908 MSC101-00 | Motion Enc/Res
DAI340-00 24 VACISO 16 Input Module NOA611-00 | Interbus-S Master Module
DAI353-00 24/48 VAC 32 Input Module NOAG611-10 | Interbus-S Master with PCP
DAI440-00 48 VAC 2x8 Input Module NOE211-00  |Ethernet TCP/IP Twisted Pair
DAI453-00 48 VAC 32 Input Module NOE251-00 | Ethernet TCP/IP Fiber Optic
DAI540-00 115 VAC 16 Input Module Isolated | NOE311-00 | Ethernet SY/MAX Twisted Pair
DAI543-00 2x8 115 VAC Input Module NOE351-00 | Ethernet SY/MAX Fiber Optic
DAI553-00 115 VAC 32 Input Module NOE511-00 | Ethernet MMS Twisted Pair
DAI740-00 230 VAC 16 Input Module NOE551-00 | Ethernet MMS Fiber Optic
DAM390-00 |16/8 Bidirectional 24 VAC NOM212-10 |MB+ Drop Interface Card
DAM490-00 |16/8 Bidirectional 48 VAC NOM2XX-00 | MB+ Drop Interface Card
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Quantum cards

Card Description

Card

Description

DAM590-00 |16/8 Bidirectional 120 VAC

NOP911-00 Profibus FMS Interface Module

DAO840-00  |24-230 VAC 16 Output

SERX53-00 Sequence Of Events Recorder

Micro cards

Card Description Card Description

MIC128 |16 1IN, 12 Relay OUT 24V DC MIC140 |8 Bit Counter/Interrupt Input
MIC129 |16 1N, 8 Relay OUT 24V DC MIC141 |4 1IN, 20UT 12 Bit 0-10V
MIC130 |161IN, 4 Relay OUT 24V DC MIC142 |41IN,2O0UT 12 Bit 1-5V
MIC131 |16 1IN, 8 Triac 4 Relay OUT 115V MIC143 |[41IN,2OUT 12 Bit ail0V
MIC132 |16 1IN, 8 Triac OUT 115V MIC144 |4 1IN, 20UT 15 Bit 0-10V
MIC133 |161IN, 4 Relay OUT 115V MIC145 |41IN,2OUT 14 Bit 1-5V
MIC134 |16 1IN, 8 Triac 4 Relay OUT 230V MIC146 |41IN,20UT 10V

MIC135 |16 IN, 8 Triac OUT 230V MIC147 |16 Bit Timer/Count Value
MIC136 |16 1IN, 4 Relay OUT 230V MIC148 |1 Word IN, 1 Word OUT
MIC137 |161IN, 12 FET OUT 24V DC MIC149 |2 Words IN, 2 Words OUT
MIC138 |16 1IN, 8 FET OUT 24V DC MIC150 |4 Words IN, 4 Words OUT
MIC139 |161IN, 4 FET OUT 24V DC MIC151 |8 Words IN, 8 Words OUT
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Momentum M1 and Interbus cards

Card Description Card Description

AAI030-00 8 Channel Differential Input BDO356-00 |24 VDC 32 Point O/P Module
AAI140-00 16 Channel single ended Input BDO9%46-50 | 115 to 230 VAC 16 Point O/P
AAI520-40 4 Channel RTD/Thermocouple IBUS-0101 | DFT 1 Word Output Module
AAO120-00 |4 Analog Output 0-20mA IBUS-0102 | DFT 1 Word Input Module
AA0921-00 |4 Analog Output 4-10mA IBUS-0103 | DFT 1 Word Bidirectional Module
ADI340-00 24 VDC 16 Point I/P Module IBUS-0201 | DFT 2 Word Output Module
ADI350-00 24 VDC 32 Point I/P Module IBUS-0202 | DFT 2 Word Input Module
ADI540-50 120 VAC 16 Point I/P Module IBUS-0203 | DFT 2 Word Bidirectional Module
ADI740-50 230 VAC 16 Point I/P Module IBUS-0231 | DFT 2 Word Output Module
ADM350-1X |24 VDC 16 In / 16 Out IBUS-0232 | DFT 2 Word Input Module
ADM370-10 |24 VDC161In / 8 Out IBUS-0233 | DFT 2 Word Bidirectional Module
ADM390-10 |24 VDC 16 In / 16 Out IBUS-0301 | DFT 3 Word Output Module
ADM390-30 |24 VDC10In / 8 Out Relay IBUS-0302 | DFT 3 Word Input Module
ADM690-50 |115 VAC101In / 8 Out IBUS-0303 | DFT 3 Word Bidirectional Module
ADO340-00 |24 VDC 16 Point O/P Module IBUS-0331 | DFT 3 Word Output Module
ADO350-00 |24 VDC 32 Point O/P Module IBUS-0332 | DFT 3 Word Input Module
ADO530-50 | 115 VAC 8 Point O/P Module IBUS-0333 | DFT 3 Word Bidirectional Module
ADO540-50 | 115 VAC 16 Point O/P Module IBUS-0401 | DFT 4 Word Output Module
ADO730-50 |24 VAC 8 Point O/P Module IBUS-0402 | DFT 4 Word Input Module
ADO740-50 |230 VAC 16 Point O/P Module IBUS-0403 | DFT 4 Word Bidirectional Module
AEC920-00 High Speed Counter 50khz IBUS-0431 | DFT 4 Word Output Module
AMMO090-00 |24 VDC 4 In / 2 Out Bidirectional IBUS-0432 | DFT 4 Word Input Module
BAI036-00 8 Channel Analog I/P Module IBUS-0433 |DFT 4 Word Bidirectional Module
BAM096-00 |41/P /20O/P Analog Module IBUS-0501 | DFT 5 Word Output Module
BAO126-00 |4 Channel Analog O/P Module IBUS-0502 | DFT 5 Word Input Module
BDI346-00 24 VDC 16 Point I/P Module IBUS-0503 | DFT 5 Word Bidirectional Module
BDI356-00 24 VDC 32 Point I/P Module IBUS-0531 | DFT 1 Word Output Module
BDI546-50 120 VAC 16 Point I/P Module IBUS-0532 | DFT 1 Word Input Module
BDI746-50 230 VAC 16 Point I/P Module IBUS-0533 | DFT 1 Word Bidirectional Module
BDM346-00 |24 VDC 16 In / 16 Out IBUS-0633 | DFT 8 Word Bidirectional Module
BDM346-30 | 8In / 8 Out Relay IBUS-1233 | DFT 16 Word Bidirectional Module
BDO346-00 24 VDC 16 Point O/P Module
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SY/MAX cards

Card Description Card Description
RIM101 16-Function 120V AC/DC Input ROM122 4-Function Isolated Output
RIM121 4-Function Analog Input ROM131 Stepper Motor Controller Module
RIM123 8 Channel High Speed Analog Input ROM141 Multiplexed BCD Output Module
RIM125 16-Function Analog Input ROM221 16-Function 120V AC Output
RIM126 8 Channel Analog/Thermo Input ROM271 16-Function 120V AC Relay
Output
RIM127 12 Channel RTD Input Module ROM421 35-140 VAC 16 Output Module
RIM131 High Speed Counter Module ROM431 16-Function 240V AC Output
RIM144 Multiplexed BCD Input Module ROM441 32-Function 24V DC Output
RIM301 85-140 VAC 16 Input Module ROMS871 64-Function Relay Output
RIM331 32-Function 24V DC Input CRM931-RG | Register RIO Adapter Module
RIM361 16-Function 240V AC/DC Input CRM931-D8 | Digital 16 Slot RIO Adapter
RIM731 64-Function 24V AC/DC Input CRM931-D4 | Digital 8 Slot RIO Adapter
SIM116 16 In Simulator CRM931-D2 | Digital 4 Slot RIO Adapter
ROM121 4-Function Analog Output CRM931-D1 | Digital 2 Slot RIO Adapter
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How NxT works with fxManager

If you've used SecurWORX Local Station for NxT from Total Control Products
(Canada) Inc. before, you'll have no problem getting to know fxManager.
fxManager is SecurWORX re-engineered to give you version control, security,
audit trailing, and scheduling for your entire database development system.

fxManager allows you to:
* Track changes made to projects and settings in fxManager;
*  Monitor and record actions performed by users;
*  Control access to projects and settings in fxManager; and
* Manage and execute scheduled events.

When fxManager is installed, you can add ProWORX NxT projects to the
fxManager Server to handle and control. To work on these projects, an
administrator adds a group(s) to the project, then assigns users and access
permissions to the group(s).

% For more information on security, see “Access Control” on page 386.

@ ProWORX NXT databases are referred to as projects in fxManager.

Users can then access projects from fxManager or the Project Manager. The
Project Manager can be opened from the Title Screen, Online Editor, or Offline
Editor.

To work on a project that’s stored on the fxManager Server, you first need to
log on to the Server, then check out the project and open it. The project can be
opened either in the Online or Offline Editor, depending on the current mode
you're working in.

% For more information on working with the Project Manager, see
“About the Project Manager” on page 393.
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About fxManager

fxManager is organized into the following sections:

The NXT projects thatare —___|

stored on the Server you're
logged on to are listed in this
part of fxManager.

From here you can assign a
group(s) to a project, then add
users and grant permissions
to the group.

The Projects section organizes the NxT projects stored on your local
computer and on the fxManager Server. This is also where you assign
who has access to each project.

The Access Control is where you define the security access for the
fxManager Server, operations performed in fxManager, and to all NxT
projects stored on the Server.

The Audit Trail section organizes all the Audit Trail settings and
report templates stored on the fxManager Server.

The Scheduler is an optional add-on to fxManager that manages and
executes scheduled events. These scheduled events are stored and
controlled by the fxManager Server.

=l

B ‘ Projects =

[=] My Computer

l'}"jpassenger door conveyor
","ILTdriver door conveyor
7 hood corveyor

7 bk, corveyor

",“lfexterior azzembly

@ Wialtz 2.
Access Control

Groups
Users

- Audit Trail
Seftings
Feport Template/
- Eﬂ} Scheduler Event List
g logic compare [—
FLC backup -

Lalnfo\u"iew Q[xManagel I

Define Audit Trail settings and
access report templates from
this section of fxManager.

A

From here you can set up
events to be carried out by
the Scheduler.

% For more information on any of these features, see fxManager’s main

help.
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Access Control
Using fxManager, a Server administrator(s) can:
* Create and manage groups;
* Add users to groups, and;

* Assign permissions to groups to allow or prevent access to NxT
projects or fxManager operations.

Users can belong to one or more groups, and in turn, inherit the permissions
assigned to the groups to which they are a member.

You configure Access Control through fxManager. For more information on
groups, users, and permissions, see fxManager's main help.

ProWORX NxT permissions

Below are the ProWORX NxT permissions you can assign to groups. Set to
True to allow users access. When set to False, the operations are denied.

Property Description

ReadfromController Allows a controller to be read from.

WritetoController Allows a controller to be written to.

StartStopController Allows the controller to be started or stopped.

EditController Allows Ladder Logic, Controller Configuration, Traffic
Cop, and associated Documentation to be modified.
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fxManager permissions

Below are the fxManager permissions you can assign to groups. Set to True to
allow users access. When set to False, the operations are denied.

Property Description
CheckInOut Allows projects to be checked in and out of the Server.
Get Allows read-only copies of project files to be accessed

from the Server.

OverrideCheckOut Allows a user to undo another user's check out.
ChangePassword Allows a user to change their own password.
ChangeAllPasswords Allows a user to change other user's passwords.
EditAuditTrail Allows:

e Audit Trail to be checked in or out;
*  Settings to be configured or edited;

*  Report Templates to be added, edited, or
deleted;

* Reports to be generated or deleted.

EditAccessControl Allows:
e Access Control to be checked in or out;

e Users to be created, added to or removed
from a group, deleted, renamed, and user
properties to be edited;

*  Groups to be created, added to or removed
from a project, deleted, renamed, and group
properties to be edited;

e Permissions to be edited and set.
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Audit Trail

Property Description
EditProjectList Allows:
* Projects to be added or destroyed;
*  Groups to be added to or removed from a
project;
* Controller addresses to be added or
removed from the Controller Address
Selection dialog box.
Label Allows labels to be added to a project.
EditEventList Allows:

Scheduler Event List to be checked in or
out;

Events to be created, added, or edited;
Scheduler properties to be edited;
Scheduler to be started or stopped.

From fxManager, you can set up the Audit Trail feature to record user
operations triggered in ProWORX NxT and in fxManager. When logged on to
a Server, Audit Trail tracks and records your actions then saves the
information to an Audit Trail database file. You can later view this information

by generating reports.

You can log such actions as editing a project in Online mode, logging on to a
Server, or creating a project.

In addition, ProWORX NxT allows you to add comments about the changes
made to a project in an edit session. These comments are also included in the

Audit Trail database records.

25

You configure Audit Trail settings and generate reports from fxManager.

o,

« For more information, see fxManager’s main help.
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The ProWORX NxT
audit type that
occurred.

The date the edit
session occurred.

The type of change(s)/

made to the project.

The Audit Trail dialog box automatically appears when you go Offline,
Online, or shut down NxT. It displays the audit information that occurred
during the last edit session in a specific project.

Audit Trail [ %]
Froperty:™ [OfflineE dit
Date: 133175 |~ The name of the user who
ser. PR — made the changes.

Project:

Edits:

=

a7

Comment:

Logic
Documentation
Configuration

Traffic Cop

passenger door conveyor

r

a7

Diata

ASCI

|

Configuration E stenzion

Extended Memory

Changed the EMTH subfunction instruction from ADD to SUBD.

=
[

Iln the Message field, you can enter details of your changes.

o]

Cancel |

— The project that was edited.

Type a description of the
changes you made to
the project.

The information you add in the comments section is logged to the Audit Trail
database file and can be used later in a generated report.
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ProWORX NxT Audit Trail settings

Below are the ProWORX NxT actions you can record in an Audit Trail. Set
conditions to True to log a record.

Property

Description

OfflineEdit

Logs a record when changes are made to a project during an
Offline session and specifies the type of change made in the
Event Description field. The possible event types are:

* Logic: the logic was edited.

*  Doc: the documentation was edited.

* Config: the configuration was edited.
e TCop: the Traffic Cop was edited.

* Data: the data memory was edited.

* ASCIIL the ASCII data was edited.

* Config_Ext: the configuration extension was
edited.

*  Ext_Mem: the extended memory was edited.

OnlineEdit

Logs a record when changes are made to a controller during an
Online session and specifies the type of change made in the
Event Description field. The possible edit types are:

* Logic: the logic was edited.

* Doc: the documentation was edited.

* Config: the configuration was edited.
*  TCop: the Traffic Cop was edited.

* Data: the data memory was edited.

*  ASCILI: the ASCII data was edited.

* Config_Ext: the configuration extension was
edited.

*  Ext_Mem: the extended memory was edited.
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fxManager Audit Trail settings

Below are the fxManager actions you can record in an Audit Trail. Set
conditions to True to log a record.

Property Description
CreateProject Logs a record each time a project is added to the Server.
GetFile Logs a record each time a read-only copy of a project is

retrieved (get) from the Server.

CheckInOut Logs a record each time a file is checked in, checked out, or
an undo check out is performed.

LogOnOff Logs a record each time a user logs on to or off the Server.

SetupChanges Logs a record each time any of the following configuration
settings change:

* Adding, editing, or removing users or groups;
» Editing permissions;
» Editing groups assigned to projects; and

* Editing Audit Trail settings.

PasswordChange | Logs a record each time a password is changed.
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Connecting to a server

Like Local Station for NxT, fxManager requires you to log on. This gives you
access to the NxT projects that are stored on the server.

» To open fxManager:

*  Click the Start button, point to Programs, then click fxManager. The
Log On dialog box appears.

Log 0
QoLD - Type your user name

|_ Type your password

Uszer: |

Paszsword: |

. Choose an fxManager
Server

.

Server: I

™ work disconnecled\ .
—— Select to work disconnected

[ ok | Ext | Help | from the Server

When logging on, you may be prompted to rename a project you've created while
disconnected that has the same name as one already on the Server.

Working Disconnected from an fxManager Server

You can work on projects while disconnected from a Server. For example, you
may want to do this when working remotely.

While disconnected, the Project Manager lists projects that were listed when
you were last connected to the Server. You can only open the projects you
checked out prior to logging on in disconnected mode. Projects can’t be
checked in while disconnected.

Changes you make to an NxT project are stored on your local computer until
the next time you connect to the Server and check in the project.

Audit Trail records project changes to an Audit Trail database file while
working disconnected. The next time you connect to the Server, these records
are transferred to the Server and you are able to check in your project changes.

v Connect to the Server periodically to get the latest fxManager settings and to
k update the Audit Trail database with any records that were logged while working
disconnected. If you plan on working disconnected for an extended period,
ensure your user property MaxTimeDisconnected is set accordingly.
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About the Project Manager

You can work on projects stored on the Server from either the Project Manager

or fxManager. You can access the Project Manager from NxT’s Title Screen or
while Online or Offline.

» To open the Project Manager:

From the File menu, select Project Manager. The Project Manager
dialog box appears.

Project Manager E
File  Miew ‘“erzsion Help!

2| x|E| Blm%cE s
M ame Versionl Action | D ate

1 Created  03/08/9812:47:44
4 Checked 03/18/9812:06:06
1 03/23/98 16:16:50
3 Created  03/24/98 12:06:06
.
1

| LabeII Comment

Indicates whether
you're connected to
the Server or work-
ing disconnected.

Created

Checked 03/06/3812:47:44
Created  03/17/3812:06:06

/
Temi T Server_2 |Logg :

The user currently
logged on to the
Server.

Displays the name
of the Server
you're logged on to.

25

When fxManager isn’t running, you're required to log on to the Server when
opening the Project Manager.

e

% For more information, see “Connecting to a server” on page 392.

The Project Manager is organized by rows and columns. Each row contains
information on a project. The columns are described below:

Column | Description

Name Name of the project that is stored on the Server, created while
disconnected, or stored on your computer.

Version The number of previous versions that exist. Click the expansion icon
next to the project name to list the previous versions.

Action Displays the last action (created, checked in, checked out) that was
performed on the project.

Date The date and time the project was last edited and saved.
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Column

Description

Label

The label associated with the project.

Comment

Toolbar

Displays part of a project’'s comment. View an entire comment, by
generating a project history report.

o,

%  For more information, see fxManager’s main help.

You can perform the following commands from the Project Manager’s toolbar.

Button

Description

Click to open a selected project you checked out from the Server or a
project you have on your computer.

Click to delete a selected project on your computer.

Click to add alabel to a selected project.

Click to get a read-only version of a selected project stored on the
Server.

Click to check out a selected project stored on the Server.

Click to check in a selected project you made changes to.

Click to undo a check out of a selected project.

= |2 2 & €| |2 X

Click to update the project list with the latest information on the
Server.
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Project icons

The following icons are displayed next to a project’s name both in the Project
Manager and fxManager to indicate the status of the project.

Icon | Description

' Indicates the project is presently checked out by you on this computer.

LY Indicates the project is checked out by another user or by you on another
computer.

- Indicates the project is a local project that was created by you while

[

disconnected from the Server on this computer. You are the only user who
can edit the project.

E Indicates the project is a local project that was created by another user
L while disconnected from the Server on this computer. Only the user who
created this project can edit it.
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Working with the Project Manager

In this section, you'll learn to work with the Project Manager. This includes:

Checking out a project;

Opening a project;

Creating a project;

Adding a project to an fxManager Server;
Checking in a project.

Getting a read-only copy of a project;
Labelling a project;

Undoing a check out; and

Deleting a project.

Checking out a project

Before you can work on any project stored on the fxManager Server, you'll
need to check it out. When you check out a project, a copy is transferred from
the Server to your local computer. This process allows you to open and make
changes to the project.

While you have a project checked out, other users can only get a read-only
copy of the project. Only the latest version of a project can be checked out, but
if you need to, you can get a read-only copy of previous versions.

Permission CheckinOut and it must be assigned to the project. For more

@ To perform a Check Out, the group you belong to must have the fxManager

information, see fxManager's main help.

» To check out a project:

1.

From the Project Manager, select the NxT project you want to check
out.

Click %l or from the Version menu, select Check Out. Now you can
open the project you've checked out.

retrieve a read-only copy of the project. For more information, see “Getting a

:g If the project is already checked out by another user, use Get Latest Version to

read-only copy of a project” on page 403.
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Opening an NXT project

Once you've checked out a project, you can open it from either the Project
Manager or fxManager.

» To open an NXT project:
1. Check out the NxT project you want.
2. Do one of the following:
* From the Project Manager, click or from the File menu, select

Open. The project is opened either in Online or Offline, depending
on the mode you're currently working in.

* From fxManager, right-click on the project you have checked out
and select Open. The Launch dialog box appears.

Launch B3

Select the mode
Launch Protw/ORx MxT Offline you want to

launch NxT in.
Online: | Launch Protw0R MxT Online

3. If you're working with ProWORX NxT Online, the Controller
Address Selection dialog box appears.

* Click the type of connection you want to establish, then select the
address.

one type of connection is available. The exact type depends on the controller
address used by ProWORX NXT Online the last time it was used. The others are

disabled.

« For information on changing the choices available in the Controller Address
Selection dialog box, see page 399.

:g If you're not starting ProWwORX NxT from the fxManager Launch dialog box, only

4. When you're finished editing the project, check it in so the latest
version is stored on the Server.

% For more information, see “Checking In a project” on page 402.
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Creating a project

In earlier versions of NxT, databases (projects) were created from the
ProWORX NxT Title Screen or Network Editor. With fxManager, you can only
create projects from fxManager.

When you create a new project, an NxT database (i.e. 984 B S908) is created
without logic. Once the project is created, you'll need to edit it to set the correct
PLC type for the project.

Projects created while disconnected are called local projects. The local projects
are only added to your local hard drive, not to the Server. To add a project to
the Server, you must reconnect to the Server then check in the project.

Audit Trail doesn’t log actions that occur in a local project. To log actions,
check project in to the Server the next time you log on in connected mode.

®,

% For more information on local projects, see fxManager’s main help.

» To create a project:

1. Inthe fxManager tab of the Navigator, right-click on the i
ProWORX NxT folder.

To create a project, the fxManager permission EditProjectList for your group
must be set to True. See your administrator if this permission is set to False.

2. Select New. The New Project dialog box appears.

Enter the name of the new project:
Idliver daor conweyor
Enter a name for the NxT database:
Idlivr_dr
¥ Check out
Camment:
Thiz databaze [project] operates the corweyor far ;I
the azzembly of the driver's door.
-]
Ok I Cancel |

3. Type the name of your new project (32-character maximum).
4. Type the name of the NxT database (8-character maximum).
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5. Do one of the following:

* Select the Check out check box (default) to edit the project or add
groups to the project once it's created on the Server.

* Clear the Check out check box to add the new project to the Server
without editing it further.

6. Type a comment or description for the new project (256-character
maximum).

7. Click OK. The project is created on the Server computer and the
Administrators group is assigned to the new project. This allows an
administrator to set up groups, users, and permissions for the project.

8. Configure the controller addresses from which a user can launch the
NxT project online.

% For more information on configuring these properties, see below.

e Once you create a new project on a Server, it's a good idea to also add groups
k to the project to allow users access to it.

Configuring the controller address selection lists

The Controller Address Selection dialog box contains lists of possible
controller addresses to which ProWORX NxT Online can connect. If you have
the EditProjectList permission, you can edit the selections in fxManager.

The ModbusAddress, ModbusPlusRouting and TCPIPAddress properties of
an NxT project managed by a Server hold the controller addresses for that
project. Each choice is composed of an address, a slash character (/ ), and a
description of that address. If more than one address is configured, the
addresses are separated by a semicolon (; ).

Example 1:
Editing selections for the Modbus list.

If the property ModbusAddress of an NxT project is set to:
1/Modbus Port #1;3/Modbus Port #2
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This lets the user select “Modbus Port #1”, which connects to Modbus address
1, or “Modbus Port #2”, which connects to Modbus address 3.

Example 2:
Configuring selections for the Modbus Plus list.

If the property ModbusPlusRouting of an NxT project is set to:
1/MB+ Routing #1;10,1/MB+ Routing #2

This lets the user select “MB+ Routing #1”, which connects to Modbus Plus
routing address “1”, or “MB+ Routing #2”, which connects to Modbus Plus
routing address “10, 1”.

Example 3:
Configuring selections for the TCP/IP list.

If the property TCPIPAddress of an NxT project is set to:
10.10.10.10/IP Address

This lets the user select only "IP Address", which connects to TCP/IP address
“10.10.10.10”.

Adding a project to an fxManager Server

Projects can only be added to a Server from fxManager. This is also useful
when transferring or importing a project between Servers.

When you add a project to a Server, an Administrators group is automatically
assigned to it. This allows an administrator to set up groups, users, and
permissions for the project.

Projects added while disconnected are called local projects. Local projects are
only added to your local hard drive, not to the Server. To add a project to the
Server, you must reconnect to the Server then check in the project.
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Audit Trail doesn’t log actions that occur in a local project. To log actions,
check project in to the Server the next time you log on in connected mode.

% For more information on local projects, see fxManager’s online help.

To add a project, the fxManager permission EditProjectList for your group must
be set to True. See your administrator if this permission is set to False.

» To add a project to a Server:

1. Inthe fxManager tab of the Navigator, right-click on the i

ProWORX NxT folder.
2. Select Add. The Add Project dialog box appears.
Enter the name of the project:
Ipassenger door corveyor
Enter the path and name of the NxT database:
Ic: S prowonssnsthdoorz\conyveyor. mdf J
¥ Check out
Comment:
Thiz database [project] operates the pazsenger ;I
door convepor,
[
0k I Cancel |

3. Type a project name for the NxT database (32-character maximum).

Type the path and NxT database file name or click _I to browse.
Do one of the following:

* Select the Check Out check box to edit the project or add groups to
the project once it's added to the Server.

* Clear the Check Out check box to add the project to the Server
without editing it further.

Type a comment (256-character maximum) for the new project.

Click OK. The project is copied to the Server computer and the
Administrators group is assigned to the new project. This allows an
administrator to set up groups, users, and permissions for the project.
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8. Configure the controller addresses from which a user can launch the
NxT project online.

% For more information, see Configuring the Controller Address
Selection Lists on page 399.

S

i Once you add a project to a Server, it's a good idea to also add groups to the
k project to allow users access to it.

Checking In a project

After saving the changes you make to a project, it's a good idea to check it in
to the fxManager Server it came from. This updates the Server with the latest
project and increments the project’s versions number within the project list.

» To check in a project:

1. From the Project Manager, select the NxT project you want to check in.

2. Click El or from the Version menu, select Check In. The Check In
dialog box appears.

Project: |passenaer door corveyar

' Femaove local copy
" Keeplocal copy
" Keep checked out
Comment:

Changed the EMTH subfunction inztruction from =
ADD ta SUBD.

ok | Cancel |

3. Choose the option you want:

* Remove local copy: (default) Removes the copy of the project on
your local computer after the check in is complete.

* Keep local copy: Updates the Server with your changes, then
leaves a read-only copy of the project on your computer.

* Keep checked out: Updates the Server with your changes, then
keeps the project checked out so you can continue working on it.
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Type a comment (256-character maximum) about the changes made
while the project was checked out.

Click OK. The Server is updated with your latest changes and the
version number is incremented within the project list.

Getting a read-only copy of a project

Use Get Latest Version to retrieve a read-only copy of a project and place that
copy on your computer. Use this command if you only need to perform a build
operation on a project or to view a project without making any changes.

» To get a read-only copy of a project:

1.

3.

From the Project Manager, select the NxT project you want to get.

Click %l, or on the Version menu, click Get Latest Version.
fxManager copies the read-only version of the project to your local
computer.

Click to view the project.

Labelling a project

Normally, different versions of projects are only identified by the version
number. Adding a label to a project gives it a more descriptive name.

» To add a label to a project:

1.

From the Project Manager, select the project you want to label.

Click &l or from the File menu, select Label. The Label dialog box
appears.

Apply Label to "passenger deoor conveyer'

Project: passenger door conveyorn
Wersion: 4
Date:  4/2/98 4:21:14 PM

Label: I hoodlock_specs

oK I Cancel |

Type a brief note in the Label box (15-character maximum).
Click OK. The label is attached to the project.
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Undoing a check out

If you don’t want to keep the changes you made to the project since you last
checked it out or to cancel the check out, fxManager provides an Undo Check
Out command.

@ You must be connected to the Server to undo a check out.

» To undo a checkout:

1. From the Project Manager, select the project you checked out that you
want to cancel.

2. Click %l or from the Version menu, select Undo Check Out. The
Undo Check Out dialog box appears.

Undo Check Out

Project: | truck door conveyor

+ Remove local copy

" Replace local copy
r

" Leave local copy as is

Cancel |

3. Select the option(s) you want for this undo:

* Remove local copy: (default) Deletes the copy of the project on
your local computer.

* Replace local copy: Replaces the local copy with a read-only copy
of the latest version on the Server.

* Keep checked out: Keeps the project checked out so you can
continue working on it after canceling the changes you made since
you last checked it out. This option is only available with the
Replace local copy option.

* Leave local copy as is: Keeps a read-only copy of the project with
the changes you made while it was checked out.

4. Click OK. The project is returned to the Server unchanged.
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Deleting a project
You can only delete project files from your computer using the Project
Manager. This can be performed while checking in a project or canceling a

check out.

@ To delete a project from a Server, use the Destroy Project feature in fxManager.
% For more information, see fxManager’'s main help.

Q

» To delete a project from your local hard drive:
1. From the Project Manager, select the project you want to delete.

2. Click il or from the File menu, select Delete.

Delete E
@ Delete "Test1" from this computer?

3. Click Yes. The project is removed from your computer.
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Address

1) On a communications network, the identifying number for a station such as a PLC.

2) Ina computer's or PLC's memory, a location where data, usually a specific input or
output value, is stored.

Address Used Table

A list of all I/ O addresses in a controller, indicating which addresses are being used in
ladder logic instructions and which are not.

Analog

Inputs (such as temperature) or outputs (such as motor speed) which can have a range of
values. Compare to discrete.

ASCII

American Standard Code for Information Interchange.

1) A way of encoding the standard text (the letters, numbers, etc. on your keyboard)
your computer generates.

2) A data transmission mode for Modbus communications which sends and receives
standard text. ASCII mode uses 7 data bits while RTU mode uses 8.

ASCIl Message

A text message transmitted or received by a programmable controller. These messages are
sent to or from a terminal through an ASCII port.

Assembly Register
A register that accepts keyboard input for command and value entry in the Network
Editor.

Attaching to

Also called selecting. Connecting your PC to a programmable controller so NxT can read its
ladder logic, Traffic Cop information, and configuration, and write changes back to it.
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Baud Rate

For serial communications, the speed (in bits per second) at which data is transmitted.

BCD

Binary coded decimal.

Binary

The base two numbering system. It has two symbols: 1 (representing “on”) and 0 (“off”).
Bit

The smallest amount of information in binary: either a1 or a 0.

Bits per second

The number of bits passed from one device to another in one second. Used to measure data
transmission speed.

Block

A section of ladder logic which is defined while using the Network Editor. This block can
be copied, deleted, saved, moved, and loaded.

BM85
A Bridge Multiplexer.

BPS

Bits per second.

BP85
A Bridge Plus.
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Bridge Multiplexer

Allows you to connect up to four Modbus devices or networks of Modbus devices to a
Modbus Plus network. Nodes on the Modbus Plus network can access slave devices
connected to the BM85 Modbus ports.

Bridge Plus

Links together two Modbus Plus networks.

Byte

A group of eight bits. A byte stores a value from 0 to 255.

Cell

A single location in ladder logic.

Channel

In an S901 I/ O subsystem, a group of 128 inputs and 128 outputs assigned to a segment.
The ladder logic in the segment usually controls all I/O operations of the corresponding
channel.

Characters per inch

The number of characters a printer prints in one inch (also called horizontal pitch).

Checksum

A calculation that sums a range of data and compares it to a pre-calculated value. This
determines if the data is in error or has changed.

Coaxial Cable

A round cable containing two conductors, one inside the other (separated by an insulator).
The inner conductor transmits a signal while the outer conductor is a shield.

Commentary

The descriptors, short comments, long comments, and page titles within a database.
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Controller

An industrial control computer, also called a programmable logic controller or PLC.

CPI

Characters per inch.

CPS

Characters per second.

Cross-reference

A list of the networks in which a particular address can be found.

Current Element

The cell or ladder logic element being edited. The Network Editor’s cursor is always on the
current element.

Current Network

The network being edited. The network displayed in the Network Editor is always the
current network.

Cursor

A bar or block which indicates a position on the screen. Generally, the cursor is located
where something can be inserted or selected.

Database

A group of files sharing a common name (but different file extensions) where the ladder
logic program and descriptor data for a controller is stored.

Data Bits

The bits in a data package which carry a message, distinct from start bits, stop bits, and
parity bits. Remote Terminal Unit mode (the Modbus default communication mode) sends
8 data bits per package. ASCII mode sends 7 data bits per package.
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Data Contents

A printout showing the data values in a ladder logic program.

Data Register
A 4xxxx holding/output register.

DCP-908

A distributed control processor providing intelligent bidirectional communication
between a supervisory 984 controller and distributed 984 controllers.

DCP Drop ID#

A distributed control processor drop address. It is equivalent to the drop number used by
the DCP.

Decimal
The base 10 number system. It consists of the symbols 0 through 9.

Default
A value automatically assigned by the computer in a software program. Usually, this value
can be changed.

Descriptor Field
One of up to nine text strings which are a short description of an address within a ladder

logic program.

Descriptors

A short description of an address within a ladder logic program. A number of descriptor
fields.

Descriptor Record

All descriptors, short comments, the long comment number, and the page title for one
address point.
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Descriptor Table

The table of addresses displayed on the screen in the descriptor module.

Descriptor Tables Listing

A group of printouts which consist of tables of descriptors, a table of short comments, long
comments, and mismatch tables.

Device

Any programmable unit (such as a PLC, numeric controller, or robot) or I/O card.

Dim Awareness

The state of a PLC that contains no logic, configuration, or traffic cop information.

Directory

A group of files and/ or subdirectories. A directory called the root directory is placed on
each disk when it is formatted. Subdirectories can be created within the root directory and
within other subdirectories. Files can be stored in a subdirectory or the root directory. In
Windows, directories are often called “folders”.

Disable

To stop the programmable controller’s logic-solving mechanism from updating the state of
a coil or updating the state of a discrete input. Also see force.

Discrete

Inputs (such as switches) or outputs (such as coils) that can only be on or off. Discrete
inputs are usually held in 1xxxx registers. Compare to analog.

Display

A visual output device such as a monitor.
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Distributed I/O (DIO)

One of four major architectures for input/output systems (also see Local I/O, Remote I/O,
and Peer-to-peer Communications). 1/ O that is installed away from the PLC over a wide area
and communicates with it through a Modbus Plus network. One Quantum controller can
support up to three distributed I/ O networks, each with up to 64 drops. The local rack
houses a DIO processor for each network, which sets the network’s head number.

Documentation

A description of a controller’s memory, logic, and configuration. The descriptors, short
comments, long comments, and page titles within a database.

Documentation Editor

The editor in which descriptors, short comments, long comments, and page titles can be
entered and modified.

Double Precision

A 32-bit format which uses two registers to store numerical values.

Drop

A group of I/O cards physically connected together as an I/O network. A controller reads
information from the drop, solves logic, then writes results to the drop in one segment of
ladder logic. The Segment Scheduler controls the order in which drops are serviced.

Duplicate Coil

An output coil address which has been assigned to more than one coil.

EEPROM
Electrically Eraseable Programmable Read-Only Memory.

Element

A ladder logic instruction such as a coil, timer, or short.
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Enable

To allow a PLC, based on the logic programmed into it, to update the state of a coil or input.

Equation Network

A special section of logic that lets the programmer solve regular mathematical equations
within the network. Not supported by every controller.

Exponential Notation

A format for numbers based on powers of 10. For example, +1.35E-4 indicates 1.35
multiplied by 10 to the power of -4 (i.e. with an exponent of -4), which works out to
0.000135.

Extended Memory

Extra register memory available for some models of 984/584 controllers. It is accessed
through the XMRD and XMWT functions.

Extension
The three letters after the period in a DOS file name, often used to indicate the file’s
purpose.

File

A collection of information stored on a disk. It can contain either a program or data.

File Name

The name of a file. NxT uses DOS naming conventions: a file name can have up to eight
characters, followed by a period and a three character extension.

Force

To change the state of a coil or a discrete input, overriding any actions in ladder logic. For
example, if a coil is forced off, but the ladder logic is trying to turn it on, it will remain off.

Function

A ProWORX command or operation.
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Global Address Change

An operation in the Network Editor which substitutes one address or a range of addresses
for another or several others.

Head

A collection of I/ O drops tied to one CPU, DIO, or RIO processor. This term is specific to
Modicon’s Quantum hardware.

Hexadecimal

A base 16 representation of an integer. It uses the symbols 0 through 9 and letters A
through F.

Instruction

One of the programmable controller’s instruction set.

I/O
Input/Output.

I/O Configurator

A PLC internal operation that maps logic element addresses to physical I/O cards. Also
known as the Traffic Cop.

Ladder Logic

A relay-based programming language typically used in programmable logic controllers.
So called because it looks vaguely like a ladder.

Ladder Logic Documentation

Text information, notes, and other descriptions of the ladder logic.

Ladder Logic Listing

A printout of a group of networks which make up a ladder logic program.
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Latch

A coil, the state of which is backed up in memory.

Lines per page

The number of lines printed on a page when printing ladder logic listings.

Lister

The Lister prints ladder logic as well as various documentation and controller reports.

Load

To retrieve data from a disk or other source.

Loader

A module that reads and writes ladder logic from a personal computer to a programmable
controller or an industrial programming terminal. It also starts and stops a programmable
controller from a personal computer.

Local I/O

One of four major architectures for input/output systems (also see Distributed I/O, Remote
I/O, and Peer-to-peer Communications). The PLC and I/O modules communicate directly
through wiring from the field. For Quantum controllers, local I/O allows a CPU, power
supply, and from one through 14 I/ O modules in a single backplane (up to 448 I/ O points).
Local I/O is limited to a single rack and is always head number 0. RIO and DIO processors
are added in the local rack to extend the controller’s I/ O system.

Long Comment

A block of text which comment on an address within a ladder logic program. These are
printed between the networks in the ladder listing.

LPI

Lines per inch.
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Machine Word
16 bits of data (two bytes). Also called a word.

Macro

Generic pieces of logic networks that can be inserted into main logic databases. See also
macro parameter.

Macro parameter
A “placeholder” variable used in a macro. When inserted into a regular logic database,
each macro parameter is mapped to a real register address.

Master

A networked device which controls the devices it connects to. Compare to slave.

Memory

The part of a computer or programmable controller which stores information for
manipulation.

Mismatch Tables

Two printouts which show the differences between two sets of data; for example, between
descriptor records that have been entered for PLC addresses and addresses that have
actually been used in a program.

Mnemonic (ni-MON-ik)
1) A memory aid.

2) A computer instruction with an abbreviated name that indicates its function. For
example, BLKM is used for the Block Move instruction.

Mnemonic Assignments

A table in the configuration menu that lists the configuration of function key levels,
prompts, and instruction mnemonics.
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Modbus

Modicon’s RS-232C master-slave serial communications protocol.

Modbus Plus

Modicon’s high-speed, peer-to-peer, token-ring communications protocol.

Modem

Modulator/Demodulator. A communications device that allows a computer to transmit
information, usually over a standard telephone line.

Module

An input/output card.

Motion Control 1/0O Drop
Usually, an I/O drop tied to an ICC410, 3220, or 3240 motion control system.

Network

1) A unit of ladder logic in a matrix of elements that is 11 columns wide and seven rows
long. It is used to group a function’s ladder logic.

2) A chain of interconnected computers and/or programmable controllers which share
data.

Network Comment

A descriptor record assigned to a network. Contains short comments, a long comment, a
page title and descriptors.

Network Editor
The editor in which you edit ladder logic.

Network Listing
A printout of a group of networks of ladder logic which make up a program.
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Network Logic

A programmable controller control program or the representation of a programmable
controller control program. It includes logic elements, networks, and register contents.

Node

A device that is connected to a network and is capable of communicating with other
network devices, usually to send or receive I/O data.

Not Described Mismatch Table

A printout of those programmable controller addresses in a ladder logic program which do
not have descriptor records.

Not in Logic Mismatch Table

A printout of those descriptor records in a database whose corresponding address is not
used in the ladder logic program.

Offline

When the computer is not connected to the programmable controller and works instead
from a database.

Online
When the computer is connected to a programmable controller, working with it directly

and in real time.

Operator

In mathematics (and in Equation Networks), a symbol or character that indicates a specific
operation to be performed on one or more elements, called operands. In “3 + Y”, the plus
sign (+) is an operator that indicates addition between the two operands, “3” and “Y”.

Order of Solve

1) The order in which segments are solved, as ordered by the Segment Scheduler.

2) The order in which elements are solved in a network.
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Page Title

A line of text which describes a page or group of pages in a ladder logic listing. Printed at
the top of the page.

Path

The part of a file specification that indicates the drive and subdirectory the file is in.

PC

Personal Computer.

Peer-to-peer

One of four major architectures for input/output systems (also see Distributed I/O, Local
/O, and Remote I/O). A protocol for networked devices in which any device can initiate
data transfer.

PLC

Programmable Logic Controller, also known simply as a controller.

Power Flow

In logic, an instruction is highlighted if it solves true and passes power. All instructions
“upstream” of it (to its left in the Traffic Cop display) must also be passing power.

Preset

The maximum value a timer or counter can have.

Processor

A programmable logic controller.

Program

For PLCs, a set of ladder logic instructions contained in a set of NxT files (a database).
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Programmable Logic Controller

An industrial control computer.

ProWORX Function

A ProWORX command or operation.

Quick Print

A function that allows you to print a network to a printer, with or without documentation.

Rack

A collection of up to 16 I/ O modules mounted in one back plane.

Radix

The base system of a value. The radix of decimal numbers is 10, the radix of binary numbers
is 2 and the radix of hexadecimal numbers is 16. In ProWORX NxT, the term “radix”
sometimes refers to a value’s data type: binary, integer, floating point and so on.

RAM

Random Access Memory.

Random Access Memory

Memory that holds programs while they are being executed.

Read Only Memory

Memory that is not erased by a power failure and that is programmed at the factory to hold
vital information. This memory cannot be changed.
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Remote 1/0 (RIO)

One of four major architectures for input/output systems (also see Distributed I/O, Local
I/O, and Peer-to-peer Communications). I/ O that is installed away from the PLC and
communicates with it though a high-performance, S908 coaxial cable network. For
Quantum controllers, an interface device at each remote I/O drop communicates with an
RIO processor in the PLC. The interface device sets the address of the drop. Each RIO
processor supports up to 31 remote drops, each of which allows 64 input words and 64
output words.

Remote Terminal Unit

A data transmission mode used for Modbus communications. RTU uses 8 data bits.

Register

A location in a PLC’s memory. It is identified by an address.

Reports Listing

A group of printouts which consist of hardware allocation, data usage, and data contents
for a ladder logic program.

ROM
Read Only Memory.

Routing Path

The sequence of devices through which a message passes to reach its final destination.

RTU

Remote Terminal Unit communications mode.

RS-232

A popular standard for a serial data link connection.

Run Light

A light on the front panel of a controller that is on while the controller is running.
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Save

To store information on a disk.

Search

To locate a specified network element (or elements) in the ladder logic.

Segment

A group of I/ O networks solved as a unit by the programmable controller. The Segment
Scheduler controls the frequency of segment execution and order of I/ O operations. Each
segment controls two I/O channels in a 584 or 984/5901 configuration, or one drop in a
984/5908 configuration.

Serial Port

A 9- or 25- pin port used for serial communications (for example, Modbus).

Short Comment Field

One of up to four lines of text which comprise a comment about an address within a PLC
network logic program. Typically printed beside output instructions, or below the network
in the network listing.

Short Comment

Up to four lines of text which comprise a comment about an address within a PLC ladder
logic program. Typically printed beside output instructions in the ladder listing.

Slave

A networked device controlled by another device. Slave devices to not initiate data
transactions. Compare to master.

Slot

The position of an I/ O module in a rack.
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State Flow

In logic, an instruction is highlighted if it solves true instead of only when it passes power
(compare to Power Flow).

Stop Bits

Bits used to indicate the end of transmission of a data item or frame.

Subdirectory

A directory within a directory.

Sweep

For a PLC, one cycle of scanning inputs, solving logic, and writing outputs.

TCP/IP

A communication protocol for computers connected through an Ethernet or Token Ring
network.

Text
A collection of ASCII characters.

Timeout

If communications fail, the program waits the specified number of seconds before trying to
communicate again.

Trace

An operation in the Network Editor that locates a specified output coil in the network logic.

Traffic Cop

A programmable controller’s internal configuration that maps logic element addresses to
physical I/O cards.
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Traffic Cop Table

A table used by the Traffic Cop that contains the configuration of the programmable
controller I/O cards and their corresponding network element addresses.

Used Table

A list of all I/ O addresses in a controller, indicating which addresses are being used in
instructions and which have not.

Utility
A computer program included in a software package, but run separately from the
package’s main program.

Vertical Form Control Unit

A device, usually programmed by a paper tape loop, that controls pagination on line
printers. It is also called a Vertical Form Unit.

Word

16 bits of data (two bytes). Also called a machine word.
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- Symbols -

.BLK Files
Exporting 171
Importing 172
.CGF Files 313
DAT
See PCFL.DAT
.DBF Files
Exporting Documentation to 224
Importing Documentation from 222
.DIF Files
and Excel 370
Exporting Documentation to 224
Importing Documentation from 222
.DPF Files
Rebuilding from .DDF Files 175
.DWW Files 282
Exporting to .DIF 283
See Log Files
.DXF Files 204
.FIL Files
Exporting 224
Importing 221
.FIS Files
Exporting 224
Importing 221
.MON Files 319
.OPT Files 270
.TEF Files
.DEF Files
Importing Traffic Cop 222
.URF Files 137, 140
Template for 142

- Numbers -

25-Pin Serial Port to Modicon 984 A, 984B, or
984X 360

25-Pin Serial to Modicon 584 with W190
Cable 362

25-Pin Serial to Modicon 984 x80 and x85 361

25-Pin Serial to Modicon E Series, Quantum,
or Compact 363

25-Pin Serial to Modicon J478 Modem 365

25-Pin Serial to Modicon Micro 311 or 411
364

4xxxx Bit Descriptors 218

584 Adaptor Module 356

584 Military Connector 368

6 Digit Addressing System Preference 31

680 Adaptor Cable 356

oxxxx Registers 148

800 Terminal Block 183

9-Pin Adaptor Cable 356

9-Pin Serial Port to Modicon 984A, 984B, or
984X 360

9-Pin Serial to Modicon 584 with W190 Cable

362

9-Pin Serial to Modicon 984 x80 and x85 361

9-Pin Serial to Modicon J478 Modem 365

9-Pin Serial to Modicon Micro 311 or 411 364

-A-

A120 Terminal Block 183
Access Control 386
Permissions 386, 387
Add Watch/Track Data Info System
Preference 31
Adding Project to fxManager Server 400
Address Used Table 158
Address/Contents Table (Data Watch
Window) 277
Addresses
Checking for Used 158
Default Addresses for New Cards 183
Disabled, Displaying 174
Editing 130

428 @ Index



Entering with the Assembly Register
129
Finding Free 160
Format in NxT 130
Global Replace 161
in Equation Networks 238
Searching for 165
Symbolic 164
Always Fit Display Option 118
Arithmetic operators 234
ASCII
Exporting .FIL Files 224
Importing .FIL Files 221
Importing Updoc 221
ASCII Ports
Configuring 57
Simple 62
Assembly Register 129
in Extended Memory Register Editor
149
in Generic Register Editor 154
in the Data Watch Window 277
in User Configurable Register Editor
139
Assignment operators 233
Attaching to a Controller 44
Network Scan 50
with a Direct Connection 45
with a Modem Connection 46
Audit Trail 388
fxManager Settings 391
ProWORX NxT Settings 390
Authorizing ProWORX NxT 8
Hardware key 9
Software key 8
Auto Addressing 183, 197
AutoCAD 204

-B-

B984 Controller, Configuring 57
Back Referencing Panel 120
Back Referencing, Setting Color of 119
Backing Up a Database 22
Bars
Instruction 128
Status Bar 116
Toolbar 114
Battery Coil, Configuring 58
Bitwise operators 235
Blocking Operations
Loading 172
Saving 171
Blocking operations
in Equation Networks 240
BMBS85. See Bridge Multiplexer.
Bookmarks 168
Going to 168
Retracing 169
Setting 168
Bridge Mode
Enabling 60
Bridge Multiplexer
Address Routing Map, Editing 344
Configuring 339
Modbus Ports, Configuring 342
Reading or Loading from 340

-C-

Cable

584 Adaptor Module 356

680 Adaptor Cable 356

9-Pin Adaptor 356
Cable Wire Diagrams 359
CGF batch file descriptions 315
Channels, Remote (Configuring) 56
Checking In a Project 402
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Checking Out
a Project 396
undoing 404
Clamps, in the Data Watch Window 285
Clock
Register for 58
Setting 98
CODEGEN
About 313
CGF description 315
Log File Viewer 315
Running with a .CGF file 313
Coil, Battery 58
Coils
Duplicate
Searching for 165, 174
Locating 174
Colors, Customizing 119
Column Width, adjusting 118
Columns, Inserting and Deleting 170
Communications Setup
Ethernet Gateway 42
Modbus 35
Modbus Plus 41
Modems 37
Overview 34
Ports, Configuring on Controllers 60
TCP/IP 42
Compact Controller EEPROM 105
Compare Function 325
On-Demand 326
Choosing Parameters 328
Printing Network Results 336
Printing Results 333
Viewing Details 334
Viewing Network Details 334
Viewing Results 329, 333

Scheduled Comparisons 329
Choosing Parameters 331
Comparison List 330
Printing Network Results 336
Printing Results 333
Setting Start Time and Interval 332
Starting or Stopping 332
Viewing Details 334
Viewing Network Details 334
Viewing Results 333

Compare Summary Window 329, 333

Printing Network Results 336

Printing Results 333

Viewing Details 334

Viewing Network Details 334

Conditional operator 236
Conditional operators and expressions 236
Configuration Extensions

Adding 78

Cyclic Data Exchange 97

Data Protect 80

Deleting 79

Overview 77

Peer Cop 89
Adding Links 89
Clearing and Deleting Links 95
Editing Links 90
Global Input 91
Global Output 91
Specific Input 94
Specific Output 93
Subfields 92

Quantum Hot Standby 82

5980 Address 81

Setting Size of 58

TCP/IP 79

Tree Control in 78

Configurator 54
Configurator, Smart 59
Configuring a BM85 339
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Configuring Controllers Controller FLASH, Transferring PCMCIA

Changing Type of 66 107
Controller Tab 64 Controller Tables, Printing 267
Editing Hardware Details of 65 Controllers

General Tab 55
Loadable Library Tab 69
Overview 54
Ports Tab 60
Setting the Type of 64
Simple ASCII Ports 62
Smart Configurator 59
User Loadables Tab 67
Configuring Mnemonics 132
Confirmation
of Device Verification (System
Preference) 31
of Instruction Deletions (System
Preference) 31
of Instruction Overwrites (System
Preference) 31
of Perform a Read (System Preference)
31
Connecting to Controllers
Ethernet Gateway 42
Modbus 35
Modbus Plus 41
Modems 37
Network Scan 50
Overview 34
Ports, Configuring 60
Selecting 44
TCP/IP 42
Constant Sweep 175
Controller
Address of 14
Controller Address Selection 397
lists in 399
Controller FLASH, Transfering Internal
FLASH 107

Cables for 359
Changing Type of 66
Configuring
Controller Tab 64
General Tab 55
Loadable Library Tab 69
Overview 54
Ports Tab 60
Simple ASCII Ports 62
Smart Configurator 59
User Loadables Tab 67
Connecting to
Ethernet Gateway 42
Modbus 35
Modbus Plus 41
Modems 37
Overview 34
TCP/IP 42
Editing Hardware Details of 65
EEPROM, Memory Transfer to 105
Flash RAM Executive transfers 108
FLASH RAM, Memory Transfer to 106
Initializing Logic in 104
Monitoring Health of 317
Networks 322
One Device 318
Viewing Status Words 321
Reading from 102
Scanning for 50
Selecting 44
Selecting Type of 16
Starting 111
Stopping 110
Type of 64
Wires for 359
Working with 102
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Writing to 103
Converting Logic to NxT 18
Converting Older Databases 17
Copy Protection 8

Hardware key 9

Software key 8
Copying

Blocks of Registers 157

Databases 21

with Back Up Function 22

Long Comments 218

Records 217, 220
Creating a New Database 13
Creating a Projects 398
Cross References, Printing 265
Cursor

Setting Color of 119
Cursor, Network Editor 120
Custom Screen Setup 117
Customer support 10
Cyclic Data Exchange Configuration

Extension 97

-D-
Data
Setting Color of 119
Data Display

in the Traffic Cop 182
Data Protect Configuration Extension 80
Data Watch Panel 122
Adding Items to 31, 122
Disabling / Forcing Discretes 123
See also Data Watch Window
Data Watch Window
DWW files 282
Exporting to .DIF 283
Adding Items to 31
Address/Contents Table 277
Assembly Register 277

Clamps 285

Data Logger View 276, 288

Data Watch View 276, 287

Database Path 32

Disabling / Forcing Discretes 286

Displaying 278

Editing Registers 286

General Procedures 279

Graphical View 276, 293

Log Files 288

PID Trend button 301

Radix 282

Setting Sample Rate 279

Spreadsheet View 276, 292

System Preferences 31

Trend View 276, 290
Reading 291

Triggers 284

Database Path System Preference 32
Database Setup

Creating a New Database 13
Editing an Existing Database 19

Databases

Backing Up 22

Comparing 325

Converting Older 17
Copying 21

Creating 13

Deleting 21

Documenting 207

Editing the Setup of 19
Exporting Documentation 224
Files Making up 352
Importing Documentation 221
Opening an Existing 17
Overview of 12

Printing 262

Rebuilding 175

Restoring 22

Saving 21

432 @ Index



Security for 24
Working with 12
Year 2000 Compatibility check for 28
DBEF Files
Exporting Documentation to 224
Importing Documentation from 222
DCP Drop ID, Configuring 56
Delete key
accessing Delete menu (System
Preference) 30
Deleting
Columns 170
Configuration Extensions 79
Instructions in Logic 132
Networks 170
Records 217, 220
Rows 170
Deleting a Database 21
Descriptor Summary
in Equation Networks 238
Descriptors
Entering 216
Importing 223
in Documentation 208
Overlaying 223
Setting Color of 119
Dial Chat dialog 49
DIF Files
and Excel 370
Exporting Documentation to 224
Importing Documentation From 222
DIO
See Distributed I/O
Disabled Addresses, Displaying 174
Disabled Coils
Searching for 165
Disabling / Forcing Discretes
in the Data Watch Window 286
Disconnected
Work from fxManager 392

Display Editor for New Instructions System
Preference 30
Displays, Customizing 120
Colors 119
Views 117
Distributed I/O 190
DIO Read/Write Status 191
Documentation Tables, Printing 265
Documenting
a Database 207
Descriptors 208
Documentation Editor 208, 214
Adding 4xxxx Bit Descriptors 218
Entering 216
Goto Address 215
Moving Text Between References
217
Documentation Summary 208, 211-
214
Table of Reference Types 209
Documentation Utilities 208, 219
Copying 220
Deleting 220
Moving 219
Removing Deleted Records 220
Documentation Window 208
Using 210
Exporting Documentation 224
Importing Documentation 221
Long Comments 208, 218
Copying its Number 218
Moving, Copying, Deleting Records 217
One-Line Documentation Window 211
Page Titles 208
Searching 213
by Blank Descriptor 214
by Descriptor 213
by Reference 213
by Symbol 214
Short Comments 208
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Symbols 208
Drops 180

Configuring number of 56
Duplicate Coils

Searching for 165, 174
DWW Files 282

Exporting to .DIF 283
DXF Files 204

-E-

Editing
Bridge Multiplexer 339
Address Routing Map 344
Database Setup 19
DIF Files with Excel 370
Instructions in Logic 130
Multiple Sub-Function Instructions
131
Modes 127
Editors
Extended Memory Register 148
Generic 152
Network 113, 297
Online and Offline 113, 297
User Configurable Register 137
EEPROM, Memory Transfer to 105
Emulate ProWORXPLUS Hotkeys System
Preference 30
Enable Contact 239
Enter Phone Number dialog 47
Entering Instructions into Logic 128
Entering Ladder Logic 113, 297
Equation Editor, PCFL
See PCFL Equation Editor
Equation Network Editor 229
Display 229
Equation Networks 228
About 228
Adding items from a list panel 229

Coils panel 230
Constants 231
Creating 228
Data Types 232
Descriptor Summary 238
Displayed in the Network Editor 240
Editing 228, 229, 231
Enable Contact 239
Exponential Notation in 233
Functions List Panel 231
Functions, list of 237
Operators List Panel 230
Operators, list of 233
Output Coils 230
Symbols List Panel 231
Used Address List 238
Value Types 231
Erasing Logic from a Controller 104
Ethernet Gateway
Configuring 42
Overview 34
Excel, Using with DIF Files 370
Executive Cartridge 65
Executive Flash RAM
see Flash RAM Executive
Exponential Notation 233
Exponentiation operator 234
Exporting Database Documentation 224
Exporting Documentation 224
Exporting logic 171
Extended Memory 65
Reading from 102
Register Editor 148
Assembly Register in 149
Documenting 149
Radix 148
Utilities for 150
Copying Blocks 151
Filling Registers 152
Moving Blocks 150
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Writing to 104
Extensions, Configuration. See
Configuration Extensions.

-F-

Face Plate display 300
FIL Files
Exporting 224
Importing 221
File, Print to 272
Fill Single Type References System
Preference 31
Filling Blocks of Registers 157
FIS Files
Exporting 224
Importing 221
flash 107
Flash RAM Executive 108
Reading Into a File 109
Writing Into a File 109
FLASH RAM, Transferring Controller
Memory to 106
Font
Changing for Printouts 273
Changing Size in Data Watch Window
281
Free Addresses, Finding 160
Functions
Searching for 165
Functions in Equation Networks 237
Functions List Panel 231
fxManager
Access Control 386
Add Projects 400
Audit Trail 388
Audit Trail Settings 391
Controller Address Selection 397, 399
Creating Projects 398
Layout 385

Logging On 392

Opening 392

Opening Projects 397
Permissions 387

Working Disconnected 392
Working with NxT 384

-G -

Generic Register Editor 152
Displaying and Searching 155
Documenting Registers 154
Editing Values 153
Editing Values with the Assembly
Register 154
Printing from 155
Getting a Read-Only Copy of a Project 403
Global I/O in Peer Cop 90
Global Input in Peer Cop 91
Global Output in Peer Cop 90, 91
Global Replace 161
Glossary 407
Graphical View (Data Watch Window) 293
Graphics Server 5
Graysoft
Importing Documentation from 221
Group Settling Time, Configuring 57

-H-

Hardware
Changing Type of 66
Editing Details of 65
Monitoring Health of 317
Hardware Clock
Register for 58
Setting 98
HB field 188
Head Number 79
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Health of Cards
in Traffic Cop 188
Health of Hardware 317
Checking Networks 322
Checking One Device 318
Viewing Status Words 321
Hot Standby, Quantum Configuration
Extension. See Configuration Extensions.
82

-1-

I/O Drawing Generator 203-?7?
Displaying I/O Drawings 204
Symbols 203

I/O Drops, Configuring number of 56

I/O Health, Monitoring 319

I/O Time Slice, Configuring 56

I/O Tree 181

I/O Words, Configuring 56

I/O, Modicon 180

IBM 5531 to Modicon 584 with W190 Cable

367
IBM 5531 to Modicon 984A, 984B or 984X
366

IBM 5531 to Modicon J478 Modem 367

IBM 5531 to Modicon x80 and x85 366

IBM AT Loopback Connector 368

IBM PC Loopback Connector 368

Icons for Projects 395

Importing Database Documentation 221

Importing Documentation 221

Importing logic 172

Initialize SA85 Adapter System Preference

29

Initializing Logic in a Controller 104

Input Latched, Configuring 57

Insert key
accessing Insert menu (System

Preference) 30

Inserting
Columns 170
Networks 170
Rows 170
Installing ProWORX NxT 3
Instruction List 121, 129
Instruction Toolbar 128
Instructions
Deleting in Logic 132
Editing in Logic 130
Entering into Logic 128
Assembly Register 129
Instruction List 129
Instruction Toolbar 128
Moving in Logic 132

Multiple Sub-Function Instructions 131

Interbus-S 193
Internal FLASH, Tranfering to Controller
FLASH 107

-]-

J478 Modem 365, 367

-K -

Keyboard Commands
As Menu Items 30
Keyboard Menu Options Enabled System
Preference 30
Keyboard shortcuts from ProWORXPLUS
30

-L-

Labelling a Project 403
Ladder Doctor

Importing Documentation from 221
Ladder Logic
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Entering 113, 297
Loading Blocks of 172
Saving Blocks of 171
LAN Health Monitor 322
Log Files, Viewing the LAN Monitor’s
323
Launching NxT from fxManager 397
Lister 263
Controller Tables 267
Documentation Tables 265
Cross References 265
Font, Changing 263, 273
Formatting a Printout 269
Mismatch Tables 268
Network Printing Options 264
Print Setup, Changing 274
Quick Picks Options 270
OPT Files 270
Loadables, User 67, 69
Loading Blocks of Logic 172
Locking Database Files 30
Log File Viewer 315
Log Files
in the Data Watch Window 288
Recording Trend/Spreadsheet data 289
Setup 288
Size of 288
Log Files, Monitor Status 319
Logbook Entries 173
Logging On
to fxManager Server 392
Logic Instructions
Deleting 132
Editing 130
Entering 128
Assembly Register 129
Instruction List 129
Instruction Toolbar 128
Moving 132
Multiple Sub-Function Instructions 131

Long Comments

Copying 218

Copying its Number 218

Entering 216

in Documentation 208
Loopback Connector

IBM AT 368

IBM PC 368

-M -

Macro Databases
See Macros
Macro Editor
Disabled Network Editor functions 308
Macro parameters 308
dialog box 309
Format 308
Macro Status
Macro has changed 311
Macro not found 311

Rec:xxx 311
Macros
About 306

Backing Up and Restoring 307

Changed macros 311

CODEGEN (automating insertions with)
313

Creating 306

Deleting 310

Editing 308

Inserting into your database 309, 313

Macro Overview display 310

Macro parameters 308

Opening existing 307

Removing from a database 310

Saving 307

Selecting a controller for 306

Status of inserted macros 311

Unlinking inserted macros 312
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Updating inserted macros 311
Viewed from Network Editor 310
Max Decimal Value System Preference 31
MEM/DIP switch 61
Memory
See also Extended Memory 150
Memory Pack 65
Memory Protect Switch 105
Message Words, Configuring 57
Micro Controller FLASH RAM 106
Micro I/O Mode 65
Micro Port Assignments 62
Military Connector 368
Millenium Bug 28
Miscompares
Printing 333
Printing Network 336
Viewing 333, 334
Viewing Network 334
Mismatch Tables, Printing 268
Mixed Pitch Printing Option
269
Mnemonics
Configuring 132, 347
Modbus
584 Adaptor Module 356
680 Adaptor Cable 356
9-Pin Adaptor Cable 356
Configuring Communications 35
Overview 34
with Modems
Configuring 37
Entering Passwords 49
Entering Phone Numbers 47
Overview 34
Selecting a Device 46
Modbus Cable Kit 355
Modbus Plus
Configuring 41
Overview 34

Modbus Ports
on a Bridge Multiplexer 342
Modem Communications
Configuring 37
Dial Chat dialog 49
Entering Passwords 49
Entering Phone Numbers 47
Modbus with 35
Overview 34
Selecting a Device 46
Modicon I/O 180
Monitor Mode, Online Editor 127
Monitor Status Log Files 319
Monitor Status Window 319
Monitoring Hardware Health 317
Networks 322
One Device 318
Viewing Status Words 321
Moving
Blocks of Registers 156
Instructions in Logic 132
Records 217, 219
Multi Function Naming System Preference
30
Multi User Access System Preference 30
Multiple Sub-Function Instructions 131
MUX Files 340

-N -

Network Display Setup 117
Network Color Setup 119
Network Cursor Setup 120

Network Editor 113, 297
About 114
Back Referencing Panel 120
Bookmarks

See Bookmarks
Creating a New Database 13
Customizing Colors in 119
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Customizing the Cursor in 120
Customizing Views in 117
Data Watch Panel 122
Deleting Items in 170
Documenting a Database 207
Inserting items in 170
Instruction List 121
Moving Segments Across Boundaries
136
Online Editing Modes 127
Opening a Database 17
Redoing a Command 129
Restricting Access to 24
Segment Scheduler 134
Symbol Summary Panel 121
Traffic Cop Display 124
Undoing a Command 129
Update Rate, Setting 125
Network Editor Cursor 120
Setting Color of 119
Network Index Printing Option
269
Network Miscompares
Printing 336
Viewing 334
Network Scan 50
Networks
Deleting 170
Inserting 170
Moving Across Segment Boundaries
136
Printing 262
Printing Options
264
NxT Convert Utility 18
NXTCONV.EXE Utility
Converting Older Databases 17

-0-

Offline Edit Mode, Online Editor 127
Offline Editor 113, 297

Changes made in 12
On-Demand Compare Function 326
One-Line Doc Window Enabled System

Preference 31

One-Line Documentation Window 211
Online Editor 113, 297

Changes made in 12

Editing Modes 127

Sweep 175
Online Mode System Preference 31
Opcodes, Editing (for User Loadables) 70
Opening

fxManager 392

Project Manager 393

Projects 397
Opening an Existing Database 17
Operations for Registers, Editing 139
Operators in Equation Networks 233
Operators List Panel 230
OPT Files 270
Optimized Mode 111
Output Coils in Equation Networks 230
Output Variable (OV)

defined 298
()Y

See Output Variable

-P-

Page Numbering Printing Option
269
Page Titles 208
Entering 216
Printing Option
269
Panels

Index ® 439



ProWORX NxT User's Guide

Back Referencing 120
Data Watch 122
Instruction List 121
Symbol Summary 121
Traffic Cop Display 124
Parentheses (in Equation Networks) 236
Password Security
see Security Settings
Passwords
fxManager 387
NxT Security Settings 24
PCFL Configuration File 255
PCFL Editor
Customizing the Register Displays 255
Editing Registers for 245
Equation Editor
See PCFL Equation Editor
Input Flags
Editing 247
Viewing 247
Output Flags
Viewing 248
PCFL.DAT file 255
Radix, changing the 245
Status Register Flags 246
PCFL Equation Editor 249
Equation Text Mode 250
Equation Text Format 250
Function List 252
Operator List 251
Postfix Entry Mode 252
Postfix Codes 253
Register Entry Mode
PCFL.DAT 255
File Format 256
Input/Output Flag Diagram Formats
259
PCMCIA, Transfering to Controller FLASH
107
Peer Cop Configuration Extension 89

Permissions
fxManager 387
ProWORX NxT 386
Phone Numbers, Entering 47
PID blocks 298
About 298
Auto vs. Manual mode 300
Engineering Range 301
Monitoring 299
See also PID displays
Tuning 300
PID displays
Adjusting the Set Point 301
Auto vs. Manual mode 300, 301
Documentation Editor shortcut 299
PID display features 299
PID Summary display 302
PID Tuner/Face Plate display 300
PID View Networks display 303
Register Editor shortcut 299
Trend graphs 301
Viewing 299
PID Summary display 302
PID Tuner/Face Plate display 300
PID View Networks display 303
PLCs
Changing Type of 66
Connecting to
Ethernet Gateway 42
Modbus 35
Modbus Plus 41
Modems 37
Overview 34
TCP/IP 42
Editing Hardware Details of 65
Initializing Logic in 104
Monitoring Health of 317
Networks 322
One Device 318
Viewing Status Words 321
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Ports, Configuring 60
Reading from 102
Scanning for 50
Selecting 44
Setting the Type of 64
Simple ASCII Ports 62
Starting 111
Stopping 110
Writing to 103
Ports, Assignments for Micro 62
Ports, Simple ASCII 62
Postfix Codes 253
Postfix Entry Mode 252
Power and Power/State Flow
Viewing 125
Power Flow
Setting Color of 119
Power Flow Size, Setting 119
Preferences, Setting and Changing 29
Print Setup, Changing 274
Print to File 272
Printer Font, Changing 273
Printing
Also see Lister
Controller Tables 267
Documentation Tables
Cross References 265
Font, Changing 273
Formatting a Printout 269
from Register Editors 140, 155
Miscompares 333
Mismatch Tables 268
Network Miscompares 336
Network Options 264
Networks 262
Print Setup, Changing 274
Quick Picks Options 270
OPT Files 270
Selected Database Information 263
Process Variable (PV)

defined 298
Program Functions (Mnemonics) 347
Program Mode, Online Editor 127
Project
Adding to fxManager 400
Checking In 402
Checking Out 396
Creating 398
Getting a Read-Only Copy 403
Icons 395
Labelling 403
Opening 397
Project Manager
Checking In a Project 402
Checking Out Projects 396
Getting a Read-Only Copy of a Project
403
Labelling a Project 403
Layout 393
Opening 393
Opening Projects 397
Toolbar 394
Undoing a Check Out 404
Prompt for Read When Exiting Online
System Preference 31
Prompt when Deleting Instructions System
Preference 31
Prompt When Overwriting Instructions
System Preference 31
ProWORX ASCII (.FIL) Files 221, 224
ProWORX NxT
Audit Trail Settings 390
Authorizing 8
Installing 3
Permissions 386
Starting 5
System Requirements 3
Working with fxManager 384
ProWORX Symbol (.FIS) Files 221, 224
PV
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See Process Variable

-Q-

Quantum
Configuring Cards 193
Terminal Block 183
Quantum Hot Standby Configuration
Extension 82
Quick Picks Printing Options 270

-R -
R I/0O Health, Monitoring 319
Racks 180
Radix

Display Single Bit for Registers 140
Editing for Registers 140, 148
in the Data Watch Window 282
Read Flash RAM Executive 109
Read/Write Status in Quantum Traffic Cop
191
Reading from a Controller 102
Read Type 102
Rebuilding a Database 175
Records. See Documenting.
Redo 129
Register Editor
Extended Memory 148
Generic 152
PCFL Editor 244
User Configurable 137
Registers
Configuring 56
Contents Utilities 156
Documenting 139, 149
Editing in the Data Watch Window 286
Editing Operations 139

Extended Memory
Copying Blocks 151
Filling Registers 152
Moving Blocks 150
Timer (Configuring) 58
Utilities
Copying Blocks 157
Filling Blocks 157
Moving Blocks 156
Registration, product 4
Relational operator 235
Relocating Logic During a Write 104
Remote Channels, Configuring 56
Remote I/O (RIO) processor 180
Removing Deleted Records 220
Replace (Global) 161
Restoring a Backed-Up Database 22
Retracing Searches 167
RIO (Remote I/O) 180
Rows, Inserting and Deleting 170

-S-

5908

Setting I/O Points per Drop 65
5980

Address Configuration Extension 81
SA85 Adapter

Initializing 29
Sample Rate

in the Data Watch Window 279
Saving a Database 21

default database path 32

with Back Up Function 22
Saving Blocks of Logic 171
Scanning a Network 50
Scheduled Comparisons 329
Screen Setup, Customizing 117
Search Panel 167
Searching
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Coils 174
Documentation 213
by Blank Descriptor 214
by Descriptor 213
by Reference 213
by Symbol 214
Duplicate Coils 174
Logic 165
Retracing 167
Viewing Results 166
Security for ProWORX NxT
fxManager Access Control 386
Password-based security 24
Security Settings
changing 24
Protected Register List 25
Segment Scheduler 134
Segments, Configuring 56
Selecting a Device 44
Network Scan 50
with a Direct Connection 45
with a Modem Connection 46
Server, fxManager 392
Set Point (SP)
defined 298
Setting System Preferences 29
Setting up Communications 35
Settling Time, Configuring 57
Short Comments
Entering 216
in Documentation 208
Show Coils in Solve Column display option
118
Simple ASCII Ports 62
Single Sweep 176
6 Digit Addressing System Preference 31
Skips, Configuring 58
Slot Edit
See Traffic Cop
Slots 180

Smart Configurator 59
SP
See Set Point
SP (Set Point)
Adjusting 301
Specific Input in Peer Cop 94
Specific Output in Peer Cop 93
Spreadsheet View (Data Watch Window)
276, 292
Start up
in Program or Monitor mode (System
Preference) 31
Starting a Controller 111
Starting ProWORX NxT 5
Startup program 5
State Flow, Viewing 125
State Ram Transferred options 83
Status Bar 116
Stopping a Controller 110
Subfields in Peer Cop 92
Sub-Function Instructions 131
Supervisor Password 24
Sweep 175
Constant 175
Single 176
Symbol Summary Panel 121, 164
Symbolic Addressing 164
Symbols
Enabling 30
Entering 216
Exporting .FIS Files 224
for Documentation 208
Importing .FIS Files 221
Setting Color of 119
Symbols List Panel 231
Symbols System Preference 30
System Options. See System Preferences.
System Preferences
Setting and Changing 29
System Requirements 3
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-T-

Table Index Printing Option

269
TCP/IP Communications

Configuration Extension 79

Configuring 42

Overview 34
TEF Files

Importing Traffic Cop from 222
Telephone Numbers, Entering 47
Terminal Block (800, Quantum, A120) 183
Time of Day Clock

Register for 58

Setting 98

Year 2000 Compatibility 28
Time Slice, I/ O (Configuring) 56
Timed Comparisons 329
Timer Register, Configuring 58
Timer, Watch Dog (Configuring) 58
Title Page Printing Option

269
TOD

See Time of Day Clock
Toolbar 114

Project Manager 394
Total Messages, Configuring 57
Track User Actions 388
Traffic Cop

200 / 500 Series 197

3xxxx Status Register 191

800 Series 185

900 Series 198

A120 Series 199

Auto Addressing 183

Data Display 182

DCP Series 187

Micro 300 Series 196

Overview 180

Quantum 190
Card Configuration 193
Interbus-S 193
Read/Write Status 191
Traffic Cop Display, in Network Editor 124
Transferring Controller Memory to EEPROM
105
Transferring Controller Memory to FLASH
RAM 106
Tree Control
in Configuration Extensions 78
in the Traffic Cop 181
Trend View (Data Watch Window) 276, 290
PID Trend graphs 301
Reading 291
Triggers, in the Data Watch Window 284
Tuner/Face Plate display 300

-U-

Unary operators 234
Undo 129
Undo a Check Out 404
Unlinking Macros 312
Update Rate, Setting 125
Updating macros 311
Updoc
Importing Documentation from 221
UREF Files 137, 140
Template for 142
Use Insert/Delete Key Menus System
Preference 30
Used Addresses
Checking for 158
in Equation Networks 238
User Configurable Register Editor 137
Display single bit 140
Documenting Registers 139
Editing Operations 139
Editing Radix 140
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Editing Values 139
Printing from 140
User Loadables
Copying into Controllers 67
Creating a Library 69
Deleting 68
Displaying Manufacturer’s Notes 70
Editing an Opcode 70
Rebuilding a Library 70
User Logic, Size of 65

-V -

Verify Device Selection System Preference
31
Viewing
Health Status Words 321
Search Results 166
Views, Customizing 117

-W -

W190 Cable 362, 367
Watch Dog Timer
Configuring 58
Reset 135
Web site 10
Wiring Diagrams 359
25-Pin Serial Port to Modicon 984A,
984B, or 984X 360

25-Pin Serial to Modicon 584 with W190

Cable 362

25-Pin Serial to Modicon 984 x80 and x85

361
25-Pin Serial to Modicon E Series,
Quantum, or Compact 363
25-Pin Serial to Modicon J478 Modem
365

25-Pin Serial to Modicon Micro 311 or 411
364
584 Military Connector 368
9-Pin Serial Port to Modicon 984A, 984B,
or 984X 360
9-Pin Serial to Modicon 584 with W190
Cable 362
9-Pin Serial to Modicon 984 x80 and x85
361
9-Pin Serial to Modicon E Series,
Quantum, or Compact 363
9-Pin Serial to Modicon J478 Modem 365
9-Pin Serial to Modicon Micro 311 or 411
364
IBM 5531 to Modicon 584 with W190
Cable 367
IBM 5531 to Modicon 984A, 984B or 984X
366
IBM 5531 to Modicon J478 Modem 367
IBM 5531 to Modicon x80 and x85 366
IBM AT Loopback Connector 368
IBM PC Loopback Connector 368
Working with Databases. See Databases,
Working with.
Write Flash RAM Executive 109
Writing to a Controller 103
Write Type 103

.Y -

Y2K Compatibility 28
Year 2000 Compatibility check 28
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